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Maconomy 2.5.2 — Summary 
This section gives a high-level summary of the key features for Maconomy 2.5.2. 

General Enhancements 

Update Resource Allocations on Non-Working Budget Types 
Deltek Tracking: 1285018 

 This feature makes it possible to edit the resource allocations sub table for budget lines of budget 
types other than the planning budget. A user can change resource assignments and bookings, 
which may be required to handle change request updates to the Baseline Budget. 

Check-in Time Required to Match Time Sheet Registration 
Deltek Tracking: 1352343 

 This feature adds the ability to require that the time an employee checks in matches the time 
registered for the day in the time sheet.  

Company Dimension Combinations 
Deltek Tracking: 1119361 

 The Company Dimension Combinations single dialog workspace is introduced to enable you to 
quickly look up account, local account, and local chart of accounts derived for a given company 
and dimension combination header. 

Document Archiving Enhancements 
Deltek Tracking: 1069050 

 You can now archive documents related to customer payments and access attached documents 
from the Financial Analysis workspace. 

Synchronous Approval Notification Enhancements 
Deltek Tracking: 1296056 

 Approval Notifications are now synchronized to improve performance. 

 New Export Statement action is added, and new Selection Criterion Statements and Selection 
Criterion Statement Lines single dialogs are added. 

 Maconomy now allows approval hierarchy selection lines without a selection criterion 
specification. 

Vendor Subcontractor Reconciliation in Different Currencies 
Deltek Tracking: 1113784, 439397 

 This enhancement now enables you to reconcile subcontractor invoices in different currencies. 
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New Fields in Option Lists and Popup Fields 
Deltek Tracking: 1275041, 1275043 

 New fields are added to the Option Lists and Popup Fields single dialog workspaces to provide 
more lists for possible values that you can populate in other workspaces. 

Enhanced Posting Period Setup 
Deltek Tracking: 1205411, 970317 

 This enhancement now enables you to update posting period setup more efficiently. It grants 
quick validation of periods when you assign a new posting period setup on companies or 
transaction type group. 

Exclude Compensation Types and Agreements from Total Base Salary  
Deltek Tracking: 1231588, 836514 

 The Incl. Result in Total Base Salary field is added to compensation types and compensation 
agreements. 

Non-Deductible Tax Amounts on Tax Settlement Entries 
Deltek Tracking: 1231601 

 This enhancement allows for both deductible and non-deductible amounts to be shown on tax 
settlement entries.  

Statutory/BPM 

Statutory Export Requirements for Enterprise Cloud 
Deltek Tracking: 1228103 

 This feature provides an updated file structure to support statutory export requirements. 

Embed Statement of Changes in Equity Report in Workspace Client 
Deltek Tracking: 1362628 

 The new report "Statement of Changes in Equity" is now embedded in the Workspace Client. 

New Fields for Flexible Statutory Reporting 
Deltek Tracking: 1228103 

 Additional fields are added to the Company Information Card to support statutory reporting.  

New Aging and Outstanding Invoice Reports for Australia 
Deltek Tracking: 1221000 

 Four reports are added to address current Australian statutory requirements.  
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E-Invoicing with Pagero 
Deltek Tracking: 1150840 

 Maconomy now allows e-invoicing for customer invoices through an integration with Pagero, a 
third-party provider of e-invoice products.  

Statement in Changes of Equity Report 
Deltek Tracking: 1211384 

 The Statement of Changes in Equity Report is introduced. This report shows how a company’s 
equity stock changes throughout the course of each financial year. 

Embed 1099 NEC Report in Workspace Client 
Deltek Tracking: 1310490 

 The 1099 NEC report is now embedded in the Statutory Reports workspace in the Workspace 
Client. 

Retrieving Statutory Report Details for Enterprise Cloud 
Deltek Tracking: 1339592 

 This feature updates details for retrieving statutory reports for Enterprise Cloud, including an 
action for retrieving the document, and notification when the report is generated.  

Improved Usability of Prompts in Finance Reports 
Deltek Tracking: 1298188 

 This feature allows a default setting for the exchange rate date, exchange rate table, and default 
reporting currency. 

Enhanced Financial Reporting Workspace Structure 
Deltek Tracking: 1300404 

 The Financial Reporting workspace is organized to group the reports in their proper categories. 

BPM Reporting Finance Universe Updated for Direct Retrieval 
Deltek Tracking: 1119361, 1314240, 1237124 

 The BPM Reporting Finance universe is updated for a more direct way of retrieving Year-End 
Result Accounts as well as AR and AP Control Accounts. 

Performance Views Optimization 
Deltek Tracking: 1310476 

 New indexes are introduced to the CALENDARDAYPV for Oracle and SQL Server for 
optimization.  
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iAccess 

Resource and Project Planning in iAccess 
Deltek Tracking: 1283104, 1283103, 1194334 

 iAccess now utilizes functionality from Deltek People Planner, an application that combines 
graphical project and resource planning for your entire resource pool and project portfolio on a 
company-wide scale.  

Maximizing Tables 
Deltek Tracking: 1070805 

 iAccess tables now feature Maximize/Restore buttons which allow users to expand tables, as 
well as revert to the original table size and position. 

Display Text for Empty Search Drop-Downs 
Deltek Tracking: 1350995 

 Searches that yield no results now display a message in the drop-down. 

Updated Calendar Widget in Time Sheet and Absence Workspaces 
Deltek Tracking: 1347844 

 The iAccess time sheet and absence workspaces now feature an updated calendar widget. 

Collapsible Menu Sections 
Deltek Tracking: 1231893 

 Users can now collapse and expand the various menu sections or groups in the iAccess menu. 

Touch 

Android Face ID Authentication 
Deltek Tracking: 1323883  

 Face recognition is now supported as an authentication method on some Android devices. 

Pull Down to Refresh Timesheets 
Deltek Tracking: 1323887  

 You can now pull down on the Timesheet screen to manually refresh timesheet data at any time. 

Default Keyboard Setting in Lowercase for Logins 
Deltek Tracking: 1380512  

 The username is case-sensitive, and the default keyboard setting for the first letter is uppercase. 
With this release, the default is changed to lowercase on the Login screen. 
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Customizable Search Screens in REST 
Deltek Tracking: 1323866 

 This feature adds support for customizable search queries in search screens for systems using 
the RESTful web service. 

Improved Popup Field Values 
Deltek Tracking: 1323876 

 In some cases, a popup field displays the internal name of the selected value. With this release, 
all popup fields now show the correct external value. 

Support for Windows Server 2019 
Deltek Tracking: 1380517 

 The Touch 3.6 Installer now supports installing Touch on Windows Server 2019. 

Expense Entry Automation With ICR 
Deltek Tracking: 1063279 

 This feature optimizes the Quick Capture feature with intelligent character recognition (ICR). The 
ICR functionality allows you to scan receipts, and automatically fill in the details in your expense 
reports through advanced optical character recognition.  

Enhanced Reloading of Timesheet Data 
Deltek Tracking: 1323887 

 You can now enable the Timesheet screen to automatically retrieve the latest data upon opening 
the screen. 

Color Coded Time Balances 
Deltek Tracking: 1380518 

 Color coding for time balances is updated to support the new check-in rule for employees in 
Maconomy. The balance is red when there is a difference between the checked-in and registered 
time. 

Integrations 

Performance Optimizations for Maconomy / People Planner 
Integration 
Deltek Tracking: 1291434 

 Extended "Update Job Budget Resource Allocations" to also support update of a year. 

 Updated the "ResourceAllocationsFromPP" extension to use the updated 
"UpdateJobResourceAllocation" dialog. 
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Technology / System Admin 

Improving Search on Import Program for Import Package Lines 
Deltek Tracking: 1368031 

 The search on Import Program for Import Packed Lines is now improved.   

REST API Enhancements 
Deltek Tracking: 1368031 

 We have released a new second version of the Maconomy REST API, improved for performance 
and with updated documentation. 

Server Performance Improvements 
Deltek Tracking: 1354068 

 We have added server performance improvements, transparent to the user, related to dialog 
container file access and CPU hotspots. 

Technology Enhancements 
Deltek Tracking: 1370999 

 We now have case insensitivity for Maconomy user login name. 

Tooling Enhancements 
Deltek Tracking: 1370999 

Tooling enhancements include: 

 Index.HTML support for Scalable Server Installation Information. 

 Validation of servers used for Maconomy Nodes. 

 Security File Check Update enhancement. 

Generic Error Codes 
Deltek Tracking: 1205091 

 For improved internal error tracking, some error messages in Maconomy may now include an 
error code, such as A-cd76e82a. Use this code if needed when communicating with Customer 
Care on a support case. 

Static Validation of MDML via Extender 
Deltek Tracking: 1271966 

 This update corrects a number of errors in standard MDML layouts which rendered static 
validation in the extender produce errors related to standard files.  
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Duplicate Index, Instance Key and Uniqueness Constraint Report Tool 
Deltek Tracking: 1303815 

 A new tool compiles the list of standard indices required and generated for a given Maconomy 
release/version.  

Application Performance Monitoring 
Deltek Tracking: 1311132 

 We have added support for turning off APM logging in Touch.  

 Updated Splunk script that extracts JVM information to Python 3. 

Synchronous Calculation of Push Notifications in Workspace Client 
Deltek Tracking: 1309937 

 Maconomy now notifies synchronously and immediately updates the To-Do pane in the 
Workspace Client. 

New Naming for Maconomy Cumulative Updates 
Deltek Tracking: 1230877  

Previously, the cumulative update (CU) numbering format has been a two-digit number. This is now 
updated to a three-digit number.  

The updated name is: 

Maconomy <version> CU <nnn> 

For example, the second CU on the 2.2.x stream is now named Maconomy 2.2.x CU 002 

Additionally, we have updated different Packing Unit (PU) types to have a single naming convention, 
rather than different but similar naming conventions.  

The updated name is: 

apu.w2000.sp105a or  tpu.NTx86.20_0.p105a? 

Existing PUs are supported without the need for renaming, and MConfig and other tools are able to 
handle both generations of names. 

BPM 

The new format for PU names necessitates an update in BPM naming format. Since this new format is 
defined for all PUs, thus it also requires an update in Reporting Packing Units (RPUs) in BPM. 

These update include: 

 New RPU name 

 New BIAR file names 

 Remove People Planner BIARs  

 Update the names of ETL  

 Remove sub-version (0) from version XML files 

The updated names are: 
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RPU Name — rpu.<main version>.<sp>.<cu>.<build number>.<solution>.zip 

Example: rpu.20.sp103.cu008.1234.s-std.zip 

BIARs — bpm-<product>.<main version>.<sp>.<cu>.<build number>.<solution>.<database>.biar 

Documentation of universes — Include version tag. \ 

ETL analysis —  bpm-analysis-etl.<main version>.<sp>.<cu>.<build number>.xml 

Example: bpm-analysis-etl.20.sp103.cu0008.1234.xml 

ETL peopleplanner — peopleplanner-etl.<main version>.<sp>.<cu><build 
number>..xml 
 
Example: peopleplanner-etl.20.sp103.cu008.1234.xml 

Certifications 
Deltek Tracking: 1240687 

 Firefox 78 ESR – for Maconomy. 

 Safari 14 – for iAccess. 

 Windows Server 2019  

 Java 8 Security Update 271 
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Maconomy 2.5.1 — Summary 
This section gives a high-level summary of the key features for Maconomy 2.5.1. 

General Enhancements 

Core Support for Touch Approvals 
Deltek Tracking: 1231904 

 This enhancement to the Workspace Client supports the new approval functionality in Touch. 
It adds support in Touch to view specific approval objects, depending on approval type, 
approver type, and so on. Approval counters are also improved to provide easier reference 
when viewing records that require your approval. 

Employee Gender on Employee Card Enhancements 
Deltek Tracking: 1249427 

 This enhancement introduces two additional employee gender values in the employee card.  

Documentation Refactored 
Deltek Tracking: 1223838, 1247929, 1247931 

 System Admin Guide is restructured for ease of use and finding content. 

 Upgrade Guide is streamlined and contains a new role-based format and workflows for ease 
of use.  

 BPM Admin Guide now contains previous BPM install and upgrade guides, including 
statutory install and upgrade, in one document. 

Enable or Disable the Conversations Functionality 
Deltek Tracking: 1138822 

 This enhancement allows you to enable or disable the Conversations functionality in the 
Workspace Client. 

Back Office 

Employee Revisions Enhancements 
Deltek Tracking: 1182755 

 The Employee Revisions single dialog workspace and Revision Selection sub-tab in the 
Employees workspace are added to allow for restrictions to be placed on the contents of this 
dialog, so that the performance impact of loading large quantities of Employee Revisions by 
default, can be avoided. 

New Supplements and Supplement Types 
Deltek Tracking: 1227573 
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 Two new single dialog workspaces are added to the Workspace Client: 

 The Supplements single dialog workspace is introduced to store a collection of fields 
open for general information.  

 The Supplement Types single dialog workspace allows you to store the external name of 
the fields to synchronize across Maconomy. 

Vendor Remittance Emails Workspace 
Deltek Tracking: 1154339 

 You can now send vendor remittance emails to show that the vendor invoice was paid within 
the payment terms. 

Aggregate Finance Entries Over Dimensions and Tasks 
Deltek Tracking: 1186465 

 This enhancement enables you to create an aggregate over finance entries posted with the 
same dimensions and tasks in the same fiscal year. 

Access Control for Format Specification 
Deltek Tracking: 1179116 

 This enhancement introduces access control to the relations in the Format Specification 
workspace and module. Maconomy now enables you to limit which users can access and 
change information used for making payments. 

Statutory/BPM 

UK MTD Fraud Prevention Headers 
Deltek Tracking: 1256888  

 The UK Making Tax Digital (MTD) Report is enhanced to include fraud prevention headers to 
meet the requirements of the UK HM Revenue and Customs (HMRC). 

Cashflow Statement Indirect Method Report 
Deltek Tracking: 1113809  

 This enhancement introduces the Cash Flow Statement Indirect Method report, which is a 
financial report used in business processes for performance management and outlines how 
cash flows in and out of a business. 

India Overdue Payments Report 
Deltek Tracking: 1213873 

 The India Overdue Payment report, known in India as the MSME Report, is used by 
companies who get supplies of goods or services from micro and small enterprises, and 
whose payments to micro and small enterprise suppliers exceed forty five days from the date 
of deemed acceptance of the goods or services.  

https://tfs.deltek.com/tfs/Deltek/6975c4c0-6dfa-40f2-b71d-45b29d45d518/_workitems/edit/1265848
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Swedish SIE Report 
Deltek Tracking: 1261540 

 The Swedish SIE (Standard Import/Export) reports are used by the Swedish tax authorities to 
audit a company’s books. The report shows details of accounts balances and the opening 
and closing of balance sheet accounts and balances of the profit and loss accounts. 

Control Account Number Object in AR Aging and AP Aging 
Deltek Tracking: 1221562 

 A new object called Control Account No. is introduced in the AR Aging and AP Aging 
universes.  

Updates for 1099 MISC and NEC Changes  
Deltek Tracking: 1226383 

 A new 1099 form called the 1099 NEC is released for tax reporting. Changes are made to the 
1099 form to account for this update. 

BPM Reporting Structures Option List 
Deltek Tracking: 1244067 

 New reporting structure option lists and values for NSAF-T and SIE are added to differentiate 
between the reporting structure lists and values used for other reports, such as Balance 
Sheet, P&L, and Trial Balance reports. 

Embed Tax Settlement Report in Workspace Client  
Deltek Tracking: 1137979 

 The Tax Settlement report is now embedded in the Workspace Client. The report is available 
in Reporting » Reports » Financial Reporting.  

Embed All Statutory Reports in Workspace Client  
Deltek Tracking: 1167901 

 For better usability and to enhance the user experience, all statutory reports are now 
embedded in Reporting » Reports » Financial Reporting in the Workspace Client. This 
includes the UK Tax Submissions WebI, Norwegian SAFT, Overdue Vendor Payments 
(India), and Statutory GSTR (India) reports. 

German GoBD GL Data Export Requirement 
Deltek Tracking: 1220987 

 Maconomy now supports GoBD, which contains rules that allow German tax authorities to 
access and verify accounting data digitally from a tax payer’s electronic bookkeeping 
process.  
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NSAFT Data Export Reporting Structure 
Deltek Tracking: 1293326 

 A new data export reporting structure for NSAFT is added to differentiate between the 
reporting structure used for other reports, such as Balance Sheet, P&L, and Trial Balance 
reports. 

Natural Sign in Finance Reports 
Deltek Tracking: 1209944 

 A new prompt is introduced in BPM Finance reports that allows users to report on financial 
figures with a natural sign. 

New Reporting Structure for Cashflow Statement Indirect Method 
Deltek Tracking: 1235863 

 A new reporting structure for Cashflow Statement is introduced to support Indirect Method in 
the standard PSO solutions. 

New Standard Dimensions 
Deltek Tracking: 1269228 

 Specification 4-10 and Local Specification 4-10 are new standard dimensions added to the 
BPM reporting universe. You can now use and add these dimensions to the reports if 
needed. 

BPM Aging Reports Enhancements 
Deltek Tracking: 1165941 

 The BPM Aging Reports are enhanced for flexibility and improved performance. 

New Filter in AP Aging, AR Aging, and WIP Aging 
Deltek Tracking: 1220989 

 A table filter is added to the Aging reports to enable you to filter a row if the aging columns 
are zero. 

Statutory Reporting Workspace 
Deltek Tracking: 1220995 

 The new Statutory Reporting workspace is added to the Workspace Client to enable you to 
easily access the Accounting Entry File, Belgium Reports, GoBD Report, USTVA Report, 
NSAFT Report, SIE Report, and Overdue Vendor Payments Report. 

UK Tax Submission and Statutory Reporting Workspaces 
Deltek Tracking: 1220995 
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 The UK Tax Submission and Statutory Reporting workspaces are added to the Workspace 
Client to enable you to easily access the Accounting Entry File, Belgium Reports, GoBD 
Report, NSAFT Report, SIE Report, and Overdue Vendor Payments Report. 

Tax Settlement Report Enhancements 
Deltek Tracking: 1221003 

 The Entry Date prompts in the Tax Settlement Report are removed and the Period prompts 
are now mandatory. This enhancement requires you to use the period intervals for filtering in 
the report. 

New Reporting Structure Name Prompt in Finance Reports 
Deltek Tracking: 1154024 

 The reporting structure prompt is added as a mandatory prompt to the Finance reports to 
enable you to easily specify the format of account headers and subtotals when you run the 
reports. This feature allows flexibility in selecting the structure to use for a balance sheet, for 
example.  

Time and Expense 

Improved Approver Access Control for Time, Expense, and Mileage 
Sheets 
Deltek Tracking: 1038584, 850544 

 Access control specifications on time, expense, and mileage sheets are improved to display 
only the records that are relevant to the approver. 

Multiple Check-in / Check-out Per Day Enhancements 
Deltek Tracking: 1256775 

 You can now import check-in data to Maconomy. 

Exclude Overtime From Time Sheets 
Deltek Tracking: 1171729 

 You can now specify whether to exclude overtime in the calculations of regular working hours 
on a time sheet. This is available in the Workspace Client, iAccess and Touch. 

Invoicing 

Withholding Tax on Customer Invoices 
Deltek Tracking: 1109747 

 Withholding tax with negative VAT rates on outgoing invoices are now supported on 
intercompany invoices, sales orders, and subscription orders. 
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Conversation Functionality Enhancements for Invoicing Workspaces 
Deltek Tracking: 1138822 

 The conversation functionality is now available in the invoicing workspaces in iAccess, and 
the Workspace Client. 

Job Cost 

Intercompany Pricing Enhancements 
Deltek Tracking:  795616 

 The Executing Company and Responsible Company fields are added to job price lists to 
enable you to specify an intercompany price between two companies. This price list can then 
be used as the intercompany price list on the jobs. 

Overtime Charge Percentage for Overhead Rates 
Deltek Tracking: 1071038 

 You can now specify an overtime charge percentage for overhead rates on time activities. 

Daily Descriptions on Tasks Created From Budget 
Deltek Tracking: 1162619 

 When you create or use a task list on a job, you can choose to enable daily descriptions by 
default on a task list. This enhancement allows you to create tasks from budget lines that use 
the same value by default. 

End User Enabled for Subscriptions and Jobs 
Deltek Tracking: 1293468 

 The End User No. field is now added to Subscription Orders, and Jobs workspaces. 

Absence Management 

Negative Balances in Absence Management 
Deltek Tracking: 1180701 

 Maconomy now supports the use of negative values to track absence balances.  

Project Planning and Resource Allocations 

Resource Planning Enhancements 
Deltek Tracking: 1164030 

 This feature adds improved support for mid-month progress evaluations, and provides 
enhancements for a more accurate progress evaluation on the job when using resource 
allocations from People Planner. 
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Resource Planning Performance Optimizations 
Deltek Tracking: 1166508 

 Performance optimizations are added to improve response time when you work with Budgets 
in the Workspace Client, particularly with Work Breakdown Structures (WBS) or Detailed 
Time Budgets.  

iAccess 

Saving User Settings on the Server 
Deltek Tracking: 1076502 

 iAccess now stores user-specific data on the server. This means users can save their 
preferred settings, and use these when they log in to iAccess on another device. 

Customizing Columns in iAccess 
Deltek Tracking: 1019336, 1070705 

 Users can now customize columns in all iAccess tables and list views. You can resize, 
rearrange, add, or remove columns; you can also revert to default settings for a table or list 
view. 

Simplified BPM Reports 
Deltek Tracking: 1180742 

 BPM reports embedded in iAccess workspaces now display without toolbars. 

Default Workspaces for Users 
Deltek Tracking: 1183902 

 Companies now have greater flexibility when specifying the default workspace that iAccess 
displays for users upon login. 

Customizable Search Layouts 
Deltek Tracking: 1066387, 1235054 

 Consultants can now use standard extension facilities to design and implement special 
layouts for both search-as-you-type and advanced searches in iAccess. 

Convenience Syntax for iAccess Configurations 
Deltek Tracking: 1290076 

 Consultants can now use various shorthand expressions when writing extensions. This 
makes specification of iAccess layouts easier.  

Enhancements to the Conversations Functionality 
Deltek Tracking: 1290385 
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 This enhancement allows users to mark a conversation as unread, and unsubscribe from a 
conversation.  

The Dashboard Workspace 
Deltek Tracking: 1042277, 987002 

 iAccess now includes a dashboard that project managers can use to view KPIs for a specific 
job. The dashboard has a dynamic layout that changes depending on the job type.  

Improved Rendering of Boolean Fields  
Deltek Tracking: 1300271 

 This enhancement changes the rendering of Boolean fields from drop-downs to radio buttons.  

iAccess Notifications for Rejected Purchase Order and Employee 
Deltek Tracking: 1111263 

 The standard notifications for rejected purchase order and rejected employee are now 
available in iAccess.  

Reference Workspaces 
Deltek Tracking: 1065619 

 Reference workspaces are added to iAccess. This is similar to the Single Dialog Workspace 
concept from the workspace client and enables you to test different functionalities or develop 
extensions to use within iAccess.  

Enhanced Document Viewer Functionality for Expense and Mileage 
Sheet Approvals 
Deltek Tracking: 1136978 

 The Approval Center now supports the Document Viewer functionality for expense, and 
mileage sheets. 

Touch 

Improved Touch Icon 
Deltek Tracking: 1254965, 1281699 

 This feature introduces changes to the Touch icon for Apple and Android. 

Support for Okta Authentication 
Deltek Tracking: 1269153 

 This feature introduces Okta authentication for Touch.  
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Enhanced Approval Workflow 
Deltek Tracking: 1221991 

 The Approval functionality is now supported in REST. In the improved Approval screen you 
can view, select, and approve items individually or by batch.  

Advanced User Setting Control 
Deltek Tracking: 896547 

 This feature enhances control for user settings on the Settings screen. You can hide or 
display the settings, or change the default values of the available settings. 

Application Performance Monitor in REST 
Deltek Tracking: 1047134 

 Touch now supports the Application Performance Monitor (APM) in REST, which creates 
performance log entries. This feature allows you to monitor client network activities. 

SSL Certificate Check Capability 
Deltek Tracking: 1212688 

 Touch now allows you to validate SSL certificate fingerprints against predefined strings for a 
more secure performance.  

New URLs for Touch 
Deltek Tracking: 1219194 

 A new screen with separate URLs are now available to download the Touch mobile from the 
Apple and Android app stores, and populate the Server URL field.  

Integrations 

Employee Creation Using an Employee Template for Talent 
Management Users 
Deltek Tracking: 1228725 

 You can now use employee templates to derive additional information when creating 
Maconomy employees from Talent Management users. 

Customer Currency Added to Deltek CRM Integration 
Deltek Tracking: 1061523 

 With this enhancement, you can select the customer currency for the Deltek CRM client, and 
at the same time update the currency for the Maconomy customer upon integration. 

Deltek CRM Integration Migrates to Vantagepoint REST API 
Deltek Tracking: 1088165 
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 Maconomy 2.5.1 now supports Vantagepoint 3.0, and as a result, the Deltek CRM Integration 
migrates to REST API. This means that Maconomy 2.5.1 CRM Integration will be compatible 
only with Vantagepoint 3.0 (or later). 

Expected Revenue Added as Opportunity Value to Jobs 
Deltek Tracking: 1080885 

 You can now calculate the total expected revenue for  main job and subjobs and have that 
sent to the corresponding opportunity in Vantagepoint CRM. 

Technology / System Admin 

Import Packages 
Deltek Tracking: 1239260, 1182371 

 Added the ability to set the default Import/Validate Import Package User  

 It is now possible to attach several import files to the Data Import Package at once, using the 
new action Bulk Attach Import Files. It is also possible to create a new Data Import 
Package using an Import Program. 

MPL / Printing 
Deltek Tracking: 1236722, 1139135 

 Added QR Code Centre Image Support in MPL to fulfill statutory e-invoicing requirement  

 Phase 1 moving MPL into Coupling Service to support large printings which had previously 
run out of memory. 

RESTful API Version 2 
Deltek Tracking: 1182794 

 Bringing RESTful API Version 2 to GA level and delivering new features to support iAccess 
development and customer integrations. 

Security Enhancements 
SIEL Security Enhancements 

Deltek Tracking: 1247915 

 Deltek Security SIEM — A new Client field is added to ensure the APM framework is SIEM-
compliant.  

 SIEM enhancements are implemented in Workspace Client, iAccess, and Touch.  

iAccess File Upload Security 

Deltek Tracking: 722386 

 File security for iAccess and WSC is now improved when uploading and downloading.  
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Background Task Enhancements 
Deltek Tracking: 1214786 

 Background Task functionality has numerous enhancements for usability and efficiency, 
including the following: 

o Search, validation, and expression functionality for input data 

o Extended test-bed functionality  

o User-defined context fields in key-generators 

o Scheduled rule dependency on existing tasks  

o Time dependent num. of active threads  

o Low priority tasks  

o Chained tasks  

o Numerous miscellaneous minor improvements 

APM Splunk Dashboard Enhancements 
Deltek Tracking: 1186991 

Numerous improvements are made to APM Splunk Dashboards to improve usability, including the 
addition of a new System Activity Dashboard, a new System Status Dashboard, and an update of existing 
Splunk design. 

Upgrade Optimization 
Deltek Tracking: 1221362  

To improve Enterprise upgrade efficiency, we now validate objects rather than dropping and recreating 
views. 

New Naming for Maconomy Cumulative Updates 
Deltek Tracking: 1230877  

Previously, the cumulative update (CU) numbering format has been a two-digit number. This is now 
updated to a three-digit number.  

Synchronous Calculation of Approval Notifications 
Deltek Tracking: 1071036 

 The list of approval notifications in iAccess is now recalculated and updated as soon as a 
user submits, approves, or rejects a notification.  

Certifications 
Deltek Tracking: 1181350 

 BO 4.2 SP8 – for Maconomy and BPM. 

 Android 10 – for iAccess.  

 SQL Server 2017 – for BPM 
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 Chrome 80 – for iAccess and BPM 

Note: Cookies restricted to first party. 

 Java 8 Security Update  

Extender Enhancements 
Deltek Tracking: 1179077 

 Enhanced custom.shortname deployment support for DFME 
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Maconomy 2.5 — Summary 
This section gives a high-level summary of the key features for Maconomy 2.5. 

General Enhancements 

Access Control for Approvers 
Deltek Tracking: 1174941 

 This enhancement introduces the concept of access tickets to grant users with temporary access 
to approval objects. 

 

Updated Deltek Branding in Maconomy and Related Products 
Deltek Tracking: 1181341 

 Updates Deltek branding in Workspace Client, Analyzer, Extender, iAccess, and the Portal. 

Approval Hierarchies 

Job Quote Approval in Maconomy 
Deltek Tracking: 1071037, 996519, 1088150, 1105888, 1076826, 1075354 

 Maconomy now supports hierarchical job quote header approval in the Workspace Client, 
iAccess, and Touch. 

Approval Hierarchy for General Journal 
Deltek Tracking: 1071040 

 A new Approval hierarchy for General Journal allows customers to configure advanced Approval 
workflows for General Journal headers and General Journal lines. 

Prevent Self-Approval in Approval Hierarchies 
Deltek Tracking: 1071042 

 Self-Approval Restrictions in Approval Hierarchies – You can now prevent self-approval of an 
Approval item by not allowing the same person who submitted the item to also approve it. 

Approval Hierarchies Refactoring 
Deltek Tracking: 1125419 

 Approval Hierarchies code is refactored to reduce code redundancies and duplication. 

Note: Refer to the detailed documentation in this guide under Deltek Tracking 1174941, for 
details, including recommendations on actions prior to going live with this release. 
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Approval Hierarchies for Draft Invoices Enhancements 
Deltek Tracking: 1145075, 1095638 

 A new field is introduced in draft invoices, which can be used as a selection criteria 
specification when setting up approval hierarchies. This enhancement also adds a system 
parameter to improve customization of approval hierarchies. 

Time and Expense Sheet Approval Improvements 
Deltek Tracking: 1162619 

 Approval workflows for time and expense sheets have been streamlined. If you are using 
approval hierarchies for these records, you can no longer combine this with a job approval 
setup. 

Back Office 

System Parameter for Number of Entries in Vendor Invoice Journals 
Deltek Tracking: 1129397, 774700 

 A single journal is created for each Vendor Invoice. Maconomy automatically creates a new 
Vendor Invoice journal and assigns the Vendor Invoice to this journal instead of grouping by the 
current user. 

Add Employee Relation to Selection Criteria for Job Draft Invoices 
Deltek Tracking: 1071043 

 The Employee relation has been added to the selection criteria line for draft invoices through the 
Project Manager field, enabling you to create more advanced Approval workflows. 

Enhanced Selection Criterion Specification and Change-on Change 
Functionality 
Deltek Tracking: 1132068 

 Company Vendor and Payment Company Vendor Added to PO Target Group -- The table 
relation on Purchase Orders is enhanced to include Company Vendor and Payment Company 
Vendor table sections.  

 Allow  “Changes on Change” for Purchase Orders – This enhancement allows Changes on 
Change functionality for Purchase Orders. It also adds Changes on Change functionality to all 
other Approval types to keep workflows consistent. 

Base Salary Rate Calculation for an Employee Range 
Deltek Tracking: 836515 

 This enhancement limits which employees are included in a base salary calculation by using a 
range of employee numbers.  

 A new field is added to the Base Salary Rate Calculation Target Group, which specifies the range 
of employee numbers to include in the calculation. 
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Removal of Euro Exchange Rate Tables 
Deltek Tracking: 1126295 

 This enhancement removes outdated Euro tables that are no longer relevant or used. It improves 
the exchange rate calculations as less lookups are required. 

New Debit Credit Field 
Deltek Tracking: 1115433 

 New Debit/Credit Field on Reporting Structure Line -- A new field on the Reporting Structure 
Line is introduced to show whether an account is debit or in credit. This feature is useful for 
statutory reports where the line must only show a debit balance or a credit balance. 

Exchange Rate Based on Invoice Date 
Deltek Tracking: 1129396, 800936 

 Use Invoice Date as Exchange Rate Date on Vendor Invoices – A new company-specific 
system parameter is added to enable Maconomy to calculate the exchange rate based on the 
invoice date, instead of the entry date, when you create vendor invoices. 

Enhanced Vendor Invoice Allocation Workspace to Support 
Reallocation 
Deltek Tracking: 774702 

 This enhancement removes the Reallocate Invoices single dialog workspace. 

 Invoice Allocation single dialog workspace now supports both allocation and reallocation of credit 
memos and vendor invoices. 

Automatic Posting of Interest Charge Notice Journals 
Deltek Tracking: 755417 

 Automatic Posting of Interest Charge Notice – A new company-specific system parameter is 
introduced to enable Maconomy to automatically post the interest charge notice journals. 

System Parameter for Unrealized Exchange Rate Variances for Control 
Accounts 
Deltek Tracking: 841812 

 Create Unrealized Exchange Rate Variances For Control Accounts – A new company-
specific system parameter is added to enable Maconomy to create unrealized exchange rate 
variances for control accounts. 

Increased System Number Capacity 
Deltek Tracking: 1130811 

 This enhancement increases the system number length from nine to 255 characters. The 
system numbers are changed from integer to string values to extend the capacity. This 
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feature also updates the object format on the BPM Reporting universes to support the 
increased system number capacity. 

Tax Depreciation of Fixed Assets 
Deltek Tracking: 536720  

 This enhancement is introduced to enable you to restrict the tax depreciation of fixed assets. 
It also provides two new options to set up limitation on tax depreciation. 

Time and Expense 

Multiple Check-in or Check-out Time Entries Per Day 
Deltek Tracking: 1077699, 439452, 924309 

 This enhancement provides a more detailed and accurate representation of time worked 
daily. You can now log multiple entries per day in time sheets to track work hours.  

 This is implemented in the Workspace Client, iAccess, and Touch. 

Mandatory Numeric Fields in Expense Justification 
Deltek Tracking: 1068628, 949720 

 You can now add mandatory numeric fields to your expense sheets and search for values in 
option lists in the Expense Sheet Justification sub-tab. This functionality is available in the 
Workspace Client, iAccess, and Touch. 

Time Sheet Overview Workspace 
Deltek Tracking: 906078 

 This new iAccess workspace enables supervisors to review time sheet status for all 
employees under their supervision. 

Color Coded Statuses 
Deltek Tracking: 1187694 

 You can now use color coding on the Status field in the Time Sheet Overview workspace in 
iAccess. 

Tax Fields in the Expenses Workspace 
Deltek Tracking: 1199815 

 The tax fields are now added to the expense sheet lines in the standard expense sheet layout 
in iAccess.  

iAccess Notifications for Missing Time Sheets 
Deltek Tracking: 1134602, 1134620 

 The standard notification for missing daily and weekly time sheets are now available in 
iAccess. 
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Approval Center in the Workspace Client 
 The Approval Center is now available in the Time & Expenses module. 

Invoicing 

Document Archive for Draft Invoices  
Deltek Tracking: 616200, 614337, 912162, 1206290, 1214209 

 You can now attach and manage documents on draft invoices. Approvers can also review 
this attachments during the approval process. 

 This is implemented in the Workspace Client and iAccess. 

Tracking Partial Payments in Invoice History 
Deltek Tracking: 586355, 804202 

 You can now track the balance of your job invoices through the Remainder fields and the 
Partially Reconciled payment status. The Payment Status field is updated with a Partially 
reconciled status. A new Remainder field shows the remainder.  

 This is implemented in the Workspace Client and iAccess. 

Statutory/BPM 

Chinese Setup Guide 
Deltek Tracking: 962671 

 Created and released a Statutory Regulatory Guide for China. 

Selection Criteria on Report Tab  
Deltek Tracking: 563042 

 The selection criteria is moved to the new Report tab to enhance BPM reports. 

iAccess 

Enhancements to the Conversation Functionality 
Deltek Tracking: 1204848, 1204853, 1204850 

 This feature improves on the Conversations functionality introduced in 2.4.5, including the 
ability to paste copied text into the message pane and display URLs as hyperlinks.  

Role-Dependent Search Options 
Deltek Tracking: 1196212, 1093984 

 You can now annotate all search restrictions in filters with a visibility condition; this allows you 
to conditionally hide individual search restrictions.  
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Displaying Additional Information on iAccess Systems 
Deltek Tracking: 1077740 

 Labels on iAccess Systems — You can now display the name of an iAccess system on its 
interface. (1046567) 

 Displaying Information on the iAccess Browser Tab — If you are logged in to iAccess, 
your browser tab now displays your name as well as the name of the workspace you are 
currently viewing. (1211119) 

Enabling Charts in iAccess 
Deltek Tracking: 1097220, 1103856 

 You can now create charts and graphs based on the data in your company's Maconomy 
system, and display these in any iAccess workspace. 

Quotes Workspace 
Deltek Tracking: 1060377, 1060423 

 iAccess now includes a new Quotes workspace in the Jobs menu that enables users to 
create and revise job quotes as well as order confirmations. 

Credit Control Enhancements 
Deltek Tracking: 1065613 

 Credit Control Support -- Adds support for managing Credit Control events in iAccess in a 
new Collections workspace. 

 A/R Review Comments -- Introduces the conversation feature in the Collections workspace. 

Embedded BPM Reports in iAccess Workspaces 
Deltek Tracking: 1068610, 966794, 1142763 

 BPM reports are now better integrated in the iAccess interface. 

Invoice History Enhancements 
Deltek Tracking: 586355, 1209696 

 This enhancement allows you to track your partially settled invoices, pre-invoices, and credit 
memos. When you view an invoice’s history, the Payment Status field now includes Partially 
Reconciled status. The Payment Status field is updated with a Partially Reconciled status. A new 
Remainder field shows the remainder, and you can check the remaining balances at a glance 

Touch 

Updated Icon in the App Store 
Deltek Tracking: 1209758 

 Touch iOS application icon now uses dark lavender in the App Store. 
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. 

String Object Type for System Numbers 
Deltek Tracking: 1189200 

Changing the object type for system numbers to String from Integer to support a higher range of system 
numbers may affect extensions that you are using in several screens in Touch, such as Purchase 
Orders, Expense Sheets, Vendor Invoices, and Draft Invoices, among others. 

Support for Quotes Approval in Touch 
Deltek Tracking: 1075354 

 Touch now supports approval of job quotes. 

Support for Time Entry Check-In and Check-Out Multiple Times Per 
Day 
Deltek Tracking: 1074882 

 You can now register time check-in and check-out entries several times per day using the 
Check In tab on the Timesheet screen. 

 This is implemented in the Workspace Client, iAccess, and Touch. 

Integrations 

Deltek Talent Management Organizational Structure Integration 
Deltek Tracking: 597579 

 This enhancement enables you to create and maintain a multi-level organizational structure 
in Maconomy and synchronize the organization structure to Talent Management making it 
available when onboarding new hires in Talent Management 

People Planner Integration  
Deltek Tracking: 1132123 

 Updated Namespace Value for People Planner – The Web Service Namespace API 
system parameter is updated with a new default value to use for logging in to the AP. 

System Admin 

Improved Data Import Package Process 
Deltek Tracking: 1035212, 1037705 

 A new Data Import Package process in Maconomy streamlines the import process. 

 A new Data Import Packages workspace streamlines the administration around importing 
multiple imports, assists in the managing of import data, offers a new level of validation and 
offers more intuitive insight into import status and error handling. 
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 Import performance: Use TDH/DbDesc instead of database lookup – The execution of 
running imports via the new Data Import Packages workspace has been optimized to improve 
the time taken to import data. (1079489) 

 The Use Internal Names in Import Dialogs system parameter enables Maconomy to 
automatically include internal field names and line types when importing information. 
(934690) 

APM Template Dashboards 
Deltek Tracking: 1126447 

We updated packaging of templates for APM, including Splunk dashboards. 

Performance Improvements 
Deltek Tracking: 1132198 

 Notifications Recalculation Optimization — There is a significant performance improvement 
for the recalculation of notifications due to a new collective query that functions by user role.  
(1062532) 

 Avoid Extraneous Database Operations — Introduced a setting to switch off legacy lifecycle 
functionality (1187732) 

Technology Enhancements 
Deltek Tracking: 1132196 

 Exporting Dates and Time Using the Default Format in Excel – You can now choose to 
export data to Microsoft Excel in the format defined by your operating system. (1036774) 

 Multiple Fonts Support – You can now specify a list of fonts to use for rendering text in 
MPL. Additionally, this feature also supports a fallback font for characters with no suitable 
font installed to render them. (591777) 

Install and Upgrade Enhancements 
Deltek Tracking: 1132199 

 Updated Message – The message issued when User Account is blocked to support Reset 
Password is updated. (996355) 

 MConfig “No Output” – Mconfig now supports a “no output” option. (783416) 

 People Planner REST URL– Mconfig is extended to include a People Planner REST API 
URL for iAccess. (1062525) 

 Disaster Recovery Configuration – Mconfig now supports a disaster recovery server 
configuration. (1178503) 

Extension Framework Enhancements 
Deltek Tracking: 1132192 

 Automatic Read Enabled in Container-Executor – There is a change in the API and the 
container-executor API read method is now deprecated. Reads are now automatically invoked 
whenever a data container is queried. (1027580) 
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 Namespace Annotation for Java Extensions – This enhancement enables you to easily 
declare constants that include the namespace for container contributions. (1027580) 

 Ability to Develop iAccess against local coupling service (1128255) 

 Deprecating iAccess FPU import wizard (1186303) 

Workspace Client Platform & Usability Enhancements 
Deltek Tracking: 947517 

 Default Communication Protocol for Workspace Client - Maconomy now uses the Mux-
RMI protocol as the default communication protocol to allow for fewer network connections, 
prevention of network channel timeouts, and better support for load balancers. (1180507) 

Certifications 
Deltek Tracking: 1132203 

 Java SE 8 – Update 231 for Maconomy 

 Oracle 19 – for Maconomy and BPM  

Note: For Pentaho, Oracle 19, is supported as a data source only and not as a database 
repository.  Additionally, while our BPM packaging supports Oracle 19, SAP itself has not officially 
certified Oracle 19 for use with BO SP5.   

 iOS 13.x – for iAccess (iPad) 

 Safari on iOS 13.1.2 – for iAccess (iPad) 

Note: Beginning with iOS 13.1.2, iPad users can now view BPM reports in either Safari or 
Chrome. However, for optimal viewing experience, SAP BI mobile still recommends the use of 
their Mobile BI app. 
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Maconomy 2.5.2 — Detail 
This section gives a detailed description of the key features for Maconomy 2.5.2. 

General Enhancements 

Update Resource Allocations for Non-Working Budget Types 
Deltek Tracking: 1285018 

The People Planner integration allows you to update the planning budget and assign resources. 
Previously, this integration was the only way to populate planning budgets with resource allocations. Also, 
you could only assign resources to planning budgets, and the assigned resources could be viewed but 
not changed.  

This feature makes it possible to edit the resource allocations sub table for budget lines of budget types 
other than the planning budget. You can change resource assignments and bookings, which may be 
required to handle change request updates to the Baseline Budget. 

Now you can change, add, and delete resource allocations on budget lines (other than the planning 

budget) via specific job budget lines.  

You can now change:  

 Assigned employee 

 Cost, if it is an amount activity 

 Resource allocation hours, if it is a time activity 

Note: The process to create or alter job budget lines remains the same. However, job budget lines will of 

course be indirectly updated when you change the resource allocation, as previous functionality of the 

People Planner integration. 

Additionally, this feature enables you to: 

 Create a periodic working budget based on People Planner Resource Allocations, which you can 
copy to form a Baseline budget, including the periodic Resource Allocations.  Note that working 
with Earned Value Management (EVM) requires a Baseline budget to compare Baseline, Actuals, 
and Remaining data.  

 Update the Baseline Budget, including the periodicized Resource Allocations, in order to 
incorporate change requests.  The change request is incorporated into EVM Reporting.  

 Remove the read-only state of ALL budgets excluding the Planning Budget, which is read only 
when a customer updates via People Planner Resource Allocations.   

Changes to Maconomy  

The following workspaces are updated: 

 Job Budget Lines Resource Allocation, Resource Allocation Hours sub-tab 

Check-in Time Required to Match Time Sheet Registration 
Deltek Tracking: 1352343 
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Maconomy now supports a new check-in rule, which requires an employee’s check-in time to match the 

registered time prior to submitting the timesheet. When the Required To Match Time Sheet check-in rule 

is selected, you cannot submit a timesheet with a nonzero time balance. A warning message displays 

stating that the registered work hours must be equal to the check-in time for a specific date. You can 

enter a round up value in the Check-In Time Round Up system parameter to allow a slight discrepancy 

between the logged hours. However, the time balance ultimately needs to be zero to submit the 

timesheet. 

Moreover, the Required With Balance check-in rule is renamed to Required To Match Or Exceed Time 

Sheet but functions the same as before. When it is selected, the check-in time must be equal or greater 

than the registered work hours, otherwise a warning message also displays. 

 

Changes to Maconomy 

The following workspaces are updated: 

 Employees single dialog 

 Employee Revisions single dialog 

Back Office 

Company Dimension Combinations 
Deltek Tracking: 1119361 

The Company Dimension Combinations single dialog workspace is introduced to enable you to quickly 
look up account, local account, and local chart of accounts derived for a given company and dimension 
combination header. Maconomy derives the information in the workspace based on the rules of each 
dimension combination on each company in your system.  Additionally, BPM can now look up the account 
and local account given a dimension combination number and a company number through the filter list. 

Note that you cannot enter or create lines in the Company Dimension Combination tab or use it to derive 
the rules of or for the dimension combination. If you add or delete a company in the Dimension 
Combination workspace, Maconomy automatically updates the Company Dimension Combination single 
dialog workspace. Likewise, if you add, change, copy, or delete a dimension combination or dimension 
combination line, the system updates the table.  

After the upgrade, the table is set up by default. Maconomy creates and populates the table by deriving 
the information from the current dimension combinations. For new customers that import their companies, 
Maconomy automatically calculates the table as if they are simply adding companies. Additionally, it is 
dynamically, synchronously, and automatically maintained.  

Changes to Maconomy 

The Company Dimension Combinations single dialog workspace is added to Maconomy to support this 
feature. 

Document Archiving Enhancements 
Deltek Tracking: 1069050 

Note: For more information, refer to the Workspace Client single dialogs documentation. 
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You can now archive documents to customer payments and access attached documents from the 
Financial Analysis workspace. Specifically, this enhancement allows you to: 

 Attach and archive a document to individual customer payments and not only to the journal where 
it is currently assigned. 

 Access the documents attached to customer payments when looking at the origin of customer 
entries and finance entries belonging to customer payments when using the Financial Analysis 
workspace. 

 Access documents attached to the journal of the entries when using the financial analysis 
workspace to look up entries. 

Document Archive on Customer Payment 

The Document Archive No. and Document Name fields are added to the filter list of the Customer 
Payments workspace. A document counter is also added to the History tab of the Customer Payments 
workspace to show the customer payment as a variable, which shows the total number of documents in 
the document archive assigned to the customer payment. Note that the documents are not directly visible 
on the customer payment and do not display in the workspace. You can use the View Document action 
to open the attachments. 

Additionally, this enhancement now enables you to attach a document directly to the customer payment, 
instead of only to the journal. A new Attach Document action is added to support this feature. You can 
only assign one document directly to the customer payment but you can add more documents to the 
same document archive. Thus, you can only attach documents to the customer payment if you have not 
submitted or posted the payment. If you have an attached document to the customer payment and you 
use this action, Maconomy replaces the document currently attached to the customer payment with a new 
one. Maconomy then removes the document from the document archive. 

The customer payment journal and the customer payments have independent archives. You can add a 
document to the journal but have different documents attached to each of the customer payments on the 
journal. The document archive functionality for customer payments is available for all existing pre-
submitted customer payments and new customer payments. Thus, you need to reopen previously 
submitted customer payment to be able to add a document. 

Access Customer Payments  

Through the Financial Analysis workspace, you can access documents attached to vendor entries, job 
entries, and finance entries that do not belong to a customer payment, on their respective vendor invoice, 
job invoice, or general journal. This enhancement adds the same document archive functionality to 
customer entries and finance entries that belong to a customer payment.  

You can now access documents attached to the customer payment journals and customer payments 
related to customer entries. A new View Document action is added to General Ledger » Financial 
Analysis » Journals » Origin » Customer Payment. If you use this action, Maconomy opens the 
document attached to the customer payment that belongs to the finance entry or customer entry. If there 
is no document attached to the customer payment, Maconomy displays an error message. 

Additionally, the Document Archive island is also added to the Customer Payment sub-tab of the 
Financial Analysis workspace. The island contains the Document Archive, Document Count, and 
Document Name fields. The fields show the number and name of the documents attached to the 
customer payments, and the number of documents in the document archive. 

Access Journal Documents  

A new View Document action is added to General Ledger » Financial Analysis » Journals » Journal. 
The action dynamically displays if there is a document attached to the journal. If you use this action, 
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Maconomy shows the document attached to the journal that belongs to the finance entry in the 
workspace.  

Changes to Maconomy  

The following workspaces are updated to support this feature: 

 Financial Analysis workspace 

 Customer Payments workspace 

 Customer Payments single dialog workspace 

 Document Archives single dialog workspace 

Procedures 

Attach a Document to a Customer Payment 

To attach a document to a customer payment: 

1. Go to Accounts Receivable » Customer Payments » Payment » Journal » Customer 
Payments. 

OR 

Go to Single Dialogs » Accounts Receivable » Registration » Customer Payments. 

2. Select a journal from the filter list. 

3. On the Customer Payments sub-tab, select a customer payment. 

4. Click Attach Document. 

5. In the file explorer window that opens, select the file. 

6. Click Open, or press ENTER. 

The document is attached. 

View Document on Unposted Customer Payment 

To view a document attached to an unposted customer payment: 

1. Go to Accounts Receivable » Customer Payments » Payments. 

OR 

Go to Single Dialogs » Accounts Receivable » Registration » Customer Payments. 

2. Select a journal from the filter list. 

3. On the Customer Payments sub-tab, select a customer payment. 

4. Click View Document. 

View Document on Posted Customer Payment 

To view a document attached to a posted customer payment: 

1. Go to Accounts Receivable » Customer Payments » History. 

2. Select a customer payment from the filter list. 

3. On the Customer Payment tab, click View Document. 
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View Document on Customer Payment of a Customer Entry 

To view a document attached to a customer payment of a customer entry: 

1. Go to General Ledger » Financial Analysis » Entries » Customer. 

2. Select a customer payment from the filter list. 

3. Go to Origin » Customer Payment. 

4. Click View Document. 

View Document on a Journal of a Customer Entry 

To view a document attached to a journal of a customer entry: 

1. Go to General Ledger » Financial Analysis » Entries » Customer. 

2. Select a customer payment from the filter list. 

3. On the Journal tab, click View Document. 

Synchronous Approval Notification Enhancements 
Deltek Tracking: 1296056 

Approval Notifications are now synchronized to improve performance. The Selection Criterion Statements 
and Selection Criterion Statement Lines single dialog workspaces are introduced to enable you to view 
the SQL statements and selection criterion statement lines that you created. 

A new Export Statement action is added to Selection Criterion Specification single dialog workspace to 
enable you to export the SQL statements created when you validate selection criterion specifications. 
Additionally, Maconomy now allows approval hierarchy selection lines without a selection criterion 
specification. 

This feature includes: 

 Enhanced Approval Hierarchy Selection  

 Target Group Performance Improvements 

 Support for Approval Hierarchy Notifications 

Changes to Maconomy 

The following workspaces are updated to support this feature: 

 Approval Hierarchies Setup 

 Campaigns 

 Notifications 

 Approval Hierarchies single dialog workspace 

 Approval Hierarchy Selection single dialog workspace 

 Job Parameter Derivation Fields single dialog workspace 

 Job Search single dialog workspace 

 Campaigns single dialog workspace 
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 User creation from User Types single dialog workspace 

 Selection Criterion Specification single dialog workspace 

 Notification Categories single dialog workspace 

 Notification Types single dialog workspace 

 Synchronous Notification Types single dialog workspace 

 Notifications single dialog workspace 

The following workspaces are added to support this feature: 

 Selection Criterion Statements single dialog workspace  

 Selection Criterion Statement Lines single dialog workspace 

 Approval Notifications after Create single dialog workspace 

 Approval Notifications after Approval single dialog workspace 

 Approval Notifications after Reject single dialog workspace 

Enhanced Approval Hierarchy Selection 

Deltek Tracking: 1251345 

Previously, you need to select a selection criterion specification on an approval hierarchy selection. You 
could create a selection criterion without approval hierarchy selection lines to make the criterion match all 
the entries. Maconomy now allows approval hierarchy selection lines without a selection criterion 
specification. Additionally, the Selection Criterion Specification No. field is no longer mandatory. 

Target Group Performance Improvements 

Deltek Tracking: 1267073 

Target groups are used primarily when you submit an object that uses approval hierarchies, and for other 
purposes. You can enter a target group specification in the Selection Criterion Specification single dialog 
workspace. Maconomy previously created an SQL-statement from the target group specification every 
time you use the target group. This enhancement reduces the number of times Maconomy creates the 
same SQL-statement from a target group specification. Then, Maconomy only recreates the SQL-
statement if you change the target group.  

The feature is enabled by default and there are no changes in the functionality. Thus, the only difference 
is that you can view and export the created SQL-statement. This can be useful when you enter the 
selection criterion specification. Additionally, the internal changes improve the system performance.  

Selection Criterion Specification Enhancements 

The Validate action is updated so Maconomy saves the created SQL-statement in the database. Thus, it 
no longer needs to interpret the target group every time you use it. Additionally, the new Export 
Statement action is added to Selection Criterion Specification single dialog workspace to enable you to 
export the SQL statements created when you validate selection criterion specifications. It creates a file 
with the saved SQL-statements.  

Note that Maconomy adds a fixed condition to the SQL-statement when it is executed in Maconomy. The 
fixed statement becomes a restriction on the instance key for the primary cursor:  

“InternalRelationName.InstanceKey = ‘InstanceKeyValue’” 
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You can then use the exported SQL-statement to validate that you created the correct target group 
specification. Maconomy validates a non-validated selection criterion before it tries to export the SQL-
statement.  

The non-validated selection criterion specification may also be validated indirectly if you use the Export 
Statement action, or if you use the selection criterion specification. For example, you use the selection 
criterion specification when you submit any data that use the specification in the approval hierarchies. 
The selection criterion specification is marked as not validated if the specification is changed.  

Selection Criterion Statements Workspace 

Maconomy can now create and store the interpreted SQL-statement for a target group in the Selection 
Criterion Statements single dialog workspace. You can create the SQL-statement manually from the 
Selection Criterion Specification single dialog workspace when you run the Validate and Export 
Statements action. Note that Maconomy also creates the SQL-statements automatically the first time you 
run these actions. Thus, you cannot create, change, or delete the data in this workspace manually. 

The Selection Criteria Statement Section tab shows information related to the primary relation, and 
optionally displays information about secondary relations. For each of the secondary relations, Maconomy 
shows the internal relation name and the join between the primary and secondary relations. Additionally, 
the Selection Criteria Statement Lines sub-tab shows the SQL-sub-statement that corresponds to the 
restrictions that you specified in the Selection Criterion Specification Lines sub-tab of the Selection 
Criterion Specification single dialog workspace. Maconomy creates one section for each group of target 
group lines separated by the outer logical operation “OR”.  

Selection Criterion Statement Lines Workspace 

The Selection Criterion Statement Lines single dialog workspace is introduced to enable you to view the 
selection criterion statement lines that you created, which you can also access in the Selection Criteria 
Statement Lines sub-tab of the Selection Criterion Statements single dialog workspace. Similarly, you 
cannot create, change, or delete the data in this workspace manually. 

Support for Approval Hierarchy Notifications 

Deltek Tracking: 1269972 

New Dialogs for Approval Notifications 

This enhancement introduces three new single dialog workspaces where you can set up approval 
notifications.  

Approval Notifications after Create  

The Approval Notifications after Create single dialog workspace enables you to create a synchronous 
notification after a user creates an approval object, for example a Time Sheet, Vendor Invoice, Job, or 
Customer. Maconomy automatically creates the notification when you create the approval object. Then, 
the system deletes the notification when you submit the approval object. 

Approval Notifications after Approval  

The Approval Notifications after Approval single dialog workspace enables you to create a synchronous 
notification after a user approves an approval object. Similarly, Maconomy automatically creates the 
notification, only when you fully approve the approval object. The system does not delete the notification 
automatically, but you can use the Close Notification action or select the Closed checkbox in the 
Notifications workspace to close the notifications. A closed notification no longer displays in the 
notification view. 
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Approval Notifications after Reject  

The Approval Notifications after Reject single dialog workspace allows you to create a synchronous 
notification after a user rejects an approval object. Maconomy automatically creates the notification when 
you reject the approval object and deletes it again when the status is changed. The status changes to 
Unsubmitted when you modify the approval object. Then, it changes to Submitted or Approved when 
you undo the rejection. 

The new dialogs contain the same information and are all linked to the approval workflow. The Approval 
Hierarchy Rule tabs show the approval type and the sub-tabs list the rules for when Maconomy should 
create a notification, how the notification should be received, and what notification should be created.  

Maconomy creates the notification only if the company number of the approval object belongs to the 
range of company numbers on the line, and if it meets the specified selection criterion specification. The 
receiver of the notification can be a named employee, a user, or an employee derived from the approval 
object. You can specify either a user or an employee directly on the approval object. You can use the 
purchase employee from the purchase order, an employee, or a user from a related table.  

For example, you can enter a location on a purchase order or Maconomy can derive the user or 
employee from the location. You can also enter an employee reference on the location. Thus, the receiver 
of the notification can be the user or employee from the Employee field from the location specified in the 
purchase order. Maconomy can support a maximum of five reference levels with predefined links. 
Additionally, Maconomy does not create a notification if the link is missing. In this example, Maconomy 
does not create a notification if there is no purchaser in the purchase order, or if you do not specify an 
employee in the location.  

Note that the user or employee can be derived from fields that Maconomy use for users or employees. It 
can also be derived from other remarks or text fields. Thus, the system creates the notification only if you 
specified a valid username or employee number. If the reference value is a user reference, Maconomy 
derives an employee number from the user. Maconomy then creates a notification to all users with the 
derived employee number. 

The following sub-tabs are also added to the Approval Hierarchy Rules tab of the Approval Hierarchies 

workspace: 

 Notifications after Create  

 Notifications after Approval 

 Notifications after Reject 

Improvements to Notifications  

The Notifications module is updated with the following enhancements: 

 A new Notifications can be closed, Default field is also added to the notification types and 
categories in the Notifications workspace, Notification Categories, and Synchronous Notification 
Types single dialog workspaces. This enables you to specify if the notification in question can be 
closed manually. Note that you can only do this if the notification type allows.  

 New Description 1-10, Title fields are added to the Synchronous Notification Types single dialog 
workspace to enable you to specify description titles that display on the notifications. Additionally, 
you can now use the Rederive Notification Values action to derive all arguments, waypoints, 
targets, and descriptions on all existing non-closed notifications of the notification type in 
question. The Field Type field in the Field References sub-tab is updated to support the new 
description title fields.  

 You can also use the new Close Notification and Reopen Notification actions to close and 
reopen notifications in the Notifications single dialog workspace. Thus, Maconomy shows the 
user who closed the notification, and the date and time the user closed it. New Description 1-10, 
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Title fields are also added to enable you to add more information related to the approval object. 
Maconomy derives the notification values in the same way as arguments, waypoints, and targets 
are derived. 

 Additionally, this enhancement enables you to import notification data in Notifications » Set-Up 
» Types and add new notification type using the + New Notification Type action. 

Vendor Subcontractor Reconciliation in Different Currencies 
Deltek Tracking: 1113784 

Prior to this release, the vendor subcontractor reconciliation functionality in Maconomy required that the 
currency on the vendor invoice received from the subcontractor be in the same currency as the job entry. 
This restricted the vendor invoice currency to the base currency when there were vendor invoice 
allocation lines of subcontractor reconciliation type. If you had foreign subcontractors who worked in a 
country different from the company’s location, the employees would have to be invoiced and be paid in 
the company’s currency, which could be different from their location’s currency. 

This enhancement enables you to reconcile subcontractor invoices in different currencies. Maconomy 
now allows vendor invoices in currencies different from the base currency when you have invoice 
allocation lines of subcontractor reconciliation type. The system converts the currency of the job entries to 
the currency of the vendor invoice for the reconciled amount as you select or deselect them. Additionally, 
when you click the Allocate Subcontractor Differences action in the Vendor Invoice tab of the Vendor 
Invoices workspace, Maconomy calculates the correct amount using the updated currency conversion. 
Note that there are no changes to the usual procedures for creating vendor invoice and invoice allocation 
lines or for the reconciliation.  

Currency Conversion Rules 

The currency that you choose impacts Maconomy’s conversion. 

 If the base currency of the job entry’s executing company is equal to the invoice allocation line’s 
currency, no conversion is necessary. 

 If the base currency of the job entry’s executing company is equal to the invoice allocation line’s 
base currency, the exchange rate is equal to the vendor invoice amount currency/vendor invoice 
amount base. 

 If the base currency of the job entry’s executing company is equal to the global enterprise 
currency, the exchange rate is equal to the vendor invoice amount currency/vendor invoice 
amount enterprise. 

 If the base currency of the job entry’s executing company is not equal to any of the above, 
Maconomy converts the currency using the global purchase exchange rate table on the date of 
the vendor invoice’s entry date. 

Changes to Maconomy 

The following workspaces are updated to support this feature: 

 Vendor Invoices 

 Vendor Subcontractor Reconciliation single dialog workspace 

Procedures 

Create a Job Journal 

Prerequisite: Make an employee a subcontractor and create a job entry. Then, use these steps to create 
a job journal. 
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To create a job journal entry: 

1. Go to Single Dialogs » Job Cost » Registration » Job Journal. 

2. In the Job Journal tab, click + New Journal. 

3. Click Save. 

4. In the Job Journal Entries tab, fill out the following fields: 

 Task 

 Employee No. 

 Quantity 

 Cost, Base 

 Job No. 

5. Click Save. 

6. In the Job Journal tab, click Post. 

The Posting Journal PDF opens. 

Create a Vendor Invoice With an Allocation Line of Subcontractor Reconciliation Type 

Prerequisite: Create a Job Journal. Then, use these steps to create a vendor invoice with an allocation 
line of subcontractor reconciliation type.  

To create the vendor invoice: 

1. Go to Accounts Payable » Vendor Invoices » Vendor Invoices. 

2. Click + New Vendor Invoice. 

The Create Vendor Invoice wizard opens. 

3. In the Create Method field, enter Manual. 

4. Fill out the following fields: 

 Vendor Name and Number 

 Amount Incl. Tax 

 Currency – any currency other than the job entry’s currency 

 Invoice No. 

 Invoice Date 

5. Click Create. 

6. In the Allocation sub-tab, click + Add Allocation Line. 

7. Fill out the following fields: 

 Purchase Line Type – Subcontractor Reconciliation 

 Job No. and Job Name 

 Task and Task Description 

 Empl. No. 

8. Click Save. 

https://home.deltek.com/sites/prst/Documentation/Public%20Folder/Maconomy%20Doc%20Editing/Current%20Working%20Documents/Internal%20-%20Doc%20Team%20Projects/Past%20Releases/2.5.2/2.5.2%20Features/252_1113784_Subcontractor%20Reconciliation%20in%20Different%20Currencies.docx#_Create_a_Job
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9. In the Subcontractor Reconciliation sub-tab, select the Selected For Subcontractor 
Reconciliation checkboxes to mark the entries for reconciliation. 

10. Click Save. Maconomy updates the amount in the Total for Subcontractor Reconciliation field 
in the Allocation Tab. 

11. In the Vendor Invoice tab, click Submit for Approval. 

12. Go to Accounts Payable » Vendor Invoices » Journals. 

13. In the Vendor Invoices sub-tab, select the entry. 

14. Click Approve Line for Posting.  

New Fields in Option Lists and Popup Fields 
Deltek Tracking: 1275041 

New fields are added to the Option Lists and Popup Fields single dialog workspaces to provide more lists 
for possible values that you can populate in other workspaces. The fields do not display by default. You 
need to open the Customize Columns wizard for the fields to display in the workspaces. 

Changes to Maconomy 

The following workspaces are updated to support this feature: 

 System Setup workspace 

 Option Lists single dialog workspace 

 Popup Fields single dialog workspace 

Procedures 

Add New Options for the Option List  

Use the Customize Columns wizard to add columns to the Options sub-tab in the Option Lists workspace. 

To add new option columns: 

1. Go to Setup » System Setup » Parameters and Numbers » Option Lists. 

OR  

Go to Single Dialogs » Setup » Set-up » Option Lists. 

2. Select an option list from the filter list. 

3. On the Options sub-tab, right click on any column and select Customize Columns. 

The Customize Columns wizard opens. 

4. In the Available Columns list, select the columns to add to the Options sub-tab. 

5. Click Add. If needed, rearrange the columns in the Show columns in this order list. 

6. Click OK. 

Add New Values to Popup Fields  

Use the Customize Columns wizard to add values to the Values sub-tab in the Popup Fields workspace. 

To add new option columns: 

1. Go to Setup » System Setup » Parameters and Numbers » Popup Fields. 
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OR  

Go to Single Dialogs » Setup » Set-up » Popup Fields. 

2. Select a popup field from the filter list. 

3. On the Values sub-tab, right click on the Name column and select Customize Columns. 

The Customize Columns wizard opens. 

4. In the Available Columns list, select the columns to add to the Values sub-tab. 

5. Click Add. If needed, rearrange the columns in the Show columns in this order list. 

6. Click OK. 

Enhanced Posting Period Setup 
Deltek Tracking: 1205411 

Previously, you could experience performance issues when you made changes to the entries in the 
Posting Period Setup Lines sub-tab of the Posting Period Setup workspace. You needed to avoid sharing 
a posting period setup among companies because Maconomy checked the entire system for each 
company in the setup. Additionally, Maconomy checked all unposted journals instead of only journals and 
subledger entries relevant to the transaction type group specified on the Posting Period Setup Line that 
you changed. Having many companies in the setup that had long transactions could also slow down 
performance and risk timeouts with abort and rollback. 

This enhancement now enables you to update posting period setup more efficiently. It also grants quick 
validation of periods when you assign a new posting period setup on companies or transaction type 
group. When you edit the G/L Start and G/L End fields in the Posting Period Setup Lines sub-tab of the 
Posting Period Setup workspace, Maconomy automatically revalidates the periods more quickly. You can 
also add as many companies as possible to the same posting period setup. Companies that share the 
same setup are checked once for the entire system. Each different posting period setup requires its own 
check of the entire system therefore grouping saves time.  

Additionally, when you create job journals and transfer time sheets that are outside the G/L posting period 
but within the Job Cost posting period, you will no longer encounter warnings for HoursJournal 
and HourTransferralElement. Maconomy automatically corrects the entry date for these journals to a valid 
G/L date without warning.  

Changes to Maconomy 

The following workspaces are updated to support this feature: 

 Companies 

 Posting Period Setup single dialog workspace 

 Transaction Type Groups single dialog workspace 

Exclude Compensation Types and Agreements from Total Base Salary  
Deltek Tracking: 1231588 

The Incl. Result in Total Base Salary field is added to compensation types and compensation 
agreements. The field enables you to specify whether compensation agreements should contribute to the 
total base salary result and base salary rate in base salary calculations. For compensation types, the field 
is enabled by default when creating a compensation agreement. You can also include compensation 
agreements and compensation type in base salary calculation without contributing to the total result or the 
base salary rate. 
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Additionally, the Incl. in Gross Pay field is renamed to Incl. in Gross Pay Calculation while the Incl. in 
Base Salary field is renamed to Incl. in Base Salary Calculation. When the Incl. Result in Total Base 
Salary field is disabled, the compensation agreement does not contribute to the total base salary and 
base salary rate. However, it can still be included in the base salary calculation if the Incl. in Base Salary 
Calculation field is enabled. This allows you to use the base salary of a compensation agreement to 
calculate compensation groups without adding to the total base salary and rate. Note that you can only 
enable the Incl. Result in Total Base Salary field if you also enabled the Incl. in Base Salary 
Calculation field. Otherwise, you will encounter an error when you try to enable the former. 

This enhancement also adds a new Incl. Result in Total Base Salary field to the Base Salary Rate Line 
sub-tab of the Base Salary Rate Calculations workspace and Base Salary Rate Line tab of the Base 
Salary Rate Calculation Lines single dialog workspace. The field shows if the base salary result of the 
base salary line is contributing to the total base salary and base salary rate of the calculation. Maconomy 
derives its value from the corresponding field on the compensation agreement for which it calculates the 
base salary. 

Changes to Maconomy 

The following workspaces are updated to support this feature: 

 Employees 

 Base Salary Rate Calculations 

 Base Salary Rate Calculation Lines single dialog workspace 

 Show Base Salary Rate Calculations single dialog workspace 

 Compensation Agreements single dialog workspace 

 Compensation Models single dialog workspace 

 Compensation Types single dialog workspace 

Procedures 

Include a Compensation Agreement in Total Base Salary 

To include a compensation agreement in the total base salary calculation: 

1. Go to Human Resources » Employees » Employees. 

2. Select an employee from the filter list. 

3. In the Employee Information tab, assign a compensation model. 

4. Click Save. 

5. Go to the Compensation Agreements tab. 

6. Click the Add Compensation Agreement action. 

7. Enter a compensation type in the Compensation Type No. field.  

8. Select the Incl. in Base Salary Calculation and Incl. Result in Total Base Salary fields. 

9. Click Save. 

10. Go to Human Resources » Base Salary Rate Calculations » Calculation » Calculate Base 
Salary Rate. 

11. In the Selection Criteria island, select the Compensation Model, Company Number, and 
Company No. to use in the calculation. 
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12. Fill out the other fields, as needed. 

13. Click Save. 

14. Click the Calculate Base Salary Rate action. 

Exclude a Compensation Agreement from the Total Base Salary But Include in Base Salary 
Calculation 

To exclude a compensation agreement from the total base salary calculation: 

1. Go to Human Resources » Employees » Employees. 

2. Select an employee from the filter list. 

3. In the Employee Information tab, assign a compensation model. 

4. Click Save. 

5. Go to the Compensation Agreements tab. 

6. Click the Add Compensation Agreement action. 

7. Enter a compensation type in the Compensation Type No. field.  

8. Select the Incl. in Base Salary Calculation field. 

9. Deselect the Incl. Result in Total Base Salary field. 

10. Click Save. 

11. Go to Human Resources » Base Salary Rate Calculations » Calculation » Calculate Base 
Salary Rate. 

12. In the Selection Criteria island, select the Compensation Model, Company Number, and 
Company No. to use in the calculation. 

13. Fill out the other fields, as needed. 

14. Click Save. 

15. Click the Calculate Base Salary Rate action. 

Install / Upgrade Considerations 

For existing compensation types and compensation agreements where the Incl. in Base Salary 
Calculation field is enabled prior to this release, the Incl. Result in Total Base Salary field is also 
enabled when you upgrade to version 2.5.2. 

All compensation types and agreements created after the upgrade or those that did not have the Incl. in 
Base Salary Calculation field enabled prior to the upgrade, have the Incl. Result in Total Base Salary 
field disabled by default. You need to manually enable it to include the compensation agreement to the 
total base salary and base salary rate for base salary rate calculations. 

Non-Deductible Tax Amounts on Tax Settlement Entries 
Deltek Tracking: 1231601 

This enhancement allows for both deductible and non-deductible amounts to be shown on tax settlement 
entries. Previously, only the deductible tax amount was shown, which led to user confusion and potential 
for error.  
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In order to further break out deductible vs non-deductible amounts and provide clarity, the following fields 
are added for non-deductible amounts. These fields are populated whenever a Tax Settlement entry is 
created. 

 Debit Tax, Currency 

 Credit Tax, Currency  

 Debit Tax, Base 

 Credit Tax, Base 

 Debit Tax, Enterprise  

 Credit Tax, Enterprise 

 Debit Tax, Reporting Currency  

 Credit Tax, Reporting Currency   

Statutory/BPM 

Statutory Export Requirements for Enterprise Cloud 
Deltek Tracking: 1228103 

 This feature provides an updated file structure to support statutory export requirements. 

Embed Statement of Changes in Equity Report in Workspace Client 
Deltek Tracking: 1362628 

 The new report "Statement of Changes in Equity" is now embedded in the Workspace Client. 

New Fields for Flexible Statutory Reporting 
Deltek Tracking: 1228103 

 Additional fields are added to the Company Information Card to support statutory reporting.  

New Aging and Outstanding Invoice Reports for Australia 
Deltek Tracking: 1221000 

Current Australian statutory requirements dictate the inclusion of additional information not provided by 
the standard AR and AP aging reports. Specifically, these standard aging reports do not include invoice-
related details such as the invoice number, due date, reconciled amount, balance, and outstanding tax. In 
addition to this, the aging reports link to transaction reports which, while listing transactions and amounts 
related to the aging reports, do not show relevant invoice information. 

To address these requirements, the following reports are added: 

 AR Aging (Australia) - This is a copy of the standard AR Aging report, but links to the new 
Outstanding Customer Invoices report. 

 AP Aging (Australia) - This is a copy of the standard AP Aging report, but links to the new 
Outstanding Vendor Invoices report. 

 Outstanding Customer Invoices – This new report includes customer information. 
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 Outstanding Vendor Invoices – This new report includes vendor information.  

These new reports will assist companies in tracking outstanding payables and receivables, as wells as 
outstanding VAT amounts. 

 

Changes to the Workspace Client  

In a PSO solution with integrated BPM, the following workspace is updated: 

 Statutory Reporting – An Australia section is added. Under this the user will find a tab for each 
new report.  

For field descriptions, refer to the Deltek Maconomy BPM Report Description Guide for more information. 

E-Invoicing with Pagero 
Deltek Tracking: 1150840 

Maconomy now allows electronic invoicing through an integration with Pagero, a third-party provider of e-

invoice products. Their solution supports e-invoicing in many countries and allows mapping to local 

formats, including the German XRechnung format. 

Originally intended to address a German statutory requirement, any company can use this functionality as 

long as they meet the following requirements: 

 They reside in a country that uses the PEPPOL BIS 3.0 format. 

Some countries may require country-specific updates to the mapping. 

 They have a Pagero account, and Pagero supports e-invoicing in their country. 

Note that only customer invoices sent to Pagero are covered (with the exception of on account invoicing 
of sales orders and subscription orders, which will be supported in a future release). To date, the 
Workspace Client is unable to process vendor invoices. 

Changes to Maconomy 

To support this functionality, the following workspaces are added to the Workspace Client: 

 Pagero Setup 

 Pagero Setup single dialog 

 Peppol Mappings single dialog 

The following workspaces are also updated: 

 Show All Invoices single dialog 

 Company Information single dialog 

 Customers 

 Customer Information Card single dialog 

 Company Customers 

Note: While these reports were created primarily to address an Australian statutory requirement, 
these can also be utilized by companies from other countries. Reach out to Consulting or Customer 
Care for more information. 
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 Company Specific Customer Information Card single dialog 

 System Setup 

 System Parameters single dialog 

Workflow 

There are no changes to the usual processes for creating and editing customer invoices. E-invoicing 
starts when you print an invoice.  

 

The following are the high-level tasks to accomplish with e-invoicing. 

Task User Details… 

Print an invoice (or 
credit memo).  

Biller 

 

 Printing an invoice starts the e-invoicing process. 
The workflow remains the same, regardless of 
which workspace or single dialog you use to print 
the invoice. 

 After you click Print Invoice or Print Credit Memo, 
Maconomy displays a PDF of the invoice. 

 Maconomy also checks if e-invoicing is enabled on 
the company customer specified as payment 
customer on the invoice.  

If not enabled: Maconomy prints the invoice and 
takes no further action. 

If enabled: Maconomy proceeds to the next step in 
the workflow.  

Attention:  

In some cases, users of the Workspace Client are allowed to edit the amounts specified in the WIP 
for Invoicing fields (Jobs workspace » Invoicing section » Invoice Selection tab » Work In 
Progress island). When users perform this manual edit, Maconomy adjusts the value in the relevant 
Invoice Quantity field (drill down further to the Selection, Billing Prices sub-tab » Entries panel). 
Since this quantity field can only display up to two decimal places, the resulting product of that 
quantity field value multiplied by the unit price will occasionally only approximate the total billing price 
for invoicing.   

Left uncorrected, invoice lines where the amount for invoicing does not equal unit price multiplied by 
quantity will cause an error when the XML containing these invoice lines is sent to Pagero. That is, 
the validation that Pagero performs on the invoice XML will fail because the PEPPOL BIS 3.0 format 
requires that those two amounts (the product of unit price multiplied by quantity, and the total billing 
price) be equal.   

To address this issue, in the XML that is sent to Pagero, the unit price is calculated (that is, unit price 
equals price divided by quantity) instead of taken directly from the Maconomy database. This means 
the unit price specified on the invoice line in the XML can differ from the unit price shown in the same 
invoice line in the Workspace Client.  

If your company requires the unit price to be the same in the PDF and XML versions of the invoice, 
you will need to manually edit the hours or amounts on each line in the applicable sub-tab instead of 

changing the WIP for Invoicing field values in the Invoice Selection tab.  
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Task User Details… 

 

Create background 
tasks, and carry 
them out in a 
specific order. 

Workspace Client  In the Background Tasks workspace, Maconomy 
creates three background tasks for that invoice. 

If you opted for batch invoicing, Maconomy creates 
three background tasks for each invoice in the 
batch.  

The three tasks are: 

1. Attach Original To Archive – This task adds 
the original PDF to the document archive of the 
invoice.  

2. Create Peppol File – This task creates the 
PEPPOL BIS 3.0 xml file. 

All attachments to the invoice are included in 
the xml file. 

Maconomy also adds the xml file to the 
document archive of the invoice 

3. Send to Pagero – This task sends the xml file 
to your Pagero Online account.  

 After sending the xml file, Maconomy displays the 
following message: “File was successfully sent to 
Pagero.” 

Maconomy also updates the invoice with the 
following information: 

o PDF and PEPPOL file names 

o PEPPOL mapping name  

o Date and time the xml was sent to Pagero 

Convert the xml file 
to the required 
format, and send the 

Pagero Upon receipt of the PEPPOL BIS 3.0 xml file, Pagero 
converts the xml to the format required by your 
customer and then sends the converted file to them.  

Attention:  

1) Reprints, intercompany invoices, and 
pre-invoices do not trigger the workflow. 

2) Zero invoicing, an internal accounting 
strategy for recognizing revenue, is also 
not included in the e-invoicing process. 
That is, printing a zero invoice will not 
trigger the Pagero workflow.  

3) On account invoicing of sales orders 
and subscription orders is currently not 
supported by the e-invoicing 
functionality.  
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Task User Details… 

invoice to your 
customer. 

This assumes that you previously added the customer 
to your directory in Pagero Online.  

Setup Instructions 

For detailed setup instructions as well as procedures for addressing common errors, refer to the Deltek 
Maconomy System Admin Guide. 

Statement of Changes in Equity Report 
Deltek Tracking: 1211384 

The Statement of Changes in Equity Report is a new report designed to display how a company’s equity 
stock changes throughout the course of each financial year. The report is becoming a statutory 
requirement in an increasing number of countries. Portugal is one of these countries. However, the report 
is designed to be standard rather than a country-specific report, and will be usable by other countries as 
statutory requirements dictate. 

The report consists of a single tab displaying one table of data. It utilizes a number of columns that can 
vary from company to company, depending on what equities they work with. Generally, one of the 
columns should be Retained Earnings.  

An example could be the following columns: 

Share Capital Statutory Reserve Other Reserve Retained Earnings 

 For each of these, the following are stated: 

 Opening balance as of the beginning of the financial year. 

 Changes to the equity made during the financial year. These are actually individual finance 
transactions that display how equity may be moved between the column.  

o For example, the company can choose to move some of their profit to Share Capital. In 
this case, you can see the amount subtracted under Retained Earnings and added to 
Share Capital. 

 Result of the Year / Result of the Period. 

 Closing Balance which is the Opening Balance + Changes + Result of the Year. 

Report Details and Scenarios 
For more details and example scenarios, refer to the Deltek Maconomy BPM Reporting Description 
Guide. 

Setup Instructions 

For setup instructions, refer to the Deltek Maconomy BPM Admin Guide. 

Embed 1099 NEC Report in Workspace Client 
Deltek Tracking: 1310490 

The 1099 NEC report is now embedded in the Statutory Reports workspace in the Workspace Client with 
all other statutory reports. 
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Retrieving Statutory Report Details for Enterprise Cloud 
Deltek Tracking: 1339592 

File Structure Change for Statutory Reports 

As more statutory report generation functionality is added, there could be filename conflicts across 
countries. In the future, it may be necessary to implement a folder structure that includes country-specific 
folders. There are currently no conflicts on filenames but this enhancement addresses this issue in 
anticipation of a potential future conflict. 

For example, for GoBD without tenant, the file structure will be Export path » Country » Output 
file (C:\Statutory\Germany\GoBD zip file). 

If there is a tenant setup, the file structure will be Export path »Tenant name » Country » Output 
file (C:\Statutory\Tenant\Germany\GoBD zip file).  

All Statutory reports will follow this file structure except for AEF France, which has a timestamp folder 
before the actual output file: 

 (C:\Statutory\Tenant\France\timestamp\AEF output file) 

 (C:\Statutory\France\timestamp\AEF output file) 

Statutory Report Retrieval 

This enhancement allows Enterprise Cloud customers to download statutory report output files locally 
rather than through a server they do not have access to. The retrieval process is part of the standard 
package for Maconomy.  

The extension used can retrieve fiels through either Tenant or Non-Tenant setup, which is specified in 
server.inifilepath.bpmexportpath.<shortname>=<Save Location>. 

All files can be downloaded or deleted from the standard file structure, such as  RootFolder » 
CountrySpecific » AnyFiles (.sie/.xml/.txt, etc.). 

 

New Fields for Flexible Statutory Reporting 
Deltek Tracking: 1228103 

The Supplement Types single dialog workspace is updated to enable you to select additional areas, 
which define where the Supplement Types and Supplements belong. The additional areas also allow the 
supplements to display in various Maconomy dialogs. Additionally, the Area field in the Supplement 
Types single dialog workspace is updated to enable you to select Company Supplement or Company 
BPM as area. 

Company Supplement and Company BPM 

If you select any of these areas, the system connects the specific instance of the supplement to a 
company and allows the supplement to display on Company Information single dialog workspace and 
Companies workspace. However, you cannot attach a supplement to the template company that you 
specify in Setup » System Setup » System Information » Finance. An error prevents you from adding 
a supplement to the template company. When you create new companies, they have empty supplement 
fields by default, but you can add them later. 

Important: Users should not add any additional folders to the structure in either the Tenant or Non-
Tenant setup as this may result in an error in retrieving files. 
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New Fields in Company Information 

This enhancement introduces the new Company Supplement and BPM fields to the Companies 
workspace and Company Information single dialog workspace to enable you to add two different 
supplements. When these fields have values, the Company Supplement and BPM sliding panels also 
display dynamically.  

The Company and Supplement are considered as one unit. Thus, when you delete a company with 
supplements attached, Maconomy automatically deletes the supplements. To preserve the supplements, 
you need to detach them from the company before you proceed with company deletion. 

Changes to Maconomy 

The following changes are made to support this feature: 

 New Fields in Companies workspace 

 Updated Documents and Notes workspace 

 New Fields in Company Information single dialog workspace 

 Updated Supplements single dialog workspace 

 Updated Supplement Types single dialog workspace 

Improved Usability of Prompts in Finance Reports 
Deltek Tracking: 1298188 

Previously, you had to fill out the mandatory Reporting Currency, Exchange Rate Table, and 
Exchange Rate Date prompts when running Finance reports. The system required you to answer these 
prompts, even though you prefer not to display the amounts in the reporting currency. Since the value in 
the Use Reporting Currency Prompt is No by default, the finance reports display data in the currency of 
the company. 

This enhancement improves the usability of the prompts in the finance reports of BPM Reporting. The 
system now automatically populates the prompts with new default values when you access the reports.  

Prompt New Default Value 

Exchange Rate Table Standard 

Exchange Rate Date Current Date 

Reporting Currency  USD in BI Launchpad 

 First currency in the list in the Workspace 
Client 

Additionally, the reporting structure of the Finance reports in the Workspace Client and the BI Launchpad 
is updated to have their own dedicated List of Values (LoVs), as follows: 

Note: The Company BPM area is connected to BPM/Statutory Reporting. Thus, BPM provides 
direction on the use of the fields in this supplement. For other purposes, we recommend that you use 
Company Supplement instead. 
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Prompt Selected Value 

Option List  Finance 

 Blank (for Changes in Equity Report) 

Selected Value  Standard 

 Cashflow Statement (for Cash Flow Reports) 

 Blank (for Changes in Equity Report) 

Changes to Maconomy 

The Financial Reporting workspace is updated to support this feature.  

Setup in Maconomy 

For more information related to the Workspace and System Parameter Setup, refer to Deltek Maconomy 
BPM Admin Guide. 

Enhanced Financial Reporting Workspace Structure 
Deltek Tracking: 1300404, 1300405  

The structure of the Financial Reporting workspace is enhanced to improve usability. The order, naming 
convention, and layout of the reports are organized and grouped based on their categories. This 
enhancement enables you to run the reports more coherently. Previously, the Financial Reporting 
workspace contains tabs for Balance Reports, Maconomy Reports, Aging Reports, and Setup.  

The new and improved layout contains the following tabs and reports: 

Tabs Reports 

Balance Reports  Balance Sheet 

 Balance Sheet Movement 

 Changes in Equity 

 Trial Balance 

 Trial Balance 

 Trial Balance Analysis 

 Trial Balance No Grouping 

Cash Flow Reports  Cash Flow Statement With Budget 

 Cash Flow Statement, By Dimension 

 Cash Flow Statement Indirect Method 

 Cash Flow Forecast 

Transaction Reports  Financial Reports 

 Finance Entries 



Maconomy 2.5.2 — Detail 

Enhancements Guide 53 

 

Tabs Reports 

 Finance Transactions 

 General Ledger 

 G/L Report Writer 

 Print 

 Reprint 

 Output 

 Reports 

 Columns 

 Metrics 

 Selection Criteria 

 Line Styles 

 Fixed Assets 

 Asset List 

Tax Reports  Customer and Vendor Turnover 

 Tax Settlement 

Profit and Loss  Profit and Loss 

 Profit and Loss, By Dimension 

 Profit and Loss, Fiscal Year 

 Profit and Loss, Periodic 

 Profit and Loss, Comparative Year 

Aging Reports  AR Aging 

 AP Aging 

 WIP Aging 

Setup  BPM 

 Reporting Structures 

 Aging 

 List of Aging Principles 

You can access the reports via the Workspace Client. They are located in Reporting » Reports » 
Overview » Financial Reporting Workspace.  

Changes to Maconomy 

To support this functionality, the Financial Reporting workspace is updated.  
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Setup in Maconomy 

For more information related to the Workspace and System Parameter Setup, refer to Deltek Maconomy 
BPM Admin Guide. 

BPM Reporting Finance Universe Updated for Direct Retrieval 
Deltek Tracking: 1119361, 1314240, 1237124 

Retrieving Year-End Result Accounts 

The BPM Reporting Finance universe is updated so that the year-end result account and associated 
dimensions are retrieved from a new table called Company Dimension Combinations in Maconomy. This 
table is capable of looking up the year-end result account for global as well as local charts of accounts, 
given a company number. The new table is joined directly to the fact tables of the universe. Previously, 
including the year-end result account in a query restricted results to only P/L accounts. The new solution 
does not have that limitation. In the standard Balance Sheet reports where the year-end result account 
objects are utilized, there is already a filter on restricting to P/L accounts, so the restriction has no effect. 
Custom Balance Sheet reports should include this filter. It is important to add a filter on company, fiscal 
year, and period. Otherwise, multiple identical rows may be included in the result set. 

Retreiving AR and AP Control Accounts 

The BPM Reporting Finance universe is updated so that AR and AP Control accounts and associated 
dimensions are retrieved from a new table called Company Dimension Combinations in Maconomy. This 
enhancement allows users to run reports on AR and AP Control Accounts and retrieve the account 
number assigned to these popup fields. Previously, using the AR or AP Control Account resulted in fields 
populating with the name of the popup (for example, “Trade”) instead of the actual account number.  

Performance Views Optimization 
Deltek Tracking: 1310476  

New indexes are introduced to the CALENDARDAYPV for Oracle and SQL Server for optimization.  

 For Oracle:  

CREATE INDEX CALENDARDAYPV02 ON CALENDARDAYPV (THEDATEDS, THEDATE); 

CREATE INDEX CALENDARDAYPV03 ON CALENDARDAYPV (THEDATE); 

 For SQL Server:  

CREATE UNIQUE NONCLUSTERED INDEX [CALENDARDAYPV02A] ON 
[dbo].[CALENDARDAYPV_A] 
( 
 [THEDATE] ASC 
) 
WITH (SORT_IN_TEMPDB = OFF, DROP_EXISTING = OFF, IGNORE_DUP_KEY = OFF, 
ONLINE = OFF) ON [PRIMARY] 
GO  

 



Maconomy 2.5.2 — Detail 

Enhancements Guide 55 

 

iAccess 

Resource and Project Planning in iAccess 
Deltek Tracking: 1283104, 1283103, 1194334 

iAccess now utilizes functionality from Deltek People Planner, an application that combines graphical 
project and resource planning for your entire resource pool and project portfolio on a company-wide 
scale.  

This feature covers the following: 

 A new system parameter for enabling the functionality in iAccess  

 A new MyPlan workspace in iAccess  

 People Planner web components and related data and actions supporting the resource manager 
role in iAccess 

 People Planner web components and related data and actions supporting the project manager 
role in iAccess 

Any People Planner-related planning information you enter in iAccess is also reflected in your Workspace 
Client installation. 

Enabling People Planner Functionality in iAccess 

A new company-specific system parameter is added to the Workspace Client, and this determines 
whether People Planner-related components and functionality are made available in your iAccess 
application. In the current version, the company of the user determines if the new People Planner related 
workspaces and actions are available for the user in iAccess. 

Changes to the Workspace Client 

To support this functionality, the following single dialog is updated: 

 System Parameters single dialog  

Setup Instructions 

This section assumes that Maconomy-People Planner integration is already enabled. To enable People 
Planner in iAccess:  

1. In the Workspace Client, go to the System Parameters single dialog. 

2. Search for Enable People Planner Web in the filter list. 

3. In the System Parameter tab, select the Enable People Planner Web check box either in the 
card for all companies, or in the table for a specific company.  

4. Click Save.  

By default, this system parameter is disabled across all solutions, whether upgrading or setting up a new 
installation.   

 

Note: The People Planner-related actions and wizards in iAccess are only available for jobs with the 

Use Imported Budget Line Resource Allocation job parameter attribute enabled.   
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System Parameters 

Parameter Description 

Enable People Planner Web Select this company-specific parameter to enable People 
Planner-related components and functionality in your iAccess 
application.  

By default, this parameter is deselected.  

 

 

MyPlan in iAccess  

MyPlan is a web-based solution that offers employees access to the projects and tasks to which they are 
assigned (or their time is allocated). It is now available to iAccess users via a dedicated workspace under 
the Self Service menu section.  

Note that the supervisor view in MyPlan is not part of the 2.5.2 implementation, but is scheduled for a 
future release.  

Changes to iAccess  

To support this functionality, the following workspace is added: 

 MyPlan 

Workflow 

Employees can now perform the following tasks in iAccess: 

 Create a Booking 

 Edit a Booking 

 Delete a Booking 

Procedures 

Create a Booking 

Employees can create bookings to allocate time for tasks assigned to them.  

To create a booking: 

1. Go to Self Service » MyPlan. 

2. If needed, switch to your preferred calendar view. Choose from the following options: 

 Day 

 Week 

 Month 

3. Double-click your preferred time slot on the calendar.  

Note: Before you can enable People Planner on iAccess, 
you must enable the integration between People Planner 
and your Maconomy system.  
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4. In the Create Booking wizard that opens, fill out the fields as needed. Only the Hours field is 
mandatory.  

 

5. Click Create. 

iAccess displays your new booking on the calendar view.  

 

Edit a Booking 

You can drag existing bookings to a different date. You can also drag the top and bottom margins of a 
booking to extend or shorten its duration. If you need to update other booking details, you can use the 
procedure in this section.  

To edit a booking: 

1. Go to Self Service » MyPlan. 

2. If needed, switch to your preferred calendar view. Choose from the following options: 

 Day 

 Week 

 Month 

3. Double-click the booking you want to edit. You can also click the vertical ellipsis on the top right 
corner of the booking, and then select Update bookings from the actions drop-down list. 

4. In the Edit Booking wizard that opens, edit the fields as needed. 

5. Click Save. 

iAccess displays your updated booking on the calendar view. 

 

Delete a Booking 

You can also remove bookings from your calendar as needed.  

To delete a booking: 

1. Go to Self Service » MyPlan. 

2. If needed, switch to your preferred calendar view. Choose from the following options: 

 Day 

 Week 

 Month 

3. On the top right corner of the booking you want to delete, click the vertical ellipsis, and then select 
Delete bookings. 

4. In the confirmation dialog that displays, click Delete.  

Note: To create an all-day appointment, double-click the all day slot at the top of either the 

Day or Week view, or double-click a day in the Month view.  

Note: To create an all-day appointment that spans multiple days, specify the first date in the 

Start field and the last date in the Finish field. 
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iAccess removes the booking from your calendar view. 

 

Resource Planning in iAccess 

Team leaders, supervisors, department managers and those who have company-wide responsibilities 
similar to those performed by these roles can now carry out their resource planning tasks in iAccess. This 
is made possible by the integration of the Resource Management web component into a new Resource 
Management workspace. While the web component interface has undergone minor updates to better 
align with iAccess, its functionality remains the same.  

 

Changes to iAccess  

To support this functionality, the following workspace is added: 

 Resource Management  

This workspace is found under the new Resource Management menu section. 

Workflow and Procedures 

For more information about the Resource Management web component and related procedures, search 
on “Resource Management (RM)” in the Deltek People Planner Web Components Guide. 

Project Planning in iAccess 

Project managers and those with similar roles can now perform their project planning tasks in iAccess. 
Specifically: 

 The Resourcing Overview web component is now embedded in a new Resourcing workspace. 

 Project managers can now manage the flow of data between Maconomy and People Planner via 
the People Planner web components embedded in the Budgeting and Progress Evaluation 
workspaces in iAccess. 

 The Jobs workspace is also updated with resourcing-related fields and a new action.  

Similar to resource planning, embedded web components for project planning have undergone some 
updates to blend into the iAccess interface, but their functionality remains the same.  

 

Changes to iAccess  

To support this functionality, the following workspace is added: 

 Resourcing 

The following workspaces are also updated: 

 Jobs 

Note: While you can view the web components embedded in iAccess on your tablet, some actions 
are only available via right-click menus, and the right-click function is not supported on tablets. Deltek 
recommends that you view these web components on desktop browsers. 

Note: While you can view the web components embedded in iAccess on your tablet, some actions 
are only available via right-click menus, and the right-click function is not supported on tablets. Deltek 
recommends that you view these web components on desktop browsers. 
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 Budgeting  

 Progress Evaluation 

All four workspaces are found under the Jobs menu section » Jobs sub-menu. 

Workflow and Procedures 

For more information about project planning web components and their related procedures, search on the 
following terms in the Deltek People Planner Web Components Guide: 

 “Resourcing Overview (RO)” – This is the web component embedded in the Resourcing 
workspace in iAccess. 

“Budgeting Assistant” – This is the web component embedded in the wizards that you open by clicking 
the Resource Booking icon on budgeting and progress evaluation lines.  

Maximizing Tables 
Deltek Tracking: 1070805 

Tables in iAccess workspaces now feature Maximize/Restore buttons which allow users to expand any 
table so that it utilizes the entire screen, as well as revert to the original table size and position. 

Display Text for Empty Search Drop-Downs 
Deltek Tracking: 1350995 

When a search yields no results, iAccess now displays the following message in the search drop-down: 
"No search results were found.". Previous to this release, searches with zero results simply displayed an 
empty drop-down. 

This enhancement is implemented on all iAccess fields where you can perform searches. 

Updated Calendar Widget in Time Sheet and Absence Workspaces 
Deltek Tracking: 1347844  

The iAccess time sheet and absence workspaces now feature an updated calendar widget.  

Clicking the Date Range Display link found at the top of the workspace opens the calendar widget. This 

link replaces the calendar icon found in older iAccess versions. 

The functionality supports split weeks. 

Changes to iAccess 

The following workspaces are updated: 

 Weekly Time Sheets 

 Daily Time Sheets 

 Absence 

Setup Instructions 

The functionality is available by default, but you can customize the calendar title by editing the relevant 
JSON templates.  
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Collapsible Menu Sections 
Deltek Tracking: 1231893 

Users can now collapse and expand the various menu sections or groups in the iAccess menu. By 
default, the Self Service menu section is expanded and all others are collapsed, but this is customizable.  

Touch 

Android Face ID Authentication 
Deltek Tracking: 1323883 

Face recognition is now supported on some Android devices. However, due to an Android operating 
system issue, face recognition may not work on all Android devices. You can still opt to use a PIN code or 
fingerprint recognition to log on to Deltek Touch. 

 

Pull Down to Refresh Timesheets 
Deltek Tracking: 1323887  

You can now pull down on the Timesheet screen to manually refresh timesheet data at any time. A time 
stamp of your last update appears at the bottom of the screen. This functionality is available for both daily 
and weekly timesheets, and does not require additional setup. 

Default Keyboard Setting in Lowercase for Logins 
Deltek Tracking: 1380512 

The username is case-sensitive, and the default keyboard setting for the first letter is uppercase. With this 
release, the default is changed to lowercase on the Login screen for a smoother and more convenient 
log in. 

Customizable Search Screens in REST 
Deltek Tracking: 1323866 

This enhancement adds support for customizable search screens for systems using the RESTful web 
service. By specifying restrictions to the search queries in the layouts, you can now control the records 
that Touch returns. 

 

Improved Popup Field Values 
Deltek Tracking: 1323876 

Note: For more information on biometric authentication, see the Security PIN and Biometric 
Authentications section in the Deltek Touch 3.6 for Maconomy 2.5.2 User Guide. 

Note: For more information on adding restrictions to the layouts, see the Modify Search or Lookup 
Fields section in the Deltek Touch 3.6 for Maconomy 2.5.2 Layout Configuration Guide. The list of 
layouts to modify are also available in Appendix A of the same document. 



Maconomy 2.5.2 — Detail 

Enhancements Guide 61 

 

In some cases, a popup field displays the internal name of the selected value. With this release, all popup 
fields now show the correct external value. 

Support for Windows Server 2019 
Deltek Tracking: 1380517 

The Touch 3.6 Installer now supports installing Touch on Windows Server 2019. 

 

Expense Entry Automation with ICR 
Deltek Tracking: 1063279 

The Quick Capture feature is enhanced with intelligent character recognition (ICR). Deltek partnered with 
Veryfi to introduce the ICR functionality, which allows you to scan receipts, and automatically fill in the 
details in your expense reports through advanced optical character recognition. 

You can utilize this feature either by capturing a photo, or selecting a photo from your device’s gallery. 
Through Veryfi’s ICR hosted system, the photo is converted to machine-readable data. The uploaded 
photo and extracted data are deleted from Veryfi’s ICR hosted system after use. 

This functionality is turned off by default, and is controlled through the ShowSettingICR, 
CanChangeSettingICR, and DefaultValueForSettingICR server settings. These settings allow you to 
show or hide the Use ICR for Expenses toggle switch on the Settings screen. When the toggle switch is 
off, the old Quick Capture feature is enabled and no photo or data is sent to Veryfi’s ICR hosted system. 
You will still be able to capture a photo of the receipt but will need to manually fill in the fields on your 
expense reports.  

 

Changes to Touch 

The following changes are made to support this feature: 

 Updated the Quick Capture screen and workflow 

 New user and server settings 

 

Procedures 

Use Quick Capture with ICR 

You can capture a receipt, and automatically fill in the details in your expense reports with the ICR 
functionality. 

Note: For more information, see the Microsoft IIS Web Server Configuration on Windows Server 2019 
section in the Deltek Touch 3.6 for Maconomy 2.5.2 Installation Guide. 

Note: This functionality requires Maconomy 2.5.2 (or higher). When you upgrade your Maconomy 
version, review the values of your new server settings. For more information, see the Server Side 
Configuration Settings section of the Deltek Touch 3.6 for Maconomy 2.5.2 Installation Guide. 

Note: For more information on the updated Quick Capture workflow and new user setting, see the  
Deltek Touch 3.6 for Maconomy 2.5.2 User Guide. 
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To use Quick Capture with ICR: 

1. Tap , and go to Quick Capture. 

2. Place the receipt on a well-lit, flat surface, and preferably on a dark background. Position your 
device accordingly.  

3. Tap the camera button then tap Submit to proceed, or the back arrow to retry. Alternatively, you 
can select a photo of the receipt from your camera gallery. Tapping Submit initiates the ICR 
process. 

You can also crop, delete, rotate, or combine the photos into a PDF prior to submitting by tapping 
the appropriate icons.  

 

4. On the Select Expense Sheet screen, tap the check mark next to an existing expense sheet to 
attach the receipt. Alternatively, tap + Create New to attach the receipt to a new expense sheet. 

5. On the Expense Sheet Line screen, review and modify the expense details as needed. 

6. Tap . 

Enhanced Reloading of Timesheet Data 
Deltek Tracking: 1323887 

When you open the Timesheet screen, you obtain the timesheet data from when you last accessed the 
screen, which may not include all the current updates. With this release, you can opt to reload your 
timesheets upon opening the Timesheet screen to get quick and real-time access to updates.  

This functionality is controlled through new server side settings, namely 
ShowSettingRefreshTimeSheetOnOpen, DefaultValueForSettingRefreshTimeSheetOnOpen, and 
CanChangeSettingRefreshTimeSheetOnOpen. These settings allow you to show or hide the Refresh 
When Opening toggle switch on the Settings screen, which is off by default. Deltek recommends it is on 
if you frequently make changes to your timesheets. A time stamp of your last update appears at the 
bottom of the screen when this feature is enabled. 

 

Changes to Touch 

The following changes are made to support this feature: 

 Updated the Timesheet screen 

 New user and server settings 

Note: The date of the transaction, any description, the amount, and currency may be derived from the 
photo using Quick Capture with ICR. Other information, such as job and task, may also be derived 
automatically depending on you Maconomy configuration. 

Tip: For receipts with more than 1 page, you can capture the pages consecutively, and 
merge these into a PDF using the Stitching icon. The PDF can be more than 2MB, and you 
can combine a minimum of 2 pages and a maximum of 5. 

Note: This functionality requires Maconomy 2.5.2 (or higher). When you upgrade your Maconomy 
version, review the values of your new server settings. For more information, see the Server Side 
Configuration Settings section of the Deltek Touch 3.6 for Maconomy 2.5.2 Installation Guide. 
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Color Coded Time Balances 
Deltek Tracking: 1380518 

Color coding for time balances in the Timesheet, Summary, and Approval screens is updated to 
support the new Required To Match Time Sheet check-in rule for employees in Maconomy. The balance 
is red when there is a difference between the checked-in and registered time. 

Integrations 

Performance Optimizations for Maconomy / People Planner 
Integration 
Deltek Tracking: 1291434 

 Extended "Update Job Budget Resource Allocations" to also support update of a year. 

 Updated the "ResourceAllocationsFromPP" extension to use the updated 
"UpdateJobResourceAllocation" dialog. 

 New integration action Get Resource Allocations & update Job Budget from PP.  

Support to Update Job Budget Resource Allocations for a Year 

Deltek Tracking: 1291434, 991086 

Prior to this release, you could update quantity and cost allocations on budget lines monthly. This 
enhancement provides the option to update the allocations up to twelve months at a time, as needed. 

In the Update Job Budget Resource Allocations single dialog workspace, the Twelve Months check box 
is added to enable you to add quantity or cost for all twelve months of the selected year. When you save 
your data, the budget line on the job is updated with the allocations you entered.  

For example, when you enter an allocated quantity of five hours each from January to May for Employee 
A, Maconomy allocates five hours each for the employee on these months in the selected time budget 
line. 

When this check box is deselected, Maconomy updates the allocations monthly, as per the existing 
functionality. 

This enhancement is available on jobs that are set up to use imported job budget resource allocations, 
and is applicable to time or amount activities on a selected job budget line. 

 

Changes to Maconomy  

The following workspaces are updated: 

 Update Job Budget Resource Allocations 

 Jobs workspace 

People Planner Integration Action 

Deltek Tracking: 1291434, 1275719 

Note: For more information, refer to the Workspace Client single dialogs documentation. 
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The action Get Resource Allocations & Update Job Budget from PP enables you to only update the 
budget in Maconomy IF there are changes to resource allocations.  

We recommend that you set up a Background task to run this action every night for all relevant projects. 
Running it ensures that each morning ALL projects are always up to date, and offsets the performance 
impact of running the process to out of office hours. 

Technology / System Admin 

Improving Search on Import Program for Import Package Lines 
Deltek Tracking: 1368031 

The search on Import Program for Import Packed Lines is now improved. Previously, you had to type the 
name (including prefixed “Import”) of the import program, such as “ImportEmpl...”   

The search is now improved so that you can search for the import program by the name of the data to 
import, such as “Empl...” 

REST API Enhancements 
Deltek Tracking: 1368031 

 We have released a new second version of the Maconomy REST API, improved for performance 
and with updated documentation. 

Server Performance Improvements 
Deltek Tracking: 1354068 

 We have added server performance improvements, transparent to the user, related to dialog 
container file access and CPU hotspots. 

Technology Enhancements 
Deltek Tracking: 1370999 

 We now have case insensitivity for Maconomy user login name. 

Tooling Enhancements 
Deltek Tracking: 1370999 

Tooling enhancements include: 

 Index.HTML support for Scalable Server Installation Information. 

 Validation of servers used for Maconomy Nodes. 

Security Enhancements 
Deltek Tracking: 1311238 

File Check Updates 

 We have updated the following terminology:  
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 whitelist is updated to allowlist  

 blacklist is updated to blocklist 

 File check using Simple Magic is no longer supported. This produces an error in the Coupling 
Service log if this was previously enabled. 

Note: See the Deltek Maconomy System Admin Guide for more details.  

Generic Error Codes 
Deltek Tracking: 1205091 

For improved internal error tracking, some error messages in Maconomy may now include an error code, 
such as A-cd76e82a. Use this code if needed when communicating with Customer Care on a support 
case. 

Static Validation of MDML via Extender 
Deltek Tracking: 1271966 

With this release, the reported MDML errors when running static validation using the Extender are now 
corrected. This includes fixing erroneous referencing of MDML fragments in standard layouts, and static 
validation errors caused by long texts in containers. Static validation currently works on all MDML layouts 
with exception to the GeneralJournal.mdml.xml, GD_Budgets.mdml.xml, 
FinanceBudgetLineActuals.mdml.xml, PreviousFinanceBudgetEmployees.mdml.xml, and 
ScheduledBackgroundTasks.mdml.xml. In addition, there are no API changes with this enhancement. 

Duplicate Index, Instance Key and Uniqueness Constraint Report Tool 
Deltek Tracking: 1303815 

A new tool compiles the list of standard indices required and generated for a given Maconomy 
release/version.  

Note: This tool is initially available for use by Deltek Technical Consultants only at this stage.  

Application Performance Monitoring 
Deltek Tracking: 1311132 

APM Logging in Touch 

We have added support for turning off APM logging in Touch, or to buffer batch logging of events.  

Touch has implemented performance monitoring for the product, including all network activity (REST 
requests) and select client/UI activity. As part of this implementation, REST requests the app sends to 
Maconomy has increased. This could impact performance.  

To curtail impact, we have added support for turning off the APM logging in Touch.  

To turn off APM logging in Touch: 

1. Go to the Touch setup file configuration.ini. 

2. Set REST_LOGGING_ENABLED="true". 

Splunk Script Updates 

We have updated the Splunk script to extract JVM information to Python 3. 
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See the Deltek Maconomy Application Performance Monitoring document for details.  

Synchronous Calculation of Push Notifications in Workspace Client 
Deltek Tracking: 1309937 

Maconomy now notifies synchronously and immediately updates the To-Do pane in the Workspace Client 
when you perform an action that either removes existing notifications or results in a new notification.  

New Naming for Maconomy Cumulative Updates 
Deltek Tracking: 1230877  

Previously, the cumulative update (CU) numbering format has been a two-digit number. This is now 
updated to a three-digit number. BPM format is also updated. 

Certifications 
Deltek Tracking: 1240687 

 Firefox 78 ESR – for Maconomy. 

 Safari 14 – for iAccess. 

 Windows Server 2019  

 Java 8 Security Update 271  
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Maconomy 2.5.1 — Detail 
This section gives a detailed description of the key features for Maconomy 2.5.1. 

General Enhancements 

Core Support for Touch Approvals 
Deltek Tracking: 1231904 

This feature adds the ability to customize which approval objects to view in both the Workspace Client 
and Touch, depending on approval type, approver type, and so on. Approval counters are also added to 
provide easier reference when viewing records that require your approval. 

New Workspace 

To improve the approval workflow in Touch, the Current Employee Approvals API single dialog is added. 
In this workspace, you can select various fields to customize how you view approval items in Touch. New 
features include the following: 

Absence and Allowance 

 These approval items are now supported. 

My Rejected Items 

 Support for rejected approval items, specifically: 

 Counters to display the total number of rejected items belonging to you, sorted by: 

 Items with Approval Hierarchies (time sheets, expense sheets, mileage sheets, 
purchase orders 

 Items without Approval Hierarchies (absences, allowances) 

Totals Counters 

 Counter to display the total number of approval items assigned to you as the designated approver 
for all approval types 

 Counter to display the total number of approval items assigned to you as substitute approver or 
super approver for all approval types 

 New fields to display the total number of approval items per approval type 

 Counter to display the total number of items for approval, available for you, for all selected 
approval types and for selected approver roles. When you select approver roles for this total by 
selecting total counters for approver roles, this field displays the sum of the items in the first two 
bullet items. 

 Counter to display the total number of rejected items belonging to you for selected approval 
types, 

 Counter to display the total number of to-dos for you. This is calculated as the sum of selected 
totals for approvals available for you and all your rejected items. 

When utilizing the new functionality, it is possible to specify the approval items to display, such as 
choosing to view only purchase orders that require your approval as a super approver for Approver B, the 
designated approver for the purchase orders.  
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Filtering Approval Items 

This enhancement adds the ability to specify what approval items should be displayed, depending on the 
approval type, approver role, or approver name.  

You can choose to view a specific approval type, such as time sheets only, that require your approval, 
using any approver role.  

Filtering approval items by approval type is available in the following: 

 Current Employee Approvals single dialog workspace 

 Current Employee Approvals API single dialog workspace 

Both Current Employee Approvals single dialogs and all the Approve by Employee single dialog 
workspaces are also updated to allow you to filter what approval lines to display in the sub-tab, depending 
on the approver role and name. When you select the Show Substitute Lines or Show Super Approver 
Lines check box(es), the Approver field will display and you can enter the employee name or number of 
a designated approver. 

The Current Employee Approvals single dialogs also allow you to filter approval counters by the specified 
job on approval lines. You can choose to combine different selection criteria to customize what approval 
items must be displayed. 

For example, you can choose to display approval lines for which you are the assigned substitute approver 
when Employee A, the designated approver, is unavailable to approve items.  

Another example of utilizing this feature is choosing to display only a specific approval type, such as 
invoice allocation lines that need your approval, but also restricting the view to lines that are associated 
with a particular job. 

Changes to Maconomy 

The following workspace is added: 

 Current Employee Approvals API single dialog workspace 

The following workspaces are updated: 

 Current Employee Approvals single dialog workspace 

 Approve Job Budgets by Employee 

 Approve Job Quotes by Employee 

 Approve Customers by Employee 

 Approve Draft Invoices by Employee 

 Approve Time Sheets by Employee 

 Approve Time Sheet Lines by Employee 

 Approve Expense Sheets by Employee 

 Approve Expense Sheet Lines by Employee 

 Approve Purchase Orders by Employee 

 Approve Purchase Order Lines by Employee 

 Approve Vendor Invoice Allocation Lines by Employee 

 Approve Vendor Invoices by Employee 

 Approve Employees by Employee 
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 Approve Jobs by Employee 

Setup Instructions 

There are no changes to the usual procedures for setting up approval hierarchies. Assign super 
approvers to approval hierarchy lines if required by the company. Assign them as you would approvers 
and substitute approvers.  

Employee Gender on Employee Card Enhancements 
Deltek Tracking: 1249427 

Maconomy now supports additional employee gender values in the Employee Card, which promotes 

diversity and inclusion in the workplace. In addition to the current values “Male,” and “Female,” you can 

now select “Diverse,” or “Prefer Not to Classify”. 

For field descriptions, refer to the Online Help. 

Changes to Maconomy 

The following workspaces are updated: 

 Employees 

 Employee Revisions single dialog 

 Contact Persons single dialog 

Enable or Disable the Conversations Functionality 
Deltek Tracking: 1138822 

In the Workspace Client, you now have the option to enable or disable the conversations functionality. 

Setup Instructions 

Enable or Disable Conversations 

When you disable a conversation type, the unread messages, and notifications are removed from the 
workspaces where the conversation type is linked. Existing conversations are still available, however, you 
cannot add or send new ones. 

To enable or disable conversations: 

1. Go to Setup » Conversations » Conversation Types. 

2. Create, or select an existing conversation type. 

3. Under the Conversation Type island, select the Enabled check box to enable, or deselect to 
disable the conversation. 

Back Office 

Employee Revisions Enhancements 
Deltek Tracking: 1182755 
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Previously in Maconomy, you encountered slow performance when you loaded employees with many 
revisions. The Employee Revisions single dialog workspace and Revision Selection sub-tab in the 
Employees workspace are added to improve employee revisions performance.  

Example 

All Revisions 

If you select this, Maconomy shows all the employee revisions regardless of the selected date range. 

Within Range 

If you select this, Maconomy shows all the employee revisions that fully or partially overlap the selected 
date range.  

Previous, Next, Current (Default) 

If you select any of this, Maconomy shows only one employee revision. Either the immediately previous 
revision, the immediately next revision, or the current revision displays regardless of the selected date 
range. 

Changes to Maconomy  

As part of this enhancement, the following changes are made: 

 Updated Employees workspace  

 Added Employee Revisions single dialog workspace  

New Supplements and Supplement Types 
Deltek Tracking: 1227573 

Two new single dialog workspaces are added to the Workspace Client: 

 The Supplements single dialog workspace  

 The Supplement Types single dialog workspace  

The Supplements Workspace 

The Supplements single dialog workspace is introduced to store a collection of fields open for general 
information. You can now see the information from Supplements in various Maconomy dialogs. It has two 
restrictions for access. Both direct access and indirect access to the associated Supplement Type must 
be granted to see the Supplement. Additionally, it enables you to store information for all the fields that 
have a title defined in Supplement Types. Note that there can be many instances of Supplements using 
the structure of a single Supplement Type. 

The List of Supplements filter shows the fields in the Supplements tab. The titles that you define in the 
fields of the Supplement Types single dialog workspace dynamically overwrites the fields in the 
Supplements tab. However, the filter does not reflect these changes. We cannot reflect the change of 
titles that a supplement type made to a supplement instance because two different supplement types may 
have different titles. The filter shows the general information also displayed in the Texts Island of the 
Supplement Types single dialog workspace. 

Note that the islands in this workspace, except for the Supplement Island, are only visible when there are 
entries in any of the corresponding fields in the Supplement Types single dialog workspace.  
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The Supplement Types Workspace 

The Supplement Types single dialog workspace allows you to store the external name of the fields to 
synchronize across Maconomy. It has direct access control. You can use the workspace to indicate which 
field from Supplements is in use and associate the field with a descriptive title that users can access 
across Maconomy. The values that you assign in the fields in each island of the Supplement Types single 
dialog workspace overwrite the field names in the islands of the Supplements single dialog workspace. 

There is a one-to-many relation between Supplement Types and Supplements. Supplement Types. A 
Supplement Type defines a structure for the Supplements of that type so that they all share the same 
fields. For example, you can use Invoice Reference Text, Invoice Issue Date, and Confirmed as titles in 
the structure. In Supplements, there can be several instances with the actual Invoice Reference Text (for 
example, invoice00017) and Invoice Issue Date (for example, 2020-12-31). 

Note that you cannot use Popups or Option Lists in Supplements as these field types hold information in 
themselves and are unsuitable for generic information. You can write any information in a text field, but in 
a Popup, you have to select from a set of predefined values. For example, you cannot reuse Popup1 with 
values Invoice, CreditMemo, and Unknown on Employees. If you need a popup value, an ad hoc solution 
is more appropriate than Supplements. 

Invoice Supplement  

The Area field in the Supplement Types single dialog workspace enables you to control in which dialogs 
you can see the supplements by using Invoice Supplement type. If you use the new area type, it allows 
the supplements to be added to an invoice and to display on predefined dialogs like Customer Entries.  

If you select Invoice Supplement as area, the system connects the specific instance of the supplement to 

an invoice and allows the supplement to display on the following relations: 

 Draft Invoice 

 Invoice 

 Customer Entries 

 Finance Entries 

 Tax Settlement Entries 

Invoice Supplement Name 

The Invoice Supplement Name field is now available on filters of dialogs that display Finance Entries. 
You can search the field that has the name of the corresponding Supplement. Additionally, it is the only 
field from Supplements that is available on the filter, unless a custom universe is created. Invoice 
Supplement Name does not display by default in the filter, but you can add it manually or in custom 
layouts. 

Additionally, you can add more information in the Entry tab of the Financial Analysis workspace for 
Finance and Customer by customizing the layout. For example, you can add Fapiao Number field, which 
automatically derives its field name from Supplement Types (internally: Text 01 Title) and the field content 
from Supplements (internally: Text 01). This functionality also exists in the Tax Entries assistant of the 
Tax Settlement tab of the Financial Operations workspace. Both Invoice Supplement Name and Fapiao 
Number are not part of the standard layout. You must add them in customization.  

Changes to Maconomy 

The following changes are made to support this feature: 

 New Supplements single dialog workspace 

 New Supplement Types single dialog workspace 
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 Updated Jobs workspace  

 Updated Show Job Invoice single dialog workspace 

 Updated Job Credit Memo single dialog workspace 

 Updated Show Invoice single dialog workspace 

 Updated Credit Memos single dialog workspace 

 Updated Show Credit Memo single dialog workspace 

 Updated Show Job Credit Memo single dialog workspace 

 Updated Financial Analysis workspace  

 Updated Financial Operations workspace 

 Updated Approval Hierarchies workspace 

 Updated Approval Hierarchies single dialog workspace 

Install / Upgrade Considerations 

This feature is available by default. Note that you can add Supplements to old Invoices. Thus, they 
display on Finance Entries and Customer Entries. However, on Tax Settlement Entries, they first show on 
Invoices that were created after Supplements are introduced in Maconomy 2.5.1. 

Vendor Remittance Emails Workspace 
Deltek Tracking: 1154339 

When you pay vendors, a remittance advice is required to provide details of all invoices and credit notes 
settled on a specific payment date. The Vendor Remittance Emails workspace is now available in the 
Accounts Payable module to support this.  

Specifically, you can do the following in the new workspace: 

 Send vendor remittance emails to show that the vendor invoice was paid within the payment 
terms. 

 View vendor remittance email logs and track all attempts to send the vendor remittance emails. 

This feature enables you to generate emails with an automatically generated attachment that contains the 
remittance advice for each vendor. Each payment generates an entry. You can report these entries as an 
on screen query for audit purposes. 

Example 

Each month, the Accounts Payable team reviews the vendor accounts (both external and internal 
vendors, such as employee expenses and credit cards) on each company. They pay the approved 
invoice and credit note entries, which are due for payment in accordance with the agreed payment terms 
for each vendor.  

Once a payment is generated, the company signatory manually or electronically signs it, and sends it to 
the vendor. This may be in the form of a physical check or an electronic bank transfer. Maconomy can 
now generate the remittance advice and send it to the vendor’s email address on the payment date or 
another preferred date. 



Maconomy 2.5.1 — Detail 

Enhancements Guide 73 

 

Vendor Remittance Email 

The vendor remittance email contains a subject, body, and the necessary payment details attached in the 
email as a PDF. Maconomy sends the email to an email you specified in the new Remittance Email 
Address field in Single Dialogs » Accounts Payable » Setup » Vendor Information Card and Single 
Dialogs » Accounts Payable » Setup » Company Specific Vendor Information Card.  

The following is the standard subject for the vendor remittance email: 

“<SETTLINGCOMPANYNAME> - Payment Remittance”  

The standard body of the email is as follows: 

“Enclosed is your payment remittance from <SETTLINGCOMPANYNAME>. Please do not reply to this email 

as it is sent from an automated address that is not monitored.” 

 

The attachment on the email is the relevant P_PaymentOrder print from Single Dialogs » Banking » 
Payment » Show Payment Orders, with the new MPL layout. Maconomy updates the log immediately 
after you click the Email Remittances action or when you click OK in the warning that displays for 
missing email (if applicable). Additionally, if no email is specified for a vendor linked to a payment 
selected for email, a warning message appears, and the system does not send an email for that company 
vendor. Maconomy also logs this. 

Send Vendor Remittance Emails 

Send Vendor Remittance Emails Procedures 

For a selected payment number, you can enter a vendor number range in the Vendor No. field to further 
select which company vendors receive a vendor remittance email. You can also show only the payments 
that have not been included in an email sent to the company vendor. Once the selection criteria is set, 
click the Email Remittances action in the Payment Order sub-tab to send the emails. If preferred, a 
background task can also trigger the action to automate the remittance emails. 

If you wish to select multiple payment orders for a single company vendor, the PDF contains one 
payment per page. If you select multiple company vendors, the system sends a single email to each of 
the company vendors. 

View Vendor Remittance Email Logs 

View Vendor Remittance Email Logs Procedures 

You can view a history of previously sent vendor remittance emails. You can also limit which log entries to 
show through the following Vendor Remittance Email selection criteria: 

 Payment No. 

 Company No. 

 Vendor No. 

 Payment Date 

 Logged Date 

Furthermore, you can restrict the entries to show the vendor remittance emails with the following status: 

 Found 

Note: Maconomy replaces the value of the <SETTLINGCOMPANYNAME> with the Settling Company 

name of the company vendor. 
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 Missing 

 Both 

 

To investigate which remittance emails failed as a part of a failed background task due to setup issues, 
get the instance key of the background task and look up the VendorRemittanceEmail relation on the 
BackgroundTaskInstanceKey field. Then, use the RemittanceEmailInstanceKey field on the 
VendorRemittanceEmailLogs relation to look for the payment logs included on that email. 

Changes to Maconomy 

The following changes are made to support this feature: 

 Added Vendor Remittance Emails workspace  

 Added Vendor Remittance Email Logs single dialog workspace 

 Updated Vendor Information Card single dialog workspace 

 Updated Company Specific Vendor Information Card single dialog workspace 

Procedures 

Send Vendor Remittance Emails 

To send vendor remittance emails: 

1. Go to Accounts Payable » Vendor Remittance Emails » Vendor Remittance Emails. 

2. In the Selection Criteria island, enter the payment number in the Payment No. field.  

3. In the Vendor No. field, enter or search the range of company vendors that you wish to send the 
vendor remittance email. 

4. Enter the payment date range in the Payment Date field. 

5. In the Vendor Group field, select the vendor group from the drop-down list. 

6. Click Save. 

7. On the Payment Orders sub-tab, click the Selected check box of the payment you wish to send. 

8. Click the Email Remittances action to send the vendor remittance email. 

View Vendor Remittance Email Logs 

To view the vendor remittance email logs: 

1. Go to Accounts Payable » Vendor Remittance Emails » Vendor Remittance Email Logs. 

OR 

Go to Single Dialogs » Accounts Payable » Registration » Vendor Remittance Email Logs. 

2. In the Payment No. field, enter the payment number.  

3. In the Vendor No. field, enter or search the range of company vendors that you wish to send the 
vendor remittance email. 

Note: Emails that failed due to setup error with email server, sender, or incorrect remittance email 
address still shows as successful. If a background task fails, the payment is still marked as sent as a 
part of a remittance email. 
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4. Enter payment date range in the Payment Date field. 

5. In the Vendor Group field, select the vendor group from the drop-down list. 

6. Click Save. 

The results display on the Vendor Remittance Email Log sub-tab. 

Aggregate Finance Entries Over Dimensions and Tasks 
Deltek Tracking: 1186465 

Previously, the dimension periods only aggregated finance entries with the same dimensions. This 
enhancement enables you to create an aggregate over finance entries posted with the same dimensions 
and tasks in the same fiscal year.  

This feature includes: 

 New Dimension Task Period Relation 

 System Parameter for Calculating Dimension Task Periods 

 Enhanced Recalculate Period Figures Program 

 New Show Dimension Periods and Show Dimension Task Periods Single Dialogs 

New Dimension Task Period Relation 

A new Dimension Task Period relation is added to Maconomy. It holds the same fields and information 
and works similarly to the existing functionality of dimension periods, but with the addition of the new 
Task Name field where the finance entries were posted. You can use the field to aggregate the finance 
entries together with the dimensions. When a finance entry is posted, the amounts from it are added 
together with the other finance entries posted in the same fiscal year, and which share the same 
dimensions, company, and task.  

You can now use the dimension task period to easily search an overview of similar financial postings in 
the same fiscal year. When you create or update a dimension period, a dimension task period is also 
created or updated. If you do not use tasks, then the dimension task periods match the dimension 
periods. 

Note that when a fiscal year is closed, the closing balance of the dimension task periods are aggregated 
to the year-end closing account. If no task is associated with year-end closing, the dimension task periods 
for the year-end closing account are only aggregated according to the dimensions and not tasks. Thus, 
the dimension task period of the year-end closing account becomes identical to the dimension period of 
the year-end closing account. 

System Parameter for Calculating Dimension Task Periods 

A new system parameter called Calculate Dimension Task Periods is introduced to enable Maconomy 
to create, calculate, and maintain dimension task periods for aggregating posted finance according to 
their dimensions and tasks. This only affect future postings, no dimension task periods are created for 
previously posted entries. 

When you enable the system parameter, a warning message displays that states that you must 
recalculate period figures to include historical data, which includes year to date for previously posted 
finance entries. When you disable the system parameter, a warning displays to inform you that dimension 
task periods are no longer calculated or updated for new postings. Maconomy no longer creates and 
maintains task periods when you post finance entries or do the year-end closing. 
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When you enable the system parameter again after a time, you need to recalculate all period figures to 
create and update the dimension task periods for the finance entries posted during the time the system 
parameter is disabled. 

Enhanced Recalculate Period Figures Program 

The Recalculate Period Figures dialog and support program is also enhanced to enable you to 
recalculate the aggregate of finance entries over dimension periods and tasks for previous fiscal years. 
All dimension task periods for the selected fiscal year, accounts, and companies are removed. Then, they 
are recreated and recalculated based on the finance entries posted in the given fiscal year. 

For example, if you changed the finance entries since their original posting and recalculated the period 
figures, the new dimension task periods only reflect the current finance entries instead of the original 
posting. You can use this functionality to calculate dimension task periods for previous fiscal years to get 
an aggregate over the dimensions and tasks and to get the correct opening balance on the current fiscal 
year. 

New Show Dimension Periods and Show Dimension Task Periods Single Dialogs 

Two new single dialogs are added to help you search the content of the dimension periods and dimension 
task periods that you can access. Note that you cannot edit the content in the single dialogs and there are 
access controls to the company on the entry.  

Changes to Maconomy 

The following changes are made to support this feature: 

 Updated System Setup workspace 

 New Show Dimension Periods single dialog 

 New Show Dimension Task Periods single dialog 

Setup Instructions 

To enable this feature: 

1. Go to System Setup » Parameters and Numbers » System Parameters. 

2. Double-click the Calculate Dimension Task Periods parameter. 

3. On the System Parameter sub-tab, select the Calculate Dimension Task Periods check box. 

4. Click Save. 

5. Run the recalculate period figures support program for the current fiscal year. 

System Parameters 

Parameter Description 

Calculate Dimension Task Periods Select this parameter to enable Maconomy to 
create, calculate, and maintain dimension 
task periods. This system parameter is 
disabled by default. 
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Parameter Description 

If it is deselected, Maconomy does not create 
or update the dimension task periods when 
you post finance entries. 

Access Control for Format Specification 
Deltek Tracking: 1179116 

This enhancement introduces access control to the relations in the Format Specification workspace and 
module. Maconomy now enables you to limit which users can access and change information used for 
making payments.  

This feature includes: 

 New Access Level on Formats 

 New User Island for Tracking Changes 

 Access Control for Import Format Descriptions 

New Access Level on Formats 

The Access Level Name and Access Level Description fields are added to the format relations of 
Format Specification workspace, Output Data Format Section, Input Data Format Section, Outgoing 
Payment Format Section, Customer Payment Format Section, Import Format Section, and Export Format 
Section. Only users who have the access level assigned to them can see and change information on the 
relations. 

You need access to the format before you can access the Form, Record, and Field relations. For 
example, you cannot access the Specification of Output Data Forms, Specification of Output Data Fields, 
or Specification of Output Data Records single dialog workspace if you do not have access to the 
Specification of Output Data Formats single dialog. 

Additionally, this enhancement restricts the input data formats and output data formats that you can use 
on customer payment formats and outgoing payment formats. On the payment formats, you can only 
assign data formats that you can access. The same limitation applies to assigning input data forms and 
output data forms on customer payment form and outgoing payment form. 

However, you can assign a payment form or customer payment to a payment mode or customer payment 
mode even though you do not have access to them. The access control only limits the ability to edit the 
setup information in the payment forms but not their use.  

New User Island for Tracking Changes 

A User island is added to the tabs in the Format Specification module and Format Specification 
workspace. The following fields are added: 

 Created 

 Changed 

 Version 

These enable you to track the users who created the entries as well as the users who made changes to 
the information in the workspaces. The fields store information of the most recent changes to the formats 
and forms used for payments.  
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Access Control for Import Format Descriptions 

This enhancement also adds access control to the import program used to set up payment formats, 
forms, records, and fields in the Import Format Descriptions single dialog workspace. You cannot make 
any changes to any formats if you do not have access rights. Additionally, you cannot assign access 
levels to formats through the import program.  

For example, if you try to change a format with an access level assigned, for which you do not have 
access to, an error message displays. Likewise, you cannot assign input data and output data formats or 
forms for customer payment formats and forms, and outgoing payment formats and forms, if you do not 
have access. However, you can make these changes in the Format Specification workspace. 

Install / Upgrade Considerations 

For existing formats and forms created prior to this release, the fields in the new User island are blank 
after you upgrade to version 2.5.1. The Changed field will only be updated once you make changes to 
the forms and formats. Furthermore, the Created field will only be set for new forms and formats. 

Changes to Maconomy 

The following workspaces are updated to support this feature: 

 Format Specification workspace 

 Specification of Output Data Formats single dialog workspace 

 Specification of Output Data Forms single dialog workspace 

 Specification of Output Data Records single dialog workspace 

 Specification of Output Data Fields single dialog workspace 

 Specification of Input Data Formats single dialog workspace 

 Specification of Input Data Records single dialog workspace 

 Specification of Input Data Fields single dialog workspace 

 Specification of Outgoing Payment Formats single dialog workspace 

 Specification of Outgoing Payment Forms single dialog workspace 

 Specification of Customer Payment Formats single dialog workspace 

 Specification of Customer Payment Forms single dialog workspace 

 Specification of Import Formats single dialog workspace 

 Specification of Import Forms single dialog workspace 

 Specification of Export Formats single dialog workspace 

 Specification of Export Forms single dialog workspace 

 Import Format Descriptions single dialog workspace 

Statutory/BPM 

Natural Sign in Finance Reports 
Deltek Tracking: 1209944 
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Prior to this release, financial figures on Profit and Loss accounts followed a standard with sign. BPM 
Finance reports usually displayed finance figures based on how they are posted in Maconomy. However, 
not all users are familiar with the standards on sign. For example, a sale is a credit on a sales account. 
Thus, in bookkeeping, it prompts a debit on balance accounts, for example, cash when you transfer Profit 
and Loss to balances from a reporting perspective.  

When sales and costs are both positive because of accounts that appear in groups and the signs are 
implied, you can now report on financial figures with the ability to display with a natural sign. This 
enhancement introduces the Use Natural Sign prompt to enable you to freely control whether the signs 
in the Finance reports should be flipped because a group of accounts imply it. Additionally, revenue now 
shows as a positive number as opposed to a negative number, for example in a credit balance. 

Example 

For example, 1010 and 1020 are sales accounts, and 2210 and 2230 are cost accounts. 1010 and 1020 
are grouped under "Revenue". 2010 and 2230 are grouped under "Cost". Both groups are under "Gross 
Profit". The debited amount and credited amounts could look like this: 

Gross Profit Balance Debit Credit 

Revenue  

1010 2500  2500 

1020 7000  7000 

Revenue Total 9500  9500 

Cost  

2210 1600 1600  

2230 4000 4000  

Cost Total 5600 5600  

Gross Profit Total 3900* 5600 9500 

The signs of the figures on the revenue accounts are flipped so that Debit - Credit yields 2500 and 7000 
instead of -2500 and -7000. The figures on the cost accounts are not flipped concerning sign. 

When calculating the Gross Profit Total, we flip the sign again so that Debit - Credit yields 9500 - 5600 
instead of 5600 - 9500. 

The prompt is added to the following reports: 

 BPM Analysis 

 Profit and Loss Overview with Forecast 

 Profit and Loss Periodical Analysis 

 BPM Reporting 

 Balance Sheet 

 Balance Sheet Movement 
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 Cash Flow Forecast 

 Cash Flow Statement 

 Cash Flow Statement, by Dimension 

 Profit and Loss 

 Profit and Loss, Comparative Year 

 Profit and Loss, Fiscal Year 

 Profit and Loss, Periodic 

 Profit and Loss, by Dimension 

 Trial Balance 

 Trial Balance Analysis 

 Trial Balance No Grouping 

The transaction reports, which are linked to the finance reports where natural sign applies, do not display 
in natural sign even though the finance reports do. For example, if linking from a finance report like Profit 
and Loss or Balance Sheet where you enabled natural sign, the balance amount may not be equal to the 
balance displayed in the transaction report because the transaction report does not apply natural sign. 

New Reporting Structure for Cashflow Statement Indirect Method 
Deltek Tracking: 1235863 

A new reporting structure for Cashflow Statement Indirect Method Report is added to the standard PSO 
solutions. The structure is added as an import file. You can easily name the grouping levels. However, 
this structure for the Cashflow is mandatory. We recommend that you follow the Reporting Structure for 
Cashflow Statement Indirect Method setup instructions. 

 

 

Sample Reporting Structure 

The report displays amount sign, depending on how you use the Invert Sign functionality of the reporting 
structure. The Invert Sign check box controls the sign of the amounts displayed. 

In the sample reporting structure, the Invert Sign check box is selected on the Additions to property 
group level but not on the Investing Activities group level. We want to flip the sign of the value of the 
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Additions to property without changing the sign of the value of the Investing Activities group. For example, 
we have $100 in Additions to property. If you use the sample reporting structure, the report displays the 
amount as -$100 both in the Additions to property and Investing Activities.  

 

Additionally, the functionality enables you to determine whether you have a Cash inflow or a Cash 
outflow. The report should have the same amounts on Cash Closing Balance and Cash Reconciliation 
rows. If this is not the result, you may need to revisit the reporting structure for any missing or excess 
accounts, and check if you applied the invert sign properly. 

Reporting Structure for Cashflow Statement Indirect Method 

To create a reporting structure for Cashflow Statement Indirect Method: 

1. Go to Setup » System Setup » Parameters and Numbers » Option Lists. 

2. Click + New Option List. 

3. In the Option List No. field, enter Finance. 

4. Click Create. 

5. On the Options sub-tab, click Add Option or press Ctrl + M. 

6. In the Name and Description fields, enter Cashflow Statement. 

7. Click Save Option (Enter), then click Save Option List (Enter). 

8. Go to Setup » Reporting » Reporting Structures. 

9. Click + New Reporting Structure. 

10. In the Create Reporting Structure dialog, enter the following setting: 

 Name — Cashflow Statement 

 Description — Cashflow Statement Reporting Structure 

 Type — Account 

 Option List — Finance 

 Selected Value — Cashflow Statement 

If Business Performance Management Reporting has already been set up in Maconomy, the 
option list might already exist; if so, add only the value Cashflow Statement and description. 

11. Click Create. 

12. Insert group headers, sub-group headers to provide the desired account structure, similar as 
done above. Cashflow usually only include a small subset of accounts. Thereby, the reporting 
structure works as a filter on accounts in addition to providing a hierarchical structure. 

a. Add two top-level groups for Net Cashflow and Cash Reconciliation.  

b. Under Net Cashflow, add three sub-level groups for Operating, Investing, and Financing 
Activities. 

c. Then, you can configure the next levels based on your preference. 

Note: When you select the Invert Sign check box, the inverted amounts are used in the computation 
instead of the original amount. 
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New Standard Dimensions 
Deltek Tracking: 1269228 

Specification 4-10 and Local Specification 4-10 are new standard dimensions from version 2.3 added to 
the BPM Reporting and BPM Analysis universes. You can now use and add these dimensions to the 
reports, if needed. 

BPM Aging Reports Enhancements 
Deltek Tracking: 1165941 

The BPM Aging Reports are enhanced for flexibility and improved performance. This feature includes: 

 Simplified CalendarDayPV 

 New Aging Periods Replace Due and Not Due Columns 

 Current Date as the Default Statement Date 

 New Dimension Objects for Flexible Aging Period Reporting 

Simplified CalendarDayPV 

Previously, the performance view CalendarDayPV indexed the date string fields that EX-views provided 
on the Calendar Day table. However, BPM reports needed date fields instead of date string fields. The 
performance view also combined with a blank row in order to avoid outer joins on date fields that were not 
mandatory in the database. The blank row in the performance view enabled the use of inner joins, which 
provided better performance. 

On Oracle, the performance view is a Materialized view, which defines one physical table. However, SQL 
Server does not offer Materialized views. It is defined using two indexed views combined in a union using 
a database view. This is the only option on SQL Server, which affected the system performance. 

This feature redefines internal structure definition of the CalendarDayPV performance view to exclude the 
combination with a null-row. Instead, the null-row is added to the Maconomy table CalendarDay. Thus, it 
improves the performance on MS SQL Server. The drop script is also corrected since it no longer needs 
to drop the null-row table and its view log. 

The RowID could also slow down performance because it may order the clustered index instead of the 
dates. When you restricted to date intervals, the system needed to find the dates in various places in the 
table. For SQL Server, the RowID was removed from the indexed view. Both the performance views for 
Oracle and SQL Server are updated.  

New Aging Periods Replace Due and Not Due Columns 

This enhancement replaces the Due and Not Due total columns of all Aging Reports with two new Aging 
periods. In order to have a total column that summarizes all that is due, you can set up an aging period. 
The following reports are updated: 

 AP Aging 

 AR Aging 

 AR Aging, by Account Manager  

 AR Aging, by Dimension 

 AR Aging (Customer Hierarchy) 

 AR Transactions 
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Previously, the amount displayed in the Balance column was calculated as the [Due] + [Not Due]. Now, 
the system calculates the balance as [Period 1] + .. + [Period 4]. Therefore, the balance shows the sum of 
the periods.  

Current Date as the Default Statement Date 

All Aging Reports now use the current date as the default statement date. The Keep Last Value property 
is no longer set to enable you to run the report more efficiently. The report queries now use the Statement 
Date universe parameter instead of a query prompt. The filter prompt on the statement date of all Aging 
Reports are enhanced to make Current Date the default value. 

New Dimension Objects for Flexible Aging Period Reporting 

This enhancement introduces Period Title, a dimension object that displays the period title. It is placed 
as the first object in the Period Title folder. A dimension object named Period No. is also added to enable 
you to sort the periods by their order of appearance in Maconomy. This enhancement facilitates more 
flexibility with the number of periods displayed, if you derive the number of periods from the periods set 
up in the aging principle in question.  

You can now create Aging Reports more easily by creating two queries. First, you can select these 
dimension objects from the Aging Principle or Period Titles to restrict to a certain aging principle (for 
example, by means of the option list and selected option, or by prompting on Aging Principle). You can 
now select the balance object along with a dimension like Customer or Company. Then, you can select 
the Period Title and Period No. from the Aging Period folder. 

You can use the dimension objects in a cross-tab table that dynamically adjusts to the periods defined 
and the periods for which there are fact data. A combination of Period Title and Period No. are stated as 
two horizontal rows. If you put the Period No. first, you get the correct sorting without having to add a 
sorting manually. The Balance object is stated as measure, and the dimension like Customer or Company 
is the vertical dimension. The cross-tab now displays the aging period’s setup regardless if it contains any 
amount. 

Note that the objects defined in the Aging Period folder are not related to any fact data. They are 
dimensions that display the full range of aging period data setup regardless if there are any fact data in 
the individual periods. These dimensions are necessary in order to create cross-tab tables where the 
columns display all the periods set up even though there are no data. This is contrary to the dimensions 
in the Aging Principle table, where they are combined with the fact table so they are restricted by the fact 
data. The AP Aging and the Job Invoicing universes are also updated. 

Additionally, a new derived table AGINGPERIOD_D is introduced to get all the aging periods. It is 
separated from other tables so that you are not restricted by the fact entries. 

New Filter in AP Aging, AR Aging, and WIP Aging 
Deltek Tracking: 1220989 

Previously, the AP Aging and AR Aging reports showed vendors and customers even though there were 
no outstanding figures on the aging columns. The vendors and customers displayed though the aging 
columns all showed zero-amounts. The WIP Aging reports filtered rows where all amounts were zero. 
However, rows on lower drill levels (Customer level or Job level, for example) could have non-zero 
amounts that summarized to zero. Thus, the system filtered these rows as well. 

This enhancement adds a table filter to the Aging reports to enable you to filter rows if the aging columns 
are zero. For WIP Aging reports, zero-rows are now filtered only if there are no amounts on the lower drill 
levels. 
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UK Tax Submission and Statutory Reporting Workspaces 
Deltek Tracking: 1220995 

The statutory reports were previously available under BPM Statutory Reporting in Reporting » Reports » 
Overview. The UK Tax Submissions workspace and the Statutory Reporting workspace are added to the 
Workspace Client to enable you to easily access these reports. 

Specifically, you can access the following in the Statutory Reporting workspace: 

Country Reports 

Belgium  Customer Listing  

 Intra Community Listing 

 Tax Declaration  

France  Accounting Entry File 

Sweden  Standard Import/Export (SIE) 

Norway  Standard Audit File – Tax (SAF-T) 

India  Overdue Vendor Payments 

Germany  GOBD 

 

For more information on the UK Tax Submission Workspace, refer to Deltek Maconomy BPM Description 
Guide. 

Upgrade 

For more information related to upgrade from a previous BPM version to 2.5.1, refer to the Uninstallation 
of Existing BPM IA SPUs instructions in Deltek Maconomy BPM Admin Guide. 

Setup in Maconomy 

For more information related to the Workspace and System Parameter Setup, refer to Deltek Maconomy 
BPM Admin Guide. 

Tax Settlement Report Enhancements 
Deltek Tracking: 1221003 

Previously in the Tax Settlement report, you could filter entries by date intervals. The report prompted for 
tax period and date. However, tax settlement is run across periods and not entry dates. The Entry Date 
prompts are removed from the Tax Settlement Report and the Period prompts are now mandatory. Entry 
dates are no longer in the report but they are in the Tax Entries tab in the Workspace Client for lookup 
and reference. This enhancement requires you to use the period intervals for filtering in the report instead 
of arbitrary date intervals. Furthermore, all companies that use tax reports should now settle their taxes 
using the tax settlement functionality in Maconomy. 
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New Reporting Structure Name Prompt in Finance Reports 
Deltek Tracking: 1154024  

Prior to this release, each finance report used a specific reporting structure for grouping accounts. Each 
finance report had an associated reporting structure setup in Maconomy, through an option list and a 
selected option in that list. A new prompt is introduced to enable you to run the same finance report using 
different reporting structures, depending on the situation.  

This enhancement adds the Reporting Structure Name prompt as a mandatory prompt to the Finance 
reports to enable you to easily specify the format of account headers and subtotals when you run the 
reports. You can now can choose one of the reporting structures that has been set up. The prompt has no 

value by default but you can save a finance report in the BI LaunchPad with a certain answer for that 
prompt. Then, the prompt is prefilled when you reopen the report. 

Additionally, it gives you the flexibility to select the structure that you wish to use. For example, you can 
have a special structure for a US GAAP balance sheet and IFRS balance sheet. Then, select which 
structure to use for the report instead of having two reports for each type (GAAP and IFRS) with their own 
separate structure embedded into BPM. 

Note that if you save a finance report with a value for the Reporting Structure Name prompt, it only works 
if you are running the report from BI LaunchPad. If you run the report from the Workspace Client, the 
value from the workspace selection criteria overwrites the value you selected in the report. Additionally, 
there are no changes in the Workspace Client. You still need to fill the selection criteria when running a 
report. You cannot search a report you previously saved with prompt answers. Thus, you still have to fill 
the Reporting Structure field in the Financial Reporting workspace in Maconomy when running a report. 

German GoBD GL Data Export Requirement 
Deltek Tracking: 1220987 

GoBD, also known as Grundsätze zum Datenzugriff und zur Prüfbarkeit digitaler Unterlagen (GDPdU), is 
required in Germany if requested by the financial or tax authorities. The export is designed to provide 
external auditors and tax authorities in Germany and other countries with an extract of the General 
Ledger either in its entirety or for selected subsets of the General Ledger or sub-ledger. 

The purpose of the GOBD data export is to produce several CSV files and one XML file for tables of 
contents that are based on the different books for submitting and receiving responses to and from 
German tax authorities. This data export consists of 28 sub-reports that are defined as CSV files for 
individual financial books and an XML file that acts as a table of contents. 

The report can be accessed via the Workspace Client in the Report Overview » German Statutory link. 
A new sub-tab is also created in the Workspace Client: Reporting » Statutory Reporting » Statutory 
Reporting » German » GOBD. 

Each of the report types has separate selection criteria that are situated within the German Statutory 
workspace. 

Reports 

The following reports are included with the German GoBD Data Export. They are grouped here by type:  

Type Report Name 

Asset Master Data  Asset 

 Asset Group 
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Type Report Name 

Asset Transactions  Asset Entry 

Banking Master Data  Payment Agent Information 

 Payment Mode 

Company Master Data  Company Information 

Customer Master Data  Company Customer 

Customer Transactions  Customer Entry 

Employee Data  Employee 

Finance and VAT Entries  Finance Entry 

Finance Master Data 

 

 Account 

 Local Account 

Item Master Data  Item 

 Item Group Information 

Job Entries  Job Entry 

Job Master Data  Activity 

 Job Header 

 Job Posting Reference Line 

 Task List Header 

Job Order Transactions  Job Order Transaction 

Order Line Data  Order Line 

Order Master Data  Order Header 

Subscription Master Data  Subscription Order Header 

Tax Master Data  FinanaceVatCode 

 VatCode 

Vendor Master Data  Company Vendor 

Vendor Transactions  Vendor Entry 

The export can be accessed via the Workspace Client. This is stored in Report Overview workspace » 
German Statutory link. 

The following files are generated as part of the export:  



Maconomy 2.5.1 — Detail 

Enhancements Guide 87 

 

 Report file(s) (.csv) 

 Index file (.xml) 

 DTD file (.dtd) 

Cashflow Statement Indirect Method Report 
Deltek Tracking: 1113809  

The Cash Flow Statement Indirect Method report is a financial report used in business processes for 
performance management and outlines how cash flows in and out of a business. This report displays 
financial figures in a certain reporting structure. It outlines the standard Operating Activities, Investing 
Activities, and Financing Activities sections. 

The report is sectioned by currency, company number, and name. 

There are two ways to display the figures in a cashflow statement report: the Direct Method and the 
Indirect Method. This report uses the indirect method. 

In the indirect method, figures are calculated differently depending on whether it is a P/L account or a 
Balance sheet: 

 For P/L accounts, the movement on the account for the period selected is displayed.  

For example, if an invoice and corresponding payment were registered in the period, the amount 
excluding tax would typically appear in the group Net Profit, which groups P/L accounts. The 
amount of the invoice is then included in what is displayed for Net Profit in the cashflow 
statement, with the corresponding balance sheet account for AR showing up in the Operating 
Activities in the changes in Accounts Receivables section. 

 For Balance sheet, the closing balance on the account is subtracted from the corresponding 
closing balance on the account from the previous year.  

For example, if a cash account closed at $1000 at the end of the selected period last year, and it 
closed at $2500 at the end of the selected period for the current year, the current period should 
display $1500; thereby, indicating a cash-inflow. 

Invert Sign Option 

You can apply this bookkeeping sign,by creating a reporting structure in the Workspace Client and 
selecting or deselecting the checkbox in Invert Sign column. By doing this, you can then tell which 
accounts need to have the natural sign and which do not. 

Note: This applies to the Reporting Structure setup referenced and explained in the Setup section.  

The goal and purpose of this report is have same amount on the Cash Closing Balance and Cash 
Reconciliation rows. If this does not occur, you may need to revisit the reporting structure for any 
missing or excess amounts, or to ensure that Invert Sign is properly applied. 

 

Cashflow Statement Indirect Method Reporting Structure Overview 

Although you can freely name the grouping levels, it is mandatory to have a specific basic structure in 
place for Cashflow. This structure is as follows:  

Note: For more information and background, see the Natural Sign in Finance Reports feature in 
this guide. 
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1. Net Cashflow (top level) 

a. Operating Activities (sub-level) 

b. Investing Activities (sub-level) 

c. Financing Activities (sub-level) 

2. Cash Reconciliation (top level) 

As shown here, you must have two top-level groupings: Net Cashflow and Cash Reconciliation. 
Additionally, you must use three sub-level groupings within Net Cashflow: Operating Activities, Investing 
Activities, and Financing Activities. 

Additional sub-levels within these groupings can be configured anyway you wish to suit your reporting 
and business purposes. 

 

Updates for 1099 MISC and NEC Changes  
Deltek Tracking: 1226383 

Effective tax year 2020 for US companies, the 1099 MISC form no longer reports on non-employee 
compensation in Box 7. The 1099 MISC report is updated so that this field is removed from the report and 
the option list is updated accordingly.  

The new 1099 NEC form is used only to report on non-employee compensation. A new report is created 
to address this new requirement with corresponding updated option list.  

This feature includes the following items:  

 Updates to the 1099 MISC Report 

 Support for the 1099 NEC Report 

Changes to Maconomy 

The 1099 MISC report is updated to remove box 7, non-employee compensation (NEC). Non-employee 
compensation is now handled exclusively through the new 1099 NEC form.  

1099 MISC Changes 

As of tax year 2020, the arrangement of boxes and the naming of the boxes in the 1099 MISC report will 
change. The following table describes these changes: 

Boxes 

Previous 
Box No. 

 
Box Title 

New 
Box No. 

 
Box Title 

1 Rents 1 Rents 

2 Royalties 2 Royalties 

3 Other Income Federal 3 Other Income 

Note: For more information on this new reporting structure, see New Reporting Structure for 

Cashflow Statement Indirect Method. 
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Previous 
Box No. 

 
Box Title 

New 
Box No. 

 
Box Title 

4 Income Tax Federal 4 Federal Income Tax Withheld 

5 Fishing Boat Proceeds 5 Fishing Boat Proceeds 

6 Medical and Healthcare Payments 6 Medical and Healthcare Payments 

7 Nonemployee Compensation 7 Payer Made Direct Sales of 5000 or 
More 

8 Substitute Payment in Lieu and 
Dividends or Interest Payer Made 

8 Substitute Payments in Lieu of 
Dividends or Interest 

9 Direct Sales of X 5000 or More 9 Crop Insurance Proceeds 

10 Crop Insurance Proceeds 10 Gross Proceeds Paid to an Attorney 

11 blank 11 blank 

12 blank 12 Section 409A Deferrals 

13 Excess Golden Parachute Payments 13 Excess Golden Parachute Payments 

14 Gross Process Paid to an Attorney 14 Nonqualified Deferred Compensation 

15a Section 409A Deferrals 15 State Tax Withheld 

15b Section 409A Income 16 State Payers State No. 
Note: Because the report is not 
pulling data for this field but from the 
company vendor's tax number, this 
option can be left out.  

16 State Tax Withheld 17 State Income 

17 State Payers State No.   

18 State Income   

The most notable change is that the previous value of box 7 is taken out. Additionally, the split of box 15 
into 15a and 15b has been rearranged number-wise, and there are new titles on some of the boxes. 

1099 NEC 

The IRS has created a new form, 1099 NEC (Non-Employee Compensation) report, which includes only 
the NEC details in order to have better audit trail and visibility for NEC transactions. The new 1099 NEC 
report is essentially a copy of the 1099 Misc report; except that it only contains 7 amount boxes. It is still 
similar to the 1099 Misc in that it consists of the following: 

 A first report tab that provides a summary of figures 

 A second report tab that provides the box values; just for fewer boxes.  
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Boxes 

Box No. Box Title 

1 Nonemployee Compensation 

2 blank 

3 blank 

4 Federal Income Tax Withheld 

5 State Tax Withheld 

6 State Payers State No. 
Note:Because the report is not pulling data for this field but from the company vendor's 
tax number, this option can be left out. 

7 State Income 

The following are other considerations to note:  

 Box 1 corresponds to Box 7 in the previous version of the 1099 MISC report.  

 Box 4 corresponds to Box 4 in 1099 Misc, Box 5 to 15 in the new 1099 MISC, along with Box 6 to 
16 and Box 7 to 17. 

Note that only Box 1 is commonly used.  

 

India Overdue Payments (MSME) Report 
Deltek Tracking: 1213873 

The India Overdue Payment report is used by companies who get supplies of goods or services from 
micro and small enterprises, and whose payments to micro and small enterprise suppliers exceed 45 
days from the date of deemed acceptance of the goods or services. The report contains a half-yearly 
return stating the amount and the details of all outstanding payments due. This report is also known as 
the MSME Report in India.  

“Specified Companies”, as per section 405 of The Companies Act, 2013), must submit a half-yearly return 
to the Ministry of Corporate Affairs stating the following: 

a. The amount of payment due;  

b. The reasons of the delay; 

c.  In addition, showing 

 All invoices for which payment was made beyond 45 days on the date of filing the 
returns; and 

 All invoices for which payment has not been made within 45 days of the invoice date 

Note: Box 6 must manually entered as there is currently no place to store a state TIN. This 
update is scheduled for a future release.  
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This report is used for statistical reasons and the Indian Government uses these details including the 
payments to ascertain how these smaller businesses are doing financially. 

The purpose of the Overdue Vendor Payment report is to give an overview of vendor invoices that were 
paid beyond a specific number of days. India’s tax authority uses a 45 day limit for invoices. However, the 
functionality in Maconomy allows for a dynamic number of days so that the user can input a value to base 
the report on. This input value acts as a parameter in calculating which invoices should in the report. By 
allowing for this flexibility, users can manually select the date range for their reports. 

For the information to be captured in the half-yearly returns, details of all invoices for which payments 
were made beyond 45 days are to be reported in the returns. The fact that the payment was made before 
filing the return should not change the reporting requirement. To summarize, the following are to be 
reported in half yearly returns: 

 All invoices for which payment was made beyond 45 days on the date of filing the returns; and 

 All invoices for which payment has not been made within 45 days of the invoice date. 

Additionally, this report shows if the invoices are open or have been closed.  

The report consists of three sorts of information: 

1. Invoice tracking information 

o Data such as vendor number, tax number, invoice number and date values 

2. Late payment amounts 

o Amounts paid late (For example, more than 45 days after the due date).  

Note that the user can choose a value other than 45. 

3. Amounts not yet paid  

o Amounts not yet paid after x days (For example, 45 days) after the due date.  

Example Scenarios 

The following are example scenarios. Although the user can decide the number of days to use for the 
report, we will assume 45 days for the sake of simplicity.  

A vendor invoice is registered with an invoice date September 2. 2019. 46 days after (October 18. 2019) 
the invoice has not been paid yet (reconciled). The invoice should then appear in the report because it is 
still outstanding after 45 days from the due date. 

Below are listed the combinations that are possible, and for each state, whether the amount should 
appear in the report or not. We also state whether the amount should display as paid late or outstanding. 
If it is paid late it is because the amount has been paid but not until after the 45 day limit. If it is 
outstanding it is because the amount has not yet been paid after 45 days.  

These are important to keep in mind when using the report because there can be some complex 
scenarios.  

In general, when we say "after ... days", we will understand this as the given number of days after the due 
date. "not appear" means that the invoice should not appear in the report. 

Example Scenarios 

Scenario Late Payment Outstanding 

Invoice paid 30 days after due date not appear not appear 
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Scenario Late Payment Outstanding 

Invoice paid 45 days after due date not appear not appear 

Invoice of $1000 paid 46 days after due date $1000 0 

Invoice unpaid 30 days after due date not appear not appear 

Invoice unpaid 45 days after due date not appear not appear 

Invoice of $1000 unpaid 46 days after due date 0 $1000 

Invoice of $1000 where 600 is paid 30 days after due date and 
400 is outstanding 30 days after due date 

not appear not appear 

Invoice of $1000 where 600 is paid 30 days after due date and 
400 is outstanding 45 days after due date 

not appear not appear 

Invoice of $1000 where 600 is paid 30 days after due date and 
400 is outstanding 46 days after due date 

0 400 

Invoice of $1000 where 600 is paid 46 days after due date and 
400 is outstanding 46 days after due date 

600 400 

Reporting Date 

When reporting the data to the authorities, the notion of a Reporting Date is used. The reporting date is 
the To Date prompt in the report. In order to prevent including all invoices that were historically paid late, 
a lower bound is also provided in terms of a From Date prompt. This way, all payments or lack of 
payments within that date interval are considered.  

Swedish SIE Report 
Deltek Tracking: 1261540 

The Swedish SIE (Standard Import/Export) reports are used by the Swedish tax authorities to audit a 
company’s books. This form is not filed but requested when an audit is to start. The purpose of the report 
is to show details of accounts balances. It also shows the opening and closing of balance sheet accounts 
and balances of the profit and loss accounts. 

In order of satisfying statutory requirements for Sweden, BPM provides an SIE file format that runs via the 
Workspace Client. The SIE-file format is used for sending accounting data between the company, the 
accountant, and the auditor. SIE is a tagged text file format, not XML 

The following includes a description of the two types of file options that are included in this report: 

The new SIE report exports the following information in two SIE file formats: 

 Year-end balance (SIE 1) 

 All recorded transactions and vouchers (SIE 4 and 4i)  

The report can be accessed via the Workspace Client. It is located in Reports » Statutory Reporting » 
Sweden. 
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UK MTD Fraud Prevention Headers 
Deltek Tracking: 1256888  

The UK Making Tax Digital (MTD) Report is enhanced to include fraud prevention headers to meet the 
requirements of the UK HM Revenue and Customs (HMRC). The fraud prevention headers are HTTP 
headers that help monitor and audit transactions to protect taxpayers’ data from fraudulent activities. The 
UK Tax Submissions workspace now also enables companies to send these particular types of user audit 
data to HMRC.  

The following header information is added: 

Fraud Prevention Header Value Description 

Gov-Client-Connection-Method The value for this header identifies the other 
headers that should be submitted to HMRC.  

The specific value for Maconomy is 
OTHER_DIRECT. 

Gov-Client-User-Agent This value is a combination of the Operating 
System Name/Operating System Version 
(System Manufacturer/System Model) of the 
machine where Maconomy is currently installed. 

System Manufacturer and System Model have 
their own setup in the UK Tax Submission 
instructions. 

Gov-Client-Device-ID This is the value derived from the Maconomy 
Installation No. 

https://tfs.deltek.com/tfs/Deltek/6975c4c0-6dfa-40f2-b71d-45b29d45d518/_workitems/edit/1265848
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Fraud Prevention Header Value Description 

Gov-Vendor-Version This is the value derived from the Maconomy 
major version regardless of CU installation. 

Gov-Client-Timezone The value is derived from the time zone of the 
machine where Maconomy is installed.  

Gov-Client-User-IDs This is the value derived from the user login 
name. 

Gov-Client-Local-IPs This value lists all local IP addresses available to 
the system where Maconomy is installed except 
Loopback addresses. 

Gov-Client-Mac-Addresses This value lists all local physical addresses 
available to the system where Maconomy is 
installed except Loopback addresses. 

Gov-Vendor-License-IDs This is the value derived and hashed from the 
customer’s product key. The information is 
concealed before submission to HMRC. 

Gov-Client-Multi-Factor This is the value derived from a Multi-Factor 
Authentication setup. If no Multi-Factor 
Authentication is set up, no data values are 
submitted to this header.  

Currently, TOTP or 2FA is only supported for this 
header value. If it is not included in your setup, we 
recommend that you set up 2FA in your 
Maconomy system to comply with HMRC’s 
requirements on Multi-Factor Authentication. 

Note: We also plan to review the following for 
inclusion later: 

 Azure: Azure may be considered in a 
future release. Customers using Azure 
can use Maconomy 2FA as a 
workaround.  

 OneLogin: Customers can use 
Maconomy 2FA as a workaround. 

 OTP: Deltek will not consider OTP as it 
does not work from a technical 
perspective. Customers can use 
Maconomy 2FA as a workaround.  

 Kerberos: Kerberos does not support 
2FA and will  not be considered 

If you use a header that is not in the list, please 
log a ticket with Customer Care so that our 
development team is aware. 
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Changes to Maconomy  

The UK Tax Submissions single dialog workspace is updated. 

Control Account No. Object in AR Aging and AP Aging 
Deltek Tracking: 1221562 

A new object called Control Account No. is introduced in the AR Aging and AP Aging universes. This 

object is used for stating the finance account of the control account for customers and vendors. This 

change was crucial in satisfying updated requirements to the Norwegian SAFT data export. 

Prior to this change being made, it was difficult to ascertain the control account that was assigned to the 

A/R and A/P control accounts from the popup fields. Although an account was mapped to the popup and 

assigned to customer and vendor, it was difficult to trace this account back to the popup fields in various 

universes for reporting. We now have the ability to add that field to reports such as NSAFT. 

Note: In 2.4.5 CU6 and 2.4.6 the objects have other CUIDs than in 2.5 CU2 and 2.5.1. Therefore, it is not 

recommended to use the objects in customizations or reports if using the universes of the 2.4.5 CU6 or 

2.4.6 releases. 

Changes to Maconomy 

The Control Account No. object is added to the following universes:  

 AR Aging 

 AP Aging 

BPM Report-Specific Reporting Structures Option List and Value 
Deltek Tracking: 1244067 

The NSAFT and SIE reports data export has a query for fetching finance figures. These are assigned 

groups by means of a reporting structure. However, the reporting structure that is assumed is the same 

as the one assumed when running other finance reports, such as the Balance Sheet, P&L, and Trial 

Balance reports. This is an issue because the Norwegian and Swedish Tax Authorities require a certain 

grouping of the accounts when reporting for NSAFT and SIE. Therefore, customers would have to change 

their own grouping used for their finance reports, which is not convenient or feasible.  

This feature allows for a new reporting structure by using a new option named NSAFT or SIE.  

This feature includes:  

 SIE Option List and Value Updates 

 NSAFT Option List and Value Updates 

Changes to Maconomy 

New values are added for NSAFT and SIE in the following locations 

 Reporting Structure Name field in Reporting » Statutory Reporting » Sweden » Standard 
Import/Export. 

 Single Dialogs » Set-Up » Reporting » Reporting Structures » Selected Value Field 
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SIE Option List and Value Updates 

The data export is changed to add ‘SIE’ as one of the values that you can enter in the Selected Value 
field in the Reporting Structures workspace. 

NSAFT Option List and Value Updates 

The data export is changed to add ‘NSAFT’ as one of the values that you can enter in the Selected Value 
field in the Reporting Structures workspace.  

NSAFT Data Export Reporting Structure 
Deltek Tracking: 1293326 

The NSAFT data export uses a reporting structure to group finance data. However, the reporting structure 

that was previously assumed was the same as the assumed setup for normal finance reporting like 

running Balance Sheet, Profit and Loss, and Trial Balance reports. This was incorrect because the groups 

need to follow a certain chart of accounts defined by the Norwegian state. Usually, companies are not 

interested in adjusting their standard finance reporting structure to that same grouping structure.  

The data export is changed to add ‘NSAFT’ as one of the values that you can enter in the Selected Value 

field in the Reporting Structures workspace. This is assumed setup in Maconomy in order for the NSAFT 

report to function. 

Changes to Maconomy 

‘NSAFT’ is added as a value to select in the Selected Value field in Set-Up » Reporting »Reporting 
Structures. 

Embed Tax Settlement Report in Workspace Client  
Deltek Tracking: 1137979 

With this enhancement, the Tax Settlement report is embedded in the Workspace Client. The report is 
available in Reporting » Reports » Overview » Financial Reporting. 

Embed All Statutory Reports in Workspace Client 
Deltek Tracking: 1167901 

For better usability and to enhance the user experience, all statutory reports are now embedded in 
Reporting » Reports » Overview » BPM Statutory Reporting in the Workspace Client. This workspace 
includes reports for the following countries:  

This includes the UK Tax Submissions WebI, Norwegian SAF-T, and Overdue Vendor Payments (India) 
reports. Other statutory reports that are developed in the future will be available here as well.  
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Time and Expense 

Improved Approver Access Control for Time, Expense, and Mileage 
Sheets 
Deltek Tracking: 1038584, 850544 

Maconomy enables you to customize a user's access and privileges within the system, depending on 
their role in the company. You can choose which specific workspaces or records can be viewed or edited 
by an employee. 

Previously, when you set up an approval workflow in Maconomy, approvers could only access records 
with lines that required approval if they were granted access to view these records in general. This 
enabled them to view all of an employee’s records, including those that were not relevant to the approver.  

With this enhancement, you no longer need to grant access to view all sheets to enable an approver to 
view the records for their approval. Access control specifications on time, expense, and mileage sheets 
are improved to display only the records that are relevant to the approver. Specifically, a user can access 
a time, expense, or mileage sheet based on the following criteria: 

 You are the creator or owner of the record. 

 You are the supervisor, secretary, or mentor of the employee who owns the record. 

 You are the designated approver, substitute approver, or super approver, depending on the 
approval hierarchies set up for an approval record. 

This enhancement improves access control for approvers by providing access to lines jf you either have 
access to the corresponding header, or if you are the project manager on the job selected on the line.  

 

Because approval through approval hierarchies does not apply to daily time sheets, the improved access 
control specifications for approvers also does not apply to these records. 

Note: Approver access to the relevant record is granted through approval hierarchies setup by 
assigning an employee to either the Approver field or Approver, Reference field in the 
Approval Hierarchies single dialog workspace. 

This functionality is not supported when you add an employee in the Approver by Employee 
Type field. Users required to approve as Employee Types still need access to all time or 
expense sheets. 
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Changes to Maconomy 

The access control specifications are updated in the following workspaces: 

 Expense Sheets single dialog workspace 

 Expense Sheet Lines single dialog workspace 

 Mileage Sheets single dialog workspace 

 Time Sheets single dialog workspace 

 Daily Time Sheets single dialog workspace 

 Daily Time Sheet Lines API single dialog workspace 

 SpeedSheet Details single dialog workspace 

 Time Sheet Lines API single dialog workspace 

 Weekly SpeedSheet Details single dialog workspace 

 Daily Time Sheet Line Expenses single dialog workspace 

 Daily Time Sheet Line Mileage single dialog workspace 

 Time Sheet Line Expenses single dialog workspace 

 Time Sheet Line Mileage single dialog workspae 

 Transfer Expense Sheet Lines single dialog workspace 

 Transfer Time Sheet Lines single dialog workspace 

 Import Expense Sheets single dialog workspace 

 Import Time Sheets single dialog workspace 

 Import Daily Time Sheets single dialog workspace 

To support this functionality, the following workspace is updated: 

 Approval Hierarchies single dialog workspace 

System Setup 

There are no changes to the usual procedures for setting up approval hierarchies. 

Multiple Check-in / Check-out Per Day Enhancements 
Deltek Tracking: 1256775 

This release adds two new enhancements to the Multiple Check-in and Check-out Per Day feature: 

 Tracking missed meals 

 Importing check-in data 

Missed Meals 

The Missed Meal field is added to several single dialog workspaces to enable you to track whether 
employees have used their daily breaks. If you choose to skip your daily break, you can select the Yes 
value to indicate that you did not use it. 

This Boolean field is used only for reporting purposes.  
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Imported Check-in Data 

You can now import check-in data for submitted time sheets to Maconomy by using the Import Time 
Sheets program. The Enable Check-in Import for Submitted Timesheets system parameter is added 
to support this functionality. 

Changes to Maconomy 

The following workspaces are updated: 

 Import Time Sheets 

 System Setup 

Setup Instructions 

Prerequisites 

Before you can import check-in data, you must do the following: 

 Ensure that the days of all entries to be imported are covered by existing time sheet headers in 
Maconomy. If the time sheet header does not exist, you can do the following: 

 Create them manually in the Time & Expense workspace 

 Create them in the import file.  

 Do not import these entries at all. 

 Enable the Enable Check-in Import for Submitted Timesheets system parameter. For more 
information about this, refer to the Enabling Import of Check-in Entries procedure. 

 Each check-in entry in the file has to have the Imported field set to true when importing to 
submitted timesheets. 

 Create daily check-in headers for each entry to be imported. 

On the employee revision, selecting any option except Disabled in the Check-in field 
automatically triggers the creation of daily check-in headers on existing time sheet headers.  

 

Import Employees example snippet to create the daily check-in headers for a revision: 

EmployeeRevision:Format EmployeeNumber FromDate CheckIn 

EmployeeRevision:Change 11 01.01.2003 Optional 

Enabling Import of Check-in Entries 

To enable this feature 

1. Go to System Setup » Parameters and Numbers » System Parameters. 

2. Double-click the Enable Check-in Import for Submitted Timesheets parameter. 

3. On the System Parameter sub-tab, select the Enable Check-in Import for Submitted 
Timesheets check box. 

Note: It is recommended to select the Optional value when enabling this on the employee 
record for less restrictions when you import the data. You may choose a different value, but 
you must take care that your entries follow the stricter validation rules imposed by them. 
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4. (Optional) To enable this for a specific company, go to the Company Specific Values sub-tab, 
specify a company number in the Company No. field. 

5. Click Save. 

Importing Check-in Entries 

The system will check imported check-in entries for basic validity. The following will be checked: 

 For imported submitted check-in entries, the check-in and check-out time must be filled out. For 
imported check-in entries for time sheets that have not been submitted, you do not need to 
provide the check-out time. 

 The check-in time on each entry must be before the check-out time 

 There should be no overlap between the periods defined on entries. 

 If the Maximum Number of Check-ins Per Day system parameter is enabled, each entry must 
not exceed the maximum value indicated by the parameter. 

The Imported flag has to be true when importing data into already submitted time sheets. 

Import Time Sheets Example 

DailyCheckInHeader:Format EmployeeNumber TheDate MissedMeal Remark1 Boolean1 Imported 

DailyCheckInHeader:Change 11 04.03.2020 1 HeaderRemarkText 1 1 

 

DailyCheckInEntry:Format EmployeeNumber TheDate CheckInTime CheckOutTime Remark1 Boolean1 Imported 

DailyCheckInEntry:KeyFields EmployeeNumber TheDate CheckInTime 

DailyCheckInEntry:Create 11 04.03.2020 08:10:00 09:10:00 EntryRemarkText123 1 1 

DailyCheckInEntry:Change 11 04.03.2020 08:10:00 09:25:00 EntryRemarkText999 0 1 

System Parameters 

Parameter Description 

Enable Check-in Import for Submitted 
Timesheets 

Enable this parameter to allow the import of 
check-in data to submitted time sheets in 
Maconomy. 

Exclude Overtime from Time Sheets 
Deltek Tracking: 1171729 

This feature enables the use of overtime specifications to register work time. You can set up overtime 
types and choose what is included or excluded in the calculation of working time for each day. 

This is available in the Workspace Client, iAccess, and Touch. 

Exclude Overtime Functionality in the Workspace Client 

This functionality introduces a new calculation of working time based on overtime types in a time sheet 
registration. You can set up various overtime types to specify whether the time registered is considered 
as overtime work or should be included in the employee’s regular working hours.  
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Overtime Types in Time Sheets 

When you create or edit an overtime type in System Setup » Parameters and Numbers » Popup 
Fields » Popup Field, select the new Include in Regular Time field to specify that time registered using 
this type is included in regular time when the system calculates time sheets. 

On time sheet lines, the Overtime Spec. field overtime type now also displays an Regular Time field to 
indicate whether it is included or not. 

When an employee registers time using an overtime type where the Include in Regular Time check box 
is selected, it is treated as regular time. If the same check box is deselected on an overtime type, then 
used to register time, it is considered overtime. Additionally, if you create a time sheet line and do not 
specify a value in the Overtime Spec. field, this is considered regular time. 

Calculating Regular Time, Overtime, and Balance 

This feature introduces the term of regular time, which specifies time activities that are included in your 
regular working hours. 

An employee’s regular time, overtime, and balance is always calculated, regardless of the Exclude 
Overtime state. 

 Regular time is calculated as Total Time minus Overtime. 

 Overtime is calculated as the sum of all time sheet lines that have a selected Overtime Spec. 
where the Include in Regular Time field is deselected. 

 Balance is calculated as Regular Time minus Fixed Time. 

The difference in functionality when this feature is enabled or disabled is displayed below: 
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Approving Time Sheets 

When an approver views a time sheet that utilizes this functionality, it also displays the fields used to 
calculate regular time, overtime, and the balance of the employee. 

Enabling Exclusion of Overtime 

The Exclude Overtime field is added to employee records and revisions to support this feature. This field 
has the same value on every day within a time sheet period, and is defined by the employee revision on 
the time sheet start per day. 

When you select this field, the following occur: 

 The minimum and maximum time validations are switched to use regular time for comparison. 

 The system switches the layouts to show data for regular time, overtime, and balance. 

For more information on enabling this, see Setup Instructions. 

Changes to Maconomy 

The following workspaces are updated: 

 System Setup workspace 

 Employees workspace 

 Time & Expenses workspace 

 Popup Fields single dialog workspace 

 Employees single dialog workspace 

 Weekly SpeedSheet single dialog workspace 

 Time Sheets single dialog workspace 

 Speed Sheet single dialog workspace 

 Daily Time Sheets single dialog workspace 

 Approval Time Sheets single dialog workspace 

 Approve Time Sheets single dialog workspace 

 Approve Time Sheets by Employee single dialog workspace 

 Daily Time Sheet Lines single dialog workspace 

 Job Time Registration single dialog workspace 

 Time Sheet Lines single dialog workspace 

 Supervisor Time Sheet Status single dialog workspace 

Setup Instructions 

Enable Exclusion of Overtime 

You can enable this functionality on an employee record. 

To enable this feature: 

1. Go to Human Resources » Employees » Employees » Employee Information. 

2. Select an employee from the filter list. 

3. In the Time Registration island, select the Exclude Overtime from Balance check box. 
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4. Click Save. 

Specify Overtime Types Included in Regular Time 

You can choose which overtime types to include or exclude in an employee’s regular time. 

To specify the overtime type: 

1. Go to System Setup » Parameters and Numbers » Popup Fields » Popup Field. 

2. Select the Overtime Type popup from the filter list. 

3. In the Values sub-tab, select an overtime type. 

4. Select the Include in Regular Time field to specify this type must be considered as regular time. 

5. Click 

6.  Save. 

Exclude Overtime Types from Time Sheet Balance in iAccess 

iAccess now supports the ability to exclude overtime types from an employee’s time sheet balance. 

Changes to iAccess 

To support this feature, the following workspaces are updated: 

 Employees 

 Weekly Time Sheets 

 Daily Time Sheets 

 Time Sheet Overview 

 Time Sheets and Time Sheet Lines tabs in the Approval Center 

Setup Instructions 

Setup is similar to that in the Workspace Client. Users with requisite rights can enable this feature on an 
employee record in Reference Workspaces » Set-Up » Set-up » Employees. 

You can also specify overtime types to include as regular time in Reference Workspaces » Set-Up » 
Set-up » Popup Fields.  

 

Exclude Overtime Types from Time Sheet Balance in Touch 

The Overtime field is now available in all time registration and approval screens. To support this 
functionality, balances are expanded to include Regular, Fixed, Balance, and Overtime statistics values 
on timesheet screens. 

You can enable this feature when you enable the Exclude Overtime from Balance field on the 
employee. If you have Touch extensions with overtime on timesheets, update your extensions to take into 
account the OvertimeType field as part of the standard timesheet layouts when the field is enabled on 
the employee. 
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Invoicing 

Withholding Tax on Customer Invoices 
Deltek Tracking: 1109747 

This enhancement adds support for negative tax rates in tax codes. This enables you to enter a negative 
VAT rate to be used for calculating withholding taxes on customer invoices. This functionality is available 
for use on all tax levels.  

With this feature, support for withholding taxes on outgoing invoices are now available on customer 
invoices, intercompany invoices, sales orders, and subscription orders. This is similar to the functionality 
used in vendor invoices. 

When you create a tax code or G/L tax code for withholding taxes, you can specify negative values in the 
following: 

 Tax Rate 

 Special Tax Rate 

 Investment Tax Rate 

 EU Acquisition Tax Rate 

When you post or print an invoice with withholding taxes, it displays the tax amounts in negative values. 

Conversation Functionality Enhancements for Invoicing Workspaces 
Deltek Tracking: 1138822 

Maconomy introduces the conversation functionality as part of the invoicing workspaces in iAccess, and 
the Workspace Client. This feature enables you to create, and respond to conversations for job invoices, 
draft invoices, and blanket invoices.  

This feature includes: 

 Conversations for Job and Blanket Invoices in the Workspace Client 

 Conversations for Job and Customer Invoices in iAccess 

Conversations on Job and Blanket Invoices in the Workspace Client 

Changes to Maconomy 

The following changes are made to support this feature: 

 Updated the Jobs, Batch Invoicing, and Blanket Invoicing workspaces 

 New notifications for unread job invoice, and blanket invoice messages 

 New fields in Jobs, Blanket Invoicing, and Conversations workspaces 

Setup Instructions 

Enable or Disable Conversations  

For details, see the Setup Instructions of the Enable or Disable the Conversations Functionality in the 
General Enhancements section. 
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Notifications 

UnreadJobInvoiceMessage 

This notification is used to inform users about any unread messages in a conversation regarding a job 
invoice. It is triggered when: 

1. A message is added to a conversation regarding a specific job invoice. 

This notification in turn triggers the Unread Job Invoice Message To-Do. 

Recipient 

The Unread Job Invoice Message To-Do is received by the following users: 

 Any employee who is already part of the conversation, or was added to the conversation by 
another employee before the message was sent. 

Workspace 

If the job invoice is unposted, the Unread Job Invoicing Message To-Do directs the recipient to the 

Conversation sliding panel of the Jobs workspace. If the job invoice is already posted, the 

Unread Job Invoicing Message To-Do directs the recipient to the Jobs workspace. 

UnreadBlanketInvoiceMessage 

This notification is used to inform users about any unread messages in a conversation regarding a 
blanket invoice. It is triggered when: 

1. A message is added to a conversation regarding a specific blanket invoice. 

This notification in turn triggers the Unread Blanket Invoice Message To-Do. 

Recipient 

The Unread Blanket Invoice Message To-Do is received by the following users: 

 Any employee who is already part of the conversation, or was added to the conversation by 
another employee before the message was sent. 

Workspace 

If the job invoice is unposted, the Unread Blanket Invoicing Message To-Do directs the recipient to the 

Conversation sliding panel of the Blanket Invoicing workspace. If the job invoice is already posted, the 

Unread Job Invoicing Message To-Do directs the recipient to the Blanket Invoicing workspace. 

Conversations on Job and Customer Invoices in iAccess 

Changes to iAccess 

To support this feature, the following workspaces are updated: 

 WIP Invoice 

 Invoice on Account 

 Draft Invoices 

 Customer Invoicing 
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Procedures 

You can use the conversations functionality to correspond with other employees in your company about 
specific job invoices, draft invoices, and blanket invoices. The following procedures impact the WIP 
Invoice, Invoice on Account, Draft Invoices, and Customer Invoicing workspaces: 

Start a Conversation 

To start a conversation: 

1. Under the Jobs menu, go to an invoicing workspace. 

2. Select a job or customer invoice from the filter list. 

3. In the input area of the Messages pane, type your message and mention a specific person by 
typing @[name] as part of the text. 

4. Click the paper plane icon or press ENTER to send the message. 

Reply to a Conversation 

When you log in to iAccess, the top right corner of the iAccess menu includes a blue Notifications icon for 
your unread messages. 

To reply to a conversation: 

1. Click the blue Notifications icon to expand your list of unread messages. 

2. Expand a job or customer invoice from the list, and click on the comment. 

iAccess then navigates to an invoicing workspace, and opens the Messages pane for that 
invoice. 

3. In the input area, type your reply. If needed, mention a specific person by typing @[name] as 
part of the text. 

4. Click the paper plane icon or press ENTER to send the message. 

Job Cost 

Intercompany Pricing Enhancements 
Deltek Tracking: 795616 

You can now create an intercompany price list with various intercompany pricing percentages for different 
companies. The Responsible Company and Executing Company fields are added to price list lines to 
allow you to enter specific intercompany price percentages per company.  

These fields are used as selection criteria in the pricing algorithm, wherein the line is matched and used if 
the responsible and executing company matches the registration.  

Example 

When working with companies located in different countries, you can now add a line with a specific 
percentage as shown in the table below: 

Intercompany Pricing 

Percentage 

Responsible Company Executing Company 

14% UK India 
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Intercompany Pricing 

Percentage 

Responsible Company Executing Company 

7% UK DK 

12% US UK 

9% UK  

10%   

Based on these price list lines, when the system calculates prices, the last line serves as the default 

intercompany pricing percentage for transactions when there are no specified companies in the Company 

fields above. The second to last line serves as the default percentage for all intercompany transactions of 

the UK company. 

Changes to Maconomy 

The following workspaces are updated: 

 Job Price Lists single dialog workspace 

 Job Price Information single dialog workspace 

Overtime Charge Percentage for Overhead Rates 
Deltek Tracking: 1071038 

Prior to this release, Maconomy allowed you to adjust the overtime charge percentage for time 
registration or amount activities on a job entry, but this applied only to the base salary for time activities. 
This feature introduces the ability to also adjust overtime charge percentage for overhead rates. The rates 
for base salary and overhead can be specified in job-specific price lists, general cost prices, employee 
records, or employee categories. Once these rates are defined, the feature is available on job entries. 

To support this functionality, the Overtime Charge %, Cost field is renamed to Overtime Charge %, 
Base Salary. This field is used to adjust overtime charges for time and amount activities. Similarly, the 
New Charge %, Cost field is renamed to New Charge %, Base Salary. These have been renamed to 
clarify that values in these fields affect the base salary rate, which is then added to the total cost on a job 
entry. 

The following fields are also added to enable the adjustment of overtime for overhead rates on time 
registrations: 

 New Charge %, Overhead – added to the Job Price Lists single dialog workspace 

 Overtime Charge %, Overhead – added to the Jobs workspace, Jobs Price Lists single dialog 
workspace, Job Price Information single dialog workspace 

This new feature is helpful when, for example, you need to register unpaid overtime on a job entry that 
should have zero cost. When you enter -100 on both the Overtime Charge %, Overhead and Overtime 
Charge %, Base Salary fields, the system uses these fields to take into consideration both the base 
salary and overhead rates on the job, then calculate this as zero cost on the line. Note that this works with 
any value, except zero, which is already used to identify fields that must remain untouched during 
calculations or adjustments. 



Maconomy 2.5.1 — Detail 

Enhancements Guide 108 

 

This feature is available by default in the Workspace Client. 

Changes to Maconomy 

The following workspaces are updated: 

 Jobs workspace 

 Job Price Lists single dialog workspace 

 Job Price Information single dialog workspace 

Daily Descriptions on Tasks Created From Budget 
Deltek Tracking: 1162619 

When you create or use a task list on a job, you can choose to enable daily descriptions by default on a 
task list. This enhancement allows you to create tasks from budget lines that use the same value by 
default. 

This is available in the Workspace Client, iAccess, and Touch. 

Daily Descriptions on Tasks in the Workspace Client 

When you create or use a task list on a job, you can choose whether to enable daily descriptions by 
editing the Use Daily Descriptions check box in Jobs » Jobs » Home » Tasks, or in the Task Lists 
single dialog workspace.  

A new functionality is added when you create a budget line with a new task (that is not included in your 
task list). This newly created task will use the same value as the task list for daily descriptions. This 
feature is available for time and amount budget lines, provided that the Create Tasks from Job 
Budgets, Time or Create Tasks from Job Budgets, Amount system parameters are enabled for each 
budget line type respectively. 

For example, if you enable daily descriptions on the task list, then create a new task by creating a budget 
line with a task not from the task list, the Use Daily Descriptions check box is selected by default on the 
task. If you choose to disable daily descriptions on the task list, then create a second task from a budget, 
the Use Daily Descriptions check box is deselected by default on this new task. 

Enabling or disabling daily descriptions on the task list only affects tasks that are created after you 
modified the task list. Previously created tasks will still retain whatever values they currently have. 

 

Setup Instructions 

You must enable the Create Tasks from Job Budgets, Time or Create Tasks from Job Budgets, 
Amount system parameters to utilize this feature. 

Setup » System Setup » Parameters and Numbers » System Parameters 

Single Dialogs » Set Up » Set-up » System Parameters » System Parameter Tab  

System Parameter island 

Note: If your job uses a shared task list, the system automatically changes it to a job-specific task list 
when you change the value of the Use Daily Descriptions check box in Jobs » Jobs » Home » 

Tasks. 
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System Parameter Description 

Group Job Cost 

 Create Tasks from Job Budgets, Amount — Enable this parameter 
to enter an amount task which does not exist on a job budget line. 
Maconomy creates the task in the job’s private task list, using the 
activity entered on the job budget line as derived activity. If the job is 
using a shared task list, a copy of that task list is automatically made 
private to the job in question. For more information, please see the 
description of the Job Tasks workspace. 

If you create a task (that is not included in the task list) from an amount 
budget line, the Use Daily Descriptions check box uses the same 
value as the Use Daily Descriptions check box on the task list itself. 

The description entered in the Description field on the job budget line 
is transferred to the new task and used as task description. If the Mark 
‘Overwrite Activity’ On Tasks system parameter is enabled, the 
Overwrite Activity field is selected for the new task. 

See also the description of the Extended Task Creation from 
Budgets system parameter. 

 Create Tasks from Job Budgets, Time — Enable this parameter to 
enter a time task which does not exist on a job budget line. Maconomy 
creates the task in the job’s private task list, using the activity entered 
on the job budget line as derived activity. If the job is using a shared 
task list, a copy of that task list is automatically made private to the job 
in question. For more information, please see the description of the 
Job Tasks workspace. 

If you create a task (that is not included in the task list) from a time 
budget line, the Use Daily Descriptions check box uses the same 
value as the Use Daily Descriptions check box on the task list itself. 

The description entered in the Description field on the job budget line 
is transferred to the new task and used as task description. If the Mark 
‘Overwrite Activity’ On Tasks system parameter is enabled, the 
Overwrite Activity field is selected for the new task. 

See also the description of the Extended Task Creation from 
Budgets system parameter. 

End User Enabled for Subscriptions and Jobs 
Deltek Tracking: 1293468 

Adding unique user numbers to your customers for your subscription orders, and jobs is now available in 

the Workspace Client. The end user information is obtained from the delivery customer, and not from the 

billing customer. With this feature, the End User No. field is added to the Subscription Orders, and Jobs 

single dialog workspaces. You can also customize your columns in the Subscription Orders, and Jobs 

workspaces to include the end user numbers. Prior to these workspaces, the functionality is utilized for 

quotes, credit orders, and sales orders. 

For field descriptions, refer to the Online Help. 
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Changes to Maconomy 

The following workspaces are updated: 

 Jobs 

 Subscription Orders 

 Jobs single dialog 

 Subscription Orders single dialog 

Absence Management 

Support for Negative Absence Balances 
Deltek Tracking: 1180701 

Employers may now allow employees to reach a negative absence balance.. When this feature is 
enabled, an employee can register absence that exceeds their available absence allowance for the 
period, provided that it does not surpass the negative absence balance limit as well. 

Negative balance limits are specified in the Absence Administration workspace. Balances must be 
specified using a negative value, and are indicated in the Days time unit. If you are using the Hours time 
unit, the system automatically converts the balance to hours, according to the user’s absence hours per 
day. 

Absence Registration and Approval 

When an employee submits absence that exceeds their absence allowance, a message displays to show 
their negative absence balance if the submission is approved. 

If an absence registration exceed both the employee’s available allowance and negative absence balance 
limit, an error message displays and the submission will not go through. 

Similarly, absence approvers will also get a message indicating the employee’s total negative balance 
once they approve the submitted absence registration. 

Example 

One company gives an employee 10 days absence allowance and -2.0 days negative absence balance 
for the current period. When the employee registers their 11th absence, the system allows this, but the 
employee is left with an absence balance of -1.0 days. 

When an absence registration using the negative absence balance has been approved, this is displayed 
as a negative value in the employee’s absence information in the Absence workspace. It is also color 
coded red to indicate that the available absence allowance has now gone into a negative balance. 

Absence Transfer 

When you move to a new period, you can choose to have the negative balance from the previous period 
taken into account when granting a new absence allowance for the current period. If an employee’s 
available balance in the previous period is negative, it is displayed using a negative value and is color 
coded red. 

Example 

Employee A has a negative absence balance of -2 .0 days in the previous period. When the supervisor 
grants allowance to employees for the current vacation period in the Absence Transfer tab on the 
Absence Administration workspace, he assigns 25.0 days to everyone using the batch operation, but he 
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also chooses to take previous vacation period negative absence balance into account. Employee A is 
automatically granted only 23.0 days. The supervisor submits and approves this. 

 

Changes to Maconomy 

The following workspaces are updated: 

 Absence Setup 

 Absence workspace 

 Absence Approval workspace 

 Absence Administration workspace 

 Absence Types single dialog workspace 

 Absence Transfer single dialog workspace 

 Absence Calendar Lines single dialog workspace 

 Employee Absence Calendars single dialog workspace 

Setup Instructions 

Add Negative Absence Balance to an Absence Type 

Use the following procedure to allow a negative balance limit on any absence type for your employees. 

To enable this feature: 

1. Go to Setup » Absence Setup » Absence Types » Absence Type. 

2. Select an absence type from the filter list. 

3. In the Negative Absence Balance Limit, Days field, specify a value. 

 

4. Click Save. 

Project Planning and Resource Allocations 

Resource Planning Enhancements 
Deltek Tracking: 1164030 

This feature adds improved support for mid-month progress evaluations, and provides enhancements for 
a more accurate progress evaluation on the job when using resource allocations from People Planner. 

This feature includes: 

Note: If a negative balance is resolved in another way (for example, the employee received no 
payment for surplus vacation days), then the supervisor may choose to NOT ask Maconomy to take 
the negative absence balance from the previous vacation period into account, or he may manually 
adjust the individual grants before submission. 

Note: Enter a negative value, such as -2.0, as a limit. If you enter a positive value, an error 
message displays when saving the record. 
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 Support for Mid-Month Progress Evaluations 

 Updated Billing Price in Progress Evaluations 

Changes to Maconomy 

The following workspaces are updated: 

 Jobs Workspace 

 System Setup 

 Update Job Budget Resource Allocations single dialog workspace 

 Job Parameters single dialog workspace 

 Job Progress single dialog workspace 

 Job Budgets single dialog workspace 

Support for Mid-Month Progress Evaluations 

For jobs set up to use imported resource allocation, the estimate to completion is based on the imported 
resource allocations after the estimate date. Resource allocations are imported monthly. In this scenario, 
if you perform a progress evaluation mid-month with an estimate date, such as on the 15th of the current 
month, then the estimate to completion does not include any resource allocations on the days in the 
current month after the 15th, but only allocations after the current month. 

This feature enables you to start progress evaluation mid-month followed by import of resource allocation, 
then have estimate to completion based on all resource allocations after the estimate date, including the 
daily allocations in the month of the estimate date. 

New System Parameter for Updating Resource Allocations 

The Use Estimate Date when Updating Resource Allocations system parameter is added to support 
this functionality. When enabled, the Update Resource Allocations from People Planner action 
updates the estimate to completion, if progress evaluation is ongoing, taking all resource allocations after 
the estimate date into account. 

As the imported resource allocations in Maconomy are stored in aggregation by month, this feature is 
implemented by not updating resource allocations before the estimate date and, importantly, by updating 
the resource allocations for the current month (the month of the estimate date) based only on resource 
allocations (in People Planner) from after the estimate date. 

Recalculating Job Budget 

When you recalculate the job budget, it also recalculates and updates prices on the imported resource 
allocations. With this enhancement, the period of the evaluation date is also updated upon recalculation. 

New Progress Evaluation Field 

The Progress Evaluation Date field is added to the Update Job Budget Resource Allocations single 
dialog workspace. This field shows the progress evaluation date for the current progress evaluation on 
the job specified in the Job No. field. This makes it easy to fetch this date in the extension. Moreover, if 
there is no ongoing progress evaluation on the job and the Use Estimate Date when Updating 
Resource Allocations system parameter is enabled, a warning message displays. 

Setup Instructions 

To enable this feature: 

1. Go to Setup » System Setup » Parameters and Numbers » System Parameters. 
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2. Double-click the Use Estimate Date when Updating Resource Allocations system parameter. 

3. On the System Parameter sub-tab, select the Use Estimate Date when Updating Resource 
Allocations check box. 

System Parameters 

Parameter Description 

Use Estimate Date when Updating Resource 
Allocations 

Select this parameter to allow the Update 
Resource Allocations from People Planner 
action to use the estimate date, if one has 
been specified. If you have started a progress 
evaluation, this action does not update the 
resource allocations in Maconomy for any 
months before the estimate date. Moreover, it 
updates the resource allocation in Maconomy 
for the month that contains the estimate date, 
based on the resource allocations within that 
month after the estimate date. 

Updated Billing Price in Progress Evaluations 

The current functionality in Maconomy allows you to update the planning budget by performing a progress 
evaluation. This updates the budgeted quantity and cost based on actuals and estimate to completion 
(ETC). Running a progress evaluation aims to update the planning budget to provide an accurate 
estimate for the total cost of the job.  

This enhancement provides the ability to update the billing price in the planning budget when you do a 
progress evaluation. The system will provide an accurate estimate for the expected billing price based on 
actuals and ETC. 

Calculation of Budgeted Billing Price 

This functionality adds the possibility to set up a job so that the budgeted billing price in the planning 
budget is updated in progress evaluation as follows: 

Budgeted billing price = Actual Billing Price(1) + ETC(2) * Progress Unit Billing Price(3) 

Wherein: 

(1) This is the registered billing price plus write up/down as of the progress evaluation date. 

(2) This is the estimated time to completion. 

(3) This is the same as the unit billing price before you run progress evaluation. It typically comes from the 
price list and is updated when you recalculate the job budget. 

For budget lines on amount activities, the formula is: 

Budgeted billing price = Actual Billing Price + ECC(4) * Progress Markup Percentage(5)/100, 

Wherein: 

(4) This is the estimated cost to completion (converted from base currency to job currency). 

(5) This is the same as the markup percentage before you run progress evaluation. It typically comes 
from the price lookup either directly or from the looked up cost and billing price, and is updated when you 
recalculate the job budget. 
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Budget lines have a unit billing price with two decimal precision. This can give rise to rounding of the total 
billing price on the budget line compared with the above formula. 

On jobs with capitalization of billing price, the registered billing price plus write up/down is the amount 
recognized as revenue (disregarding revenue adjustment entries on time-and-material jobs). In the 
following example, we will therefore use the familiar term “revenue recognized” instead of “actual billing 
price”. Note that the above Actual Billing Price excludes revenue adjustments, such as adjustments to 
revenue recognized coming from evaluation of work in progress or revenue recognition by completion 
percentage or overrun adjustment. 

Example 1 

You have budgeted 100 hours at €100.00 and registered 50 hours at the same hourly rate. Before 
performing the first progress evaluation, the billing price was increased to €110. With the current 
functionality, the budgeted number of hours and budgeted billing price remains the same when you 
perform a progress evaluation. If the budget prices are recalculated, then the budgeted billing price is 
updated to €11,000.  

With the new functionality, the budgeted billing price is updated to €10,500 (€5,000 in registered billing 
price plus 50 hours ETC at €110). In this example, the Progress Unit Billing Price is updated from €100 to 
€110 when the budget is recalculated. If you then change the ETC from 50 to 60, the above formula for 
the budgeted billing price would be €11,600 (€5000 plus 60 * €110). However, because the system uses 
rounding of the unit price to two decimal precision, the unit billing price is updated to €105.45 and the total 
billing price is therefore €11,599.50. 

Example 2 

You have budgeted 100 hours, registered 60 hours, written off 30 hours, and invoiced 30 hours at the 
original rate. If the billing price on both budget line and actuals is €100.00, the initial budgeted billing price 
is €10,000 and revenue recognized is €3,000. The action which initiates the progress evaluation currently 
updates ETC to 40 hours and budgeted billing price to €10,000. If you then manually update ETC to 80 
hours, Maconomy updates the budgeted billing price to €14,000.  

With the new functionality, the new progress evaluation also gives ETC to 40 hours, but a budgeted billing 
price to €7,000 (€3,000 in revenue recognized plus €4,000 from the estimated hours to completion at 
€100). If you then manually update ETC to 80 hours, Maconomy updates the budgeted billing price to 
€11,000. 

New Job Parameter Attribute 

The Billing Price Based on Actuals and ETC attribute under the Progress Evaluation job parameter is 
added to support this feature. For more details regarding setup, see Setup Instructions. 

Setup Instructions 

Create a Job Parameter With the New Attribute 

To enable this feature, you must first create a job parameter where the Billing Price Based on Actuals 
and ETC attribute is enabled. 

To create a job parameter with this attribute: 

1. Go to Setup » Job Cost Setup » Job Parameters. 

2. In the Type column on the filter list, select the Progress Evaluation parameter. 

Note: You can set up an amount activity with the Progress by Quantity check box selected. In this 
case, the same formula as for time activities will apply. 
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3. In the Attributes sub-tab, select the Billing Price Based on Actuals and ETC line. 

4. In the Value field, change the value to Yes.  

5. Click Save. 

Enabling the Updated Billing Price in Progress Evaluations Feature 

Once you have created the job parameter, you can apply this to your job using the following procedure: 

To enable this feature: 

1. Go to Jobs » Jobs » Setup » Parameter Selections. 

2. Select the Progress Evaluation parameter type. 

3. Double click the New Parameter Name field. 

4. In the wizard that opens, select the Billing Price Based on Actuals and ETC attribute. 

5. Click OK. 

6. Click Change Job Parameters. 

Resource Planning Performance Optimizations 
Deltek Tracking: 1166508 

This feature includes: 

 Update Resource Allocations Scheduled Background Task 

 Budget Performance Improvements 

Changes to Maconomy  

The following workspaces are updated: 

 Background Tasks workspace 

 Jobs workspace 

Update Resource Allocations Scheduled Background Task 

This enhancement adds the Update Resource Allocations from People Planner background task, which 
runs the Get Resource Allocations & Update Job Budget from People Planner action in the Jobs 
workspace. It is recommended to set up this task to run outside office hours on a daily basis for all 
relevant jobs. This ensures that all jobs are up to date the next day.  

This task is added to the demo data import files in PSO systems only. 

Budget Performance Improvements 

The following improvements have been made to the Jobs workspace: 

 Addition of the Last Budget Recalculation field to display the time and date at which the budget 
was last recalculated. 

 Improved response time when working with budgets while the Detailed Time Budget job 
parameter is disabled 

 Optimized performance when working with budgets using Work Breakdown Structure (WBS) 
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iAccess 

Saving iAccess User Settings on the Server 
Deltek Tracking: 1076502 

iAccess now stores user-specific data on the server. This means users can save their preferred settings, 
and use these when they log in to iAccess on another device. This functionality will be utilized for storing 
customization settings such as those for columns (also new with this release). 

Previous to this release, user settings were stored on the client.  

 

Setup Instructions 

This functionality is available by default. 

Customizing Columns in iAccess 
Deltek Tracking: 1019336, 1070705 

Users can now customize columns in all iAccess tables and list views. Specifically, you can: 

 Resize columns to display contents better, or optimize screen space. 

 Rearrange columns directly on the table, or using the new Customize Columns wizard. 

 Add or remove columns using the wizard. 

 Revert to default settings for a table or list view. 

Your user preferences are saved on the server, and are available to you even if you switch browsers 
and/or devices. 

 

Changes to iAccess 

To support this functionality, all tables and list views now include a gear icon that users need to click to 
open the new Customize Columns wizard. 

Procedures 

The following sections provide detailed steps for customizing tables in iAccess. All your column 
customizations are saved on the server. 

Note: Language settings are not saved on the server. 

Note: Advanced search (CTRL+G) dialogs and list views include a Customize Columns wizard, but 
you can only use it to remove visible columns. You cannot add new columns because all available 
columns (as specified in the layout) are already visible by default. New columns can only be added by 
modifying the layout. This is a limitation that will be removed in a future release. 

For information about customizing the layout for advanced searches, refer to the “Customizable 
Search Layouts” feature section in this document. 
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Resize and Rearrange Columns 

You can resize table columns to display information better. You can also customize the arrangement of 
columns, either in the table itself or by using the Customize Columns wizard.  

To resize and rearrange columns: 

6. Go to the table or list view you want to customize. 

7. To resize columns: 

a. Hover your pointer on the margin of a column name until you see the icon for adjusting 
width. 

b. Click and drag the margin to your preferred width, then release the mouse button.  

8. To rearrange columns directly in the table: 

a. Click and drag the column name to your preferred location, then release the mouse 
button. 

9. To rearrange columns using the Customize Columns wizard: 

a. On the row of column names, click the gear icon to open the Customize Columns wizard. 

b. In the Visible Columns list, click and drag the column name to your preferred location on 
the list.  

c. Click Apply to save your changes and close the wizard. 

Add or Remove Columns 

Use the Customize Columns wizard to add or remove columns from any table. 

To add or remove table columns: 

1. Go to the table or list view you want to customize. 

2. On the row of column names, click the gear icon to open the Customize Columns wizard. 

3. To add columns: 

a. From the Available Columns list, hover your pointer over the end of a column name until 
you see the Add Column arrow icon.  

b. Click the Add Column arrow icon to move that column name to the Visible Columns list. 

c. If needed, rearrange the columns on the Visible Columns list as detailed in the previous 
procedure. 

4. To remove columns: 

a. From the Visible Columns list, hover your pointer over the end of a column name until 
you see the X or Remove Column icon.  

b. Click the Remove Column icon to move that column name to the Available Columns list. 

5. Click Apply to save your changes and close the wizard.  

Restore Default Column Settings 

You can use the Customize Columns wizard to undo all your customizations for a specific table. 

To restore default column settings: 

1. Go to the table or list view you want to customize. 
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2. On the row of column names, click the gear icon to open the Customize Columns wizard. 

3. Click the Restore Defaults action. 

4. Click Apply to save your changes and close the wizard.  

Setup Instructions 

By default, the functionality is available for all users and in all tables and list views. However, companies 
can choose to disable it globally, or only for individual tables. They can also decide to apply 
customizations or restrictions based on user roles, and so on.  

Simplified BPM Reports 
Deltek Tracking: 1180742 

BPM reports embedded in iAccess workspaces now display without toolbars. Please notice that this 
means that some BPM report features such as Export are no longer available in iAccess. It is possible 
change the appearance of a report to include the toolbars via a layout customization. 

Default Workspaces for Users 

Deltek Tracking: 1183902 

Companies now have greater flexibility when specifying the default workspace that iAccess displays for 
users upon login. Specifically: 

 For a multi-company setup, you can specify a default workspace for users from a specific 
company. 

 You can specify a default workspace for a given user role. 

Customizable Search Layouts 
Deltek Tracking: 1066387, 1235054 

In older iAccess versions, columns displayed during searches were limited to those pre-defined by 
default, and customizations were only possible through a Java extension. With this release, consultants 
can now use standard extension facilities to design and implement special layouts for both search-as-
you-type and advanced searches (CTRL+G). Some of the customizations you can apply are:  

 Information that users see about records listed in search drop-down lists 

 Columns that users see in advanced search dialogs 

 Restrictions, so searches list fewer but more relevant results 

 The order in which iAccess lists records in a search result 

 Disabling the search drop-down list for specific fields 

Changes to iAccess 

To support this functionality, the following changes are applied: 

 All search layouts are enhanced by increasing the number of fields available. 

 A free text field for cross-column searches is added to all advanced search layouts. 

 If you hover your mouse pointer over any value in a search drop-down list, iAccess displays a tool 
tip so you know what type of information that is. For example, you will know that a series of 
numbers shown is actually a job number. 
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 In the Expenses workspace, expense justification is enhanced by disabling the search drop-down 
on text fields. 

Convenience Syntax for iAccess Configurations 
Deltek Tracking: 1290076 

Consultants can now use various shorthand expressions when writing extensions. This enhancement 
makes the specification of iAccess layouts easier. 

Enhancements to the Conversations Functionality 
Deltek Tracking: 1290385 

iAccess users now have the option to: 

 Mark specific messages in a conversation as unread. They can do this in the Messages pane of 
the relevant record. 

 Mark all unread messages for a single conversation as read using the new action added to the 
Message Center. Previous to this release, users could only mark all unread messages for all 
conversations as read.  

 Unsubscribe from notifications for a conversation using the new action added to the Message 
Center. 

The Dashboard Workspace 
Deltek Tracking: 1042277, 987002 

The new Dashboard workspace highlights important job-related data for project managers, department or 
program managers, and other stakeholders. It shows relevant graphs and key performance indicators 
(KPI) for the selected job. Some of these KPIs rely on the new Analyzer REST foundation, while others 
pull information from Maconomy dialogs. 

The workspace utilizes a specific layout and displays different data depending on the job type of the 
selected job. The three job types are: 

 Fixed price 

 Time and material 

 Non-invoiceable 

Companies can also customize their dashboards to fit their specific needs. Some of the details they can 
specify are: 

 The charts and KPI boxes that display on each dashboard 

 The height of charts and KPI boxes 

 How values are displayed in KPI boxes 

 The colors used for the boxes and the text inside 

This workspace is listed under the Jobs submenu in iAccess. It can be viewed by project managers and 
other users assigned the requisite roles or access rights. 

Changes to iAccess 

The following changes are made to support this functionality: 
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 A new Dashboard workspace 

 The Overview tab is removed from the Jobs workspace. 

Improved Rendering of Boolean Fields 
Deltek Tracking: 1300271 

This enhancement changes the rendering of all Boolean fields in iAccess. By default, the drop-down lists 
for selecting a value for this field type are now converted to radio buttons. 

iAccess Notifications for Rejected Purchase Order and Employee 
Deltek Tracking: 1111263 

This feature introduces standard notifications in iAccess for rejected purchase order and employee. 

The following notifications are included: 

 Rejected Purchase Order – Appears for the user to indicate that a submitted PO has been 
rejected. This notification points to the relevant PO. 

 Rejected Employee – Appears for the user to indicate that the submitted employee has been 
rejected. This notification points to the employee information of the rejected employee. 

Reference Workspaces 
Deltek Tracking: 1065619 

Reference workspaces are now available in iAccess to provide access to all available features within the 
system. You can use these workspaces to test different functionalities or develop extensions to use within 
iAccess. The layout of these workspaces is based on the single dialogs workspaces in the Workspace 
Client. 

These workspaces are available by default for users with the requisite access rights. 

 

Enhanced Document Viewer Functionality for Expense and Mileage 
Sheet Approvals 
Deltek Tracking: 1136978 

The Document Viewer is now available in the Approval Center for expense, and mileage sheet lines. You 

can open, view, and download related documents directly from the Expense Sheet Lines tab or Mileage 

Sheet Lines tab. You can also view documents attached to the expense sheets and mileage sheets from 

the Document Viewer on the Receipts, and Documents tabs, respectively. 

 

Note: For more information, refer to the Workspace Client single dialogs documentation. 

Note: The Document Viewer displays when a document is attached to the expense, or mileage sheet 
line. 
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Changes to iAccess 

The Document Viewer in the Approval Center workspace is updated. 

Touch 

Improved Touch Icon 
Deltek Tracking: 1254965, 1281699 

This feature introduces changes to the Touch icon for Apple and Android.  

 For iOS: The Touch icon color is updated in the Apple App store, and on the device home in 
compliance with new Apple regulations. 

 

  

 For Android: A new Touch icon is available in Google Play, and on the device home and splash 
screens. 

 

Support for Okta Authentication 
Deltek Tracking: 1269153 

This feature introduces Okta authentication for Touch. This functionality is disabled by default. 

Setup Instructions 

 

Register an Okta Application for the Touch Native Application 

When you add the Touch URL to the Redirect URI’s field in the Okta application, you enable the 
integration of Deltek Touch with the Maconomy Okta application. 

To add the Touch URL to the Redirect URI: 

1. Open the Okta management portal. 

2. Tap the Apps tab. 

3. On the Apps tab, select the Maconomy application. 

Note: This functionality is available in REST Touch on Maconomy 2.4.7 and 2.5, and succeeding 
versions. You can log in with Okta on your iOS and Android native applications, and Chrome and 
Safari web applications. 

When you are using Maconomy 2.4.7, 2.5.1 or later versions, enable Okta in the Maconomy Core 
product. However, when you using the Maconomy 2.5 version, install the 2.5 C.U. 9 patch prior to 
enabling Okta in the Maconomy Core product. 
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4. Tap Configuration. 

5. In the Redirect URI’s field, add the Touch URL (using the format 
<yourTouchURL>/maconomyshared/backend/oauth2authcodereturn.php). For example, 
https://mactouchcph2.deltek.com/DeltekMaconomyTouchTime/maconomyshared/backend/oauth
2authcodereturn.php. 

Turn On Okta in the Web Service 

When you change specific external credential values in the custom DeltekTouch.I file, you enable Okta in 
the Web Service. 

To turn on Okta in the Web Service: 

1. Set UseExternalCredentials to true to use non-Maconomy credentials in Touch. 
UseExternalCredentials is set to false by default. 

2. Set ExternalCredentialsType: #K”Okta”. ExternalCredentialsType is empty by default. 

Enhanced Approval Workflow 
Deltek Tracking: 1221991 

The Approval functionality is now supported in REST, wherein the process is similar to MScript approvals 

with a few key differences. To make it more user-friendly, the approval items are grouped differently, and 

swiping lines to access approval actions is possible. 

This enhancement grants easy and quick approval access to timesheets, expense sheets, purchase 

orders, vendor invoices, invoice allocations, draft invoices, job quotes, and absence and allowance 

requests through the Items for Approval screen. The items are separated by section, and a section 

appears on the screen when there are pending items for approval. 

Procedures 

Approve or Reject Approval Items 

You can approve, or reject approval requests from the Items for Approval screen. The Undo action is 
not applicable. 

1. Tap , and tap Approvals. 

2. On Items for Approval, tap an approval category. 

3. On the selected approval category, tap a submitted line to review, or swipe to approve or reject. 

4. On the selected approval screen, take any of the following actions: 

 Tap  , and tap Approve, or Reject. 

Tapping Reject requires you to state a reason for the rejection. 

 Tap  or  on the header to switch between requests. 

 

Note: Approval procedures for project managers, and supervisors are updated in the Approvals 
section of the Touch for Maconomy 3.5 User Guide for Android and iOS. 

https://mactouchcph2.deltek.com/DeltekMaconomyTouchTime/maconomyshared/backend/oauth2authcodereturn.php
https://mactouchcph2.deltek.com/DeltekMaconomyTouchTime/maconomyshared/backend/oauth2authcodereturn.php
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Approve Items by Batch 

You can enable batch approval on the Settings screen, and utilize the functionality for My Approvals and 
Substitute Approvals.  

1. Tap , and tap Approvals. 

2. On the Items for Approval screen, tap Select Multiple. 

3. Tap the check mark beside any item from any section to mark items to approve or reject. 

4. Tap Approve Selected to approve the items, or Cancel to revert the selection made. 

 

Advanced User Setting Control 
Deltek Tracking: 896547 

This feature enhances control for user settings on the Settings screen. You now have the option to 
globally select which settings you would like to make available for the users, modify the default value for 
the setting that is shown, and define whether the end user can edit the setting. This control is achieved 
through new server settings. 

 

In addition, the Settings screen has been updated with a new section called Timesheet that now 
contains the Submit Mode and Registration Unit fields as well as the Use Week Numbers and Keep 
on timesheet as default toggle switches, which were included in the General section in the previous 
version. 

 

Application Performance Monitor in REST 
Deltek Tracking: 1047134  

Touch now supports the Application Performance Monitor (APM) in REST, which creates performance log 
entries. This feature allows you to monitor, and investigate network, and user interface performance.  

In Maconomy 2.5, the APM functionality is enabled by default. APM creates the MaconomyMonitor.log 
file, which contains log in attempts and other performance activities. With Touch 3.5, the network time 
and the time spent for task completion are logged for Maconomy REST requests. PIN, biometrics, 
Maconomy login, and domain login are the only authentications supported by this functionality.  

This functionality is disabled by default.  

Note: You cannot reject items, and undo approval or rejection by batch. Tapping Reject requires 
you to state a reason for the rejection. 

Attention: When you upgrade your Maconomy version, review the values of your new server settings. 

For more information, see the Server Side Configuration Settings section of the Deltek Touch for 
Maconomy Installation. 

Attention: For more information, see the Settings section of the Deltek Touch for Maconomy User 
Guide. 
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SSL Certificate Check Capability 
Deltek Tracking: 1212688 

Touch now allows you to validate SSL certificate fingerprints against predefined strings for a more secure 
performance. You can enable this feature with Touch 3.5 and later versions when you add the SSL 
certificate fingerprint for your Touch URL into the configuration.ini file on the Touch server. This 
functionality is disabled by default. 

When you log in from the Touch URL screen, the SSL certificate check is prompted, and is verified once 
upon authentication in each session. Prior to certificate expiration, you can include the expired, and new 
SSL certificate fingerprints in the configuration.ini file on the Touch server in order for you to continually 
use the feature. 

 

SIEM / Security Enhancements 
Deltek Tracking: 1212811 

In Maconomy 2.5.1, a new Client field is added to APM to ensure the framework is SIEM-compliant. 
Touch sets this field on all its Maconomy requests. 

See the Deltek Maconomy Application Performance Monitoring documentation for details.  

New URLs for Touch Mobile 
Deltek Tracking: 1219194 

Tapping the link in the email message, which your administrator sends you, now directs you to a page 
that displays one link or two separate links, depending on your mobile operating system. 

 For iOS: When you tap the first link, it directs you to the mobile application in the Apple App 
Store, allowing you to download it into your device. When you tap the second link, the Touch 
Server URL field in the downloaded application is automatically populated. 

 For Android: When you tap the link, it either automatically populates the Touch Server URL field 
(if the application is already installed) or directs you to download the application from Google Play 
(if the application is not yet installed). 

Integrations 

Employee Creation Using an Employee Template for Talent 
Management Users 
Deltek Tracking: 1228725 

Attention: For more information on how to turn on this logging, see the Appendix C: Logging 
Capability section of the Deltek Touch for Maconomy Installation Guide. 

Attention: For more information, see the Set Up HTTPS section of the Deltek Touch for Maconomy 
Installation Guide. 
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In Maconomy, you can now assign a template to automatically fill in employee information when creating 

employees from Talent Management. When you enable the Derive Template Employee on Creation 

system parameter, you can set up an employee template based on the company, or system information. 

To support this functionality, the Template Employee field is added in the System Setup workspace. The 

former allows you to derive employee data from the employee template on the company, whereas the 

latter allows you to use the system information. 

Changes to Maconomy 

The following workspaces are updated: 

 System Setup 

 Employees 

 Company Information single dialog 

 System Information single dialog 

Setup Instructions 

 

Enable Employee Template at Employee Creation 

To enable this feature: 

1. Go to Setup » System Setup » Parameters and Numbers » System Parameters. 

2. Double-click the Derive Template Employee on Creation parameter. 

3. On the System Parameter sub-tab, select the Derive Template Employee on Creation check 
box. 

Set up an Employee Template Using Company Information 

To set up an employee template using the company information: 

1. Go to Company Information » Company Information. 

2. On the Template island, select template from the Employee field. 

3. Click OK. 

Set up an Employee Template Using System Information 

To set up an employee template using the system information: 

1. Go to Setup » System Setup » System Information » Employees. 

2. Double-click the Template Employee field. 

3. Click OK. 

Note: You can set up Maconomy to use an employee template either from the company, or 
system information. By default, Maconomy uses the company information based on the 
company set for the employee. If the company information is not available, the system 
information is used. 
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System Parameters 

Parameter Description 

Derive Template Employee on Creation Select this parameter to automatically obtain 
an employee template using the available 
company, or system information. 

Deselect this parameter to disable using 
employee templates at employee creation for 
integrated Talent Management users. 

Customer Currency Added to Deltek CRM Integration 
Deltek Tracking: 1061523 

With this enhancement, the currency for the Deltek CRM client is now integrated to the Maconomy 
customer. You can select the customer currency through the Custom Currency Code field for the Deltek 
CRM client, which simultaneously changes the Currency field for the Maconomy customer. 

This feature is available in Vantagepoint 3.0 and later versions. 

Deltek CRM Integration Migrates to Vantagepoint REST API 
Deltek Tracking: 1088165 

With this release, Maconomy now only supports Vantagepoint 3.0, and no longer supports Vision 7.6 and 
DPS 1.1. The Vantagepoint SOAP APIs are deprecated in version 3.0, and consequently, the Deltek 
CRM Integration migrated to REST API.  

Expected Revenue Added as Opportunity Value to Jobs 
Deltek Tracking: 1080885 

Previously, you can only transfer the budget information for a specific job from Maconomy to Deltek CRM 

opportunities. With this feature, you can now calculate the total expected revenue for the main job and the 

corresponding subjobs, and transfer the information to Deltek CRM. The expected revenue is calculated 

based on the type of job, and is available in the new field Expected Revenue Incl. Subjobs. The new 

field is transferred to Deltek CRM if the new job parameter attribute Use Expected Revenue as 

Opportunity Budget Value is enabled. 

For new fields and descriptions, see Appendix A. 

Changes to Maconomy 

The following workspaces are updated: 

 Jobs 

 Job Cost Setup 
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Setup Instructions 

Set the Expected Revenue as Budget Value for Jobs 

You can opt to use the expected revenue instead of the job budget type to calculate the opportunity value 
in Deltek CRM. You can calculate the total expected revenue for main job and subjobs and send the 
information to the corresponding opportunity in Vantagepoint CRM. The expected revenue is calculated in 
the currency of the main job based on the current exchange rate. When you select this Boolean attribute, 
the budget type revenue is overwritten, and the expected revenue is used as the budget value to be 
transferred to Deltek CRM.   

 To set up the expected revenue as the budget value: 

1. Go to Setup » Job Cost Setup » Parameters » Job Parameters. 

2. Search for Job Parameter Type CRM Integration job parameter type, and enable the parameter 
Use Expected Revenue as Opportunity Budget Value parameter. 

Technology / System Admin 

APM Splunk Dashboard Enhancements 
Deltek Tracking: 1186991 

Numerous improvements are made to APM Splunk Dashboards to improve usability, including the 
addition of a new System Activity Dashboard, a new System Status Dashboard, and an update of existing 
Splunk design. 

Additionally, the APM documentation is refactored with a new structure for ease of use, and updated 
content, including configuration, Splunk setup, and troubleshooting.  

See the Deltek Maconomy Application Performance Monitoring guide for details.  

Import Packages 
Deltek Tracking: 1239260, 1182371 

 Added the ability to set the default Import/Validate Import Package User  

 It is now possible to attach several import files to the Data Import Package at once, using the 
new action Bulk Attach Import Files. It is also possible to create a new Data Import 
Package using an Import Program. 

 

It is now possible to attach several import files to the Data Import Package at once, using the new 

action 'Bulk Attach Import Files'. It is also possible to create a new Data Import Package using an 

Import Program. 

Bulk Attach Import Files 

The field Attach Import File Name is added to the Data Import Package Lines. Use this field to 

specify the file name of an import file you want attached to the line later, using the Bulk Attach 

Import Files action. When you select Bulk Attach Import Files, you are prompted to select a 

number of import files. You can select as many as you want at once, and you can select both tab 

separated files and zip files. The zip file is unzipped and any import files in the archive are considered 



Maconomy 2.5.1 — Detail 

Enhancements Guide 128 

 

for attachment. All files selected must be unique. If a selected file matches the filename in the Attach 

Import File Name field of a line, that file is attached to that line. 

Import Data Import Package using Import Program 

The new import functionality is available in the Data Import Package workspace from the Load 

Package from File and Load Lines from File actions. From these two actions you can select Load 

from Import File in addition to loading an existing .mip package. You are prompted to select an 

Import File, which must adhere to the following rules: 

 Only DataImportPackageLine lines can be specified  in the Import File 

 Only Create and Create/update (the latter is a represented by leaving the action field blank) 

lines are allowed.  

 The lines may not contain the fields PackageInstanceKey or PackageName  

You can select Bulk Attach Import Files to Package Lines after Import if you want to run the Bulk 

Attach action immediately after the import is done. In that case, you are prompted again, this time to 

select the import files to attach to the newly imported lines. 

MPL / Printing 
Deltek Tracking: 1236722, 1139135 

QR Code Centre Image Support 

We have added QR Code Centre Image Support in MPL to fulfill statutory e-invoicing requirement.  

Prior to this release, MPL has supported generating QR codes using the <bardcode> tag, for example, 
the following code: 
 
<barcode {"Hello world"} QRCODE>  

 

would generate a QR code encoding the “Hello world” text. 

It is now possible to overlay images at the center of such QR codes without compromising the QR code’s 
readability. A QR code scanner/app is now able to scan such a QR code successfully even though part of 
the QR code area is overlaid by an image.   

For example, the following code: 

<barcode {"Hello world"} 

    QRCODE  

    height=46mm 

    qrOverlayImage={"qrcode\image.png"} 

 

will overlay the qrcode\image.png from the Maconomy’s document archive at the center of the QR code. 

 

Technically, overlaying images over QR codes is possible because QR codes implement error 
correction, which means that a QR code can still be read by a scanner even though part of it is damaged 
or covered by an image. The QR code specification lists the following error correction levels and their 
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corresponding theoretical recovery rates (the percent of the coding words that can be missing without 
affecting the QR code's readability). 

 L: 7% 

 M: 15% 

 Q: 25& 

 L: 30% 

In practice, for the QR codes to scan correctly, the overlay should often take up less than that theoretical 
limit. It is up to the MPL layout developer to choose the right error correction level and overlay image size 
depending on the use case. The chosen values should be tested extensively in practice.  

These two properties can be set using the following <barcode> attributes: 

 qrErrorCorrection - the requested error correction level. Valid values are: L (lowest), M, Q, H 
(highest).  
The default values are 

o L without an overlay image 

o M when an overlay image 

 qrOverlayAreaRatio - the ratio of the overall qr code picture's area (including the QR code’s silent 
zone) that the overlay picture should take up. Valid values are from 0.0 to 1.0.   
The default value for error correction level M is 0.05. 

Apart from these two attributes, you can also set the requested overlay image quality with 
the qrOverlayQuality attribute. Since the overlay image is drawn over the QR code image, the QR code 
image must be scaled up to have enough pixels to draw the overlay image over without losing quality.    

qrOverlayQuality - the requested quality level. The valid values are: L (lowest), M, Q, H (highest). Level H 
indicates that the overlay image should be drawn with original quality and the QR code image should be 
scaled up accordingly (up to 2000 x 2000 pixels max). The higher the quality level, the more RAM 
memory the QR code image will consume when generating a PDF and the bigger the resulting PDF size 
will be. It is recommended that you use the lowest possible value that renders a satisfying quality.  

The default value is Q. 
 

The following examples shows how to set all the above described attributes:  

 <barcode {"Hello world"} 

    QRCODE  

    height=46mm 

    width=46mm   

    qrOverlayImage={"qrcode\swiss_flag.png"} 

    qrErrorCorrection=M 

    qrOverlayAreaRatio=0.025 

    qrOverlayQuality=L> 

 

Moving MPL into Coupling Service 

Phase 1 moving MPL into Coupling Service supports large printings which had previously a run out of 
memory. 

The MPL print engine in Maconomy is ported to run inside the Coupling Service, instead of as an 
embedded Java process inside each MaconomyServer intance. 
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This reduces the average memory footprint of the MaconomyServer processes, while also making it 
possible to produce larger prints without running into memory limitations. 

The embedded MPL engine is still available in the 2.5 release stream in order to support various 
command line operations, such as the '-U*P' arguments as well as MScript and import invocations, which 
require print functionality. In future releases, the embedded print engine will be removed entirely, and 
these operations will either be ported to the CouplingService, or they will be desupported. The '-U*P' 
arguments as well as the '-x' argument for stand-alone script execution are supported by the 
CouplingService as of 2.5.1. 

RESTful API Version 2 
Deltek Tracking: 1182794 

 Bringing RESTful API Version 2 to GA level and delivering new features to support iAccess 
development and customer integrations. 

 RESTful API is optimized for performance and scalability.  

Security Enhancements 
Deltek Tracking: 1247915, 722386 

 Deltek Security SIEM — A new Client field is added to ensure the APM framework is SIEM-
compliant.  

o Client — Shows a string identifying the client that issued the request. 

o SIEM enhancements are implemented in Workspace Client, iAccess, and Touch.  

 iAccess File Upload Security — File security for iAccess and WSC is now improved when 
uploading and downloading.  

o See “Security Service File Check” in the Deltek Maconomy System Admin Guide 
for details. 

APM Splunk Dashboard Enhancements 
Deltek Tracking: 1186991 

Numerous improvements are made to APM Splunk Dashboards to improve usability, including the 
addition of a new System Activity Dashboard, a new System Status Dashboard, and an update of existing 
Splunk design. 

Upgrade Optimization 
Deltek Tracking: 1221362  

To improve Enterprise upgrade efficiency, we now validate objects rather than dropping and recreating 
views. 

Certifications 
Deltek Tracking: 1132203 

 BO 4.2 SP8 – for Maconomy and BPM. 

 Android 10 – for iAccess.  

 SQL Server 2017 – for BPM 
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 Chrome 80 – for iAccess and BPM 

Note: Cookies restricted to first party. 

 Java 8 Security Update  

Extender Enhancements 
Deltek Tracking: 1179077 

 Enhanced custom.shortname Deployment Support for DFME –  This enhancement 
supports DFME in simplifying the deployment customizations to the custom.shortname layer 
to the an environment containing different shortnames. With this release, the Extender 
introduces a server/environment-specific custom shortname configuration setting. 

Synchronous Calculation of Approval Notifications 
Deltek Tracking: 1071036  

Customers can now configure the enablement of synchronous calculation for all approval notifications 
(except for Timesheet Not Created, Reject, or To Be Submitted), for named employees (not employee 
types or All). Utilizing this functionality improves performance due to Maconomy calculating notifications 
immediately and only once, thereby reducing and distributing the load on the server over a broader period 
of time. Notifications in iAccess are updated more immediately for users; notifications in the Workspace 
Client still require a refresh to update, but will update faster. 

Changes to Maconomy  

To support this functionality, the following workspaces are updated: 

 Notifications 

 Approval Hierarchies 

 Notification Types single dialog 

 Approval Hierarchies single dialog 

A new Synchronous Notification Types single dialog is also added.  

Setup Instructions 
See the Deltek Maconomy System Admin Guide for details.  

Background Task Enhancements 
Deltek Tracking: 1214786 

Clear “Override Auto-Deletion of Tasks” 
Previously, within the Override Auto-Deletion of Tasks group, the Ignore Until field retained the 
specified date and time, even after the date had passed.  

With the new Override Auto-Deletion of Tasks field, you can set up system defaults to override auto-
deletion, as well as specify dates on which tasks should be deleted.  

This is useful in testing and to improve monitoring.  
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Previously for this type of testing or monitoring, you would toggle the Delete Automatically field. When 
Delete Automatically is selected on a background task, once a task executes successfully, it is 
automatically deleted. This is useful, because the system can quickly fill with numerous successfully 
finished tasks, which are unnecessary to retain since they have already been executed and, besides 
historic information, there is no reason to retain them further. 

However, sometimes you want to debug or test, and for this reason it is helpful to keep tasks even if they 
have finished successfully. While you could deselect the Delete Automatically field on the task, since 
some tasks are created from within the system, you do not have control over them and cannot deselect 
auto-deletion for those tasks. 

For this reason, we have introduced the Ignore Until field, where you can specify date and time of 
deletion, meaning that once task has finished successfully, it is not deleted automatically until the 
specified date, giving you time to investigate the task. 

To Override Auto-Deletion of Tasks: 

1. Go to Background Tasks > Management > System Defaults.  

2. In the Override Auto-Deletion of Tasks group, Ignore Until field, enter the date and the time on 
which the tasks must be deleted.  

After this date and time, the system resumes auto-deletion of tasks. 

Update of Radio Buttons 
Radio buttons are updated in Status and Editing tabs for ease of use. The radio buttons had the previous 
order and naming: Pending, Running, Succeeded, Incomplete (Unhandled), Failed (Unhandled), 
Rescheduled, and All.  

The radio buttons are updated to: 

 Pending — Shows all pending tasks.  

 Running — Shows all running tasks. 

 Succeeded — Shows all tasks successfully completed. 

 Incomplete — Updated to show all incomplete tasks. 

 Failed — Shows all failed tasks.  

 Unhandled —Shows all unhandled tasks, including incomplete and failed tasks.  

 All [default] — Shows all tasks. Updated as the default selection. 

Additionally, on the Editing > Background Tasks tab, when you selected the Active Pending Tasks 
option, you would see a standing system task. Now this is updated so that standing system task is 
removed from the Active Pending tasks view. Select All to show all pending tasks, including the active 
system task, which is always active and always pending. This setup now provides a better view of true 
Active Pending tasks.  

Chained Background Tasks 
At times it is necessary to specify that a number of background tasks (defined by some properties) should 
be executed such that only one task from the group is executed at any time. 

Functionality for this is already included in tasks, but cannot be specified for rules. For this reason, a new 
Chained Task Execution field and a grouping field are introduced on rules.  

If the grouping field is assigned with field name from the rule context, tasks generated by the rule are 
grouped in a number of chains, where all the tasks in one chain have the same value for the context field.  
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For example, one group-field is CompanyNumber. If CompanyNumber is defined as the group field, all 
tasks with the same context CompanyNumber generated from the current rule are chained and executed 
in a sequence, in such a way that all the tasks (for a given company) are executed alone, (meaning, 
without any other task from the same company being executed at the same time). If the grouping field is 
not assigned (but the chained execution is enabled), all tasks generated by the rule are linked in one 
chain and all these tasks are executed without overlap. 

The Recalculate User Notifications rule is converted to utilize this new feature. If a user has multiple 
user roles, then notifications for those roles are recalculated in a chain / succession. 

Task Cleanup Improved with New Field and Actions 
In the Selection & Clean-up tab, a new field and new and updated actions help facilitate the task cleanup 
process, including a new option to delete test-bed generated tasks.  

Pending Tasks 

Now you can select to delete tasks by state. Previously, when you tried to delete a task, the system would 
not allow you to delete tasks that were Pending and Inactive. This is updated so such tasks can be 
deleted. 

Deleting Lines 

Previously, you had to list specific lines to delete. This could be tedious if you had numerous lines. Now, 
you can delete selected tasks. Additionally, where before you had the potential to delete a line you did not 
mean to delete, now, you can use the Export Selected Tasks action and review material prior to 
deletion.   

New and updated fields and actions include: 

Origin — Select to clean-up tasks by how they started. Selections include: Manual, Schedule Rule, API, 
Core Application, and Test Bed. 

Export Selected Lines — This action creates an Excel export of the background tasks specified in the 
selection criteria of the tab. This is an alternative to the Show Lines action and works for more than 5000 
lines.  

Export Selected Tasks — This action exports to Excel all the tasks with the Selection Criteria that you’ve 
selected. Leave the Selection Criteria fields blank to export everything in the database. Alternatively, filter 
by container or origin or any Selection Criteria field to narrow your list. This action allows you to verify 
lines before you delete them. 

Delete Selected Tasks —Use this action to delete selected tasks. You no longer need to select “Show 
Lines.” This is helpful when you have numerous tasks (sometimes more than 5,000). Previously, you 
wouldn’t be able to delete from this window. With the new updates, you can delete from this window. If 
you do not specify any criteria, then the action acts like a “delete all lines” action and will delete all lines. 

Delete Shown — This action is replaced by the Delete Selected Tasks action.  

Verify and Delete Tasks 

1. Go to Background Tasks > Management > Selection & Clean-Up. 

2. In the Selection Criteria tab, enter information in any fields you choose to use as task filters.  

3. Click Export Selected Tasks.  

4. Review the exported information.  

5. When verified, in the Selection Criteria tab, again enter information for fields you choose to filter.  

6. Click Delete Selected Tasks.  
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Support for Expressions in Input Fields 
This enhancement brings new support for Expressions in email and Document Archive input fields. In 
email handling options areas, previously you could specify a valid email only. Now the e-mail (and other) 
fields used for document handling on rules and tasks are updated to handle as expression fields as well 
as e-mail addresses. This makes it possible to use data from the context fields to complete these fields. 
This functionality is similar to that which is already used for other fields on rules. 

For the fields E-mail From and E-mail To, the system can automatically determine if the field contains a 
valid e-mail address expression. However, for the Document Archive number and subject / body fields in 
the e-mail, you must explicitly specify if it is an expression or not (using the Yes/No expression field). 

Background Shading 

Background shading offers at-a-glance information for a field type. Expressions are indicated via purple 
background color. Without color on the field, it is an email.  

This convention is used in these areas: 

 Input Document Handling (Using Doc. Archives) 

 Output Document Handling (Using E-mail) 

 Output Document Handling (Using Doc. Archive 

 Send Email on Completion (fields with Expr. column/field to the right of them). 

To use expressions in Output Document Handling / Email: 

1. Go to Background Tasks > Management > List of Scheduled Rules.  

2. In the E-mail To field, select an expression from the Context Field Name field. 

3. If this is a Document Archive number field, or subject / body field in the email notifications, then 
you must set the Expr. value to Yes to explicitly say that this is an expression. 

Extended Test Bed 
The Test Bed functionality enables you to test your rule without actually activating it so that you can see 
in action how it works and if it produces a result that you expect. Previously, the Test Bed functionality 
could be cumbersome to use. For instance, you sometimes had to disable batch execution if you wanted 
to inspect generated tasks before they were executed. Also, when you ran a test, the rules would be 
activated and generated, and there was no way to confirm the rule and ensure it behaved as expected 
prior to activation. 

We have now extended the Test Bed functionality for ease of use and versatility, including updating the 
format for at-a-glance status and adding key actions and a new wizard, described below. Additionally, 
now you can test the rules before the rule is activated.  

Updated include: 

 Changed the name of Run Generator Unconditionally action to Test Schedule Rule. Click on this 
action and a new wizard displays enabling you to test the schedule rule.  

 Added a new Origin field on a task to define the rule from which it generated. This field is also 
used when checking if any pending task from a rule exists. In this column, you can select a new 
value called Test Bed, so that you can filter by this type or by Manual, Schedule Rule, API, or 
Core Application 

 Possible now to generate tasks from a disabled rule. 

 New Schedule Rule column in the Generated Background Tasks sub-tab enables you to see 
where the background task started.   
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 The Generated Background Tasks sub-tab will actually show you the tasks that were generated 
when the rule was executed. This is an improvement, since previously, you needed to switch to a 
different window to view the generated rules. 

 You no longer need to activate a rule to test it. 

Added new actions: 

 Delete Inactive Test Tasks — If you have tested and found that everything is okay, and you 
don’t want to activate the tasks, you can instead delete them.  

 Activate Inactive Test Tasks — Generally, activating inactive / generated test tasks is used as a 
second phase of testing. For the first phase, generate the test tasks and investigate them. To 
perform further testing, use this action to activate them again and evaluate if they are being 
executed correctly.  

 Show Next Scheduled Rule Execution — Click to show the next 50 scheduled runs so you can 
check the time pattern as needed. 

To test background tasks in the Test Bed: 

1. Go to Background Tasks > Setup > List of Scheduled Rules > Test Bed.  

2. Click Test Schedule Rule. A wizard displays.  

3. In the Max No. of Test Tasks field, enter the number of tests you would like to generate. This is 
helpful if you have thousands of tasks, but for example you would like to only test 50 or so to 
ensure that the rule is working correctly. Specify 0 (zero) for no limit / to generate all in the 
database. 

4. Select Activate Generated Test Tasks to specify whether tasks must be activated. If you do not 
want the tasks activated, deselect this field.  

5. Section Generate Test Tasks in the Background to continue to have access to the UI and 
related functionality while background tasks run. 

Terminology Changes 
Some terminology is updated in Scheduled Background Tasks for clarity. Specifically, previously we had 
used the word Task where Rule was the more precise term. To support this change, numerous fields and 
actions are updated, as follows: 

 New Background Task Generator — Updated to New Schedule Rule  

 Run Generator Unconditionally — Updated to Test Schedule Rule. 

 Rule [in create wizard] — Updated to Rule Type. 

 Generator [Group title] — Updated to Schedule Rule. 

Additionally, Scheduled Rule types are called Tasks. These are updated as well, as follows: 

 Single Task — Updated to Single Schedule Rule 

 Sub Task — Updated to Sub Schedule Rule 

 Sequential Task — Updated to Sequential Schedule Rule 

 Interleaved Tasks — Updated to Interleaved Schedule Rule 

Finally, Tasks in the Data Input pane are called Parameters/Fields. Rules in the same pane are called 
Parameters. Both are now updated and called Data. 
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Note: The updates in this feature are non-backward compatible, and Interleaved Rules are now 
deprecated. While they can still be used, we highly recommend you switch to Sequential Rules instead. 
The Interleaved Rules functionality will eventually be removed in future versions. 

Create Document Archive 
Deltek Tracking: 1242315 (15) 

Previously, any time you specified a Document Archive on a task and executed it, any documents that 
were produced from the task were saved in that Document Archive. In a situation where such a 
Document Archive did not exist, the task would end up in an Incomplete state. With the new functionality, 
if the specified Document Archive does not exist, it is created automatically by the system. This improves 
ease of use, as users need not be concerned about the existence of a Document Archive before running 
a task. 

On tasks and rules, callback-handlers can be defined to store documents from execution (such as prints) 
in a document archive. This (named) document archive must already exist at this point. 

Today, a task fails if the defined document archive does not exists. This is updated so the callback 
handlers using document archive automatically create the document archive if it does not exist. This is 
similar to the functionality when using folders in the file-system, as these are also created if they do not 
exist. 

Test Scheduled Rule Time Pattern 
In the Test Bed assistant, used for testing scheduled rules, a new Show Next Scheduled Rule action 
shows the next fifty (50) execution times for the current rule. This action is beneficial for debugging, and is 
used to verify that the time pattern entered for the rule results in the wanted executions. For ease of use, 
you can also run / test the rule prior to activating the rule.  

Note: Take into consideration the data in the No. of Runs Left field and the valid interval when 
evaluating execution times. 

The new functionality also enables you to test scheduled rule time patterns before you activate them.  

In the Test Bed area, a new Test Schedule Rule action triggers a wizard which enables you to test 
schedule rules.  

Use this action to verify that the time pattern entered for the rule resolves in the needed executions. 

Note the ‘No. of Runs Left” and the valid interval should also be taken into consideration when execution 
times are resolved. 

More Flexible Context Fields from a Key-Generator 
Previously, a key-generator had (10) extract fields. When entering a field name (such as FieldNameX) in 
an extract-field, the value of the field (FieldNameX) from the key-generator container would be assigned a 
context-field with the same name (context.FieldNameX) when resolving a rule with this key-generator. 
This meant the field name both defined a name (for the context-field) and a value (from the key-generator 
container). 

To create more flexibility, we have updated context fields from a key-generator and we added the ability 
to define your own five fields. The existing 10 extract fields only allowed you to enter fields that actually 
existed in a database. The new five fields give you the ability to define them yourself by specifying the 
name of the field, type, and value of that field. While they do not exist in the database, they are 
dynamically generated during the runtime of the rule. These fields can be an expression or fixed value, 
and can be used on rules.  
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These five new user-defined fields have exactly the same behavior as the 10 existing extract fields in the 
context of a Schedule Rule. For example, you can use them in the Record Condition, document handlers, 
email notifications, and so on.  

Additionally, you can specify that your user-defined field can hold a value that is an expression and this 
expression must be evaluated during the run of rule. This also means that you can reference database 
fields as a value and perform some operation on them to generate a new value.  

For example, you might define a rule “CostMultiplyByTwo” where you use the expression “CostPrice * 2.” 
This takes the existing value of the “CostPrice” field, multiplies it by two, and assigns the result to the 
“CostMultiplyByTwo” field.  

Label Rescheduled Task as Handled 
If a task fails, you can reschedule it. However, previously the rescheduled task would not be labeled as 
“handled.” This update ensures that when a task is rescheduled, it is labeled handled. 

“User Input” Is Default Line Type 
“User Input” is now the default line type for data input for tasks and rules. 

Validation of Field Names for Tasks and Rules  

Previously, field names were not validated when entered on tasks, rules, and the related data panes. This 
led to internal errors during runtime, resulting in failing tasks. 

Validation are now implemented so that tasks and rules are validated as container and action names are 
validated. This optimizes functionality when accessed from import programs or the extension batch API.  

The following container selection fields in background tasks and scheduled rules are validated: 

 For tasks: Container Selection Field 1 – 4 

 For rules: Container Selection - Container Field (1-10) 

 For tasks, rules, and key generators (table pane), field names holding values (but not parameter 
names) are also validated. 

Additionally, all input fields containing expressions (in tasks, rules, data [parameters] ) are analyzed for 
existence of fields and context (context, card, table) fields. Pop-up field values are also validated, as are 
Action and Container Names.  

Both named actions and standard actions are now entered in the same field: Action Name and the field 
Standard Action is removed from the standard layout. 

More Evenly Distributed Retry Scheduling  
Previously, when a task failed due to “Data in Use,” it was rescheduled a number of times. However, 
when a number of tasks (possibly generated at the same time) were trying to use the same database 
resources, they could all fall into a looping pattern where none went through. To improve efficiency and 
more evenly distribute retry scheduling, we have extended the default number of retries to five (5) as well 
as randomized the amount of time between retries.  

The randomized time-pattern is calculated in the following way. There is a parameter defining the 
rescheduling delay (default 30 seconds). A task is rescheduled a number of delays plus a random amount 
of time, giving a result in the interval between the current rescheduling and the (possible) next 
rescheduling. 

For example: 



Maconomy 2.5.1 — Detail 

Enhancements Guide 138 

 

Rescheduling 
Count 

1 2 3 4 5 6, 7, ... 

Delay Period 1 3 5 7 9 9 

Randomized 
Delay % 

100 - 299 300 - 499 500 - 699 700 - 899 900 - 1099 900 -1099 

When a task is rescheduled, all existing log-lines are removed from the task and a single line states that 
the task is rescheduled for the [number] time.  

Hold Tasks Rule If Tasks Are Still Pending 
We have updated rules so that tasks will hold even if tasks from the previous generation are still waiting 
to execute. A new popup field indicates if a rule should run now, or later. 

To create rule to hold tasks:  

1. Go to Background Tasks > Schedule Rules.  

2. In the Name field, select the name of the Schedule Rule to update.  

3. In the When Last Run Not Complete field, choose: 

 Run Anyway — If you choose this option then when the rule is triggered, it will run 
regardless if there are tasks that have not yet finished from the previous run of this rule. 

 Skip — Select this option to skip the current run of the rule if there exist tasks that have not 
yet finished from the previous run of this rule. Additionally, the Next Due Date and Time are 
updated as if this rule ran successfully. For example, if the rule is set up to run every minute 
and the next run is at 3:01 p.m., but there are tasks from previous runs that have not yet 
finished, then the rule is skipped and the Next Due Time is updated to 3:02 p.m. 

 Postpone — Similar to Skip, except the Next Due Time is NOT updated. If we take the 
example above then the rule will be skipped, but the Next Due Time will NOT be updated and 
will stay as 3:01 PM. Select this option to skip if there are existing tasks from the previous 
run, but you want to make sure the next due time is not updated, so that the rule can be run 
as soon as possible. 

 

Notes: 

 The time in the Next Due field is not updated when a rule is rejected due to existing tasks. 

 The Schedule Rule field tells the name of the rule from which each task originates. Select to 
show Tasks with the reference to the rule generating them. This enables you to easily check if  
un-executed tasks still exist. If the task was created manually (and not from the rule) this field is 
empty 

 Do-not-generate is default for new rules created. 

 

Reduce Number of Requests for Pending Tasks 
We have reduced the number of request for pending tasks from N times a minute (where N is the number 
of background task threads) to once a minute. This reduces the load on the system and makes it possible 
to configure a large number of background task threads without wasting resources in idle situations. 
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Previously, all active tasks were asking for pending tasks with a given interval (default: 60 secs). This 
meant that even in periods where there was no activity, all tasks requested new tasks with the same 
interval. 

We have updated this to improve efficiency: 

 Added a queue for holding all pending threads. When the poll interval is up, the queue releases a 
thread (X), which will ask for a pending task.  

o If no pending tasks exists, the thread X returns to the queue and new thread is released 
when a new poll period is up.  

o If, on the other hand, a task (A) is pending, the thread (X) signals to the queue that there 
may be more pending tasks before starting to execute the task (A). This signal leads the 
queue to release another thread (Y), which might pick-up another pending tasks (B) – 
and release yet another thread (Z) from the queue, before execution of the tasks (B) 
begins.  

In this way, threads picking up tasks which lead to new active threads keep the process 
running until no more tasks are pending and thereby the threads queue up again.  

 If no threads are in the queue when a release signal is received, the queue counts needed 
threads and a new thread is released as soon as it enters the queue. This process repeats as 
long as the needed thread counter is larger than zero (0). 

 There is a thread queue-instance for each short-name in a Coupling Service as short-name are 
handled independently in relation to the batch framework threads. 

Standardize Case of Names for Containers, Actions, and Fields 
When entering a name for a container, an action (including standard actions) or a field, the casing of the 
field auto-corrects to proper standard case. This is important in cases where you use the fields as 
restriction, such as deleting tasks by another task or the selection in “Selection & Clean-up”. 

Note: This conversion is not done when defining tasks from JavaAPI or import-programs. 

Added Find-Containers for Container, Action and Field Names 
When entering a name for a container, an action (including standard actions) or a field, the casing of the 
field now auto-corrects to proper standard case. This is important in cases where you use the fields as 
restriction, such as deleting tasks by another task or the selection in “Selection & Clean-up”. 

Find-containers are added for use in all cases where container, action, or field names are entered. For 
fields, the field type is derived and assigned from the search. 

This impacts the following fields: 

 Container 

o Container name (including namespace) 

o Container type (Filter, Card, Card-table) 

o Namespace 
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o Container name without namespace. Not unique 

o Container title 

 Action 

o Action name (including namespace) 

o Action type (ICRUDP, named action) 

o Namespace 

o Container name (including namespace) 

o Pane type 

o Action name without namespace. Not unique 

o Action title 

 Field 

o Field name (including namespace) 

o Field type 

o Namespace 

o Container name (including namespace) 

o Pane type 

o Field type without namespace 

o Field title 

Low Priority Tasks 
There are times where it makes sense to run tasks with a lower priority than usual. A good example of 
this is a notification calculation, where a lot of time is spent on non-critical tasks, which are generated to 
execute at the same time. This load can block all Background Task resources for hours and prohibit other 
more critical tasks from being executed. 

This is resolved by supporting tasks of two priorities (standard and lower).  

In the default configuration, standard priority tasks are picked approximately twice as often by a polling 

thread as low priority tasks when both standard and low priority tasks exists and are due – even though 

the due time of the low priority tasks are clockwise before the standard priority tasks.  

The priority ratio between standard and low priority tasks (default: 70%) can be configured, but cannot be 

raised over 90%. This is done to avoid starvation of low priority tasks. On the other hand, setting a value 

of 0% will make the Maconomy ignore the setting of low/standard on tasks/rules and thereby make the 

system as before this feature was introduced. 

For at-a-glance use, low priority tasks have a light blue foreground color status panes. 

To set tasks as low priority: 

1. Go to Background Tasks > Setup > List of Schedule Rules > Schedule Rule.  

2. In the Background Task area, select the Low Priority check box.  
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To set tasks as low priority: 

3. Go to Background Tasks > Setup > List of Schedule Rules > Schedule Rule.  

4. In the Background Task area, select the Low Priority check box.  

 
 



Maconomy 2.5 — Detail 

Enhancements Guide 142 

 

Maconomy 2.5 — Detail  
This section gives detail of the key features for Maconomy 2.5. 

General Enhancements 

Support for Third-Party Vendor OneLogin SSO 
Deltek Tracking: 1132168 

In addition to support for third-party vendor Microsoft’s Azure Single Sign-On (SSO), Maconomy now 
supports the third-party vendor OneLogin. If you favor this vendor’s solution, you can now utilize it as your 
company’s standard for authentication in Maconomy. It offers a cloud-based identity and access 
management system that works across all Maconomy user interfaces, for both cloud and on-premises 
deployments.  

This feature includes: 

 Maconomy/Workspace Client Support for OneLogin SSO 

 iAccess Support for OneLogin SSO 

 Touch Support for OneLogin SSO 

 

Access Control for Approvers 
Deltek Tracking: 1174941, 1174952 

When a company sets up the approval of records (such as vendor invoices or expense sheets) with 
approval hierarchies, as an approver, you are automatically given access to the record that requires your 
approval. This occurs even if you did not originally have access to the record. 

For example, if you are the approver of an expense sheet from an employee whose employee records 
you do not have access to, you normally cannot view their expense sheets. However, when the employee 
submits an expense sheet for your approval, Maconomy then gives you the proper access required to 
view it.  

This enhancement provides this kind of access for approvers through the use of Approver Access 
Tickets, which can be scheduled for deletion. 

Once the record is approved, the date of approval is stamped on the ticket and a scheduled background 
task will remove the ticket after a specified number of days. Likewise, the system deletes submitted 
access tickets that remain unapproved after a specified number of days.  

 

Maconomy runs the scheduled background task to delete expired tickets daily. However, system 
administrators can modify the scheduled background task to determine when tickets are deleted. You can 
also manually delete expired tickets in the new Approver Access Ticket Expiration single dialog 
workspace. 

Note: See the Deltek Maconomy 2.5 System Admin Guide for details on OneLogin SSO as well as 
generic support for third-party SSO vendors. 

Note: By default, Maconomy deletes approver tickets that have already been approved after 60 days. 
Submitted but unapproved tickets are deleted 120 days after submission for approval. 
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Install / Upgrade Considerations 

This feature limits user access to approval items. To provide optimal performance upon upgrade to 2.5, 
you can use the Grant Access to Historic Data action when creating or modifying an approval hierarchy 
rule to give approvers access to objects they have approved in the past. 

 

Changes to Maconomy 

The following workspace is added: 

 Approver Access Ticket Expiration single dialog workspace 

The following workspaces are updated: 

 Approval Hierarchies 

 Approval Hierarchy Rules single dialog workspace 

Setup 

Enabling Expiration of Approver Access Tickets  

Use these steps to enable the deletion of expired approver access tickets. 

To enable the expiration of tickets: 

1. Go to Setup » Approval Hierarchies » Approval Hierarchy Rules. 

2. Select an approval type.  

3. Edit information in the tab as needed. 

4. Select the Approved Tickets Expire check box if you wish to allow approved tickets to expire. 

5. In the Days from Approval to Expiration field, enter a value to determine how many days after 
the ticket is approved to determine when it should be deleted. 

6. Select the Unapproved Tickets Expire check box if you wish to allow unapproved tickets to 
expire. 

7. In the Days from Submission to Expiration field, enter a value to determine how many days 
after the ticket is submitted to determine when it should be deleted. 

8. Click Save. 

Updated Deltek Branding in Maconomy and Related Products 
Deltek Tracking: 1181341 

 Updates Deltek branding in Workspace Client, Analyzer, Extender, iAccess, and the Portal. 
This includes logos, tag lines, landing and splash screens for all UIs. 

Note: This feature is currently not supported for jobs, job budgets, and draft invoices that use approval 
hierarchies. 

This feature provides performance improvements in Maconomy 2.5 and will be utilized in future 
versions to improve the access control for items for approval. 
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Approval Hierarchies 

Job Quote Approval in Maconomy 
Deltek Tracking: 1071037 

Maconomy now supports hierarchical job quote approval in the Workspace Client, iAccess, and Touch.  

This feature includes: 

 Approval Hierarchies for Job Quotes in the Workspace Client  

 Improvements to the Approval Center Workspace 

 Core Support for Status Indicator in the New iAccess Quotes Workspace 

 Job Quote Approval in iAccess 

 Support for Quotes Approval in Touch 

Approval Hierarchies for Job Quotes in the Workspace Client 

Deltek Tracking: 996519 

Companies can now set up approval hierarchies for job quote headers. This enhancement supports 
standard features such as reapproval setup, automatic approvals, specification of changes allowed 
without requiring reapproval, and so on.  

Changes to Maconomy 

To support this functionality, the following workspaces are updated: 

 Approval Hierarchies  

 Jobs  

New notifications for job quote approval are also added. 

Setup Instructions 

Use the various tabs and panels in the Approval Hierarchies workspace to set up approval hierarchies for 
your company’s job quotes. Specify the following: 

 Approvers and substitute approvers  

Employees can only approve job quotes to which they have been granted access by the 
company’s access control setup.  

 The process that a job quote will follow if it is approved/rejected 

 The employees who will receive notifications after a job quote is approved/rejected 

 If you want to require reapproval of job quote headers with added/edited/removed quotation 
printout lines  

 The field changes for which you will not require reapproval 

 If you want to require a multi-approver setup (that is, requiring a job quote to go through several 
approvers) 

You also have the option to make the setup level-specific, such that approvers on the lower levels 
of the approval hierarchy have to approve the job quote before the higher-level approvers are 
notified about the job quote requiring their review. 
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If preferred, you can also opt to set up automatic approval of job quotes.  

Note that you cannot set up states for job quotes.  

Multi-Company Setup 

For each individual user, you can set up permissions for submitting and/or approving job quotes. You can 
also specify exceptions at the company level. This means that if a user has access to job quotes for two 
companies, you can give that user a different set of permissions per company (for example, permission to 
submit but not approve job quotes for one company). 

Upgrading 

A simple approval hierarchy setup is in place to allow automatic submission and approval of historic job 
quotes. This setup will allow companies who choose to opt out of approval hierarchies for job quotes to 
continue using their existing workflows. 

Improvements to the Approval Center Workspace  

Deltek Tracking: 1088150 

A new Job Quotes tab is added to the Approval Center workspace in the Workspace Client. This 
enhancement is based on approval hierarchies for job quotes (introduced with version 2.5), and also adds 
job quote approval to iAccess.  

Changes to Maconomy 

The following changes are made to support this enhancement: 

 Updated Approval Center workspace 

 New Approve Job Quotes by Employee single dialog 

Core Support for Status Indicator in the New iAccess Quotes Workspace 

Deltek Tracking: 1105888 

Fields are added to single dialogs in the Workspace Client to support the Status Indicator field in the new 
iAccess Quotes workspace.  

The updated single dialogs are: 

 Quote Editing  

 Quote Revisions 

Job Quote Approval in iAccess 

Deltek Tracking: 1076826   

You can now approve or reject job quotes from within iAccess. A new tab is added to the Approval Center 
workspace for this functionality, which is based on approval hierarchies for job quotes (also introduced 
with version 2.5).  

Changes to iAccess 

The following changes are made to support this enhancement: 

 A new Job Quotes tab in the Approval Center workspace 

 New notifications for approvers (including those for specific employee types and substitute 
approvers) and for rejected job quotes 
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Setup Instructions 

If approval hierarchies are set up in the Workspace Client, this functionality is enabled by default in 
iAccess. 
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Support for Quote Approval in Touch 
Deltek Tracking: 1075354 

Touch now supports approval of job quotes. The Quotes Approval (displays list of job quotes awaiting 
approval), Quote (allows you to approve or reject a job quote), and Quote Line (displays job quote line 
details) screens are available. 

When the Approvals toggle switch is set to On on the Settings screen and there are job quotes that you 
need to approve, the Items for Approvals screen includes Quotes in the list with the corresponding 
counter. If substitute approval is enabled, the Substitute Approvals tab on Items for Approval also 
includes Quotes in the list. 

Approval Hierarchy for General Journal 
Deltek Tracking: 1071040 

Approval hierarchies in Maconomy now support general journals, enabling you to configure workflows for 
approval of general journals. Select the General Journal approval type in the Approval Hierarchies 
workspace to enable this feature. 

The approval of general journals is similar to the existing functionality for approving vendor invoices. You 
can manage the workflow surrounding General Journal in the Approvals workspace. 

You can control approval at the line-level of each journal. For each individual user, you can specify 
whether the specific employee should have access to submit and approve general journals. Exceptions to 
this can be specified at the level of companies. For example, if a user has access to general journals in 
two companies, it would be possible to only give the user access to submit general journals in one of the 
two companies. 

The Submission of General Journal Required system parameter has been removed from Maconomy 
2.5. 

New notifications for general journal approval are also added. 

 

Changes to Maconomy  

The following workspaces are updated:  

 Financial Operations 

 Approval Hierarchies 

 Selection Criterion Specification 

Install / Upgrade Considerations   

If submitted general journals exist in the system prior to upgrading to 2.5, then a new simple approval 
hierarchy will be created for General journal where approval on header will be required but everyone will 
be able to approve. All existing submitted general journals will then have approval groups created for 
them and they will be set as having been approved. You can then set up the approval hierarchy for 
general journals. 

Note: The Allow Posting of Own Journals system parameter and the Post Own Journals fields 
are no longer supported for general journals. Hence, general journals must be approved before they 
are posted, except for those without any general journal lines. 
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Prevent Self-Approval in Approval Hierarchies 
Deltek Tracking: 1071042 

Previously, in Maconomy, a submitter was able to approve their own submission, based on the approval 
rules setup. It is now possible to specify on an approval hierarchy line whether self-approval should be 
allowed for the submitter.  

You can also specify the default setting for self-approval when creating new approval hierarchy lines.  

If the submitter is designated as approver by the approval hierarchy but self-approval is not allowed, then 
the substitute approver or super approver will have to approve the submission.  If the submitter happens 
to be the super approver or substitute approver, the system will not allow the submitter to approve the 
submission. 

 

Changes to Maconomy 

The Approval Hierarchies workspace is updated. 

Setup Instructions 

Set Self-Approval in Approval Hierarchies  

To specify the default setting for self-approval: 

1. Go to Setup » Approval Hierarchies » Approval Hierarchy Selections. 

2. On the Approval Hierarchy Selection Lines tab, select an approval hierarchy line. 

3. On the Approval Hierarchies tab: 

 Select the Submitter Can Approve (Default) check box to allow someone to approve their 
own requests. 

or 

 Deselect the Submitter Can Approve (Default) check box to prevent someone from 
approving their own requests. 

To enable self-approval for an approval hierarchy line: 

1. Go to Setup » Approval Hierarchies » Approval Hierarchy Selections » Approval Hierarchy 
Selection Lines. 

4. On the Approval Hierarchy Selection Lines subtab, select an approval hierarchy line. 

5. On the Approvers subtab, select the check box in the Submitter Can Approve column. 

Upgrade Considerations 

When upgrading Maconomy, all approval hierarchies/ approval lines will set to allow self-approval to 
support the same setup as before the upgrade. If you want to disallow self-approval, you have to 
manually update your approval hierarchies. 

Note: If you do not specify substitute or super approver and the record locks up, you can adjust the 
record and it will re-route for approval. You will first need to adjust the approval hierarchy to address 
the lack of substitute / super approver. 
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Approval Hierarchies Refactoring 
Deltek Tracking: 1125419 

Approval Hierarchies code is refactored to reduce code redundancies and duplication. This enhancement 
increases the consistency and sustainability of the codes for Approval Hierarchies. There are also new 
user actions added to Maconomy to enable you to restrict a user’s ability to do the following: 

 Approve Vendor Invoices 

 Submit Job Budgets 

 Submit Purchase Orders  

 

The Release Vendor Invoices field, located in the Employees workspace, Actions single dialog 
workspace, and User Action Groups single dialog workspace, used to release, submit, and approve 
vendor invoices is renamed as Submit Vendor Invoices. 

Changes to Maconomy 

The following workspaces are updated: 

 Employees  

 Users 

 Actions single dialog workspace 

 User Action Groups single dialog workspace 

Approval Hierarchies for Draft Invoices Enhancements 
Deltek Tracking: 1145075, 1095638 

A new field called Total, Invoice Currency is added to the Invoice Editing tab in the Jobs workspace. If 
the value in this field is zero, the system identifies the draft invoice as a zero invoice. 

You can use this field as one of the selection criteria specifications when setting up approval hierarchies 
for draft invoices. For instance, you can specify that draft invoices with a value of zero in the Total, 
Invoice Currency field can be excluded from approval. 

The Invoice Editing Required with Approval Hierarchies system parameter is also introduced in this 
release, and enables you to require invoice editing on all jobs set up with approval hierarchies for draft 
invoices. 

Time and Expense Sheet Approval Improvements 
Deltek Tracking: 1162619 

Prior to 2.5, time and expense approval was enabled by setting up supervisor and project manager 
approval of time and expense on a job, creating approval hierarchies for these records, or using a 
combination of both approval workflows. In this release, you can no longer combine them. If you have 
configured approval hierarchies for header or line approval on either time or expense sheets, the setup of 
supervisor and project manager approval on a job has no effect. If you would like to have supervisor or 
project approval for these records, you can assign them as the designated approvers in your approval 
hierarchies setup. 

Note: There are no changes in the user experience when using these new functionalities 
after the upgrade. 
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This enhancement is available in the Workspace Client and iAccess. 

 

Back Office 

System Parameter for Number of Entries in Vendor Invoice Journals 
Deltek Tracking: 1129397, 774700 

Prior to this release, Maconomy grouped the vendor invoices that you created in a single vendor invoice 
journal. As a result, you could not submit the vendor invoices for approval if you were unable to submit 
and approve them before you closed or changed the posting period. You could not change the entry date 
on the vendor invoices. Maconomy stopped you with an error message when you submitted, approved, or 
changed the entry date. It allowed you to change the entry date if there was only one vendor invoice in 
that journal.  

The Max Number of Entries in Vendor Invoice Journals company-specific system parameter is added 
to Maconomy to enable you to customize how you create new journals. You can specify if you want to 
group vendor invoices under the same journal. It also gives you the option to create a new journal for 
each vendor invoice. This enhancement is useful, for example, when you do not want to group your 
vendor invoices in a single journal to be able to change the entry date if they were unapproved when the 
posting period closed. 

 

Changes to Maconomy 

The System Setup workspace is updated. 

Setup Instructions 

To enable this feature: 

1. Go to System Setup » Parameters and Numbers » System Parameters. 

2. Double-click the Max Number of Entries in Vendor Invoice Journals parameter. 

3. On the System Parameter sub-tab, enter a value in the Max Number of Entries in Vendor 
Invoice Journals field. 

4. (Optional) To enable this for a specific company, go to the Company Specific Values sub-tab, 
specify the company number in the Company No. field and enter a value in the Max Number of 
Entries in Vendor Invoice Journals field. 

5. Click Save. 

Note: Approval workspaces for time and expense sheet lines will be updated in a future release to 
support project manager approval of lines, even when the approval goes through approval 
hierarchies. 

Note: You can still manually group the vendor invoices under the same journal. Additionally, it does 
not support the invoices created in the Vendor Invoice single dialog workspace and import programs. 



Maconomy 2.5 — Detail 

Enhancements Guide 151 

 

System Parameters 

Parameter Description 

Max Number of Entries in Vendor Invoice 
Journals 

Enter the maximum number of vendor 
invoices in a vendor invoice journal. 

By default, the value in this field is zero. The 
vendor invoices you create group in a single 
journal.  

If the value in this field is one, only one 
vendor invoice saves in a journal.  

If the value in this field is two or higher, 
Maconomy automatically uses the value as 
reference for the number of vendor invoice 
entries grouped in a journal.  

Add Employee Relation to Selection Criteria for Job Draft Invoices 
Deltek Tracking: 1071043 

You can now create selection criterion for draft invoices which make use of fields from the employee 
relation, based on the project manager of the draft invoice. 

In the Approval Hierarchies workspace, Employee Type has been added to Selection Criterion 
Specification Lines on the Approval Hierarchy Selections tab for draft invoices through the Project 
Manager field. This changes the approval route if someone with the Employee Type submits a record. 

Changes to Maconomy 

The Approval Hierarchies workspace is updated. 

Enhanced Selection Criterion Specification and Changes on Changes 
Functionality 
Deltek Tracking: 1132068 

This enhancement is introduced to expand your ability to create selection criteria specifications for the 
purchase order header, to program rules on the changes on change functionality, and to set up approval 
hierarchy rules for changes on the fields of previously approved items.  

Changes to Maconomy 

As part of this enhancement, the following workspaces are updated: 

 Selection Criterion Specification single dialog workspace 

 Changes on Change single dialog workspace 

 Approval Hierarchies 

 Approval Hierarchies single dialog workspace 

Purchase Order Selection Criterion Specification Enhancements 

Deltek Tracking: 829148 
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The new Company Vendor and Payment Company Vendor table sections are added to the target 
group table for purchase order. These table sections enable you to create or set up a selection criteria 
specification for PurchaseOrder and PurchaseOrderLine types. You can now search the additional criteria 
on the Table Section field on the Selection Criterion Specification Lines sub-tab of the Selection Criterion 
Specification single dialog workspace. The selection criteria specification applies to the company vendor 
assigned to the purchase order as the supplier or as the payment supplier on the purchase order. These 
can be different vendors. 

You can use the company vendor table section for delimitation of the company and vendor of the 
purchase order and the payment company vendor table section for delimitation of the company and 
payment vendor of the purchase order. Additionally, this enhancement now allows you to use selection 
criterion specifications to determine the approval hierarchy that you can use for the approval of payment 
terms other than the payment term on the company-specific vendor.  

Expanded Changes on Change Functionality  

Deltek Tracking: 829150 

The Changes on Change sub-tab of the Approval Hierarchies workspace and the Changes on Change 
single dialog workspace is enhanced to expand your ability to program rules, choose which field gets 
updated based on the changes to a specific field, and set up approval hierarchy rules on the Purchase 
Order Header and Purchase Order Line. For example, you can now specify on a field-level for a record, if 
‘x’ field is changed, then also change ‘y’ field. 

Additionally, you can set up approval hierarchy rules for the changes on approved fields of certain 
workspaces. To support this, the changes on change functionality now also provides the following new 
relations: 

 Employee 

 User 

 User Role 

 User Role Action Information 

 Vendor Invoice Journal 

 Invoice Allocation Line 

 Time Sheet Header 

 Time Sheet Lines 

 Expense Sheet 

 Expense Sheet Lines 

 Draft Invoice 

 Invoice Line 

 Job Budget 

 Job Budget Line 

You can search for the new table relations on the Relation field of the Changes on Change sub-tab of the 
Approval Hierarchies workspace and the Changes on Change single dialog workspace. 

Base Salary Rate Calculation for an Employee Range 
 Deltek Tracking: 836515 
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Previously, Maconomy calculated the base salary rate for all employees of a company. As a result, the 
calculation took a long time for large companies. 

This enhancement introduces the Employee No. field in the Selection Criteria island of the Calculate 
Base Salary Rate single dialog workspace and Calculate Base Salary Rate tab of the Base Salary Rate 
Calculations workspace. The new field allows you to specify the range of employee numbers to include in 
the calculation of the base salary rate.  

Additionally, the enhancement enables Maconomy to calculate the base salary rates more efficiently. This 
is helpful when you need to calculate the base salary rates every week for different employees, especially 
if employees work on different customer contracts frequently. Note that the calculation is based on the 
setup of the assigned employee-specific compensation agreements. 

Changes to Maconomy 

The following workspaces are updated: 

 Base Salary Rate Calculations 

 Calculate Base Salary Rate single dialog workspace 

Procedures 

Calculate Base Salary Rate of an Employee Range 

You can specify the range of employee numbers to include in the base salary rate calculation. 

To calculate the base salary rate of a specific employee range: 

1. Go to Human Resources » Base Salary Rate Calculations » Calculation » Calculate Base 
Salary Rate. 

2. In the Selection Criteria island, select the Compensation Model and Company No. to use in this 
calculation. 

 

3. Enter the range of employee numbers to include in the calculation. Provide a start and end 
number in the two Employee No. fields. 

4. In the Calculate island, select the Calculation Period Start and End dates. The Calculation 
Period, Month field populates with the percentage of a month this range contains.  

5. Click Save. 

6. Click the Calculate Base Salary Rate action. 

 

7. The results display in the Base Salary Calculations sub-tab. Review as needed to evaluate, such 
as to see flags in the No. of Warnings field. 

Removal of Euro Exchange Rate Tables 
Deltek Tracking: 1126295 

Note: You can enter a range of company numbers by providing a start and end number in the two 

Company No. fields. 

Note: In the Show Results island, if you enter a date range in the Date field, certain results display in 
the sub-tab. This does not have an effect on the calculation. 
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Previously, you can use the Euro Exchange Rate Table single dialog workspace to list currencies in the 
Economic and Monetary Union (EMU) of the European Union (EU) and their exchange rates related to 
the Euro. Maconomy used the EU Commission rules to calculate the exchange rates for the currencies 
listed in the workspace. Users do not use this functionality anymore because there is no transition period 
that restricts the currencies to the Euro. 

This enhancement removes the Euro Exchange Rate Table single dialog workspace, its functionality, and 
the database relations for Euro exchange rate for any currency. As a result, the Euro Currency field in 
the System Information single dialog workspace is also removed since you no longer need to select the 
currency code to be used as the Euro. It also optimizes exchange rate calculations. Now, you only need 
to maintain currency exchange rate tables in the Exchange Rate Tables single dialog workspace. 

New DebitCredit Field on ReportingStructureLine 
Deltek Tracking: 1115433 

This enhancement introduces a new Debit/Credit field in the Financial Reporting workspace and 
Reporting Structures single dialog workspace to enable you to differentiate debit and credit accounts. 
BPM reports can now display credit and debit accounts in a reporting structure grouping.  

Changes to Maconomy 

The following workspaces are updated: 

 Financial Reporting 

 Reporting Structure single dialog workspace 

Exchange Rate Based on Invoice Date 
Deltek Tracking: 1129396, 800936 

The Use Invoice Date as Exchange Rate Date on Vendor Invoices company-specific system parameter 

is added to enable Maconomy to calculate the exchange rate based on the invoice date, instead of the 

entry date, when you create vendor invoices.  

Previoulsy in Maconomy, vendor invoices derived the exchange date rate from the entry date of the 

vendor invoice. In order to support the option of using invoice date instead to derive the exchange rate 

date for vendor invoices, we introduce a new system parameter named Use Invoice Date as Exchange 

Rate Date on Vendor Invoices. When this system parameter is enabled, vendor invoices will use the 

invoice date instead of the entry date as the exchange rate date. The system parameter is company-

specific, meaning one can enable and disable the option on the company level. 

By default the system parameter is turned off, so that the standard behavior for Maconomy matches the 

current functionality of deriving exchange rate from entry date on vendor invoices. 

The Use Invoice Date as Exchange Rate Date system parameter used to derive the exchange rate 
dates from invoice dates on the job invoices is renamed as Use Invoice Date as Exchange Rate Date 
on Job Invoices to help you differentiate their functionalities. 

Changes to Maconomy  

The System Setup workspace is updated. 
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Setup Instructions 

To enable this feature for all companies: 

1. Go to System Setup » Parameters and Numbers » System Parameters. 

2. Double-click the Use Invoice Date as Exchange Rate Date on Vendor Invoices parameter. 

3. On the System Parameter sub-tab, select the Use Invoice Date as Exchange Rate Date on 
Vendor Invoices check box. 

4. (Optional) To enable this for a specific company, go to the Company Specific Values sub-tab, 
specify the company number in the Company No. field and select the Use Invoice Date as 
Exchange Rate Date on Vendor Invoices check box. 

5. Click Save. 

System Parameters 

Parameter Description 

Use Invoice Date as Exchange Rate Date on 
Vendor Invoices 

Select this parameter to use the invoice date 
as the exchange rate date. 

Deselect this parameter to use the entry date 
as the exchange rate date. 

Use Invoice Date as Exchange Rate Date on 
Job Invoices 

The Use Invoice Date as Exchange Rate 
Date system parameter is renamed to Use 
Invoice Date as Exchange Rate Date on 
Job Invoices. 

Select this parameter to enable Maconomy to 
calculate the billing price of job entries in 
currencies other than the base currency of 
the company of the job at the date of 
invoicing.  

If it is deselected, Maconomy uses the date 
of the job entry for currency conversion. 

Enhanced Vendor Invoice Allocation Workspace to Support 
Reallocation 
Deltek Tracking: 774702  

Previously, the Reallocate Invoices single dialog workspace showed posted but not fully allocated 
invoices only. You can only change a few fields on these invoices, for example, the Reference Date and 
Remarks fields. The Reallocate Invoices single dialog workspace is removed from Maconomy. The 
Invoice Allocation single dialog workspace now supports both allocation and reallocation of credit memos 
and vendor invoices.  

The improved Invoice Allocation single dialog workspace now also shows the vendor invoices and credit 
memos that have been posted but not yet allocated. Additionally, you can access all the previously 
available fields and actions for reallocation in the Invoice Allocation single dialog workspace. The fields, 
Reallocation Date and Date Posted, are added to the Invoice Allocation tab. 
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Changes to Maconomy 

The following changes are made to support this feature:  

 Updated Invoice Allocation single dialog workspace 

 Removed Reallocate Invoices single dialog workspace 

 Removed Print Invoice Reallocation 

Automatic Posting of Interest Charge Notice Journals 
Deltek Tracking: 755417 

The Automatic Posting of Interest Charge Notice company-specific system parameter is introduced to 
enable Maconomy to automatically post the interest charge notice journals. These journals are created 
when a user approves the interest charge selections in the Change Interest Charge Selection or Approve 
Interest Criteria single dialog workspaces, and in the Interest workspace. The system parameter is 
enabled by default when you upgrade to 2.5, but can be disabled in the System Setup.  

Changes to Maconomy 

The System Setup workspace is updated.  

Setup Instructions 

To enable this feature: 

1. Go to System Setup » Parameters and Numbers » System Parameters. 

2. Double-click the Automatic Posting of Interest Charge Notice parameter. 

3. On the System Parameter sub-tab, select the Automatic Posting of Interest Charge Notice 
check box. 

4. (Optional) To enable this for a specific company, go to the Company Specific Values sub-tab, 
specify the company number in the Company No. field, and select the Automatic Posting of 
Interest Charge Notice check box. 

5. Click Save. 

System Parameters 

Parameter Description 

Automatic Posting of Interest Charge Notice Select this parameter to automatically post 
interest charge notice journals. 

System Parameter for Unrealized Exchange Rate Variances for Control 
Accounts 
Deltek Tracking: 841812 

Prior to this update, the Print Currency Report single dialog workspace only created unrealized exchange 
rate variances for manual accounts. Maconomy did not create G/L entries for control accounts. The 
system skipped the control accounts in the process even if you marked them as currency accounts.  
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The Create Unrealized Exchange Rate Variances For Control Accounts company-specific system 
parameter is introduced to enable Maconomy to create unrealized exchange rate variances for control 
accounts. When you print the currency report, the printout now also displays the exchange rate variances 
for control accounts. 

Changes to Maconomy 

The System Setup workspaces is updated. 

Setup Instructions 

To enable this feature: 

1. Go to Setup » System Setup » Parameters and Numbers » System Parameters. 

2. Double-click the Create Unrealized Exchange Rate Variances For Control Accounts 
parameter. 

3. On the System Parameter sub-tab, select the Create Unrealized Exchange Rate Variances For 
Control Accounts check box. 

4. (Optional) To enable this for a specific company, go to the Company Specific Values sub-tab, 
specify the company number in the Company No. field, and select the Create Unrealized 
Exchange Rate Variances For Control Accounts check box. 

5. Click Save. 

System Parameters 

Parameter Description 

Create Unrealized Exchange Rate Variances 
For Control Accounts 

Select this parameter to create unrealized 
exchange rate variances for control accounts 
in the Print Currency Report single dialog 
workspace. 

Deselect this parameter to include unrealized 
exchange rate variances only for manual 
accounts. 

Increased System Number Capacity  
Deltek Tracking: 1130811 

Previously, Maconomy used integer values for system numbers and allowed the maximum length of nine 
characters. Some companies used the first three characters as the company number and the fourth 
character as the type of the system number. Thus, only five characters remained for the individual 
numbers. As a result, companies ran out of system numbers. 

This enhancement increases the system number length from nine to 255 characters. Now, companies no 
longer need to reuse and reset their system numbers every year. The system numbers are changed from 
integer to string values to extend the capacity, and enable you to use text to further differentiate the 
numbers. This change impacts both system numbers and transaction numbers.   

Additionally, this feature improves the readability of the system numbers. You can now use alphabetical 
characters in the company prefix, prefix, and suffix. This makes it easier for the users to read the system 
numbers. For example, you can now assign Inv0000323 for your Invoice and Tim0000323 for your 
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Timesheet. It also allows external programs to analyze and understand the numbers correctly. However, 
Maconomy only allows numerical characters (0-9) for the running number. There are instances where you 
have the option to use either transaction numbers or system numbers. This option is still available after 
the upgrade. 

Additionally, this feature updates the object format on the BPM Reporting universes to support the 
increased system number capacity. This feature also updates the data type of a large number of 
database fields from integer to string values.  

Format 

The alignment of the old and new numbers is different. The old number aligns to the right while the new 
numbers align to the left. The system numbers are still incremented by one each time you use a number. 
The system numbers contain alphabetical characters only if you choose to add them in the prefix and 
suffix. 

Sorting 

Different sorting rules apply to strings and integers. For example, Maconomy sorts the numbers [1, 7, 11, 
15, 25, 137] in ascending order as expected for integer values. For string values, Maconomy sorts the 
information based on the lexical order of the characters. When sorting rules for string values apply to the 
numbers in the example, the new order is [1, 11, 137, 15, 25, 7]. Sorting rules for string values now apply 
when you sort the new system numbers. Maconomy sorts the strings with numbers based on the order of 
the characters from left to right. 

You can pad the new numbers with zeroes to replicate how integers are sorted. For example, if you apply 
zero padding in the numbers [1, 7, 11, 15, 25, 137], the numbers are in lexical order [001, 007, 011, 015, 
025, 137] as expected for integers. Additionally, previous selection criteria does not work as expected 
without zero padding. 

Limit for Use of Letters in System Numbers 

The use of letters in system numbers is incompatible with the following Maconomy features: 

 Invoice Signature Calculation 

 Invoice Numbers in Payment Identifications 

Invoice Signature Calculation 

If you enable the Calculate Invoice Signature parameter, you cannot use letters in system numbers for 
invoices that follow a specific format. This company-specific parameter is statutory for Portugal. 

If the parameter is enabled, Maconomy calculates the signature for invoices based on selected fields from 
the invoice and a private key. Thus, an error occurs when you use the numbers in signatures. 

Invoice Numbers in Payment Identifications 

In Europe, the system numbers are useful for companies that utilize invoice numbers in payment 
identifications. These invoice numbers appear when the invoices are generated for payments and Giro 
Cards. However, the system numbers cannot have letters because the banks require that companies use 
only numbers in the payment identifications. If you use letters in the system numbers, Maconomy 
generates a random number for the payment identification. 

 

Note: We recommend that you refrain from using letters in system numbers if you wish to keep these 
functionalities. 
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Examples 

No Issues with System Number Capacity 

Company A upgrades their system and the system number capacity increases. They are not running out 
of numbers but they still proceeds with the upgrade. The users did not apply any changes to their system 
numbers. They noticed the changes in the sorting order in the selection criteria. After a few weeks, the 
users from Company A adapt to the new sorting order and they are able to select ranges in the selection 
criteria. 

Keep the Numbers but Add Zero Padding 

Company B chooses to keep the system number setup and adds zero padding for all system numbers, 
which they have not used previously. Before the upgrade, their last invoice number was 40001. After the 
upgrade, the invoice number of the new invoice that they created became 000040002. Additionally, they 
experienced the changes in the sorting order in the selection criteria for all the old numbers. The users 
from Company B realize that the new numbers are now easier to sort and select. 

Extend the System Numbers 

Company C needs the new functionality and extends the number of digits to nine. They entered 10 for 

their company prefix (in the Prefix Specification island), which they left unchanged. They also did not 

change the entry in the Next Number field. Then, they updated the numeral value of the prefix of the 

invoice numbers from seven to be a text, that is invoice.  

Before the upgrade, the company’s last invoice number was 107400001. After the upgrade, the invoice 

number of the new invoice that they created became 10invoice000400002. In the new invoice, the users 

from Company C easily realize that it is an invoice number, the two first digits is the company number, 

and the counter is on 400002. Maconomy now provides a more convenient way for the users to 

remember what the number represent. 

 

Procedures 

Specify the Number of Digits in a Series 

You can specify the number of digits that a series consists, excluding the prefix and suffix.  

To specify the number of digits in a series: 

1. Go to Setup » System Setup » Parameters and Numbers » System Numbers » [select 
company] » Numbers » System Numbers. 

2. In the System Numbers sub-tab, select the number series to update. 

3. In the No. of Digits field, enter the minimum number of digits that a series should contain. 

 

4. Click Save.  

Note: Update the external programs that use system numbers to understand the new prefix value (for 

example, invoice) instead of the old numeral value.  

Note: We recommend that you specify the number of digits to allow enough room for new 
system numbers in the future. 
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Pad Numbers with Zeroes to Sort Integers 

Use these steps to pad the new numbers with zeroes to sort the information in the natural order and 
match how Maconomy sorts integers.  

To pad numbers with zeroes: 

1. Go to Setup » System Setup » Parameters and Numbers » System Numbers » [select 
company] » Numbers. 

2. In the Prefix Specifications island, in the System Numbers field, enter the prefix of the system 
numbers in the current company. 

 

3. In the System Numbers sub-tab, select the number series to update. 

4. In the Next Number field, enter the next number in the series. 

 

5. In the No. of Digits field, enter the minimum number of digits that a series should contain. 

6. Click Save.  

Setup Instructions 

To enable this feature: 

1. Go to Setup » System Setup » Parameters and Numbers » System Numbers » [select 
company] » Numbers. 

2. In the Prefix Specifications island, in the System Numbers field, enter the prefix of the system 
numbers in the current company. 

3. In the System Numbers sub-tab, select the number of series to update. 

4. In the Next Number field, enter the next number in the series. 

5. In the System Numbers sub-tab, in the No. of Digits field, enter the minimum number of digits 
that a series should contain. 

6. (Optional) Complete the Suffix and Last Number fields. 

7. Click Save.  

Install / Upgrade Considerations 

You cannot continue to use the previous functionality with integers after the upgrade. If you do not update 
the programs, these will fail to integrate with Maconomy. 

Note: We do not recommend that you add zeroes in the prefix. Zero padding on the prefixes 
could result to risks. For example, 012000137 and 12000137 are two different numbers in the 
system but users may view these as same numbers, which can lead to confusion and errors. 

Note: When the number in the Next Number field contains fewer digits, Maconomy adds the 
necessary number of zeroes between the prefix and the entry in the Next Number field to 
make the next number reach the minimum number of digits. 
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There are numerous upgrade considerations. For more information, see the Deltek Maconomy 2.5 
Upgrade Guide. 

Tax Depreciation of Fixed Assets 
Deltek Tracking: 536720  

Previously, Maconomy used depreciation period to calculate fixed asset depreciation. Each time you 
calculated the depreciation, Maconomy checked how much depreciation it should have calculated from 
the depreciation start date, and deducted the accumulated depreciation from it.  

This enhancement is introduced to enable you to restrict the tax depreciation of fixed assets. Multiple tax 
systems exist. Some are simple modifications of the regular Straight Line principle (referred to as Straight 
Line), and the others are based on complex calculations. While this update preserves the existing option 
that does not limit tax depreciation, it also provides two new options to set up limitation on tax 
depreciation. 

The two new options are: 

1. Straight Line tax depreciation with parameter 

2. Table-based depreciation specifying the percentage year by year 

These are added to support both simple and complex tax depreciation systems. You can now use tax 
accelerated depreciation, in addition to Straight Line depreciation. Additionally, this update now enables 
you to set up tax depreciation tables based on annual tax percentage. Then, you can use the tax 
depreciation tables in the Asset Group, where Maconomy derives the tax depreciation setup.  

This is a requirement in some countries, including Italy, India, and the US. In Italy, the law specifies an 
upper percentage on the assets value, which are depreciable each year. However, for the first fiscal year, 
the upper limit is only half of the amount allowed in subsequent years. It is as if a company, with fiscal 
year from January 1 to December 31, purchased all of its assets on July 1. This is regardless of the actual 
purchase date in the calendar year. 

In the US, the Modified Accelerated Cost Recovery System (MACRS) is the tax depreciation system. 
Under MACRS, half-year depreciation is the standard. Some additional complex calculations are subject 
to several parameters based on the type of asset. Additionally, the Class Life Asset Depreciation Range 
(CLADR) lookup tables reduced complex calculations. Thus, it provides an easy access to the 
depreciation rates. 

For more information about this feature, refer to the Deltek Maconomy Concepts Guide. 

Time & Expense 

Multiple Check-in or Check-out Time Entries Per Day 
Deltek Tracking: 1077699, 439452, 924309 

This enhancement provides a more detailed and accurate representation of all work hours logged daily. 
Prior to this release, Maconomy could only log one time entry for check-in/check-out per employee daily. 
You can now enable employees to log multiple check-in and check-out entries per day to track work 
hours in time sheets. 

This functionality is available in the Workspace Client, iAccess, and Touch. 

Warning: All legacy and current data must be updated, as the entire database must be reviewed to 
copy over the old system numbers to the new system number format.  
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This feature includes: 

 Multiple Check-in and Check-out Time Entries Per Day in the Workspace Client 

 Multiple Check-in and Check-out Time Entries Per Day in iAccess 

Multiple Check-in and Check-out Time Entries Per Day in the Workspace Client  

Deltek Tracking: 439452 

This functionality adds the Check-in tab to both daily and weekly time sheets, where you can log and view 
all check-in and check-out entries within a specific day. Maconomy displays the total number of hours 
registered daily and weekly, as well as the balance between registered work time and check-in time. A 
company can choose to round up employee in check-in and check-out entries using a system parameter 
introduced with this feature. 

Enabling this feature is done on an employee record. When multiple daily check-in entries are enabled on 
an employee revision on the record, the check-in tabs become available in daily and weekly time sheets 
for the period indicated in the revision. Note that if you disable check-in on an employee revision, then 
any registered check-in-data will not be deleted. However, the workspace will no longer show the check-
in tabs in weekly and daily time sheets. 

When you create a check-in/check-out entry for a date covered by the time sheet, the sub-tab 
automatically sorts the lines by check-in time to ensure entries are always displayed in order. When you 
enter lines for the day, take note of the following: 

 Entry times must not overlap. Specifically, the correct way to log check-in entries is displayed as 
so: 

Check-in Time Check-out Time 

Correct 

09:00 12:00 

12:00 13:00 

Incorrect  

09:00 12:00 

11:50 13:00 

 You must enter a check-in time in each entry line. 

 The check-in time must be before the check-out time.  

 You cannot create zero duration check-in entries (for example, 08:00 to 08:00). 

 If you enter 00:00 as the check-in time, the system logs this as the beginning of the day. 

 Depending on time format set up for your company (either 12-hour or 24-hour format), if you enter 
00:00 or 24:00 as the check-out time, the system logs this as the end of the day.  

 When you submit the time sheet, all check-in and check-out times must have values. 

 If the company has chosen to round up employee check-in time, the system calculates entries as 
follows: 

 The first daily totals are rounded up to the nearest minutes defined by the system parameter. 
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 Rounded totals for each day are summed up for all the week days. 

Additionally, this feature currently has the following limitations: 

 You cannot register a single time entry that spans from 00:00 to 24:00. An error occurs when you 
save the line. You must create a minimum of two entries to split the check-in times. For example, 
you may record check-ins in two entries, one or 00:00 to 09:00 and another for 09:00 to 24:00. 

 Check-in and out time cannot span days. If you work on a shift that crosses to the next day, you 
must create a minimum of two check-in entries, one for each day. For example, create one entry 
for 22:00 to 00:00, and a second entry for 00:00 to 05:00 on the following date. 

The system blocks submission of a timesheet if the check-in balance is negative, which means that the 
check-in time is less than the time registered. It calculates check-in balance for each date to ensure 
accuracy.  

For example, if you are required to work eight hours per day, then you create a check-in entry for five 
hours of work, and a separate entry for one more hour of work, the system calculates this as a total of six 
hours logged for the day. If you try to submit your daily time sheet with these entries, an error occurs as 
there are still two hours unaccounted for. You must make sure to create check-in and check-out entries 
that are equal to eight hours, or exceeds this value. 

Note that employees with split week time sheets show only the tabs that are relevant for the days of the 
split week. 

Approval of Time Sheets 

When an approver views a time sheet submitted for approval, totals for the check-in duration and balance 
are both displayed for easy reference. The approver can also view all entries logged per day of the week. 

New System Parameters 

Check-in/out requirements are set at the company level by system parameters added to support this 
functionality. 

The Maximum Number of Check-ins Per Day Limit system parameter enables you to specify a limit to 
the number of check-in registrations an employee may add on a specific date. By default, the value in this 
parameter is zero, which means there is no limit on the number of check-ins. 

You can also set up Maconomy to round up employee daily check-in time using the Check-in Time 
Round Up system parameter. Total check-in times can be rounded up to a value that is a multiple of a 
number of minutes. The system parameter allows rounding to 0(no rounding), 5, 10, 15, 20, 30, and 60 
minutes. This has a positive impact on the daily check-in balance which, upon time sheet submission, 
may require more check-in time than time sheet registered hours.  

Balance Validation Rules 

When the system calculates check-in balances for an employee, the following is considered: 

 Days without fixed working hours are skipped in the validation, unless the employee adds time 
registrations on any of these days. 

 An employee’s check-in duration (which may be rounded up, if this functionality is enabled) per 
day should be equal to or exceed the registered work time duration. 

 If an employee registers an absence the system does not validate check-in balance for that day 
upon time sheet submission. 

 If an employee registers both absence and work hours on a day, the system validates check-in 
balance for that day. 

Changes to Maconomy 

The following workspaces are updated: 
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 System Setup 

 Time and Expenses workspace 

 Employees workspace 

Procedures 

Enter Data for a Check-in Time Entry 

Use these steps to  create check-in entries to log your work hours. 

To register check-in time: 

1. Go to Time & Expenses » Time & Expenses » Time » Day » Check-in. 

2. Click on the day you want to register check-in time for. 

3. In the Checked in field, enter a check-in time. 

4. In the Checked out field, enter activity check-out time. 

5. Click Save. 

Maconomy automatically updates the total check-in time and balance in the Check-in tab. 

Setup Instructions 

Enable Limit on Daily Check-in Entries 

Use these steps to set up a limit regarding the number of check-ins employees can enter in a daily 
timesheet. 

To enable a maximum limit on check-ins per day: 

1. Go to System Setup » Parameters and Numbers » System Parameters. 

2. Double-click the Maximum Number of Check-ins Per Day Limit parameter. 

3. On the System Parameter sub-tab, enter a value in the Maximum Number of Check-ins Per 
Day Limit field. 

 

4. Click Save. 

Enable Check-in Time Round Up 

Use these steps to enable Maconomy to round up the check-in minutes to a selected value.  

To enable check-in time round up: 

1. Go to System Setup » Parameters and Numbers » System Parameters. 

2. Double click the Check-in Time Round Up parameter. 

3. On the System Parameter sub-tab, enter a value in the Check-in Time Round Up field. 

You can only enter one of the following values: zero (indicates that no rounding should occur), 5, 
10, 15, 20, 30, or 60. 

4. Click Save. 

Note: If you enter a value of zero, this indicates there is no maximum limit on the check-ins 
per day. 
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Enable Multiple Check-in Entries  

Use these steps to allow an employee to register multiple check-in and out entries daily. 

To enable this feature: 

1. Go to Human Resources » Employees » Employee Information. 

2. Select an employee record from the filter list. 

3. In the Check-in field, select one of the following options: 

 Disabled 

 Optional 

 Required 

 Required with Balance 

4. Click Save. 

System Parameters 

Setup » System Setup » Parameters and Numbers » System Parameters » System Parameter 

Parameter Description 

Maximum Number of Check ins Per Day 
Limit 

Specify a value to restrict the number of 
times an employee can log check-in time 
entries per day. 

By default, the value in this parameter is 
zero, which indicates there is no limit. 

Check-in Time Round Up Specify a value in this field to round up time 
entries to the nearest increment.  

You can only enter one of the following 
values: zero (indicates that no rounding 
should occur), 5, 10, 15, 20, 30, or 60. 

The default value in this field is zero. 

Multiple Check-in and Check-out Time Entries Per Day in iAccess 

Deltek Tracking: 924309 

iAccess now supports multiple check-in and check-out time entries per day for employees. 

Changes to iAccess 

To support this feature, the following workspaces are updated: 

 Employees  

 Weekly Time Sheets  

 Daily Time Sheets 

 Time Sheet Overview 
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Procedures 

Enter Data for a Check-in Entry 

Use these steps to create check-in entries to log your work hours. 

To register check-in time: 

1. Go to Daily Time Sheets or Weekly Time Sheets. 

2. Click Check-In. 

3. Click + Add Daily Check-in Entry. 

4. In the Checked In field, enter the check-in time. 

5. In the Checked Out field, enter the check-out time. 

6. Click Save. 

iAccess automatically updates the total check-in time and balance on the time sheet.. 

Setup Instructions 

To enable this feature: 

1. Go to the Employees workspace. 

2. Select an employee from the filter list.  

3. From the Other Actions drop-down list, click Edit.  

4. In the Check-In field, select an option from the drop-down list: 

 Disabled 

 Optional 

 Required 

 Required with Balance 

5. Click Save. 

Mandatory Numeric Fields in Expense Justification 
Deltek Tracking: 1068628, 949720 

To further supply detailed substantiations of your expenses, mandatory numeric fields are now available 
in the Time and Expenses workspace. This feature enables you to include amount, integer, and real 
values in the Expense Justification fields, and select ones that are required for your expense sheets. All 
mandatory fields are color coded yellow. Furthermore, you can optimize your search of applicable and 
valid expense justification values with the improved Option List field. 

Once enabled in the Workspace Client, this functionality is also available in iAccess and Touch. 

Changes to Maconomy 

The Time and Expenses workspace is updated. 
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Setup Instructions 

To enable this feature:  

1. Go to Setup » System Setup » Parameters and Numbers » System Parameters. 

2. Double-click the Enable Standard Extensions parameter. 

3. On the System Parameter sub-tab, select the Enable Standard Extensions check box. 

4. Restart the Workspace Client to apply setup changes. 

Time Sheet Overview Workspace 
Deltek Tracking: 906078 

The Time Sheet Overview workspace provides supervisors (or secretaries) with the ability to review the 
time sheet status of all employees under their supervision.  

Specifically, you can do the following: 

 View your employees’ time sheets for a particular week, including split weeks time sheets. 

 View time sheet status to determine whether supervisor action is required. 

 View detailed status information in the info bubble, including who created or submitted the time 
sheet. 

 View detailed information regarding a time sheet in the wizard. 

 Email employees about time sheets. 

 Open an employee’s time sheet for editing.  

By default, the workspace opens to the date of the previous week and displays time sheets sorted by 
employee name. All time sheets are read-only, but clicking the Create/Edit icon on a line redirects you to 
the Weekly Time Sheets workspace to create or edit the employee’s time sheet. 

This workspace is listed under the Approvals section in iAccess.  

Setup Instructions 

If all setup steps have been performed in the Workspace Client, the Time Sheet Overview workspace is 
available by default to supervisors and other users with the requisite permissions. 

Color Coded Statuses 
Deltek Tracking: 1187694 

You can now use color coding on the Status field in the Time Sheet Overview workspace. This provides 
at-a-glance view of both progress and issues that may require your action.  

Tax Fields in the Expenses Workspace 
Deltek Tracking: 1199815 

Tax-related fields are now available in the Expenses workspace to enable tax calculation for your 
expenses. The Tax Code 1 and Tax Amount fields are available by default in the Expenses workspace. 
The use of multiple tax fields are also supported, depending on the setup of your company in the 
Workspace Client. 
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Changes to iAccess 

The Expenses workspace is updated to support this functionality. 

Setup Instructions 

Tax codes are created in the Workspace Client. iAccess uses the specified tax codes based on the setup 
for your company.  

iAccess Notifications for Missing Time Sheets 
Deltek Tracking: 1134602, 1134620 

This feature introduces standard notifications in iAccess for missing daily and weekly time sheets. 

The following notifications are included: 

 Daily Time Sheets not Created – Appears for the user to indicate a time sheet is not submitted 
for the day. By default, all missing time sheets within the last two months are included. This 
notification points to the Daily Time Sheets workspace. 

 Weekly Time Sheets not Created – Appears for the user to indicate a time sheet is not 
submitted for the week. By default, all missing time sheets within the last two months are 
included. This notification points to the Weekly Time Sheets workspace. 

Approval Center in the Workspace Client 
The Approval Center workspace is now available in the Time & Expenses module. Customers who prefer 
to manage their approvals using the Approval Center can now do this by making it available for their 
users in the workspace client. 

Invoicing 

Document Archive for Draft Invoices  
Deltek Tracking: 616200 

A document archive is now available for draft invoices. When you create or edit a draft invoice, you can 
attach and manage supporting documents on it. When a draft invoice is submitted for approval, approvers 
can also review the attachments. 

This enhancement is available in the Workspace Client and iAccess. 

This feature includes: 

 Document Archive for Draft Invoices in the Workspace Client 

 Document Archive for Draft Invoices in iAccess 

Document Archive for Draft Invoices in the Workspace Client 

Deltek Tracking:614337, 912162 

This enhancement adds the ability to attach and manage documents on a draft invoice in the Jobs 
workspace. 

You can attach documents to a draft invoice in the Invoice Editing tab in the Jobs workspace. 
Attachments can be viewed using the View Document action on the Invoice Editing tab or in the new 
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Documents sub-tab. You can also add, delete, update, export, lock, and unlock documents in this sub-
tab. 

Once the draft invoice is submitted for approval, an approver can now easily review the supporting 
documents on the draft invoice. Approvers can view attachments on invoices submitted for approval in 
Jobs » Jobs » Invoicing » Draft Invoices » Invoice Editing » Documents. 

When the draft invoice goes through the invoicing process, the document archive is reassigned to the 
final invoice or credit memo. This allows you to view any attached documents in the invoice history, if 
needed. 

Access to the draft invoice for approval is controlled by the approval hierarchies set up by your company. 

Changes to Maconomy  

 Jobs workspace 

 Invoice Editing single dialog workspace 

 Blanket Invoicing workspace 

 Blanket Invoice Selection single dialog workspace 

 Invoice Selection single dialog workspace 

 Sales Orders workspace 

 Show Invoices single dialog workspace 

 Show Credit Memos single dialog workspace 

 Job Invoice History single dialog workspace 

 Job Invoice Overview single dialog workspace 

 Documents and Notes workspace 

 Document Archives single dialog workspace 

Procedures 

Attach a Document to a Draft Invoice 

Use these steps to add one or more documents to a draft invoice. 

To attach a document to an invoice: 

8. Go to Jobs » Jobs » Invoicing » Draft Invoices » Invoice Editing. 

9. Select a job with a draft invoice. 

10. Click Attach Document, then browse and select the needed document. 

The document is attached and can be viewed in the Documents sub-tab. 

Review a Document on a Draft Invoice 

Use these steps to manage documents attached to the invoice. 

To review a document for an invoice  

 Go to Jobs » Jobs » Invoicing » Draft Invoices » Invoice Editing » Documents. 

 Select the relevant document line, and select one of the available actions: 

 Delete Document 
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 Update 

 Export 

 Show 

 Lock 

 Unlock 

 Export to Excel 

 New 

Setup Instructions 

Once you perform all necessary approval hierarchies setup, this functionality is available by default. 

Document Archive for Draft Invoices in iAccess 

Deltek Tracking: 1206290, 1214209 

A document archive is now available in several workspaces related to invoicing. This enables you to 
attach and manage documents related to a draft invoice. Depending on the invoice type you are working 
on, this is done in any of the following workspaces: 

 WIP Invoice workspace 

 Invoice on Account workspace 

 Customer Invoicing workspace 

 Draft Invoices workspace 

You can also view attachments on existing invoices in the Job Invoices workspaces. However, you 
cannot attach additional documents in this workspace. 

A document archive is also added to the Draft Invoices tab in the Approval Center. Once a draft invoice 
with attachments is submitted for approval, the Documents tab is displayed when you open the approval 
wizard. Note that you cannot manage any files attached to the draft invoice  in the Approval Center You 
can download any of the attachments, but you cannot upload new revisions or remove any documents. 

When a draft invoice goes through the invoicing process, the document archive is reassigned to the final 
invoice or credit memo. To view the document archive for printed invoices or credit memos, go to the 
Invoice History tab of any workspace that utilizes invoices. 

 

Changes to iAccess 

To support this feature, the following workspaces are updated: 

 WIP Invoice workspace 

 Invoice on Account workspace 

 Draft Invoices workspace 

 Invoices workspace 

 Customers workspace 

 Customer Invoicing workspace 

Note: This feature is also available in the Invoicing sample workspace. 
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 Invoicing sample workspace 

 Draft Invoices tab in the Approval Center 

Procedures 

Attach Documents to a Draft Invoice 

Use these steps to attach documents to a draft invoice. Depending on the invoice type you are working 
on, this may occur in any of the following: WIP Invoice workspace, Invoice on Account workspace, Draft 
Invoices workspace, or Customer Invoicing workspace. 

To attach documents to a draft invoice: 

1. Go to the Invoice Editing tab in any of the invoicing workspaces. 

OR 

Go to the Draft Invoices workspace. 

2. Select a draft invoice from the filter list. 

3. From the Other Actions drop-down list, select Attach Document. 

4. Click Choose Files. 

5. In the file explorer window that opens, select the file. 

6. Click Open, or press ENTER. 

7. Click OK. 

iAccess automatically saves your changes, and lists the new attachment in the Documents tab of 
this workspace. 

 

View a Document 

You can view any document listed in the Documents tab. Depending on the invoice type you are working 
on, you can review attached documents in any of the following workspaces: WIP Invoice workspace, 
Invoice on Account workspace, Customer Invoicing workspace, Draft Invoices workspace, or Job Invoices 
workspace. 

To view a document: 

1. Go to the Invoice Editing tab in the WIP Invoice workspace, Invoice on Account workspace, or 
Customer Invoicing workspace. 

OR 

Go to the Draft Invoices or Job Invoices workspace. 

2. Select a draft invoice from the filter list. 

3. In the Documents tab, select a line. 

4. Click Row Tools » View Document on the line. 

The file is downloaded to your computer/device. 

Note: If you want to enter additional remarks for a specific document, you can fill out the 
Remark field for that document in the Documents tab. Click Save, or press ENTER to save 
the information. 
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View Attachment on a Draft Invoice 

Approvers can review documents attached to approval items in the Draft Invoices tab. 

To view a document attached to a draft invoice: 

1. Go to Approval Center workspace » Draft Invoices tab. 

2. Click the View Details icon on a line. 

3. In the Documents sub-tab, click the filename in the Document field of the line. 

The file is downloaded to your computer/device. 

Setup 

Once you perform all necessary approval hierarchies setup in the Workspace Client, this functionality is 
available by default in iAccess. 

Tracking Partial Payments in Invoice History 
Deltek Tracking: 586355, 804202 

This enhancement allows you to track your partially settled invoices, pre-invoices, and credit memos. 
When you view an invoice’s history, the Payment Status field now includes Partially Reconciled status. 
The Payment Status field is updated with a Partially Reconciled status. A new Remainder field shows 
the remainder, and you can check the remaining balances at a glance. 

Note: This is implemented in the Workspace Client and iAccess. 

Changes to Maconomy 

The following workspaces are updated: 

 Jobs workspace 

 Job Invoices workspace 

 Customer Invoice History single dialog workspace 

 Job Invoice History single dialog workspace 

 Job Invoice Overview single dialog workspace 

 Show All Invoices single dialog workspace 

 Show Job Invoice single dialog workspace 

 Show Job Credit Memo single dialog workspace 

Setup Instructions 

There are no changes to setup for this enhancement. 

Statutory/BPM 

Chinese Setup Guide 
Deltek Tracking: 962671 

 Statutory Regulatory Guide for China.  
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Selection Criteria on Report Tab  
Deltek Tracking: 563042 

To enhance BPM reports, the selection criteria has been moved to the new Report tab, so that the report 
data is the primary focus of the report. Previously, the selection criteria displayed before the report data. 

iAccess 

Enhancements to the Conversation Functionality 
Deltek Tracking: 1204848, 1204853, 1204850 

This feature improves on the Conversations functionality introduced in 2.4.5. Specifically: 

 Users can now paste copied text into the input area of the messages pane. 

Note: This functionality is not available in Internet Explorer.  

 iAccess is now able to detect any URLs and email addresses in a message, and display 
these as hyperlinks. 

Role-Dependent Search Options 
Deltek Tracking: 1196212, 1093984 

You can now annotate all search restrictions in search filters with a visibility condition. This allows you to 
conditionally hide individual search restrictions. While visibility conditions cannot make use of workspace 
data, these can be based on global functions such as hasRole() and envVar(). 

This is a user interface feature (that is, not based on access control), and can be applied to any filter. 

Displaying Additional Information on iAccess Systems 
Deltek Tracking: 1077740 

Employees can now view more details on the iAccess system they are currently using. The 
enhancements described in the following sections are especially useful for companies who use multiple 
environments or have multiple iAccess sessions open simultaneously. 

Labels on iAccess Systems 

Deltek Tracking: 1046567 

Similar to available functionality in the Workspace Client, you can now display the name of an iAccess 
system on its interface. You can specify a text string, with background and foreground color coding. This 
label is clearly visible even if you switch from one workspace to another. 

Setup Instructions 

For detailed setup information, refer to the “Displaying System Information on Clients” section in the 
Deltek Maconomy System Administrator Guide.  

Displaying Information on the iAccess Browser Tab 

Deltek Tracking: 1211119 
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If you are logged in to iAccess, your browser tab now displays your name as well as the name of the 
workspace you are currently viewing. 

Enabling Charts in iAccess 
Deltek Tracking: 1097220, 1103856 

You can now create charts and graphs based on the data in your company's Maconomy system, and 
display these in any iAccess workspace. 

Charts are not enabled by default, but you can add them to your installation as needed. To view the 
example workspaces that show the available chart types, go to Examples » Charts.  

Quotes Workspace 
Deltek Tracking: 1060377, 1060423 

The Quotes workspace enables you to create, edit, and print job quotes as well as order confirmations. In 
addition, this workspace supports quote revisions, and the approval hierarchy functionality for job quotes 
(also new with 2.5). 

Specifically, you can perform the following tasks: 

 Add, insert, copy, and delete quote lines. 

 Add a quote based on a budget. 

 Review, delete or restore, and approve or reject quote revisions. 

 Print quotes, draft quotes, and order confirmations. 

The Quotes tab displays your quotes and relevant account information, including calculations. In this tab 
you can print, submit, approve, and accomplish other administrative tasks in relation to your quotes and 
order confirmations. The Quote Revisions tab displays all versions of your quote lines. These capabilities 
are parallel to what is in the Workspace Client. 

The Quotes workspace is included in the Jobs section of the iAccess menu. 

Notifications  

The following notifications are included: 

 Rejected Job Quote – Appears for a user who submitted the job quote to indicate the quote 
has been rejected. This notification points to the relevant job quote in the Quotes workspace. 

Changes to iAccess 

To support this functionality, the Quotes workspace is added to iAccess. 

Workflow 

The high-level workflow for creating and revising quotes in the Quotes workspace is as follows: 

Task User Details… 

Create or edit a quote. Project manager  The quote can be 
created from an existing 
budget or in the Quotes 
workspace 
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Task User Details… 

 Update quote 
information and 
calculations as needed. 

Submit a quote. Project manager, or any 
employee with requisite 
permissions 

 Submit a quote for 
approval. 

Approve a quote. Approver  The designated 
approver views, and 
approves or rejects 
submitted job quotes. 

 You cannot edit an 
approved quote unless 
you reopen the quote. 

Reopen a quote. Project Manager  Reopen a quote, if 
needed. 

Print a quote, draft quote, or 
order confirmation. 

Project manager, or any 
employee with requisite 
permissions 

 You can print your job 
quotes and order 
confirmations. 

Delete and restore quote 
revisions. 

Project Manager  You can delete quote 
revisions and restore 
the versions, if needed. 

 Prior to restoration, 
reopen the approved or 
deleted quote. 

Setup Instructions 

For users with the requisite access rights, the Quotes workspace is available by default. 

Credit Control Follow-Up 
Deltek Tracking: 1065613 

This feature introduces support for credit control in iAccess. Credit Control concerns following up on 
outstanding customer payments and is typically managed by A/R. However, sometimes the project 
manager or account manager may be involved in the credit control process. Since these roles primarily 
use iAccess, this feature ensures that these roles can manage their part of the credit control in iAccess. 

We've introduced two methods for credit control: 

1. Standard Credit Control functionality based on event flows  

2. Credit control based on the new Conversation functionality with A/R Review Comments. 

3. New Collections workspace to support the functionality. 

Note: Additionally, a the Cash Collection notification is added to iAccess.  
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Changes to Maconomy 

 A new field Credit Control Event Flow No. is added to Show All Invoices in order to provide 
a foreign key to eventflow. 

 A new action Create Credit Control Event Flow is added to Show All Invoices. 

 A new Collections workspace supports the functionality. 

Standard Credit Control Based on Event Flows 

The typical workflow for credit control follows:  

 The A/R responsible starts an event flow in Workspace Client for an unpaid customer invoice.  

 The A/R person may need an action from the project manager (or account manager/another 
person) and therefore creates an event in the event flow for follow-up by the project manager. 

 The project manager receives a notification about the event. When opening the notification the 
project manager is brought to the event where he can describe the action he took and close the 
event. 

Cash Collection Activity Notification 

The standard notification, Cash Collection Activity, has been added to iAccess to inform users about open 
cash collection events that are assigned to them. 

It is triggered when:  

 A cash collection event is open on or before the planning starting date specified on the event.  

 An event follow-up date is either on the current date or in the past.  

This notification in turn triggers the Collection Activity notification. The Collection Activity notification is 
received by the following users:  

 The employee assigned to the event. The user will be sent to the new Collections workspace. 

A/R Review Comments 

In addition to the standard credit control functionality, the Conversations feature has been added to the 
new Collections workspace to provide an additional way to communicate about unpaid customer invoices 
(or to have a conversation about any invoice). 

The conversation appears as a second tab in the workspace. 

Any unread conversation will appear in the Conversations Center (standard conversation functionality). 

Collections Workspace 

A new Collections workspace (Customers » Collections) shows all invoices to which a user has access. 
If a Cash Collection workflow has been created for the invoice, a tab Invoice displays with the cash 
collection events. 

Invoice Tab—This tab shows all invoices/credit memos to which the user has access to (Job 
Cost/Sales/Subscription Order invoices/Credit Memos). 

Embedded BPM Reports in iAccess Workspaces 
Deltek Tracking: 1068610, 966794, 1142763 
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BPM reports are now better integrated into the iAccess interface. If you click a report name in the menu, 
iAccess opens the workspace for that report and displays the report as an embedded web page. Each 
workspace still features a configurable link that you can click to run the report and open it in a separate 
browser tab.  

Note that some links in iAccess reports still link to workspaces in the Workspace Client. 

Changes to iAccess 

To support this enhancement, all reports are now standalone workspaces that are listed in the menu, or 
under submenus. Specifically: 

 The Reports tab of the Job Home workspace is now a submenu (Jobs » Jobs » Reports) that 
lists the following new report workspaces:  

o WIP Aging 

o Profitability Budget 

o A/R Transactions 

 The Job Reports workspace previously found under the Reporting menu section is now a 
submenu under the Jobs menu section. It lists the following new report workspaces: 

o Job Profitability Summary 

o Job Profitability Budget 

o Job Profitability Budget, by Task 

o Job Profitability Comparison 

o Job Profitability Periodic 

o Job Profitability Transactions 

o Job Budget to Actuals YTD 

o Job Budget to Actuals, by Task 

o Job Status, by Task & Employee 

o WIP Aging 

o Revenue Analysis 

 The Customer Reports workspace under the Customers menu section is now a submenu that 
lists the following new report workspaces: 

o A/R Aging 

o A/R Transactions 

o Customer Invoices 

o Customer Profitability 

o Customer Statement 

o WIP Aging by Dimension 

 The Reports menu section is now called Reporting. 

 BI Launch Pad is now a standalone report workspace under the Reporting menu section. 

 The Management Reports workspace is now a submenu under the Reporting menu section. 
It lists the following new report workspaces: 
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o Utilization, by Employee  

o Realization, by Employee 

o Realization, by Account Manager 

o Job Profitability Summary, by Job  

o Customer Profitability, by Customer 

o Profit and Loss 

o Profit and Loss, by Dimension 

o A/R Aging 

 The Reports workspace previously found under the Self Service menu section is now the 
Employee Reports submenu found under the Human Resources menu section. This new 
submenu lists the following new report workspaces:  

o Employee Time Overview 

o Utilization 

o Realization 

 

Invoice History Enhancements 
Deltek Tracking: 586355, 1209696 

Tracking the remaining balances of your job invoices is now available in iAccess. This functionality 
introduces the Remainder field and the Partially Reconciled payment status to enable you to easily 
determine partial payments made to your invoices.  

The Partially Reconciled status is color-coded either yellow or red. The status is yellow if there are 
payments made but the invoice is not yet due, whereas red indicates partially paid invoices that are due. 

Changes to iAccess 

The Remainder field and the Partially Reconciled payment status are available in the following 
workspaces: 

 Invoice on Account 

 WIP Invoice 

 Job Invoices 

 Customers 

 Customer Invoicing 

 Collections 

Note: These reports are no longer meant for the use of the individual employee, but are now 
intended for Human Resource personnel, People Managers, and the like. Thus, the reports 
have been moved to the Human Resources menu section, and they no longer display with 
the employee number prefilled. 

Companies who wish to allow their individual employees access to these reports will have to 
customize their installation so that the reports are moved back to the Self Service menu 
section; they will also have to enable the employee number prompt. 
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Setup Instructions 

There are no changes to setup for this enhancement. 

Touch 

Updated Icon in the App Store 
Deltek Tracking: 1209758 

The color of the Touch iOS application icon that displays in the Apple App Store has been updated to 
use dark lavender. In the previous release, the icon used blue, which was similar to that of the other 
Deltek mobile applications.  

 

String Object Type for System Numbers 
Deltek Tracking: 1189200 

The object type for system numbers has been changed to String from Integer to support a higher range of 
system numbers, on which many Maconomy fields are based. If you are using extensions in Touch 
(especially based on the MScript Web service), this update may affect several screens, such as 
Purchase Orders, Expense Sheets, Vendor Invoices, and Draft Invoices, among others.  

If you are using extensions, you need to review them to make sure they are not affected. 

Support for Quote Approval in Touch 
Deltek Tracking: 1075354 

Touch now supports approval of job quotes.  

 

Support for Time Entry Check-In and Check-Out Multiple Times Per 
Day 
Deltek Tracking: 1074882 

You can now register and update time check-in and check-out entries several times per day on the 
Timesheet screen. This is useful, for example, when you have urgent personal appointment or breaks 
within your working day. You can only use this feature, however, if the Check-In field for you on the 
Employees tab in Maconomy core is enabled. 

The Summary and Timesheet (for Approval) screens have also been updated with the check in feature. 

Note: The icon color (blue) for Android remains the same. 

Note: For more information, please see Support for Quote Approval in Touch under the Job Quote 
Approval in Maconomy section of this document. 
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Integrations 

Deltek Talent Management Organizational Structure Integration 
Deltek Tracking: 597578 

This enhancement enables you to create and maintain a multi-level organizational structure in 
Maconomy, and to obtain and apply the hierarchy to new hires in Talent Management. 

Prior to this, the organizational information for a Maconomy employee and a Talent Management user 
was limited to the top organizational unit. By utilizing the tree structure functionality in the Reporting 
Structures workspace, you can now select top, intermediate, and bottom organizational levels. The 
Maconomy company will serve as the top level, whereas an Entity dimension will reflect the executing 
department at the bottom. As for intermediate levels, you can select any value. In addition, you can push 
the organizational structure and any subsequent changes from Maconomy to Talent Management. 
Likewise you have the option to apply the structure to new hires and vice versa. 

To facilitate this synchronization, the Reporting Structure Name field and Export Organizational 
Structure action are available in the Talent Management Setup workspace. The former allows you to 
select an existing reporting structure in Maconomy while the latter creates a background task that exports 
the selected organizational structure to Talent Management.  

With this integration you can set up and maintain your organizational structure primarily in Maconomy. 

Changes to Maconomy 

The following workspaces are updated: 

 Talent Management Setup workspace 

 Talent Management Integration Setup single dialog workspace 

Procedures 

Export Organizational Structure 

When you have created your organizational structure in Maconomy, you can export the organizational 
information to Talent Management. 

 

To export the organizational structure: 

1. Go to Set-up » Talent Management Setup. 

2. Select an existing reporting structure from the Reporting Structure Name field. The selected 
structure must be an Entity type. 

3. Click the Save Talent Management Integration Setup icon. 

4. Click the Export Organizational Structure action to create a background task that will export the 
organizational structure. 

5. View the exported organizational structure of the Talent Management user under the Position 
Information section. 

Note: Updates to the organizational structure will only reflect on a Maconomy employee connected to 
a Talent Management user. 
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Setup Instructions 

Enable Deltek Talent Management Integration 

To enable this feature: 

1. Go to Setup » System Setup » Parameters and Numbers » System Parameters. 

2. Double-click the Enable Standard Extensions parameter. 

3. On the System Parameter sub-tab, select the Enable Deltek Talent Management Integration 
parameter. Enable the integration for all companies referenced in the organizational structure. 

Create Organizational Structures 

The Reporting Structures workspace allows you to create a hierarchical structure through its tree table 
functionality. 

 

To create the organizational structure: 

1. Go to Set-up » Reporting » Reporting Structures » Reporting Structure Lines. 

2. Create a new reporting structure with an Entity type. 

3. Add reporting structure lines to reflect the organizational structure that you want to export to 
Talent Management. 

In the Classification field, add company numbers as top organizational levels and assign each 
number only once. The bottom organization levels must be entity dimensions and have no label 
restrictions. These are not specific to a company and you can use the entity dimensions multiple 
times. For example, you can add the same department name for companies 1 and 2. 

As for intermediate levels, you must enter free texts in the Description field and place these in 
the hierarchy using the Grouping or Indentation on the line. 

People Planner Integration  
Deltek Tracking: 1132123 

Updated Namespace Value for People Planner 

Deltek Tracking: 1135203 

The Web Service API Namespace API system parameter is updated with a new default value: 
http://peopleplanner.deltek.com/api.  

The value in this parameter is used when logging in to the People Planner API.  

Note: Not all fields on the Reporting Structures workspace are used for the Talent Management 
integration. For example, the Periodic field is a generic field for Reporting Structures but does not 
apply to an organizational structure. 

http://peopleplanner.deltek.com/api
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System Admin 

Improved Data Imports 
Deltek Tracking: 1035212, 934690 

 A new Data Import Packages workspace streamlines the administration around importing multiple 
imports, assists in the managing of import data, offers a new level of validation and offers more 
intuitive insight into import status and error handling. 

 Import performance: Use TDH/DbDesc instead of database lookup – The execution of running 
imports via the new Data Import Packages workspace has been optimized to improve the time 
taken to import data. (1079489) 

System Parameter for Import Programs 
The Use Internal Names in Import Dialogs system parameter is introduced to enable Maconomy to 
automatically include internal names in import criteria as a default setting when you open any import 
dialog box. This system parameter is enabled by default when you upgrade to 2.4.5, but can be disabled 
in the System Setup. 

Note: See the Deltek Maconomy 2.5 System Admin Guide for details.  

APM Template Dashboards 
Deltek Tracking: 1126447 

The Application Performance Monitor (APM) is a logging framework designed to serve several different 
monitoring purposes: 

1. Audit logging of all user logins 

2. High-level activity logging of incoming requests 

3. Detailed drill-down logging of long-running requests 

Note: See the Deltek Maconomy Application Performance Monitor guide for more details.  

With 2.5, we release template dashboards built using Splunk, a third-party vendor, to help you view 
logging data in a graphical format. 

Performance Improvements 
Notifications Recalculation Optimization 

Deltek Tracking: 1062532 

There is a significant performance improvement for the recalculation of notifications due to a new 
collective query that functions by user role.   

Switch Off Legacy Lifestyle Functionality  

Deltek Tracking: 1187732 

 A setting is introduced to switch off legacy lifecycle functionality, and avoid database operations 
caused by legacy lifecycle functionality. 
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Technology Enhancements 
Deltek Tracking: 1132196 

 Import Program for Import Packages – Allows for ability to upload files and create package 
lines and structure. 

Time and Date Formats in Exported Data 

Deltek Tracking: 1036774 

Prior to this release, when you exported data from the Workspace Client to Microsoft Excel containing 

time and date information, the dates were saved as yyyy-mm-dd and times were saved as H:mm, which 

is the standard Maconomy format. This enhancement enables you to export this data either the 
Maconomy standard format mentioned above, or in the format speciffied by your operating system 
settings. 

By default, this data is exported in the operating system format. The DateTimeExportFormat parameter is 
added to the ExportDataSet action in the GlobalDefinitions.mdml.xml file to allow you to change the 
setting. To change the export date format to the Maconomy standard format, you must set the parameter 
value to MaconomyStandard in the GlobalDefinitions file. 

Multiple Fonts Support 

Deltek Tracking: 591777 

You can now specify a list of fonts to use for rendering text in MPL. For each character in the text, an 
appropriate font supporting it is selected from the list. Previously, unsupported characters would be 
ignored by the system and thus, printed as blank. 

This feature also supports a fallback font. For characters with no suitable font installed to render them, 
they will be rendered with a font to obviously show that there is some additional font configuration 
required, as opposed to before where they would simply be left blank in the print. 

fontname attribute 

The fontname attribute describing the font(s) to be used now supports both a single STRING value as 

well as a LIST of STRING value. For example, given that JhengHei and Leelawade fonts have been 
configured to be used in Maconomy, (for Simplified Chinese and Thai accordingly), fonts are now 
specified in the following manner. 

Current functionality: "你好，世界 สวัสดีเพื่อนของฉัน hello":fontname="Helvetica"  

New functionality: "你好，世界 สวัสดีเพื่อนของฉัน hello":fontname=["Helvetica", "JhengHei", 
“Leelawade"]  

Because the fontname attribute can now take a list of fonts, an appropriate font is used for each 

character. In this example, Helvetica is used to print “hello”, JhengHei to print 你好，世界, and 

Leelawade to print สวัสดีเพื่อนของฉัน. Altogether, the text is printed as follows: 

 

The new list format can be used in any place where the fontname attribute is expected, for example, in 

the default tag: 

<default tag=text attribute=fontname value=["Helvetica", "JhengHei", “Leelawade"]> 

<default tag=eval attribute=fontname value=["Helvetica", "JhengHei", “Leelawade"]> 
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Default Font 

A default font to use system-wise for Maconomy prints can be specified in the 
Definitions/MaconomyCustom.ini file by editing the DefaultFont setting under the MPLConfig section. For 
example: 

[MPLConfig] 

DefaultFont=HelveticaUni 

As of Maconomy 2.5, the default font can be a comma separated list as well, for example: 

[MPLConfig] 

DefaultFont= HelveticaUni, JhengHei, Leelawade 

Specifying the default font to be a list of fonts allows Maconomy to support printing in multiple languages 
without having to customize your MPL layouts. 

 

Last Resort Font 

It is now possible to also configure a last resort font to be used when no other configured fonts support a 
given character. For example, if the Unicode Last Resort font 

(https://unicode.org/policies/lastresortfont_eula.html) is used as the last resort font in Maconomy, this 

text: 

"你好，世界 สวสัดเีพือ่นของฉัน hello":fontname="Helvetica" 

will be printed in the following way: 

 

Previously, only the word “hello” would show in reports. The other characters were printed as blank. 

Maconomy 2.5 pre-packages the Unicode Last Resort font in the TPU as 
FontSupport\fonts\LastResort.ttf. To use it, you must: 

6. Specify it in the FontSupport\FontFileMap.lst file as a tab separated entry: 

LastResort   LastResort.ttf 

7. Add it to the FontSupport\FontAttributeMap.lst file, also as a tab separated entry: 

LastResort        LastResort 

8. Configure the LastResortFont setting in the Definitions\MaconomyCustom.ini file 
[MPLConfig] 

LastResortFont=LastResort    

For more information about this feature, refer to the Deltek Maconomy System Administration Guide and 
Deltek Maconomy Language Reference Guide. 

Note: Remember to recompile your prints after changing the default fonts by running 
MaconomyServer –UP, –UEP, and –UIP commands, for example: 

MaconomyServer.w_20_0.cmd -Sw200 –UP    // re-compiles standard layouts 

MaconomyServer.w_20_0.cmd -Sw200 –UEP   // exports custom layouts 

MaconomyServer.w_20_0.cmd -Sw200 –UIP   // re-imports (re-compiles) custom layouts 

https://unicode.org/policies/lastresortfont_eula.html
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Install and Upgrade Enhancements 
Deltek Tracking: 1132199 

Updated Message 

Deltek Tracking: 996355 

The message issued when User Account is blocked to support Reset Password is updated. 

MConfig “No Output” Option 

Deltek Tracking: 783416 

When running MConfig from a command line with a script, it is now possible to add an option  
"—nooutput." This prevents MConfig from asking for information missing in the script and fail instead.  

For example: 

MConfig --nooutput MyScript.msc 

People Planner REST URL 

Deltek Tracking: 1062525 

Mconfig is extended to include a People Planner REST API URL for iAccess. 

Disaster Recovery Configuration 

Deltek Tracking: 1178503 

Mconfig now supports a disaster recovery server configuration. 

Extension Framework Enhancements 
Deltek Tracking: 1132192 

 Automatic Read Enabled in Container-Executor Operations – Reads are now automatically 
invoked whenever a data container is queried. Previously, it was in some cases necessary to 
explicitly read before querying it. This enhancement introduces a reread() method that you can 
utilize for cases where an explicit re-read of a container is necessary due to the side effects in 
other container-executors. See the Migration Guideline in the Extension Framework 
Programmer's Guide for details. (1027580) 

 Namespace Annotation for Java Extensions – Namespaces are now defined differently. With 
this enhancement, it is easier to declare constants that include the namespace. The Extension 
Framework Programmer’s Guide highlights how to migrate from the old deprecated way of 
defining namespaces to the new way. (1027580) 

 Ability to Develop iAccess against local coupling service (1128255) 

 Deprecating iAccess FPU import wizard (1186303) 

Workspace Client Platform & Usability Enhancements 
Deltek Tracking: 947517 
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Default Communication Protocol for Workspace Client  

Deltek Tracking: 1180507 

Maconomy 2.5 now uses Mux-RMI as the default communication protocol between the Workspace Client 
and the Coupling Service. 

This particularly benefits users that access Maconomy from the internet, rather than through the local 
company network. Benefits include shorter connect time, fewer network errors, and better load balancing 
and fail-over characteristics. 

For network administrators, the new protocol means that session stickiness is no longer required for the 
Workspace Client to work reliably on load balanced Maconomy installations. 
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Appendix A – Field Descriptions 
This section lists fields and descriptions for 2.5.1 features. 

Synchronous Approval Notification Enhancements Fields / 
Descriptions 
Single Dialogs » Set-Up » Set-Up » Selection Criterion Specification » Selection Criterion 
Specification  

Field Description 

Validated This field shows if the selection criterion 

specification has been validated successfully 

when you use the Validate action. 

 

Action Description 

Validate Use this action to validate the selection 
criterion specification.  

Export Statement Use this action to create a file with the saved 
SQL-statements. 

Single Dialogs » Set-Up » Set-Up » Selection Criterion Statements » Selection Criteria Statement 
Section 

Selection Criterion Statement Section island 

Field Description 

Selection Criterion Specification No. This field shows the identification number of 
the current selection criterion specification. 

Type This field shows the type of the current 
selection criterion specification. 

Section No. This field shows the section number of the 
current selection criterion specification. 
Maconomy creates one section for each 
group of lines separated by the outer logical 
operation “OR”. 

Line No. This field shows the interval of line numbers 
from the selection criterion specification 
tables covered by the selection criterion 
statement section. 
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Field Description 

Internal Relation Name This field shows the internal relation name of 
the primary relation. 

Relation Alias This field shows the relation alias of the 
primary relation. 

Joins island 

Field Description 

Join 1-10 This field shows the internal relation name 
and the relation alias for the join relation. 

Fixed Condition, Join 1-10 This field shows the fixed condition of the join 
to the join relation. 

Single Dialogs » Set-Up » Set-Up » Selection Criterion Statements » Selection Criteria Statement 
Section » Selection Criteria Statement Lines 

Field Description 

Line No. This field shows the line number. Maconomy 
sorts the SQL-statements by line number. 

SQL Sub Expression This field shows the SQL sub expression. 

Single Dialogs » Set-Up » Set-Up » Selection Criterion Statement Lines » Selection Criteria 
Statement Line  

Selection Criterion Statement Section island 

Field Description 

Selection Criterion Specification No. This field shows the identification number of 
the selection criterion specification. 

Type This field shows the type of the selection 
criterion specification. 

Section No. This field shows the section number. 
Maconomy creates one section for each 
group of lines separated by the outer logical 
operation “OR”. 

Line No. This field shows the line number. Maconomy 
sorts the SQL-statements by line number. 

Statement island 
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Field Description 

SQL Sub Expression This field shows the SQL sub expression. 

Setup » Approval Hierarchies Setup » Approval Hierarchy Rules » Notifications after Create  

Setup » Approval Hierarchies Setup» Approval Hierarchy Rules » Notifications after Reject  

Setup » Approval Hierarchies Setup» Approval Hierarchy Rules » Notifications after Approval  

Field Description 

From Company No. Select the starting company number of the 
approval objects to which the approval 
hierarchy rules apply.  

To Company No. Select the ending company number of the 
approval objects to which the approval 
hierarchy rules apply. 

Selection Criterion Specification No. Specify a selection criterion specification. The 

current line is only used, if the approval 

object in question meets the requirements 

specified on the selection criterion 

specification. 

Notification Reference Select the notification reference from the 
drop-down list. It can be a named employee 
specified in the Employee No. field, the 
submitter, or a user or an employee derived 
from the reference specification. 

Employee No. Enter the employee number of the receiver of 
the notification. This field is only used if you 
select Employee in the Notification 
Reference field.  

User Reference Select the checkbox to derive the employee 

number from the user. This field is only used 

if you select Reference in the Notification 

Reference field. 

If you select this field, Maconomy assumes 

that the derived value is a user. It then 

assumes that the derived value is an 

employee if you do not select this field.  

Reference, Employee Select the employee reference, for example, 
supervisor. This field is mandatory if the 
Notification Reference is Submitter or 
Reference. 
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Field Description 

The notification can be assigned either to the 
derived employee, or for one of the reference 
employees specified on the employee. 

Reference Relation 1 Select the relation of the reference for the 
current approval object. This field is 
mandatory if the Notification Reference is 
Reference.  

The receiver of the notification can be derived 
from one of the pre-defined table linked to the 
approval object. 

Reference Relation 2 to 5 Select the relation of the reference for the 
current approval object. The receiver of the 
notification can be derived from one of the 
pre-defined table linked to reference relation 
1 to 4. 

Target Internal Relation Name This field shows the target internal relation 

name and field where the system derives the 

receiver of the notification. The target internal 

relation name is a closed field. 

It is initialized to the internal relation name for 
the approval type. You can select a reference 
relation, and Maconomy uses the reference 
relation as the target relation.  

Target Internal Field Name Select a text field from this field. Maconomy 

derives the receiver of the notification from 

the Target Internal Relation Name and 

Target Internal Field Name fields. 

Notification Type Select the notification type. Maconomy 

creates a notification of this type, for the 

derived user(s), if the approval object belongs 

to the entered restrictions. 

You can select a synchronous notification 
type in this field.  

Approval Action This field shows the approval action of the 
current line. The possible approval actions 
are: 

 Approve 

 Reject 

 Create 
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Field Description 

The line is created and maintained in the 
corresponding Approval Notifications after 
Create, Approval Notifications after Approval, 
and Approval Notifications after Reject single 
dialogs. 

Approval Relation This field shows the relation used in 
connection with the type of registration. The 
available values as standard are Purchase 
Order, Purchase Order Line, Expense Sheet, 
Expense Sheet Line, Vendor Invoice, and 
Invoice Allocation Line. 

Approval Type This field shows the type of approval that the 
approval object relates to: Purchase Orders, 
Expense Sheets, or Vendor Invoices. 

Instance Key This field shows the line’s unique identifiable 
key in the Maconomy database. 

Internal Relation Name 1 to 5 These fields display the internal names of a 
Maconomy database relation. 

The relation must correspond to the internal 
relation name to which it is linked. 

Line No. This field shows the current line’s number in 
the sequence of lines. The lines are 
numbered consecutively in the order of their 
creation. 

Selection Criterion Specification Type This field shows the selection criterion 
specification type. 

Transaction Timestamp This field shows the date and time of the last 
change.  

Action 

Action Description 

Add New Selection Criteria Specification Use this action to create a new selection 
criteria specification and assign the 
specification to the current line. 

Set-Up » Notifications » Setup » Types » Type  

Category Island  
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Field Description 

Notifications can be closed Select the checkbox to specify if the 

notification can be closed by default.  

A notification can only be closed, if the 

notification type allows this. Maconomy uses 

this value as the default, when you create a 

new notification type. 

 

Descriptions Island 

Field Description 

Description 1-10, Title Enter a title for the new description fields. 

The description title displays on the 

notification. 

 

Action 

Action Description 

Rederive Notification Values Use this action if to derive all values such as 
arguments, waypoints, targets, and 
descriptions on all existing non-closed 
notifications of the current type. 

 

Set-Up » Notifications » Setup » Categories » Category  

Notification Category Island  

Field Description 

Notifications can be closed, Default Select the checkbox to specify if the 

notification can be closed by default.  

A notification can only be closed, if the 

notification type allows this. Maconomy uses 

this value as the default, when you create a 

new notification type. 

 

Set-Up » Notifications » Notifications » User Notifications » Notifications » Notification » Type 

Category Island  
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Field Description 

Notifications can be closed Select the checkbox to specify if the 

notification can be closed by default.  

A notification can only be closed, if the 

notification type allows this. Maconomy uses 

this value as the default, when you create a 

new notification type. 

Set-Up » Notifications » Notifications » Notifications » Notification » Type 

Category Island  

Field Description 

Notifications can be closed Select the checkbox to specify if the 

notification can be closed by default.  

A notification can only be closed, if the 

notification type allows this. Maconomy uses 

this value as the default, when you create a 

new notification type. 

Set-Up » Notifications » Notifications » User Notifications » Notifications  

Set-Up » Notifications » Notifications » Notifications  

Field Description 

Description 1-10 These fields show information related to the 
approval object. The information is derived 
when Maconomy creates the notification, and 
the specific information depends on the 
notification type setup. 

 

Set-Up » Notifications » Notifications » User Notifications » Notifications » Notification 

Set-Up » Notifications » Notifications » Notifications » Notification 

Show as Island 

Field Description 

Closed By This field shows the user who closed the 
notification. 

Closed Date This field shows the date the user closed the 

notification. 
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Field Description 

Closed Time This field shows the time the user closed the 

notification. 

Actions 

Action Description 

Close Notification Use this action to close the notification. This 
action marks the Closed field, and sets the 
values in the Closed By, Closed Date, and 
Closed Time fields. 

Reopen Notification Use this action to reopen the closed 
notification. This action automatically 
unmarks the Closed field, and resets the 
values in the Closed By, Closed Date, and 
Closed Time fields. 

Set-Up » Notifications » Setup » Types 

Actions 

Action Description 

+New Notification Type Use this action to add a new notification type. 

Import Use this action to import the notification data. 

New Fields for Flexible Statutory Reporting Fields / 
Descriptions 
Setup » Documents and Notes » Supplements » Supplement Types  

Amounts Island 

Field Description 

Amount 1-15 Enter the titles to assign to the Amount fields 
with Amount 1 to 15 names. 

Setup » Documents and Notes » Supplements » Supplements 

Amount Island 

Field Description 

Amount 1-15 Enter information related to the titles 
assigned to the Amount fields. 
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Field Description 

Amount 1-15 Currency Specify the currency for Amount 1 to 15. The 
fields are optional. 

Note: The Amount 1 – 15 Currency fields 
do not have corresponding field names in 
Supplement Types single dialog workspace. 
The fields display together with the amount in 
a unit field. 

General Ledger » Companies » Home » Information 

Supplement Island 

Field Description 

Company Supplement Enter the company supplement to use in the 
company. 

BPM Enter the BPM supplement to use in the 
company. 

General Ledger » Companies » Home » Information » Company Supplement 

General Ledger » Companies » Home » Information » BPM 

Supplement Island  

Field Description 

Supplement Type Enter the name of the supplement type.  

Name Enter the name of the supplement to identify 
and reference the set of fields. The name 
must be unique. 

Description Enter a description of the information stored 
in the Supplements. 

Area This field shows the value directly inherited 
from Supplement Types single dialog 
workspace. The field is closed for editing. 

Texts Island 

Field Description 

Text 1-30 Enter information related to the titles 
assigned to the free Text fields. 

User Island 
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Field Description 

Created This field shows the date and name of the 
user who created the supplement. 

Changed This field shows the date and name of the 
user who recently made changes to the 
supplement. 

Version This field shows the latest version number of 
the supplement. The number is incremented 
by one each time a change is made to the 
supplement. 

Boolean Island 

Field Description 

Boolean 1-10 Enter information related to the titles 
assigned to the Boolean fields. 

Date Island 

Field Description 

Date 1-10 Enter information related to the titles 
assigned to the Date fields. 

Access Level Island 

Field Description 

Access Level Description Enter the description of the access level 
required to access the supplement. 

Access Level Name Enter the name of the access level required 
to access the supplement. 

Amount Island 

Field Description 

Amount 1-15 Enter information related to the titles 
assigned to the Amount fields. 

Amount 1-15 Currency Specify the currency for Amount 1 to 15. The 
fields are optional. 

Note: The Amount 1 – 15 Currency fields 
do not have corresponding field names in 
Supplement Types single dialog workspace. 
The fields display together with the amount in 
a unit field. 
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Integer Island 

Field Description 

Integer 1-5 Enter information related to the titles 
assigned to the Integer fields. 

Real Island 

Field Description 

Real 1-5 Enter information related to the titles 
assigned to the Real fields. 

Exclude Compensation Types and Agreements from Total 
Base Salary Fields / Descriptions 
Human Resources » Employees » Setup » Compensation Models » Compensation Types  

Human Resources » Employees » Setup » Compensation Models » Compensation Types » 

Compensation Type » Compensation Types 

Human Resources » Employees » Setup » Compensation Models » Compensation Types » 

Compensation Type  

Calculation island 

Field Description 

Incl. in Gross Pay Calculation The Incl. in Gross Pay field is renamed to 
Incl. in Gross Pay Calculation. 

Select this field to specify if the compensation 
type should contribute to the gross pay 
calculation. 

Incl. in Base Salary Calculation The Incl. in Base Salary field is renamed to 
Incl. in Base Salary Calculation. 

Select this field to specify if the compensation 
type should contribute to the base salary 
calculation. 

Incl. Result in Total Base Salary Select this field to specify if the compensation 
type should contribute to the total base salary 
result and base salary rate when doing base 
salary calculations. Note that you can only 
enable this field if you also enabled the Incl. 
in Base Salary Calculation field. 

Human Resources » Employees » Employees » Employees » Compensation Agreements 
Compensation Agreements 
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Field Description 

Incl. in Gross Pay Calculation The Incl. in Gross Pay field is renamed to 
Incl. in Gross Pay Calculation. 

Select this field to specify if the compensation 
agreement should contribute to the gross pay 
calculation. 

Incl. in Base Salary Calculation The Incl. in Base Salary field is renamed to 
Incl. in Base Salary Calculation. 

Select this field to specify if the compensation 
agreement should contribute to the base 
salary calculation. 

Incl. Result in Total Base Salary Select this field to specify if the compensation 
agreement should contribute to the total base 
salary result and base salary rate when doing 
base salary calculations. Note that you can 
only enable this field if you also enabled the 
Incl. in Base Salary Calculation field. 

Human Resources » Base Salary Rate Calculations » Calculation » Base Salary Rates » Base 

Salary Rate Header » Base Salary Rate Line 

Field Description 

Incl. Result in Total Base Salary This field shows if the base salary rate line 
contributes to the total base salary and base 
salary rate. 

Human Resources » Base Salary Rate Calculations » Calculation » Base Salary Rate Details » 

Base Salary Rate Line 

Agreement island 

Field Description 

Incl. Result in Total Base Salary This field shows if the base salary rate line 
contributes to the total base salary and base 
salary rate. 

New Fields in Option Lists and Popup Fields Fields / 
Description 
System Setup » Parameters and Numbers » Option Lists » Option List » Options 

The fields do not display by default. Use the Customize Columns wizard for the fields to display. 
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Field Description 

Amount 1-5 Enter amounts related to the current option 
list. 

Boolean 1-5 Select the checkbox to assign attributes to 
the current option list. 

Date 1-5 Enter or select a number of dates related to 
the current option list.  

Integer 1-5 Enter integer information related to the 
current option list. 

Real 1-5 Enter information related to the current option 
list in the form of real numbers, that is, 
decimal numbers. 

String 1-5 Enter string values related to the current 
option list. 

Time 1-5 Enter certain key times related to the current 
option list. 

System Setup » Parameters and Numbers » Popup Fields » Popup Field » Values 

The fields do not display by default. Use the Customize Columns wizard for the fields to display. 

Field Description 

Date 1-4 Enter or select a number of dates related to 
the current popup field. 

Time 1-4 Enter certain key times related to the current 
popup field. 

Document Archiving Enhancements Fields / Descriptions 
Accounts Receivable » Customer Payments » History » Customer Payment  

Document Archive Island  

Field Description 

Document Archive No. This field shows the number of the document 
archive assigned to the customer payment. 

Document Count This field shows the number of documents in 
the document archive assigned to the 
customer payment.  
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Field Description 

Document Name This field shows the name of the document 
assigned to the customer payment. 

Accounts Receivable » Customer Payments » Payment » Journal 

Accounts Receivable » Customer Payments » Payment » Journal » Customer Payments 

Customer Payment Action 

Action Description 

Attach Document Use this action to attach a document to the 
customer payment. The action is only 
available if you have not submitted or posted 
the customer payment. 

View Document Use this action to show the document 
attached to the customer payment.  

If you use this action and there is no 
document attached to the customer payment, 
Maconomy displays an error message. 

Expected Revenue Added as Opportunity Value to Jobs Fields 
/ Descriptions 
Jobs » Jobs » Home » Subjobs 

Price island 

Field Description 

Expected Revenue Incl. Subjobs This field shows the total expected revenue 

price, which is the sum of the expected 

revenues of all main jobs, and subjobs.  

The expected revenue is calculated in the 

currency of the main job based on the 

exchange rate, and depends on the following 

type of main jobs: 

 Fixed Price – The expected revenue 
for the job is the sum of the fixed 
price, and the sales from the working 
budget. The fixed price is derived 
from the attributes of the Pricing 
Principle job parameter, which are 
determined either through the job 
budget type, or the job quote. 
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Field Description 

 Time & Material, no cap – The 
expected revenue for the job is the 
total sales price from the most recent 
approved version of the planned 
budget. 

 Time & Material, with a cap – The 
expected revenue for the job is the 
sum of the lowest fixed price value, 
and the total sales price from the 
most recent approved version of the 
planned budget. 

 Time & Material, with revenue 
recognition – The expected revenue 
for the job is calculated similar to the 
expected revenue for fixed price jobs. 

The expected revenue for the main job is 
updated when the expected revenue of a 
linked subjob is changed.  

 

This section lists fields and descriptions for 2.5 features. 

Document Archive for Draft Invoices Fields / Descriptions 
Jobs » Jobs » Invoicing » Draft Invoices » Invoice Editing  

Single Dialogs » Job Cost » Invoicing » Invoice Editing » Invoice Editing 

Document Archive island 

Field Description 

Document Archive This field shows the archive number of the 
attached document 

Document Count This field shows the number of documents in 
the Document Archive. 

 

Action Description 

Attach Document Use this action to attach a document to the 
current invoice. For example, this could be a 
scanned receipt which serves as 
documentation for the invoice. 
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Action Description 

Delete Document Use this action to delete the current 
document from the invoice’s document 
archive. 

If a document archive is assigned to the 
invoice edit being removed, it remains 
assigned to the now saved previous edit. 

Restore Editing Use this action to restore a previous edit of 
the invoice.  

If the previous edit has a document archive, it 
is assigned to the current edit. 

Restore Editing, Summary Use this action to restore a previous edit of 
the invoice.  

If the previous edit has a document archive, it 
is assigned to the current edit. 

Restore Editing from Invoice Use this action to copy an invoice edit from a 
printed invoice.  

If the copied edit has a document archive, it 
is not reassigned or copied to the current 
invoice edit. 

Print Invoice Use this action to print the invoice.  

When you print an invoice that has a 
document archive, it is reassigned to the 
finalized invoice. 

Jobs » Blanket Invoicing » Invoice Selection » Draft Invoices » Invoice Editing 

Single Dialogs » Job Cost » Invoicing » Blanket Invoice Selection » Blanket Invoice Collection 

Action Description 

Remove Approval Use this action to remove approval of a draft 
invoice. When removed, the draft is saved as 
a previous edit. 

The document archive for the previous edit is 
no longer attached to any invoice, but 
continues to exist in the Documents and 
Notes workspace. 

Print Invoice Use this action to print the invoice.  

When you print an invoice that has a 
document archive, it is reassigned to the 
finalized invoice. 

Jobs » Blanket Invoicing » Invoice Editing » Invoice Editing » Documents 
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Action Description 

Delete Use this action to remove the blanket invoice 
draft invoice edit as a whole. Job specific 
lines are saved as previous edits on each job 
separately. For deleted blanket draft invoices, 
the document archive is not saved to any 
previous edit and thus cannot be restored. 
However, the document archive remains 
accessible in the Documents and Notes 
workspace. 

Restore Editing Use this action to restore previous edits from 
jobs now involved in the blanket invoicing as 
a current invoice edit. Unlike ordinary invoice 
edits, the document archive for a previous 
blanket draft invoice edit is not restored to the 
invoice editing view. 

Restore Editing, Summary Use this action to restore previous edits from 
jobs now involved in the blanket invoicing as 
a current invoice edit. Unlike ordinary invoice 
edits, the document archive for a previous 
blanket draft invoice edit is not restored to the 
invoice editing view. 

Jobs » Jobs » Invoicing » Invoice Selection 

Single Dialogs » Job Cost » Invoicing » Invoice Selection » Invoice Selection  

Action Description 

Remove Latest Draft Use this action to remove the current draft 
invoice and save it as a previous edit. 

If the draft invoices has a document archive, 
it remains attached to the previous edit. 
unless the invoice is a blanket invoice. 

The previous edit overwrites any existing 
previous edits. Any document archive for the 
deleted previous edit is no longer attached to 
any invoice, but continues to exist in the 
Documents and Notes workspace. 

Remove All Drafts Use this action to remove the current draft 
invoice and save it as a previous edit.  

If the draft invoice has a document archive, it 
remains attached to the previous edit, unless 
the invoice is a blanket invoice. 

The previous edit overwrites any existing 
previous edits. Any document archive for the 
deleted previous edit is no longer attached to 
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Action Description 

any invoice, but continues to exist in the 
Documents and Notes workspace. 

Print Invoice Use this action to print an invoice. When you 
print an invoice that has a document archive, 
it is reassigned to the finalized invoice. 

Setup » Documents and Notes » Documents » Document Archives 

Single Dialogs » Set-Up » Document Handling » Document Archives single dialog workspace» 
Document Archives » Documents sub-tab 

Action Description 

Delete Document Archive Use this action to delete a document archive. 

An error displays if you delete a document 
archive that is used in an invoice edit, 
previous edit, or an invoice. 

Sales Orders » Sales Orders » Lookup » Invoices 

Single Dialogs » Sales Orders » Lookup » Show Invoice » Show Invoice 

Document Archive island 

Field Description 

Document Archive Number This field shows the archive number of the 
attached document. 

Document Archive Description This field shows the document archive 
description. 

Sales Orders » Sales Orders » Lookup » Credit Memos 

Single Dialogs » Sales Orders » Lookup » Show Credit Memo » Show Credit Memo 

Document Archive island 

Action Description 

Document Archive Number This field shows the archive number of the 
attached document. 

Document Archive Description This field shows the document archive 
description. 

Jobs » Jobs » Invoicing » Invoice History 

Single Dialogs » Job Cost » Invoicing » Job Invoice History » Job Invoice History » Invoices 
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Action Description 

Document Archive Number This field shows the archive number of the 
attached document. 

Document Archive Description This field shows the document archive 
description. 

Single Dialogs » Job Cost » Lookup » Job Invoice Overview » Job Invoice Overview » Job Invoice 
Lines 

Action Description 

Document Archive Number This field shows the archive number of the 
attached document. 

Document Archive Description This field shows the document archive 
description. 

Enhanced Vendor Invoice Allocation Workspace to Support 
Reallocation Fields / Descriptions 
Single Dialog » Accounts Payable » Registration » Invoice Allocation » Invoice Allocation Tab  

Invoice Island 

Field Description 

Reallocation Date This dynamic field shows the date when you 
reallocated the invoice. Maconomy suggests 
the date on which the invoice or credit memo 
was registered, but you can change the date 
manually. Maconomy checks that the date is 
within the open posting period. 

Date Posted This dynamic field shows the date when you 
posted the vendor invoice or credit memo. 
This dynamic field shows only when you post 
the vendor invoices and credit memos. 

Attn. Specify the vendor’s attention person; that is, 
the person to whom shipping and payment 
information is directed. 

Company Island 

Field Description 

Base Currency This field shows the currency used as base 
currency in the company specified in the 
Company No. field. See the Base Currency 
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Field Description 

field in the Company Information single dialog 
workspace in the G/L module for a detailed 
description of the concepts of company base 
currency and enterprise currency. 

Approval Hierarchy Status Island 

Field Description 

Approval Relation This field shows the relation used in 
connection with the type of registration. 

Approval No. This field shows the approval number of the 
vendor invoice or credit memo. The number 
is incremented by one each time you submit 
the vendor invoice or credit memo for 
approval. 

Approval line No. This field shows the approval line number, 
which indicates the current approval level of 
the vendor invoice or credit memo based on 
the order in the current approval hierarchy. 

Approval Status This field shows the approval status of the 
current vendor invoice or credit memo. The 
possible statuses are: 

 Approved 

 Rejected 

 Released 

Approval Status Details This field shows details regarding the latest 
approval status of the current vendor invoice 
or credit memo. 

Header Can Be Approved By Current User This field indicates if the current user can 
approve the header of the vendor invoice or 
credit memo. 

Header Approved Or Rejected By This field shows the user who approved or 
rejected the header of the vendor invoice or 
credit memo. 

Header Approval Or Rejection Date This field shows the date when the user 
approved or rejected the header of the 
vendor invoice or credit memo. 

Header Approval Or Rejection Time This field shows the time when the user 
approved or rejected the header of the 
vendor invoice or credit memo. 
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Field Description 

Header Approval Or Rejection Comment This field shows any comments entered by 
the user related to the approval, release, or 
rejection of the vendor invoice or credit 
memo. 

Workflow Status This field shows the status of the vendor 
invoice or credit memo within a workflow. The 
possible workflow statuses are: 

 Open 

 Closed 

 Submitted 

 Approved 

 Rejected Header 

 Rejected Lines 

Single Dialog » Accounts Payable » Registration » Invoice Allocation » Invoice Allocation Tab » 

Invoice Allocation Lines Sub-Tab 

Field Description 

Local Account No. Specify a local account number when you 
allocate the invoice to a company that uses 
local chart of accounts. 

Approval Hierarchies Refactoring Fields / Descriptions 
Human Resources » Employees » Employees » Employees » Users » User Information » Roles » 
Actions 

Setup » Users » Users » User Information » Actions 

Single Dialog » Set-Up » Access Control » Actions » Actions Tab 

Single Dialog » Set-Up » Access Control » User Action Groups » User Action Group Tab 

Permitted Job/Cost Actions Island 

Field Description 

Submit Job Budgets Select this check box to allow users in the 
selected group to submit job budgets. During 
upgrade, this field uses the value in the 
Change Job Budgets field. 

Permitted A/P Actions Island 
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Field Description 

Submit Purchase Orders Select this check box to allow users in the 
selected group to use the Submit Purchase 
Order action in the Purchase Orders 
workspace. During upgrade, this field is 
selected by default. 

Submit Vendor Invoices The Release Vendor Invoices field is 
renamed to Submit Vendor Invoices. 

Select this check box to allow all users in the 
selected group to release vendor invoices. It 
gives users the ability to submit invoices for 
approval in the Vendor Invoices and Invoice 
Allocation workspaces. 

Approve Vendor Invoices Select this check box to allow all users in the 
selected group to approve vendor invoices for 
posting in the Vendor Invoices and Invoice 
Allocation workspaces. During upgrade, this 
field uses the value in the Submit Vendor 
Invoices field. 

Human Resources » Employees » Employees » Employees » Users » User Information » Roles » Actions 
» Company Specific Actions Sub-Tab 

Setup » Users » Users » User Information » Actions » Company Specific Actions Sub-tab 

Single Dialog » Set-Up » Access Control » Actions » Company Specific Actions Sub-tab 

Field Description 

Submit Purchase Orders Select this check box to enable the user role to submit 
purchase orders. 

Approve Vendor Invoices Select this check box to enable the user role to 
approve vendor invoices. 

Submit Draft Invoice Select this check box to enable the user role to submit 
draft invoices. 

Approve Draft Invoice Select this check box to enable the user role to 
approve draft invoices. 

Submit Job Budgets Select this check box to enable the user role to submit 
job budgets. Only users with access rights can select 
this field. 

 

Note: If a user without access rights tries to select 
the Submit Job Budgets field, Maconomy 
displays an error message. 



Appendix A – Field Descriptions 

Enhancements Guide 209 

 

Field Description 

Approve Job Budgets Select this check box to enable the user role to 
approve job budgets. Only users with access rights 
can select this field. 

 

Access Control for Approvers Fields / Descriptions 
Setup » Approval Hierarchies » Approval Hierarchy Rules 

Single Dialogs » Set-Up » Approval » Approval Hierarchy Rules » Approval Hierarchy Rules 

Approver Access Tickets island 

Field Description 

Approved Tickets Expire Select this check box to enable deletion of access tickets after a 
specified number of days after approval. Maconomy runs a daily 
scheduled background task to delete expired tickets.  

If this check box is deselected, approver access tickets do not 
expire. Note that not deleting tickets may gradually impact 
system performance. 

 

Days from Approval to Expiration Specify the number of days before an approved access ticket 
expires and is deleted. 

By default, the value in this field is 60. Maconomy deletes the 
ticket 60 days after the objects in the ticket are approved. 

Unapproved Tickets Expire Select this check box to delete unapproved access tickets after 
a specified number of days. Maconomy runs a daily background 
task to delete expired tickets. t 

 

If this check box is deselected, unapproved access tickets do 
not expire. Note that not deleting tickets may gradually impact 
system performance. 

 

Note: If a user without access rights tries to select 
the Approve Job Budgets field, Maconomy 
displays an error message. 

Note: This functionality does not apply to approval 
hierarchies used in jobs, job budgets, job quotes, and draft 
invoices. 

Note: This functionality does not apply to approval 
hierarchies used in jobs, job budgets, job quotes and draft 
invoices. 
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Field Description 

Days from Submission to Expiration Specify the number of days before a submitted and unapproved 
access ticket expires and is deleted. 

By default, the value in this field is 120. Maconomy deletes the 
ticket 120 days after the ticket is submitted and remains 
unapproved. 

Single Dialogs » Set-Up » Approval » Approver Access Ticket Expiration » Approver Access 
Ticket Expiration 

Action Description 

Delete Expired Tickets This action is run by a scheduled background 
task to delete all expired approver excess 
tickets.  

Approval Hierarchy for General Journal Enhancement Fields 
/ Descriptions 
General Ledger » Financial Operations » General Journal » General Journals » General Journal 

Field Description 

Approval Status This field displays the current approval status of the selected 
general journal, e.g. who and when it was submitted and 
approved. Note that this field only has relevance when general 
journals are set up to be approved via approval hierarchies. 

Actions 

Action Description 

Submit This action submits the general journal for approval. 

The submit action is not shown if you do not use approval 

hierarchies or if you only have line approvals and have not 

yet created a line. You can post the journal in the latter case. 

In other case you will not be able to post the journal (and 

general journal lines) unless it is fully approved. 

Approve This action displays when a general journal has been 
submitted. Use this action to approve the general journal. 
This action will not be enabled after rejection. To approve, 
you will have to undo rejection, and then approve. 

Reject This action displays when a general journal has been 
submitted. Use this action to reject the general journal. 
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Action Description 

Undo Approval/Reject This action displays when a general journal has been 
submitted. Use this action to undo the approval or rejection. 

Approve All This action displays when you have line approval and the 
general journal or the general journal lines have been 
submitted. Use this action to approve the general journal 
(header) and general journal lines. 

Reject All This action displays when you have line approval and the 
general journal or the general journal lines have been 
submitted. Use this action to reject the general journal 
(header) and general journal lines. 

Undo All Approval/Reject
  

This action displays when you have line approval and the 
general journal or the general journal lines have been 
submitted. Use this action to undo approval or reject the 
general journal (header) and general journal lines. 

Setup » Users » Actions Tab 

Single Dialogs » Set-Up » Access Control » Actions» 

Permitted G/L Actions Island 

Action Description 

Submit General Journals Select this check box to allow all users in the selected group 
to submit general journals. Note that the old Submit Journal 
action still exists, but is no longer relevant for General 
Journal. 

Approve General Journals Select this check box to allow all users in the selected group 
to approve general journals. 

Setup » Users » Actions Tab » Company Specific Actions Sub Tab 

Action Description 

Submit General Journals Select this check box to enable the user role to submit 
general journals in the company specified on the line. 

Approve General Journals Select this check box to enable the user role to approve 
general journals in the company specified on the line. 

New DebitCredit Field on ReportingStructureLine Fields / 
Descriptions 
General Ledger » Financial Reporting » Setup » BPM » Reporting Structure » Reporting Structure 



Appendix A – Field Descriptions 

Enhancements Guide 212 

 

Single Dialog » Set-Up » Reporting » Reporting Structures » Reporting Structure Header » 

Reporting Structure Lines Sub-Tab 

Field Description 

Debit/Credit Select whether the account in the reporting 
structure line is a debit or a credit balance. 

Base Salary Rate Calculation for an Employee Range Fields / 
Descriptions 
Human Resources » Base Salary Rate Calculations » Calculation » Calculate Base Salary Rate 

Single Dialog » Human Resources » Compensation Calculation » Calculate Base Salary Rate 

Selection Criteria island  

Field Description 

Employee No. Enter the range of employee numbers to 
include in the base salary rate calculation. If 
this field is blank, Maconomy calculates the 
base salary rate for all employees. 

Self -Approval in Approval Hierarchies Fields / Descriptions 
Setup » Approval Hierarchies » Approval Hierarchy Selections » Approval Hierarchies 

Single Dialog » Set-Up » Approval » Approval Hierarchies 

Approval Hierarchy Island  

Field Description 

Submitter Can Approve (Default) Select this check box to specify the default setting for 
self-approval when creating new approval hierarchy 
lines.  

Setup » Approval Hierarchies » Approval Hierarchy Selections » Approvers 

Single Dialog » Set-Up » Approval » Approval Hierarchies » Approvers 

Field Description 

Submitter Can Approve Select this check box to allow submitters to approve 
their own submittals for an approval hierarchy line. 
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Tracking Partial Payments in Invoice History Fields / 
Descriptions 
Jobs » Jobs » Lookup » Invoice History 

Single Dialogs » API » Job Cost » Lookup » Customer Invoice History » Invoice 

Field Description 

Remainder, Standard This field shows the balance of the invoice, 
pre-invoice or credit memo, which remains to 
be reconciled, in standard currency. 

Remainder, Base This field shows the balance of the invoice, 
pre-invoice or credit memo, which remains to 
be reconciled, in base currency. 

Remainder, Original This field shows the balance of the invoice, 
pre-invoice or credit memo, which remains to 
be reconciled, in original currency. 

Jobs » Job Invoices » Home » Overview 

Price Breakdown island 

Field Description 

Payment Status This field is updated to include: 

 Partially Reconciled – The invoice, 
pre-invoice or credit memo has been 
partially settled. 

Jobs » Jobs » Lookup » Invoice History » Invoice 

Single Dialogs » Job Cost » Lookup » Show Job Invoice » Show Job Invoice 

Single Dialogs » Job Cost » Lookup » Show Job Credit Memo » Show Job Credit Memo 

Status island 

Field Description 

Payment Status This field is updated to include: 

 Partially Reconciled – The invoice, 
pre-invoice or credit memo has been 
partially settled. 

Remainder, Standard This field shows the balance of the invoice, 
pre-invoice or credit memo, which remains to 
be reconciled, in standard currency. 
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Field Description 

Remainder, Invoice Currency This field shows the balance of the invoice, 
pre-invoice or credit memo, which remains to 
be reconciled, in invoice currency. 

Remainder, Base This field shows the balance of the invoice, 
pre-invoice or credit memo, which remains to 
be reconciled, in base currency. 

Single Dialogs » Job Cost » Invoicing » Job Invoice History » Job Invoice History 

Totals island 

Field Description 

Remainder, Base This field shows the balance of the customer 
entry, which remains to be reconciled, in 
base currency. 

Single Dialogs » Job Cost » Invoicing » Job Invoice History » Invoices 

Single Dialogs » Accounts Receivable » Lookup » Show All Invoices » Invoice 

Field Description 

Payment Status This field is updated to include: 

 Partially Reconciled – The invoice, pre-
invoice or credit memo has been 
partially settled. 

Remainder, Standard This field shows the balance of the invoice, 
pre-invoice or credit memo, which remains to 
be reconciled, in standard currency. 

Remainder, Base This field shows the balance of the customer 
entry, which remains to be reconciled, in 
base currency. 

Remainder, Original This field shows the balance of the invoice, 
pre-invoice or credit memo, which remains to 
be reconciled, in original currency. 

Standard Currency This field shows the standard currency of the 
invoice customer entry. 

Base Currency This field shows the base currency of the 
invoice customer entry. 

Original Currency This field shows the original currency of the 
invoice customer entry. 
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Invoice History Enhancements Fields / Descriptions 
Invoice on Account, WIP Invoice, Customer Invoicing 

Invoice History tab 

Field Description 

Remainder This field displays the remaining balance of your invoice, pre-invoice, or credit 
memo, in the currency of your invoice. 

Payment Status This field displays the additional status: 

 Partially Reconciled – The amount due for the job invoice is partially 
paid. The status is color-coded yellow if the invoice has a remaining 
balance and red if there are payments made but the balance is due. This 
is in the currency of your invoice. 

Job Invoices, Collections 

Overview tab 

Field Description 

Remainder This field displays the remaining balance of your invoice, pre-invoice, or credit 
memo, in the currency of your invoice. 

Payment Status This field displays the additional status: 

 Partially Reconciled – The amount due for the job invoice is partially 
paid. The status is color-coded yellow if the invoice has a remaining 
balance and red if there are payments made but the balance is due. This 
is in the currency of your invoice. 

Job Invoices 

Crediting tab 

Field Description 

Remainder This field displays the remaining balance of your invoice, pre-invoice, or credit 
memo, in the currency of your invoice. 

Payment Status This field displays the additional status: 

 Partially Reconciled – The amount due for the job invoice is partially 
paid. The status is color-coded yellow if the invoice has a remaining 
balance and red if there are payments made but the balance is due. This 
is in the currency of your invoice. 

Deltek Talent Management Organizational Structure 
Integration Fields / Descriptions 
Setup » Talent Management Setup » Administration 
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Single Dialog » Set-Up » Set-Up » Talent Management Integration Setup 

Field Description 

Reporting Structure Name This field allows you to select an existing 
reporting structure to export to Talent 
Management. The selected structure must be 
an entity, which is currently the only 
dimension supported in this integration. 

Action 

Action Description 

Export Organizational Structure Select this action to delete all previously 
exported organizational structures and to 
upload a new one. If you delete an 
organizational structure without exporting a 
new one, the Talent Management user 
information will not change. 

In addition, this action creates a background 
task that runs a validation of all the top 
organization levels, and the company and 
entity combinations between Maconomy and 
Talent Management. Once verified that the 
top levels are company numbers and the 
combinations are available, you can export 
the selected organizational structure to Talent 
Management. 

Employee Revisions Enhancements Fields / Descriptions 
Human Resources » Employees » Employees » Employees » Employee Information » Revision 

Selection 

Single Dialogs » Human Resources » Registration » Employee Revisions » Employee Revision 

Selection Criteria  

Employee Revision Selection Criteria island  

Field Description 

Selection Criteria Choose the selection criteria to display the 
employee revisions. 

 Previous – If you select this criteria, the 
previous employee revisions display. 

 Current – This criteria is selected by 
default. It displays the current employee 
revision. 
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Field Description 

 Next – If you select this criteria, the next 
employee revisions displays. 

 All Revisions – If you select this 
criteria, the system shows all revisions. 
Using null dates in both From Date and 
To Date also selects all revisions. Thus, 
no revisions are shown when the 
Selection Criteria field is left blank. 

 Within Range – If you select this 
criteria, Maconomy uses the dates that 
you set in the Selection Range field. If 
any revision overlaps the range fully or 
partly, it will be included. 

Selection Range Select the date range of the employee 
revisions. 

Action 

Action Description 

Save Employee Use this action to save the selection criteria. 

Human Resources » Employees » Employees » Employees » Employee Information » Revision 

Selection » Employee Revisions  

Single Dialogs » Human Resources » Registration » Employee Revisions » Employee Revision 

Selection Criteria » Employee Revisions  

Field Description 

From Date Enter or select the starting date of the 
employee revisions. 

To Date Enter or select the ending date of the 
employee revisions. 

Is Current This field is automatically selected if the line 
contains the current revision. 

Change Description Enter a short description of the employee 
revision. 

Name 1 Enter the employee’s name. 

Title Enter the employee’s personal title, for 
example, Mr., Ms., or Dr. 

Names 2-5 Enter the names of the employees. 
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Field Description 

Phone Enter the contact number of the current 
employee. 

Soc. Security No. Enter the employee’s social security number. 
This field is for reference only. If you entered 
social security number validation rules for the 
employee’s country in the Rules of Validation 
workspace in Set-Up module, Maconomy 
verifies that the social security number 
complies with the validation rules.  

Country Enter the employee’s country of residence. 

Blocked Select the check box to block the employee. 
A blocked employee cannot be used in any 
other workspaces. 

Time Unit Specify the unit of time for the employee, as 
either Hour or Day. This field affects the 
interpretation of every field that represents 
time on the employee and is the Time Unit on 
new time sheets created by (or for) the 
employee in the period covered by the 
current employee revision. 

Cost Enter the employee’s cost per hour or day 
(depending on the Time Unit). If the field is 
blank, Maconomy uses the cost of the item in 
the Item No. field. If both fields are blank, the 
cost for time activities for this employee is 
considered zero. 

Base Salary Rate This field shows the base salary rate for the 
employee. If you change this field, 
Maconomy updates the Cost with the sum of 
this field and the overhead rate. The base 
salary rate is per hour or day, depending on 
the Time Unit. 

Overhead Rate This field shows the overhead cost rate 
allocated to the employee. If you change this 
field, Maconomy updates the Cost with the 
sum of this field and the base salary rate. The 
overhead rate is per hour or day, depending 
on the Time Unit. 

Overhead Rate % This field shows all the costs associated with 
the employee that is not strictly his salary. 
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Field Description 

Overhead Rate as % This field shows the percentage of all the 
costs associated with the employee that is 
not strictly his salary. 

Overhead Maintenance This field indicates whether the overhead 
maintenance cost is being updated by a 
batch update or employee specific. 

Note that it is not possible to delete a revision 
if you selected batch update. 

Intercompany Price Enter a price to use as the cost when the 
employee registers hours on a job assigned 
to another company than the one in which 
the employee is employed. However, the 
calculation of cost prices may also depend on 
other factors. The intercompany price is per 
hour or day, depending on the Time Unit.  

Billing Price Enter the billing price per hour for entries 
registered by the current employee. The 
billing price is per hour or day, depending on 
the Time Unit. 

Item No. Enter a warehouse item, from which the sales 
price and cost is suggested in budgeting, and 
which is used in job journal entries for this 
employee. Maconomy verifies that the item 
you enter exists in the system and is not 
discontinued. 

Sales Employee Select the check box to mark the employee 
as a sales employee. 

Account Manager Select the check box to mark the employee 
as an account manager. 

Zip Code Enter the zip code of the employee. 

Postal District Enter the name of the postal district in which 
the current employee resides. 

Profession Enter the employee’s profession. This is for 
reference only. 

Education Enter the employee’s education. This is for 
reference only. 

Position Enter the employee’s position. This is for 
reference only. 



Appendix A – Field Descriptions 

Enhancements Guide 220 

 

Field Description 

Alternative Job Title Enter a job title with a different classification 
level than Position field. 

EEO Classification Use this field for equal employment 
opportunity tracking. 

Bank Name Enter the name of the employee’s bank. This 
field is for reference only. 

Reg. No. Enter the registration number of the 
employee’s bank. This field is for reference 
only. 

Bank Acc. No. Enter the employee’s bank account number. 
This field is for reference only. 

Date Employed Enter the date when the employee started 
working. This is for reference only. 

Termination Date Enter the date the employment was 
terminated. 

Time Sheet Start Date Enter the date the employee starts using 
timesheets. Maconomy automatically keeps 
the field synchronized with the Date 
Employed field unless you manually enter a 
different value. 

Time Sheet End Date Enter the date the employee stops using 
timesheets. Maconomy automatically keeps 
the field synchronized with the Termination 
Date field unless you manually enter a 
different value. 

Check-in Select if the current employee is expected to 
check in for work. The possible entries are: 

 Disabled 

 Optional 

 Required 

 Required with Balance 

Base Salary, Code Enter a base salary code that denotes a 
salary group, and so on. The field is for 
reference only. 

Base Salary Enter the base salary rate for the employee. 
If you change this field, Maconomy updates 
the Cost with the sum of this field and the 
overhead rate. The amount must be entered 
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Field Description 

in the base currency of the company. The 
base salary rate is per hour or day, 
depending on the Time Unit. 

Salary Supplement, Code Enter a salary supplement code that denotes 
a salary group, and so on. The field is for 
reference only. 

Salary Supplement Enter the employee’s salary supplement, if 
applicable. The amount must be entered in 
the base currency of the company. 

Overtime Rate, Code Enter the overtime rate code that denotes a 
salary group, and so on. The field is for 
reference only. 

Overtime Rate Enter the employee’s hourly rate for overtime 
work. The amount must be entered in the 
base currency of the company. 

Withholding Rate Enter the employee’s withholding rate. This 
field is for reference only. 

Allowance per Month Enter the employee’s monthly tax allowance, 
if applicable. This field is for reference only. 

Allowance per Fortnight Enter the employee’s fortnightly tax 
allowance, if applicable. This field is for 
reference only. 

Allowance per Week Enter the employee’s weekly tax allowance, if 
applicable. This field is for reference only. 

Allowance per Day Enter the employee’s daily tax allowance, if 
applicable. This field is for reference only. 

Tax Allowance Card Select the check box if the employee has a 
valid tax allowance card. This field is for 
reference only. 

Tax Allowance Enter the employee’s total tax allowance. 
This field is for reference only. 

Pension Plan, Company Select the check box if the employee joined a 
company pension plan. The field is for 
reference only. 

Pension Type, Company Enter the employee’s company pension plan. 
The fields are for reference only. 
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Field Description 

Pension Amount, Company Enter the amount to be paid to the 
employee’s company pension. 

Pension Plan, Personal Select the check box if the employee has a 
private pension plan. The field is for 
reference only. 

Pension Type, Personal Enter the employee’s private pension plan. 
The field is for reference only. 

Pension Amount, Personal Enter the amount to be paid to the 
employee’s private pension. 

Remarks 1-5 Enter information related to the current 
employee. 

Supervisor, No.  Enter the number of a senior employee. 
Unless you give the user the access to all 
time sheets in the Actions workspace, the 
user will only have access to changing, 
creating, approving, and printing his or her 
own time sheets and those of junior 
employees. 

Maximum Working Time Enter the maximum number of time per day 
that can be entered for the employee in the 
Time Sheets workspace in the Job Cost 
module. This field is per hour or day, 
depending on the Time Unit. 

Absence Hours per Day Enter the maximum number of absence 
hours per day. By default, the value in this 
field is zero. 

Use Fixed Working Time as Maximum Select the check box to automatically set the 
fixed working time as maximum and override 
the maximum working time. 

Employee Type Select the employee type that you created in 
the Popup Fields workspace. 

Willing to Relocate Select the check box to indicate that the 
employee is willing to relocate. 

Employment No. Enter the employment number of the 
employee associated with the entry. If the 
employee has several functions in the 
company, you can use this number to 
indicate one of the functions. 
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Field Description 

Subcontractor Vendor, No. Select a subcontractor vendor number (if 
any) for the employee. Job entries posted for 
the employee have the reconciliation 
subcontractor number assigned accordingly. 

Department Enter the department to which the employee 
belongs. 

Secretary, No. Enter the number of a secretary assigned to 
the employee. Among the tasks of a 
secretary can be entering the employee’s 
time sheets and transferring them for further 
editing in the Job Journal single dialog 
workspace. 

Fixed Working Time, Monday-Sunday Enter the employee’s working hours for each 
day. If you change an existing working time, a 
warning message displays stating that 
absence registrations using allowance 
already exist for the period (employee 
revision), and changing the value may require 
allowance adjustment. 

Minimum Working Time Enter the minimum amount of working time to 
be calculated for the employee. 

Deviation Allowed Specify the amount to use for calculating the 
minimum amount of time, which the 
employee must specify for each day in a time 
sheet. The minimum number of hours is 
calculated as the fixed working time less the 
number in this field. 

Week Calendar No. Enter or select a week calendar to assign to 
the current employee. 

Job Price Group No. Enter or select the number of the job price 
group assigned to the current employee. 

Popup 1-5 Select various information about the 
employee. For each field, you can choose 
from the options created as values Employee 

Popup 1 – Employee Popup 5 in the Popup 

Fields single dialog workspace. 

Statistics 1-4 Enter a number of statistics codes for further 
specification of the employee. For example, 
you can use the statistics codes as selection 
criteria in a number of printouts. 
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Field Description 

Vendor No. Specify the number of a vendor, thus 
associating the employee with a vendor in the 
A/P module. This way, outlay 
reimbursements to a given employee can be 
handled through the A/P module. 

Primary Employee Category No. This field shows the number of the primary 
employee category of the employee. 

Reduction % Enter a reduction percentage of the 
employee’s available time, “planning time,” as 
part of the fixed amount of working time. 

Document Archive No. Assign a document archive number to the 
employee in question. 

E-mail Specify the e-mail address of the employee. 
The field is for reference only. 

Personal Email Address Enter the contact person's personal e-mail 
address. 

E-mail when responsible for approval Select the check box if the employee prefers 
to be notified if he is responsible for approval, 
for example, a purchase order or an expense 
sheet. The field is for information only, as 
Maconomy does not automatically notify the 
employee. 

E-mail when responsible for invoice 
allocation 

Select the check box if the employee prefers 
to be notified if he is responsible for allocating 
an invoice. The field is for information only, 
as Maconomy does not automatically notify 
the employee. 

Standard Billing Price Enter the standard billing price per hour for 
entries registered by the current employee. 
The standard billing price is used if the Use 
standard billing price for time activities 
system parameter is enabled, otherwise the 
standard billing price is set to equal the 
registered billing price. 

Initials Specify the initials by which the employee is 
known in the company. Maconomy checks 
that other employees do not use the initials in 
the system. 

Maiden Name Enter the employee’s maiden name. 
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Field Description 

Name in Local Alphabet Enter the employee’s name in their local 
alphabet. 

Gender Specify the gender of the employee. The field 
is for reference only. 

Date of Birth Enter the employee’s date of birth. 

Mobile Specify the primary mobile phone number of 
the current employee. The field is for 
reference only. 

Mobile 2 Specify the secondary mobile phone number 
of the current employee. The field is for 
reference only. 

Phone 2 Specify the secondary phone number of the 
current employee. The field is for reference 
only. 

Notice Date Enter the date when the employee is given 
notice if he was terminated or the date when 
he gave notice if he resigned. 

Retirement Date Specify the date when the employee has 
retired or is expected to retire. 

Date 1-5 Specify a number of dates related to the 
current employee. 

Amount 1-5 Specify a number of amounts related to the 
current employee. 

Option List 1-10 Select a number of option lists containing 
values that you wish to use for further 
specification of the employee. 

Selected Value 1-10 Specify values available in the respective 
option lists you specified. If you have not 
entered an option list in one of the Option 
List fields, you can enter any value in the 
corresponding value field. 

Text 1-5 Enter additional text to apply to the employee 
in question. 

Real 1-5 Specify a number of figures relating to the 
current employee. 

Boolean 1-5 Assign attributes to the current employee. 
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Field Description 

Absence Approver, No. Specify the number of the employee 
responsible for approving absence for the 
current employee. 

Fixed Number of Absence Hours, Monday-
Sunday 

Enter how many hours the current employee 
is expected to be absent for each day in the 
week. 

Working Hours Range This field shows the range of the actual 
working hours. 

Permitted Deviation, Work Hours Specify the maximum permitted difference 
between the actual working hours and the 
number of registered hours. The difference is 
shown in the Balance field in the time sheet. 
This field cannot be completed for employees 
with Time Unit "Day." 

Checked in, Expected Time, Monday-Sunday Enter the time when the current employee is 
expected to check in for work. 

Checked Out, Expected Time, Monday-
Sunday 

Enter the time when the current employee is 
expected to check out from work. 

Mentor No. Enter the number of a mentor assigned to the 
employee, for instance to help train the 
employee. The mentor assigned in this field 
is automatically granted read-only access to 
the time and expense sheets of the employee 
in question. 

Substitute 1-5 These fields show the substitute approvers 
who support the handling of substitute 
approvals. 

Must Use Time Sheets Select the check box to require the current 
employee to create time sheets. 

Posting Reference, Commission Enter the number of a dimension combination 
that contains the G/L account to use when 
posting general journals from commission 
calculations in the Commission Calculation 
single dialog workspace 

Posting Reference, Commission Offset Enter the number of a dimension combination 
that contains the G/L account to use when 
posting general journals from commission 
calculations in the Commission Calculation 
single dialog workspace. 



Appendix A – Field Descriptions 

Enhancements Guide 227 

 

Field Description 

Transfer Location Select the check box to derive the location of 
the dimension Account from the current 
employee. 

Transfer Entity Select the check box to derive the entity of 
the dimension Account from the current 
employee. 

Transfer Project Select the check box to derive the project of 
the dimension Account from the current 
employee. 

Transfer Purpose Select the check box to derive the purpose of 
the dimension Account from the current 
employee. 

Transfer Spec. 2-3 Select the check box to derive the entries of 
these fields for the dimension Account from 
the current employee. 

Transfer Local Spec. 1-3 Select the check box to derive the entries of 
these fields for the dimension Account from 
the current employee. 

Description Enter information that describes the current 
employee. 

Selected Value Enter or choose a value from the selected 
option list. 

Dimension Comb. No. Enter the number of a dimension combination 
of the Dimension Derivation type created in 
the Dimension Combinations single dialog 
workspace. 

Dim. Comb., Description Enter the description of the dimension 
combination. 

Account No. Enter the employee’s bank account number. 
This field is for reference only. 

Account Name Enter the employee’s bank account name. 
This field is for reference only. 

Overwrite Account Select the check box to overwrite the existing 
account. 

Local Account No. Enter the employee’s local account number. 
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Field Description 

Local Account, Description Enter a description of the employee’s local 
account number. 

Overwrite Local Account Select the checkbox to require local account 
set on the employee to overwrite local 
accounts set on higher-level relations. 

Location Enter a value for the dimension Location if 
you want a value to be derived from the 
current employee. 

Location, Description Enter a description of the Location assigned 
to the employee. 

Overwrite Location Select this check box to control whether the 
Location can be overwritten by the derived 
Location specified on this account. 

Entity Enter a value for the dimension Entity if you 
want a value to be derived from the current 
employee. 

Entity, Description Enter a description of the Entity assigned to 
the employee. 

Overwrite Entity Select this check box to control whether the 
Entity can be overwritten by the derived 
Entity specified on this account. 

Project Enter a value for the dimension Project if you 
want a value to be derived from the current 
employee. 

Project, Description Enter a description of the Project assigned to 
the employee. 

Overwrite Project Select this check box to control whether the 
Project can be overwritten by the derived 
Project specified on this account. 

Purpose Enter a value for the dimension Purpose if 
you want a value to be derived from the 
current employee. 

Purpose, Description Enter a description of the Purpose assigned 
to the employee. 

Overwrite Purpose Select this check box to control whether the 
Purpose can be overwritten by the derived 
Purpose specified on this account. 
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Field Description 

Spec. 2-3 Enter a value for the dimension Specification 
if you want a value to be derived from the 
current employee. 

Spec. 2-3, Description Enter a description of the Specification 
assigned to the employee. 

Overwrite Spec. 2-3 Select this check box to control whether the 
Specification can be overwritten by the 
derived Specification indicated on this 
account. 

Local Spec. 1-3 Enter a value for the dimension Local 
Specification if you want a value to be 
derived from the current employee. 

Local Spec. 1-3, Description Enter a description of the Local Specification 
assigned to the employee. 

Overwrite Local Spec. 1-3 Select this check box to control whether the 
Local Specification can be overwritten by the 
derived Local Specification indicated on this 
account. 

Vendor Remittance Emails Workspace Fields / Descriptions 
Accounts Payable » Vendor Remittance Emails » Vendor Remittance Emails 

Selection Criteria island  

Field Description 

Payment No. Enter the payment order’s payment number. 
This is a mandatory field. 

Vendor No. Enter a range of vendor numbers that should 
receive the vendor remittance email. 

Payment Date Enter an interval of payment dates. The 
Payment Orders sub-tab only shows payment 
orders with payment dates within this interval. 

Vendor Group Select a vendor group that should receive the 
vendor remittance email. 

Show Sent Select the check box to show previously sent 
vendor remittance emails. 

Accounts Payable » Vendor Remittance Emails » Vendor Remittance Emails » Payment Orders 



Appendix A – Field Descriptions 

Enhancements Guide 230 

 

Field Description 

Selected Select the check box to send a vendor 
remittance email for this payment. 

Last Sent Date This field shows the date a user last sent the 
vendor remittance email. 

Last Sent By This field shows the user who last sent the 
vendor remittance email. 

Payment Date This field shows the payment date of the 
payment order. 

Pay to Vendor No. This field shows the Pay to Vendor number. 
The Pay to Vendor number indicates the 
address to which payment is sent. 

Supplier No. This field shows the number of the supplier. 

Company No. This field shows the number of the customer. 

Paym. No. This field shows the payment order’s 
payment number.  

Paid, Currency This field shows the payment order amount in 
the delivery vendor’s currency. 

Discount, Currency This field shows the discount amount given in 
the vendor’s currency. 

Currency This field shows the delivery vendor’s 
currency. 

Paid, Base This field shows the payment order amount in 
base currency. 

Discount, Base This field shows the discount amount given in 
the company’s base currency. 

Payment Mode This field shows the payment mode. 

Payment Form This field shows the payment form of the 
payment order. 

Payment Agent This field shows the payment agent used for 
the payment. 

Card Type Code This field shows the payment order’s card 
type code. 
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Field Description 

Payer Identification This field shows the payment order’s payer 
identification. 

Transaction Serial No. This field shows the transaction serial 
number of the payment order. 

Payment Description This field shows the payment description. 

Import Date This field shows the payment order’s import 
date. 

Check Book This field shows the checkbook assigned to 
the current payment order. 

Check No. This field shows the number of the check 
used in connection with the payment order. 

Reference Check No. This field shows the reference number of the 
check used in connection with the payment 
order.  

Origin This field shows the origin of the payment 
order. 

Payment Selection This field shows if a user selected the 
payment order for payment. 

Entered This field shows if the payment agent 
acknowledged receipt of the amount and 
registered the payment order.  

Paid This field shows if the payment agent 
registered the payment order as paid. 

Closed This field shows if the payment order has 
been closed. It is closed when it has been 
approved as paid, closed, or error reported. 

Error Reported This field shows if the payment order has 
been error reported. 

Reversed This field shows if the payment order has 
been reversed. 

Changed by This field shows the name of the user who 
last changed the payment order information. 

Changed on This field shows the date when the payment 
order information was last changed. 

Payment Orders action 
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Action Description 

Select All Click this action to select all payments for 
sending vendor remittance email. 

Deselect All Click this action to deselect all payments for 
sending vendor remittance email. 

Email Remittances Click this action to send the email 
remittances for the payments selected. 

Accounts Payable » Vendor Remittance Emails » Vendor Remittance Email Logs 

Single Dialogs » Accounts Payable » Registration » Vendor Remittance Email Logs 

Selection Criteria island  

Field Description 

Payment No. Enter the payment number to display in the 
Vendor Remittance Email Log sub-tab.  

Vendor No. Enter a range of vendor numbers that should 
display in the Vendor Remittance Email Log 
sub-tab. 

Company Number Enter the company number that should 
display in the Vendor Remittance Email Log 
sub-tab. 

Payment Date Enter an interval of payment dates. The 
Vendor Remittance Email Log sub-tab only 
shows entries with payment dates within this 
interval. 

Logged Date Enter a range of email log dates that should 
display in the Vendor Remittance Email Log 
sub-tab. 

Show successful attempts Select the check box to show the vendor 
remittance emails that Maconomy was able 
to send successfully. 

Show unsuccessful attempts Select the check box to show the vendor 
remittance emails that Maconomy was 
unable to send successfully. 

Accounts Payable » Vendor Remittance Emails » Vendor Remittance Email Logs » Vendor 

Remittance Email Log 

Single Dialogs » Accounts Payable » Registration » Vendor Remittance Email Logs » Vendor 

Remittance Email Log 
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Field Description 

Logged Date This field shows the date when a user 
attempted to send the vendor remittance 
email. 

Logged Time This field shows the time when a user 
attempted to send the vendor remittance 
email. 

Logged By This field shows the user who sent the 
vendor remittance email. 

Failed, Missing Email This field specifies if the vendor remittance 
email failed. 

Payment No. This field shows the payment order’s 
payment number. 

Payment Line No. This field shows the payment line number 
used as reference to a specific payment 
order. 

Payment Date This field shows the payment date of the 
payment order. 

Payment Group No. This field shows the payment group number, 
if you assigned a group to the payment order. 

Company No. This field shows the number of the customer. 

Vendor Number This field shows the payment order’s 
payment vendor number. 

Name 1 This field shows the name of the company 
vendor based on the origin of the payment 
line. 

Remittance Email Address This field shows the email address specified 
for a vendor linked to the payment selected 
for email. 

Currency This field shows the delivery vendor’s 
currency. 

Paid in Standard This field shows the amount paid in the 
vendor’s standard currency. 

Single Dialogs » Accounts Payable » Setup » Vendor Information Card  

Single Dialogs » Accounts Payable » Setup » Company Specific Vendor Information Card 
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Field Description 

Remittance Email Address Specify the email address of the vendor 
linked to the payment where Maconomy 
sends the vendor remittance email. 

Aggregate Finance Entries Over Dimensions and Tasks 
Single Dialog » General Ledger » Lookup » Show Dimension Periods  

Period Information island  

Field Description 

Fiscal Year This field shows the fiscal year when the 
dimension period aggregates over the 
finance entries. 

Company No. This field shows the company number the 
dimension period aggregates over the 
finance entries. 

Account No. This field shows the account number the 
dimension period aggregates over finance 
entries. 

Local Account No. This field shows the local account number the 
dimension period aggregates over finance 
entries. 

Base Currency This field shows the currency of the company 
of the dimension period. 

Account Currency This field shows the currency of the account 
where you posted the finance entries of the 
dimension period. 

Debit Balance island 

Field Description 

Debit 1-12, Base These fields show the aggregated base debit 
amount of the finance entries posted in the 
1st-12th period of the fiscal year. 

Credit Balance island 



Appendix A – Field Descriptions 

Enhancements Guide 235 

 

Field Description 

Credit 1-12, Base These fields show the aggregated base credit 
amount of the finance entries posted in the 
1st-12th period of the fiscal year. 

Tax island 

Field Description 

Tax Opening This field shows the opening tax balance of 
the dimension period. 

Tax 1-12 These fields show the aggregated tax amount 
of the finance entries posted in the 1st-12th 
period of the fiscal year. 

Dimensions island 

Field Description 

Location This field shows the location where the 
dimension period aggregates over the 
finance entries. 

Entity This field shows the entity by which the 
dimension period aggregates over the 
finance entries. 

Project This field shows the project by which the 
dimension period aggregates over the 
finance entries. 

Purpose This field shows the purpose by which the 
dimension period aggregates over the 
finance entries. 

Spec. 1-10 These fields show the specifications of the 
dimension period that aggregates over the 
finance entries. 

Local Spec. 1-10 These fields show the local specifications of 
the dimension period that aggregates over 
the finance entries. 

Opening Balance island 

Field Description 

Debit Opening, Base This field shows the opening debit balance of 
the dimension period in base currency. 
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Field Description 

Credit Opening, Base This field shows the opening credit balance of 
the dimension period in base currency. 

Debit Opening, Currency This field shows the opening debit balance of 
the dimension period in account currency. 

Credit Opening, Currency This field shows the opening credit balance of 
the dimension period in account currency. 

Debit Opening, Enterprise This field shows the opening debit balance of 
the dimension period in enterprise currency. 

Credit Opening, Enterprise This field shows the opening credit balance of 
the dimension period in enterprise currency. 

Year End Result island 

Field Description 

Debit Year End Result, Base This field shows the year-end debit balance 
of the dimension period in base currency. 

Credit Year End Result, Base This field shows the year-end credit balance 
of the dimension period in base currency. 

Debit Year End Result, Currency This field shows the year-end debit balance 
of the dimension period in account currency. 

Credit Year End Result, Currency This field shows the year-end credit balance 
of the dimension period in account currency. 

Debit Year End Result, Enterprise This field shows the year-end debit balance 
of the dimension period in enterprise 
currency. 

Credit Year End Result, Enterprise This field shows the year-end credit balance 
of the dimension period in enterprise 
currency. 

Quantity A island 

Field Description 

Quantity A Opening This field shows the opening quantity A of the 
dimension period. 

Quantity A Year End Result This field shows the year-end quantity A of 
the dimension period. 



Appendix A – Field Descriptions 

Enhancements Guide 237 

 

Field Description 

Quantity A 1-12 These fields show the aggregated quantity A 
of the finance entries posted in the 1st-12th 
period of the fiscal year. 

Quantity B island 

Field Description 

Quantity B Opening This field shows the opening quantity B of the 
dimension period. 

Quantity B Year End Result This field shows the year-end quantity B of 
the dimension period. 

Quantity B 1-12 These fields show the aggregated quantity B 
of the finance entries posted in the 1st-12th 
period of the fiscal year. 

Committed island 

Field Description 

Committed Opening, Base This field shows the committed opening of 
the dimension period in base currency. 

Committed 1-12, Base These fields show the aggregated committed 
amounts of the finance entries posted in the 
1st-12th period of the fiscal year. 

Single Dialog » General Ledger » Lookup » Show Dimension Task Periods  

Period Information island 

Field Description 

Fiscal Year This field shows the fiscal year when the 
dimension task period aggregates over the 
finance entries. 

Company No. This field shows the company number the 
dimension task period aggregates over the 
finance entries. 

Account No. This field shows the account number the 
dimension task period aggregates over 
finance entries. 

Local Account No. This field shows the local account number the 
dimension task period aggregates over 
finance entries. 
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Field Description 

Task Name This field shows the task name the dimension 
task period aggregates over finance entries. 

Base Currency This field shows the currency of the company 
of the dimension task period. 

Account Currency This field shows the currency of the account 
where the finance entries of the dimension 
task period are posted. 

Debit Balance island 

Field Description 

Debit 1-12, Base These fields show the aggregated base debit 
amount of the finance entries posted in the 
1st-12th period of the fiscal year. 

Credit Balance island 

Field Description 

Credit 1-12, Base These fields show the aggregated base credit 
amount of the finance entries posted in the 
1st-12th period of the fiscal year. 

Tax island 

Field Description 

Tax Opening This field shows the opening tax balance of 
the dimension task period. 

Tax 1-12 These fields show the aggregated tax amount 
of the finance entries posted in 1st-12th period 
of the fiscal year. 

Dimensions island 

Field Description 

Location This field shows the location where the 
dimension task period aggregates over the 
finance entries. 

Entity This field shows the entity by which the 
dimension task period aggregates over the 
finance entries. 
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Field Description 

Project This field shows the project by which the 
dimension task period aggregates over the 
finance entries. 

Purpose This field shows the purpose by which the 
dimension task period aggregates over the 
finance entries. 

Spec. 1-10 These fields show the specifications of the 
dimension task period that aggregates over 
the finance entries. 

Local Spec. 1-10 These fields show the local specifications of 
the dimension task period that aggregates 
over finance entries. 

Opening Balance island 

Field Description 

Debit Opening, Base This field shows the opening debit balance of 
the dimension task period in base currency. 

Credit Opening, Base This field shows the opening credit balance of 
the dimension task period in base currency. 

Debit Opening, Currency This field shows the opening debit balance of 
the dimension task period in account 
currency. 

Credit Opening, Currency This field shows the opening credit balance of 
the dimension task period in account 
currency. 

Debit Opening, Enterprise This field shows the opening debit balance of 
the dimension task period in enterprise 
currency. 

Credit Opening, Enterprise This field shows the opening credit balance of 
the dimension task period in enterprise 
currency. 

Year End Result island 

Field Description 

Debit Year End Result, Base This field shows the year-end debit balance 
of the dimension task period in base 
currency. 
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Field Description 

Credit Year End Result, Base This field shows the year-end credit balance 
of the dimension task period in base 
currency. 

Debit Year End Result, Currency This field shows the year-end debit balance 
of the dimension task period in account 
currency. 

Credit Year End Result, Currency This field shows the year-end credit balance 
of the dimension task period in account 
currency. 

Debit Year End Result, Enterprise This field shows the year-end debit balance 
of the dimension task period in enterprise 
currency. 

Credit Year End Result, Enterprise This field shows the year-end credit balance 
of the dimension task period in enterprise 
currency. 

Quantity A island 

Field Description 

Quantity A Opening This field shows the opening quantity A of the 
dimension task period. 

Quantity A Year End Result This field shows the year-end quantity A of 
the dimension task period. 

Quantity A 1-12 These fields show the aggregated quantity A 
of the finance entries posted in the 1st-12th 
period of the fiscal year. 

Quantity B island 

Field Description 

Quantity B Opening This field shows the opening quantity B of the 
dimension task period. 

Quantity B Year End Result This field shows the year-end quantity B of 
the dimension task period. 

Quantity B 1-12 These fields show the aggregated quantity B 
of the finance entries posted in the 1st-12th 
period of the fiscal year. 

Committed island 
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Field Description 

Committed Opening, Base This field shows the committed opening of 
the dimension task period in base currency. 

Committed 1-12, Base These fields show the aggregated committed 
amount of the finance entries posted in the 
1st-12th period of the fiscal year. 

Access Control for Format Specification Fields / Descriptions 
Setup » Format Specification » Payment » List of Formats » Format  

Setup » Format Specification » Customer Payment » List of Formats » Format  

Setup » Format Specification » Import » List of Formats » Format  

Setup » Format Specification » Export » List of Formats » Format  

Setup » Format Specification » Output Data » List of Formats » Format  

Setup » Format Specification » Input Data » List of Formats » Format  

Single Dialog » Format Specification » Output Data Format » Specification of Output Data Formats 

» Specification of Output Data Formats Tab  

Single Dialog » Format Specification » Input Data Format » Specification of Input Data Formats » 

Specification of Input Data Formats Tab  

Single Dialog » Format Specification » Outgoing Payment Format » Specification of Outgoing 

Payment Formats » Specification of Outgoing Payment Formats Tab  

Single Dialog » Format Specification » Customer Payment Format » Specification of Customer 

Payment Formats » Specification of Customer Payment Formats Tab  

Single Dialog » Format Specification » Import Format » Specification of Import Formats » 

Specification of Import Formats Tab  

Single Dialog » Format Specification » Export Format » Specification of Export Formats » 

Specification of Export Formats Tab  

Access Level island  

Field Description 

Access Level Name Enter the name of the access level required 
to access the format and its forms. 

Access Level Description Enter the description of the access level 
required to access the format and its forms. 

User island 
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Field Description 

Created This field shows the date and name of the 
user who created the format. 

Changed This field shows the date and name of the 
user who recently made changes to the 
format. 

Version This field shows the latest version number of 
the format. The number is incremented by 
one each time a change is made to the 
format. 

Setup » Format Specification » Payment » List of Forms » Form 

Setup » Format Specification » Customer Payment » List of Forms » Form  

Setup » Format Specification » Import » List of Forms » Form  

Setup » Format Specification » Export » List of Forms » Form  

Setup » Format Specification » Output Data » List of Forms » Form  

Single Dialog » Format Specification » Output Data Format » Specification of Output Data Forms » 

Specification of Output Data Forms Tab  

Single Dialog » Format Specification » Outgoing Payment Format » Specification of Outgoing 

Payment Forms » Specification of Outgoing Payment Forms Tab  

Single Dialog » Format Specification » Customer Payment Format » Specification of Customer 

Payment Forms » Specification of Customer Payment Forms Tab  

Single Dialog » Format Specification » Import Format » Specification of Import Forms » 

Specification of Import Forms Tab  

Single Dialog » Format Specification » Export Format » Specification of Export Forms » 

Specification of Export Forms Tab  

User island 

Field Description 

Created This field shows the date and name of the 
user who created the form. 

Changed This field shows the date and name of the 
user who recently made changes to the form. 

Version This field shows the latest version number of 
the form. The number is incremented by one 
each time a change is made to the form. 

Setup » Format Specification » Output Data » List of Records » Record  
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Setup » Format Specification » Input Data » List of Records » Record  

Single Dialog » Format Specification » Output Data Format » Specification of Output Data Records 

» Specification of Output Data Records Tab  

Single Dialog » Format Specification » Input Data Format » Specification of Input Data Records » 

Specification of Input Data Records Tab 

User island 

Field Description 

Created This field shows the date and name of the 
user who created the record. 

Changed This field shows the date and name of the 
user who recently made changes to the 
record. 

Version This field shows the latest version number of 
the record. The number is incremented by 
one each time a change is made to the 
record. 

Setup » Format Specification » Output Data » List of Fields » Field  

Setup » Format Specification » Input Data » List of Fields » Field  

Single Dialog » Format Specification » Output Data Format » Specification of Output Data Fields » 

Specification of Output Data Fields Tab  

Single Dialog » Format Specification » Input Data Format » Specification of Input Data Fields » 

Specification of Input Data Fields Tab  

User island 

Field Description 

Created This field shows the date and name of the 
user who created the data field. 

Changed This field shows the date and name of the 
user who recently made changes to the data 
field. 

Version This field shows the latest version number of 
the data field. The number is incremented by 
one each time a change is made to the data 
field. 

Intercompany Pricing Enhancements Fields / Descriptions 
Single Dialogs » Job Cost » Set-up » Job Price Lists » Job Price Lists tab 
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Selection Criteria island 

Field Description  

Responsible Company Enter a range of responsible companies to limit 
the lines shown in the Job Price List Lines sub-tab 
to match the range specified. 

Executing Company Enter a range of executing companies to limit the 
lines shown in the Job Price List Lines sub-tab to 
match the range specified. 

Jobs » Jobs » Home » Prices » Job Specific Prices sub-tab 

Single Dialogs » Job Cost » Set-up » Job Price Lists » Job Price Lists » Job Price List Lines sub-
tab 

Single Dialogs » Job Cost » Creation » Job Price Information » Job Price information » Job Price 
List Lines sub-tab 

Field Description  

Responsible Company Enter the number of the responsible company for 
which you want to calculate a price or a markup. If 
you leave this field blank, the responsible 
company is not included in the combination of 
factors that cause the line to be used on an entry 
in, for example, a job journal. 

Executing Company Enter the number of the executing company for 
which you want to calculate a price or a markup. If 
you leave this field blank, the executing company 
is not included in the combination of factors that 
cause the line to be used on an entry in, for 
example, a job journal. 

Statutory Reporting Workspace Fields / Descriptions 

Belgium 

Customer Listing 

Reporting » Statutory Reporting » Belgium » Customer Listing  

Selection Criteria island  

Field Description Mandatory 

Representative E-mail Address Enter the representative’s email 
address. 
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Field Description Mandatory 

Company No. Enter the company number to 
include in the report. 

Yes 

Year Enter the year number to 
include in the report. 

No 

Lower Limit Enter the total amount excl. tax 
above or equal to this limit of 
customers that should be 
included in the report. 

Yes 

Include Customers in Credit Select Yes to include customers 
for which the total amount excl. 
tax is more negative or equal to 
the negative value of the Lower 
Limit. The system compares the 
absolute value to the absolute 
value of the Lower Limit.  

Select No to match the total 
amount against the lower limit in 
a normal way. 

Yes 

Customer Listing Action 

Action Description 

Run Report Click this action to start a background task 
that performs the data export based on the 
selection criteria. 

Intra Community Listing 

Reporting » Statutory Reporting » Belgium » Intra Community Listing  

Selection Criteria island  

Field Description Mandatory 

Representative E-mail Address Enter the representative’s email 
address. 

 

Company No. Enter the company number to 
include in the report. 

Yes 

Lower Limit Enter the total amount excl. tax 
above or equal to this limit of 
customers that should be 
included in the report. 

Yes 
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Field Description Mandatory 

Include Customers in Credit Select Yes to include customers 
for which the total amount excl. 
tax is more negative or equal to 
the negative value of the Lower 
Limit. The system compares the 
absolute value to the absolute 
value of the Lower Limit.  

Select No to match the total 
amount against the lower limit in 
a normal way. 

Yes 

Period island  

Field Description Mandatory 

Year Enter the year number to 
include in the report. 

Yes/No 

Quarter No. Enter the quarter number to 
include in the report. 

Yes/No 

Month No. Enter the month number to 
include in the report. 

Yes/No 

Intra Community Listing Action 

Action Description 

Run Report Click this action to start a background task 
that performs the data export based on the 
selection criteria. 

Tax Declaration 

Reporting » Statutory Reporting » Belgium » Tax Declaration  

Selection Criteria island  

Field Description 

Representative E-mail Address Enter the representative’s email address. 

Company No. Enter the company number to include in the 
report. 

Tax Reporting Unit Enter the tax reporting unit to include in the 
report. 

Customer Listing Nihil Copy to come. 
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Field Description 

Ask for Refund Select a value from the drop-down list if you 
want to ask for a refund. 

Ask for Payment Form Select a value from the drop-down list if you 
want to ask for a payment form. 

Period island  

Field Description Mandatory 

Year Enter the year number to 
include in the report. 

Yes/No 

Quarter No. Enter the quarter number to 
include in the report. 

Yes/No 

Month No. Enter the month number to 
include in the report. 

Yes/No 

Tax Declaration Action 

Action Description 

Run Report Click this action to start a background task 
that performs the data export based on the 
selection criteria. 

France 

Accounting Entry File 

Reporting » Statutory Reporting » France » Accounting Entry File 

Common Selection Criteria island  

Field Description Mandatory 

Company No. Enter the company number of 
the opening balance entries and 
finance transactions to include in 
the report. 

Yes 

Fiscal Year Enter the fiscal year to include in 
the report. 

Yes 

Opening Balance Selection Criteria island  
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Field Description Mandatory 

Accounts Excluded Enter the range of accounts for 
which the opening balance 
entries should be excluded in 
the report. 

No 

Transactions Selection Criteria island  

Field Description Mandatory 

Entry Date Enter the entry date of the 
finance transactions to include in 
the report. 

Yes 

Transaction Types Enter the transaction types to 
include in the report. 

Yes 

Accounts Excluded Enter the range of account 
numbers for which the finance 
transactions should be excluded 
in the report. 

No 

 

Accounting Entry File Action 

Action Description 

Run Report Click this action to start a background task 
that performs the data export based on the 
selection criteria. 

Sweden 

Standard Import/Export 

Reporting » Statutory Reporting » Sweden » Standard Import/Export 

Selection Criteria island  

Field Description Mandatory 

Chart of Accounts Type Select the chart of accounts type 
to include in the report. 

Yes 

Company No. Enter or select the company 
number of the accounts to 
include in the report. 

Yes 

Fiscal Year-Period (YYYY-MM) Enter the fiscal year period 
range of the account 

Yes 
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Field Description Mandatory 

transactions to include in the 
report. 

Reporting Structure Name Enter the reporting structure 
name to include in the report. 

Yes 

Number of Previous Years Enter the number of previous 
years to include in the report. 
Shows comparative years. If you 
select 0, then only current year 
shows. If you select 1, it shows 
current and previous year and 
so on. 

Yes 

File Type island  

Field Description Mandatory 

Enter [1] for SIE 1 or Enter [4] 
for SIE 4 

Enter the file type that should be 
created. 

Yes 

Include Optional Fields for SIE 4 island  

Field Description 

#TRANS [Object List] Select the check box to include the 
transaction item in the report. 

Include Dimensions for SIE 4 island  

Field Description 

Activity No. Select the check boxes to include the 
following dimensions in the report: 

 Activity No. 

 Asset No. 

 Customer No. 

 Employee No. 

 Entity Name 

 Item No. 

 Job No. 

 Location Name 

 Project Name 

 Purpose Name 

 Task Name 
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Field Description 

 Vendor No. 

 Spec. 1-10 

 Local Spec 1-10 

Standard Import/Export Action 

Action Description 

Run Report Click this action to start a background task 
that performs the data export based on the 
selection criteria. 

Norway 

Standard Audit File - Tax 

Reporting » Statutory Reporting » Norway » Standard Audit File - Tax  

Selection Criteria island  

Field Description Mandatory 

Company No. Enter the company number to 
include in the report. 

Yes 

Year-Period Enter the range of the year 
period to include in the report. 

Yes 

Chart of Accounts Type Select the chart of accounts type 
to include in the report. 

Yes 

Header Comment Enter information related to the 
exported XML file. 

No 

Standard Audit File - Tax Action 

Action Description 

Generate Report Click this action to generate a background 
task that performs the data export based on 
the selection criteria. 

India 

Overdue Vendor Payments 

Reporting » Statutory Reporting » India » Overdue Vendor Payments 

Selection Criteria island  
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Field Description Mandatory 

From Date Use this field to filter off the 
vendor entries. Only vendor 
entries having an Invoice Date 
equal to or after this date are 
included. 

Yes 

To Date Use this field to filter off the 
vendor entries. Only vendor 
entries having an Invoice Date 
before the number of days 
answered in the Number of 
Days prompt are included. 

Yes 

Number of Days This field states the number of 
days (for example, 45 days) that 
should be used in the filter. The 
default value is 45. 

Yes 

Company No. Use this field to search for or 
enter a company number. 

 

Vendor No. Use this field to search or enter 
a vendor number as needed.  

No 

Vendor Group Use this drop-down to restrict to 
specific vendor groups. 

Multiple valued. 

No 

Country Use this drop-down to include 
only vendors from the countries 
stated by the user. 

Multiple valued. 

No 

Transaction Type Use this text field to enter a 
value or text related to the type 
of transaction. 

 

Transaction No. Use this text field to enter a 
transaction number. 

 

Employee No. Use this field to search for or 
enter an employee number. 

 

Segment This field restricts to a specific 
vendor segments. 

Multiple valued. 

No 

Area This field restricts to a specific 
vendor area. 

No 
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Currency island  

Field Description Mandatory 

Currency Type Use this drop-down to indicate 
which currency type amounts 
should be displayed in the 
report. The possible currency 
types are: 

 Account Currency 

 Base Currency 

 Enterprise Currency 

Yes 

Currency Use this drop-down to indicate 
the currency that should be 
used in the report (EUR, USD, 
DKK, NOK, SEK, GBP).  

 

Print Control island  

Field Description 

Include Inactive Vendors Select the check box to include inactive 
vendors in the list. 

Selection Criteria, Dimensions island  

Field Description 

Location Enter the location to include in the report. 

Entity Enter the entity to include in the report. 

Project Name Enter the project name to include in the 
report. 

Purpose Name Enter the purpose name to include in the 
report. 

Spec. 1-10 Enter the specifications to include in the 
report, as needed. 

Local Spec. 1-10 Enter the local specifications to include in the 
report, as needed. 

Overdue Vendor Payments Action 

Action Description 

Open PDF Report Click this action to open the PDF report 
based on the selected criteria. 
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Action Description 

Open Live Report Click this action to open the report in BI 
LaunchPad. 

Germany 

GoBD 

Reporting » Statutory Reporting » Germany » GOBD 

Selection Criteria island  

Field Description 

Company No. Enter the company number to include in the 
report. 

Period Enter the date interval of the account 
transactions to include in the report. 

Comment island  

Field Description 

Comment Enter additional information related to the 
report. 

File types to Export island  

Field Description 

File types to Export Use this field to include entries for which the 
VAT data is one of the following. You can 
select multiple report types: 

 Asset Master Data 

 Asset Transactions 

 Company Master Data 

 Customer Master Data 

 Customer Transactions 

 Vendor Master Data 

 Vendor Transactions 

 Finance Master Data Account/Local 
Account 

 Finance Transactions 

 Item Master Data 
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Field Description 

 Job Order Transactions 

 Subscription Master Data 

 Order Master Data 

 Finance and VAT Entries  

 Employee Data 

 Banking Master Data 

 Job Master Data 

 Job Entries 

 Tax Master Data 

Note: These reports are retrieved from the 
database and included in the .csv export that 
is generated from the Workspace Client. 

GOBD Action 

Action Description 

Generate Report Click this action to generate a background 
task that performs the data export based on 
the selection criteria. 

New Supplements and Supplement Types Fields / 
Descriptions 
Setup » Documents and Notes » Supplements » Supplements 

Single Dialogs » Set-Up » Note » Supplements  

Use this workspace to store information for all the fields that have a title defined in Supplement Types. 
There can be many instances of Supplements using the structure of a single Supplement Type. The 
islands in this workspace, except for the Supplement Island, are only visible when there are entries in any 
of the corresponding fields in the Supplement Types single dialog workspace. 

Supplement Island  

Field Description 

Supplement Type Enter the name of the supplement type.  

Name Enter the name of the supplement to identify 
and reference the set of fields. The name 
must be unique. 

Description Enter a description of the information stored 
in the Supplements. 
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Field Description 

Area This field shows the value directly inherited 
from Supplement Types single dialog 
workspace. The field is closed for editing. 

Texts Island 

Field Description 

Text 1-30 Enter information related to the titles 
assigned to the free Text fields. 

User Island 

Field Description 

Created This field shows the date and name of the 
user who created the supplement. 

Changed This field shows the date and name of the 
user who recently made changes to the 
supplement. 

Version This field shows the latest version number of 
the supplement. The number is incremented 
by one each time a change is made to the 
supplement. 

Boolean Island 

Field Description 

Boolean 1-10 Enter information related to the titles 
assigned to the Boolean fields. 

Date Island 

Field Description 

Date 1-10 Enter information related to the titles 
assigned to the Date fields. 

Access Level Island 

Field Description 

Access Level Description Enter the description of the access level 
required to access the supplement. 

Access Level Name Enter the name of the access level required 
to access the supplement. 
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Amount Island 

Field Description 

Amount 1-5 Enter information related to the titles 
assigned to the Amount fields. 

Amount 1-5 Currency Specify the currency for Amount 1 to 5. The 
fields are optional. 

Note: The Amount 1 – 5 Currency fields do 
not have corresponding field names in 
Supplement Types single dialog workspace. 
The fields display together with the amount in 
a unit field. 

Integer Island 

Field Description 

Integer 1-5 Enter information related to the titles 
assigned to the Integer fields. 

Real Island 

Field Description 

Real 1-5 Enter information related to the titles 
assigned to the Real fields. 

Supplements actions 

Action Description 

New Supplement Use this action to create a new supplement. 
The Supplement Type and Name fields are 
mandatory fields. 

If you wish to update the supplement, you 
can edit all fields except for the Supplement 
Type and Area fields. 

Delete Supplement Use this action to delete the supplement.  

Note: You can only delete a supplement 
when it is no longer used on any relations. 

Setup » Documents and Notes » Supplements » Supplement Types 

Single Dialogs » Set-Up » Note » Supplement Types  

Use the information in the workspace to indicate which fields from Supplements are in use and define the 

fields with a descriptive title that you can access across Maconomy. 

Supplement Type Island  
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Use the information in the workspace to identify the Supplement Type and define where the Supplements 
display in Maconomy. 

Field Description 

Name Enter the name of the supplement to identify 
and reference the set of titles. The name 
must be unique. 

Description Enter a description and usage of the 
supplement type. 

Area Select the area that controls in which relation 
the Supplements are accessible. You can 
only update this field when the Supplement 
Type Name is not in use on any 
Supplements. 

Texts Island 

The island consists of general titles, such as Text 1 Title and a custom title, such as Title for the free text 
field with name Text 1, which becomes field names in Supplements, for example Invoice Name. 

Field Description 

Text 1-30 Enter the titles to assign to the free Text 
fields with Text 1 to 30 names. 

User Island 

Field Description 

Created This field shows the date and name of the 
user who created the supplement type. 

Changed This field shows the date and name of the 
user who recently made changes to the 
supplement type. 

Version This field shows the latest version number of 
the supplement type. The number is 
incremented by one each time a change is 
made to the supplement type. 

Booleans Island 

Field Description 

Boolean 1-10 Enter the titles to assign to the Boolean 
fields with Boolean 1 to 10 names. 

Dates Island 
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Field Description 

Date 1-10 Enter the titles to assign to the Date fields 
with Date 1 to 10 names. 

Access Level Island 

Field Description 

Access Level Description Enter the description of the access level 
required to access the supplement type. 

Access Level Name Enter the name of the access level required 
to access the supplement type. 

Integers Island 

Field Description 

Integer 1-5 Enter the titles to assign to the Integer fields 
with Integer 1 to 5 names. 

Reals Island 

Field Description 

Real 1-5 Enter the titles to assign to the Real fields 
with Real 1 to 5 names. 

Amounts Island 

Field Description 

Amount 1-5 Enter the titles to assign to the Amount fields 
with Amount 1 to 5 names. 

Supplement Types actions 

Action Description 

New Supplement Type Use this action to create a new supplement 
type. The Name field is a mandatory field. 

If you wish to update the supplement type, 
you can edit all fields except for the Area field 
when the Supplement Type is used on a 
Supplement. 

Delete Supplement Type Use this action to delete the supplement.  

Note: You can only delete a supplement type 
when it is no longer used on any 
Supplements. 
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Jobs » Jobs » Invoicing » Draft Invoices » Invoice Editing 

Jobs » Jobs » Invoicing » Invoice History  

Invoice Island 

Field Description 

Invoice Supplement Name Enter the invoice supplement name to use in 
the draft invoice. You must enter an existing 
Supplement. Otherwise, no validation 
happens before the draft invoice is converted 
to an invoice through the Print Invoice 
action. 

Jobs » Blanket Invoicing » Invoice Selection » Draft Invoices » Invoice Editing  

Jobs » Blanket Invoicing » Invoice Editing » Draft Invoices » Invoice Editing  

Jobs » Batch Invoicing » Invoice Processing » Invoice Draft Status » Draft Invoices » Invoice 

Editing Assistant 

Jobs » Batch Invoicing » Invoice Processing » Job Invoicing » Draft Invoices » Invoice Editing 

Assistant 

Jobs » Batch Invoicing » Invoice Processing » Job Crediting » Draft Credit Memos » Invoice 

Editing Assistant 

Jobs » Batch Invoicing » Invoice Processing » Blanket Invoicing Overview » Blanket Invoicing 

Overview » Bill to Customers » Draft Invoices Assistant » Invoice Editing 

Sales Orders » Sales Orders » Lookup » Invoices » Invoice 

Single Dialogs » Job Cost » Lookup » Show Job Invoice  

Single Dialogs » General Ledger » Lookup » Show Intercompany Invoice Details 

Invoice Island 

Field Description 

Invoice Supplement Name Enter the invoice supplement name to use in 
the invoice. 

Sales Orders » Sales Orders » Lookup » Credit Memos » Credit Memo 

Subscription Orders » Subscription Orders » Lookup » Credit Memos » Show Credit Memo 

Single Dialogs » Job Cost » Lookup » Show Job Credit Memo  

Single Dialogs » Sales Orders » Invoicing » Credit Memos  

Single Dialogs » Sales Orders » Lookup » Show Credit Memo 

Credit Memo Island 
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Field Description 

Invoice Supplement Name Enter the invoice supplement name to use in 
the credit memo. 

Subscription Orders » Subscription Orders » Lookup » Invoices » Show Invoice 

Single Dialogs » Sales Orders » Lookup » Show Invoice 

Invoice Island 

Field Description 

Invoice Supplement Name Enter the invoice supplement name to use in 
the invoice. Currently, this is the only option 
for adding Supplements to Sales Orders and 
Subscription Orders. Thus, you cannot add 
the supplement from a draft. 

Jobs » Job Invoices » Home » Overview » Invoice Supplement 

Supplement Island  

Field Description 

Supplement Type This field shows the name of the supplement 
type.  

Name Enter the name of the supplement to identify 
and reference the set of fields. The name 
must be unique. 

Description Enter a description of the information stored 
in the Supplements. 

Area This field shows the value directly inherited 
from Supplement Types single dialog 
workspace. The field is closed for editing. 

Texts Island 

Field Description 

Text 1-30 Enter information related to the titles 
assigned to the free Text fields. 

User Island 

Field Description 

Created This field shows the date and name of the 
user who created the supplement. 
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Field Description 

Changed This field shows the date and name of the 
user who recently made changes to the 
supplement. 

Version This field shows the latest version number of 
the supplement. The number is incremented 
by one each time a change is made to the 
supplement. 

Boolean Island 

Field Description 

Boolean 1-10 Enter information related to the titles 
assigned to the Boolean fields. 

Date Island 

Field Description 

Date 1-10 Enter information related to the titles 
assigned to the Date fields. 

Access Level Island 

Field Description 

Access Level Description Enter the description of the access level 
required to access the supplement. 

Access Level Name Enter the name of the access level required 
to access the supplement. 

Amount Island 

Field Description 

Amount 1-5 Enter information related to the titles 
assigned to the Amount fields. 

Amount 1-5 Currency Specify the currency for Amount 1 to 5. The 
fields are optional. 

Note: The Amount 1 – 5 Currency fields do 
not have corresponding field names in 
Supplement Types single dialog workspace. 
The fields display together with the amount in 
a unit field. 

Integer Island 
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Field Description 

Integer 1-5 Enter information related to the titles 
assigned to the Integer fields. 

Real Island 

Field Description 

Real 1-5 Enter information related to the titles 
assigned to the Real fields. 

General Ledger » Financial Analysis » Entries » Finance » Entry 

Entry Information Island 

You can customize the layout to add more fields and information in this island. 

Field Description 

Invoice Supplement Name Enter the invoice supplement name to use in 
the finance entries.  

General Ledger » Financial Analysis » Entries » Finance » Entry » Invoice Supplement Assistant 

General Ledger » Financial Analysis » Entries » Customer » Entry » Invoice Supplement Assistant 

Supplement Island  

Field Description 

Supplement Type Enter the name of the supplement type.  

Name Enter the name of the supplement to identify 
and reference the set of fields. The name 
must be unique. 

Description Enter a description of the information stored 
in the Supplements. 

Area This field shows the value directly inherited 
from Supplement Types single dialog 
workspace. The field is closed for editing. 

Texts Island 

Field Description 

Text 1-30 Enter information related to the titles 
assigned to the free Text fields. 

User Island 
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Field Description 

Created This field shows the date and name of the 
user who created the supplement. 

Changed This field shows the date and name of the 
user who recently made changes to the 
supplement. 

Version This field shows the latest version number of 
the supplement. The number is incremented 
by one each time a change is made to the 
supplement. 

Boolean Island 

Field Description 

Boolean 1-10 Enter information related to the titles 
assigned to the Boolean fields. 

Date Island 

Field Description 

Date 1-10 Enter information related to the titles 
assigned to the Date fields. 

Access Level Island 

Field Description 

Access Level Description Enter the description of the access level 
required to access the supplement. 

Access Level Name Enter the name of the access level required 
to access the supplement. 

Amount Island 

Field Description 

Amount 1-5 Enter information related to the titles 
assigned to the Amount fields. 

Amount 1-5 Currency Specify the currency for Amount 1 to 5. The 
fields are optional. 

Note: The Amount 1 – 5 Currency fields do 
not have corresponding field names in 
Supplement Types single dialog workspace. 
The fields display together with the amount in 
a unit field. 
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Integer Island 

Field Description 

Integer 1-5 Enter information related to the titles 
assigned to the Integer fields. 

Real Island 

Field Description 

Real 1-5 Enter information related to the titles 
assigned to the Real fields. 

Supplements actions 

Action Description 

New Supplement Use this action to create a new supplement. 
The Supplement Type and Name fields are 
mandatory fields. 

If you wish to update the supplement, you 
can edit all fields except for the Supplement 
Type and Area fields. 

Delete Supplement Use this action to delete the supplement.  

Note: You can only delete a supplement 
when it is no longer used on any relations. 

General Ledger » Financial Operations » Tax » Tax Settlement » Details Assistant » Tax 
Specifications » Tax Entries 

General Ledger » Financial Operations » Tax » History » Tax Settlement » Details Assistant » Tax 
Specifications » Tax Entries 

Field Description 

Invoice Supplement Name Enter the invoice supplement name to use in 
the tax entries.  

General Ledger » Financial Operations » Tax » Tax Settlement » Details Assistant » Tax 
Specifications » Tax Entries » Invoice Supplement 

The tab dynamically displays only when the invoice of the tax settlement entry has an associated 
supplement. 

Supplement Island  

Field Description 

Supplement Type Enter the name of the supplement type.  
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Field Description 

Name Enter the name of the supplement to identify 
and reference the set of fields. The name 
must be unique. 

Description Enter a description of the information stored 
in the Supplements. 

Area This field shows the value directly inherited 
from Supplement Types single dialog 
workspace. The field is closed for editing. 

Texts Island 

Field Description 

Text 1-30 Enter information related to the titles 
assigned to the free Text fields. 

User Island 

Field Description 

Created This field shows the date and name of the 
user who created the supplement. 

Changed This field shows the date and name of the 
user who recently made changes to the 
supplement. 

Version This field shows the latest version number of 
the supplement. The number is incremented 
by one each time a change is made to the 
supplement. 

Boolean Island 

Field Description 

Boolean 1-10 Enter information related to the titles 
assigned to the Boolean fields. 

Date Island 

Field Description 

Date 1-10 Enter information related to the titles 
assigned to the Date fields. 

Access Level Island 
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Field Description 

Access Level Description Enter the description of the access level 
required to access the supplement. 

Access Level Name Enter the name of the access level required 
to access the supplement. 

Amount Island 

Field Description 

Amount 1-5 Enter information related to the titles 
assigned to the Amount fields. 

Amount 1-5 Currency Specify the currency for Amount 1 to 5. The 
fields are optional. 

Note: The Amount 1 – 5 Currency fields do 
not have corresponding field names in 
Supplement Types single dialog workspace. 
The fields display together with the amount in 
a unit field. 

Integer Island 

Field Description 

Integer 1-5 Enter information related to the titles 
assigned to the Integer fields. 

Real Island 

Field Description 

Real 1-5 Enter information related to the titles 
assigned to the Real fields. 

E-Invoicing with Pagero Fields/Descriptions 
Setup » Pagero Setup workspace » Pagero Setup tab 

Single Dialogs » Integrations » Pagero Setup single dialog 

If you are enabling the e-invoicing integration with Pagero, use this single dialog to specify information 
about the Pagero account to which Maconomy should send invoice xml files. You also need to indicate 
whether Pagero will run with a production system or a test system.  

Field Description 

Pagero Username In this field, enter the e-mail address 
associated with the Pagero account you will 
use for the integration. 
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Field Description 

Current System Nature This field displays the system nature of the 
current system. 

Production Nature If the current system is a production system, 
use this field to specify the system name for 
its corresponding production nature. 
Available options for this field are based on 
the system natures you defined in the 
server.ini file.  

Integrate a production system with Pagero if 
you intend to send printed invoices as xml 
files to Pagero. Pagero will then send these 
invoices to your customers. 

If you specify the same system name for both 
the Production Nature and Test Nature 
fields, Maconomy displays an error message.  

Test Nature If the current system is a test system, use this 
field to specify the system name for its 
corresponding test nature.  

Available options for this field are based on 
the system natures you defined in the 
server.ini file. 

Integrate a test system with Pagero if you 
intend to send printed invoices as xml files to 
Pagero but do not want to send these 
invoices on to actual customers.  

If you specify the same system name for both 
the Production Nature and Test Nature 
fields, Maconomy displays an error message.  

 

Tab Actions  

Action Description 

Update Pagero Login Information After updating your password on the Pagero 
site, click this action to update your Pagero 
login information in the Workspace Client.  

 

Setup » Pagero Setup workspace » Peppol Mappings tab 

Single Dialogs » Integrations » Peppol Mappings single dialog 

As part of the electronic invoicing functionality, the fields in a Maconomy invoice are mapped to specific 
fields in the PEPPOL BIS 3.0 format. There are four mapping types, one for each invoice type: 

 Job Cost Invoice 
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 Job Cost Credit Memo 

 Order Invoice 

 Order Credit Memo 

When you enable the Enable E-Invoicing system parameter, Maconomy enables the four standard 
mappings—one for each of the mapping types or invoice types listed above—and automatically sets them 
as the default mappings. You can view detailed information about those mappings on this single dialog. 

Select a standard/customized mapping name from the filter list to view its details in the tab and sub-tab of 
the single dialog, or select a standard mapping name to use it as a starting point for a customized 
mapping. 

If you create customized mappings, you can also set those as default mappings for their corresponding 
mapping types.  

 

Mapping Information island 

Field Description 

Mapping Name  This field displays the mapping name for the 
mapping type you selected from the filter list. 

When you click the New Peppol Mapping 
Header action to create a customized 
mapping, this field becomes editable. Enter a 
unique name for the mapping. 

You cannot change the value of this field 
once you create and save the customized 
mapping.  

Mapping Type This field displays the type of invoice for 
which the mapping details in the tab and sub-
tab will be used.   

When you click the New Peppol Mapping 
Header action to create a customized 
mapping, this field becomes editable. Select 
a value from the drop-down list. 

The available options are: 

 Job Cost Invoice 

 Job Cost Credit Memo 

 Order Invoice 

 Order Credit Memo 

You cannot change the value of this field 
once you create and save the customized 
mapping. 

Standard If the mapping name/type you selected from 
the filter list is a standard mapping, this check 
box is automatically selected.  
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Field Description 

You cannot edit or delete standard mappings. 

Default Mapping If the mapping name/type you selected from 
the filter list is a default mapping, this check 
box is automatically selected. 

When you click the New Peppol Mapping 
Header action, this check box becomes 
editable. Select this check box if you want the 
customized mapping you are creating to be 
the default mapping for a specific mapping 
type (or invoice type). 

Once you select this check box on the 
customized mapping you are creating and 
you save your changes, Maconomy 
automatically deselects the previous mapping 
specified as default for that mapping type (or 
invoice type).  

You cannot clear this check box directly on 
an existing mapping (whether standard or 
customized).  

Show Unused Lines On standard mappings or existing 
customized mappings, you can select this 
check box if you want to display all Peppol 
elements or lines on the sub-tab, including 
unused lines.  

 

Tab Actions 

Action Description 

New Peppol Mapping Header Click this action to create a customized 
mapping. When you are customizing a 
mapping for a mapping type or invoice type, 
Maconomy begins by listing all the lines and 
values for the standard mapping for that 
mapping type or invoice type.  

Delete Peppol Mapping Header Click this action to delete the customized 
mapping that you selected from the filter list. 
You cannot delete standard mappings. 

 

Setup » Pagero Setup workspace » Peppol Mappings tab » Peppol Mapping Header » Peppol 
Mapping Line sub-tab 

Single Dialogs » Integrations » Peppol Mappings single dialog » Peppol Mapping Header tab » 
Peppol Mapping Line sub-tab 
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The Peppol Mapping Line sub-tab displays the full PEPPOL 3.0 format in levels. Certain line fields are 
editable when you are creating a customized mapping.  

Field Description 

Field Name This field displays the name of the field (or 
Peppol element) in the PEPPOL BIS 3.0 
format 

Mandatory If the Peppol element specified on the current 
line is mandatory, this check box is 
automatically selected. Even when 
customizing a mapping, you cannot exclude 
(by clearing the Included check box) lines 
that are marked as mandatory.  

If a parent line is marked as mandatory, the 
lines under it (sublevels) are also mandatory. 

XML Type This field indicates whether the Peppol 
element on the current line is an attribute, or 
an element (branch or leaf).  

Included If you want to exclude the Peppol element on 
the current line from your customized 
mapping, clear this check box. 

You cannot exclude mandatory lines.  

Maconomy Relation Name When customizing a mapping, use this field 
to select the Maconomy database relation or 
table from which you will specify a value for 
the Maconomy Field Name field. 

The full list of options are: 

 Company Specific Customer 
(CompanyCustomer) 

 Company (CompanyInformation) 

 Document Revision 
(DocumentRevision)  

 Invoice (Invoice) 

 Invoice Line (InvoiceLine) 

 Invoice Line (InvoicePrintoutLine) 

 Job (JobHeader)  

 Sales Orders  (OrderHeader) 

You cannot use all relations everywhere in 
the mapping, or in all mappings. For 
example, InvoicePrintoutLine can only be 
used for job-related mapping and only under 
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Field Description 

the cac:InvoiceLine element. Maconomy will 
validate that these are used correctly. 

Maconomy Field Name  When customizing a mapping, use this field 
to specify the Maconomy field that you will 
map to the Peppol element on the current 
line. You can only choose a field from those 
available in the database relation you 
specified in the Maconomy Relation Name 
field.  

Text When customizing a mapping, use this field 
to specify the fixed text that you want to map 
to the Peppol element on the current line.  

If you specify values for both the Maconomy 
Field Name  and Text fields, Maconomy will 
use the specified text if the specified 
Maconomy field is empty. 

Standard Calculation If you want the PEPPOL element or field to 
display a value calculated from the values of 
other fields in the Maconomy database, use 
this field to make that specification. Select a 
value from the drop-down. The options 
available in this drop-down will depend on 
what you specify in the Maconomy Field 
Name field. 

Calculation Description If you specified a calculation in the Standard 
Calculation field, you can use this field to 
enter a brief description. 

Field Type This field displays the field type of the Peppol 
element on the current line (for example: 
Date, String, or Amount). 

Fixed Mapping If this check box is selected, it means the 
mapping on the current line is fixed by 
Maconomy, and you cannot customize it.  
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